
Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ez az útmutató az ILME-FR7 / ILME-FR7K Interchangeable Lens Digital Camera konfigurációját és működését ismerteti.

Szükség szerint lapozza fel ezt a kézikönyvet és a kapcsolódó készülékek kezelői utasításait.

Áttekintés

Tipikus felhasználási alkalmazások

A rendszer felépítése

Egy egység vezérlése a mellékelt infra távvezérlővel

Egy egység vezérlése táblagéppel vagy számítógéppel

Egy egység vezérlése külső távvezérlővel

Több egység vezérlése külső távvezérlővel

A készülék részeinek és kezelőszerveinek helye

Elölnézet

Hátulnézet

Csatlakozótömb

Oldalnézet

Felülnézet

Alulnézet

Objektívtámasztó

Az infra távvezérlő (tartozék) részeinek helye és szerepe

A webes alkalmazás képernyője

A webes alkalmazás képernyőjének áttekintése

A képernyők közös területének felépítése

Az élő működtető képernyő felépítése

A lejátszásvezérlő képernyő felépítése

A beállító képernyő felépítése
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Előkészítés

Kamera menü

Kameraképernyő

Az egység felszerelése

Felerősítés mozdulatlan helyre, álló helyzetben

Felerősítés magas, mozdulatlan helyre, álló helyzetben

Mennyezetre szerelés

Objektív csatlakoztatása/eltávolítása

Óvintézkedések az objektív csatlakoztatásakor/eltávolításakor

Az objektív kapcsolóinak ellenőrzése

Figyelmeztetések zoomos objektív használata esetére

Objektív felszerelése

Objektív leszerelése

Kábelek csatlakoztatása

Az egység hálózati eszközhöz csatlakoztatása vezetékkel

Tápellátás csatlakoztatása

Használat hálózati feszültségről

A PoE++ táplálás használata

A pásztázás/döntés visszaállítása

Felvételkészítés előtti konfigurálás

Az egység inicializálása a webes alkalmazással

A webes alkalmazás elérése webböngészőből

Az egység inicializálása

Alapvető használati konfigurálás

Memóriakártyák előkészítése

Támogatott memóriakártyák

Memóriakártyák behelyezése

Memóriakártya kivétele

2



Felvételkészítés

Memóriakártyák formázása (inicializálása)

A maradék felvételrögzítési idő ellenőrzése

Memóriakártyák visszaállítása

Alapvető használat

Felvétel elindítása/leállítása

Átkapcsolás memóriakártyák között

A hang ellenőrzése

Időadatok megadása

A felvétel megtekintése (Rec Review)

A keretezés beállítása

Keretezés állító képernyő

A felvételkészítési irány beállítása

A felvételkészítési irány állítása a webes alkalmazással

A pásztázó/döntő mozgás sebességének állítása

A pásztázó/döntő mozgás gyorsulásának állítása

A felvételkészítési irány állítása a mellékelt infra távvezérlővel

A Zoom beállítása

A Zoom Type beállítása

A zoom állítása a webes alkalmazással

A zoomolási sebesség beállítása

A zoomolás állítása a mellékelt infra távvezérlővel

A kamera pásztázó/döntő/zoom helyzetének (előbeállított helyzetének) elmentése/visszaállítása

E-bajonettes objektív kalibrálása

A pásztázó/döntő és zoom helyzet elmentése/visszaállítása a webes alkalmazás használatával

Előbeállított helyzetek átnevezése a webes alkalmazással

Elmentett előbeállított helyzet lecserélése új helyzetre a webes alkalmazással

Elmentett előbeállított helyzet törlése a webes alkalmazással

A pásztázás/döntés és a zoom/fókusz művelet szinkronizálása előbeállított helyzet visszaállításakor
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Az átállási gyorsaság (pásztázás-döntés/zoom/fókusz) módosítása előbeállított helyzet visszaállításakor

A pásztázó/döntő és zoom helyzet elmentése/visszaállítása a mellékelt infra távvezérlővel

A kamera keretezési műveleteinek (PTZ trace) felvétele/lejátszása

Kamera keretezési műveletek rögzítése a webes alkalmazással

Kamera keretezési műveletek lejátszása a webes alkalmazással

A kamera rögzített keretezési műveleteinek törlése a webes alkalmazással

Kamera keretezési műveletek rögzítése a mellékelt infra távvezérlővel

Kamera keretezési műveletek lejátszása a mellékelt infra távvezérlővel

A fókuszálás beállítása

Fókuszállító képernyő

Kézi fókuszálás (Manual Focus) beállítása

Kézi állítás a webes alkalmazással

Kézi állítás a mellékelt infra távvezérlővel

Fókuszálás fókuszhelyzet megadásával (Spot Focus)

Automatikus fókuszálás ideiglenes használata (gombnyomásos automatikus fókuszálás (AF))

Kockázó automatikus fókuszálás használata (Push Auto Focus (AF-S))

Automatikus fókuszálás (Auto Focus) beállítása

Automatikus állítás a webes alkalmazással

Automatikus állítás a mellékelt infra távvezérlővel

Az automatikus fókuszálási mező/helyzet (fókuszmező) beállítása

A fókuszmező gyors átállítása (Focus Setting)

A fókuszmező keretének mozgatása érintéses művelettel (érintéses fókuszmező)

Az automatikus fókuszálás működésének állítása (AF átállási gyorsaság, AF témaelmozdulási érzékenység)

Az automatikus fókuszálási célpont kézi beállítása (AF Assist) a webes alkalmazással

Kézi fókuszálás az automatikus fókuszálás használatakor a mellékelt infra távvezérlővel

Kézi fókuszálás ideiglenes használata automatikus fókuszálás közben (gombnyomásos kézi fókuszálás)

Követés arc és szem érzékeléssel (Face/Eye Detection AF)

Megadott téma követése (Valós idejű követő AF)

A fényerő beállítása
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Hasznos funkciók

Fényerő állító képernyő

A bázisérzékenység beállítása

Automatikus fényerőállítás célszintjének beállítása

A fényrekesz beállítása

A fényrekesz automatikus állítása

A fényrekesz kézi állítása

Az erősítés beállítása

Az erősítés automatikus állítása

Az erősítés kézi állítása

A záridő beállítása

A záridő automatikus állítása

A záridő kézi állítása

A megvilágítási szint (ND szűrő) állítása

Az ND szűrőről

Beállítás előbeállított üzemmódban

Automatikus beállítás változó üzemmódban

Kézi beállítás változó üzemmódban

Természetes színek beállítása (fehéregyensúly)

Fehéregyensúly állító képernyő

A fehéregyensúly automatikus állítása

A fehéregyensúly kézi beállítása

Automatikus fehéregyensúly állítás lefuttatása

A rögzítendő hang konfigurálása

Hang konfiguráló képernyő

A hangbemeneti eszköz kiválasztása

A felvételi hangszint automatikus állítása

A felvételi hangszint kézi állítása

A közvetlen menü használata
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Programozható gombok

Lassított és gyorsított felvétel

Szakaszos videofelvétel készítés (Interval Rec)

Gyorsítótárazott képek rögzítése (Picture Cache Rec)

Egyidejű rögzítés az „A” és „B” memóriakártyára (2-slot Simul Rec)

Videojel figyelő

Klipjelölők

Légzéskompenzálás

Proxy felvétel

A proxy felvétel áttekintése

Proxy felvételkészítés

Felvételkészítés kívánt megjelenéssel

A megjelenés áttekintése

Megjelenés (Look) kiválasztása

Kívánt bázismegjelenés importálása

Megjelenés testre szabása

Megjelenés elmentése

Bázismegjelenés törlése

Felvételkészítés a megjelenés állításával az utófeldolgozás során

Felvételkészítés a megjelenés állításával az utófeldolgozás során

LUT alkalmazása HDMI kimenetre és streamelésre

LUT módosítása

Sötét és világos területek eloszlásának módosítása a rögzített képen

RAW felvétel készítése

RAW videó rögzítése

RAW videó rögzítése lassított és gyorsított felvétel üzemmódban

A Bokeh (Bokeh Control Function) beállítása

A bokeh-vezérlési funkció be/ki kapcsolása
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Hálózati funkciók

A miniatűrök képernyője

Kameramenü és beállítási részletek

A bokeh mértékének állítása

Konfigurációs adatok elmentése és betöltése

Konfigurációs adatok elmentésének és betöltésének áttekintése

ALL fájl mentése

ALL fájl betöltése

Fájlok átvitele

A fájlátvitelről

Fájlátviteli célhely regisztrálása

Fájl választása és feltöltése

Memóriakártyán levő proxy fájl feltöltése a miniatűrök képernyőjéről

Memóriakártyán levő eredeti fájl feltöltése a miniatűrök képernyőjéről

A fájlátviteli állapot ellenőrzése

Feltöltés Secure FTP protokollal

A streamelés konfigurálása

Streamelés

A streamelési formátum beállítása

A streamelési videó kodek beállítása

A streamelési hang kodek beállítása

A streamelés elindítása/leállítása

A miniatűrök képernyője

Klipek lejátszása és klipekkel kapcsolatos egyéb műveletek

Felvett klipek lejátszása

Rögzített klipeken végezhető műveletek

A kamera menü felépítése

A kameramenü használata

A kameramenü használata
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Karakterlánc beírása

User menü

User

Edit User menü

Edit User

Shooting menü

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project menü

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Paint/Look menü

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt menü

P/T Acceleration

TC/Media menü

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring menü

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio menü
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Audio Input

Audio Output

Thumbnail menü

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical menü

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network menü

Wired LAN

File Transfer

Maintenance menü

Language

Clock Set

Hours Meter

Shooting menü beállítások és alapértelmezett értékek

ISO/Gain beállítások és alapértelmezett értékek
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Webes menü és beállítási részletek

AGC Limit beállítások és alapértelmezett értékek

Az egyes felvételi üzemmódokhoz elmentett képminőség beállítások

A webes menü felépítése

Webes menü műveletek

Shooting menü

Focus

Project menü

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look menü

Base Look

Pan-Tilt menü

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring menü

Output Format

Output Display

Audio menü

Audio Input
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Audio Output

Technical menü

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network menü

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 – 3

SSL

Referer Check

Brute Force Attack Protection

Stream menü

Stream

Video Stream

Audio Stream

Maintenance menü

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Külső eszköz csatlakoztatása

Függelék

Service

EULA

Software

Külső monitorok és felvevők csatlakoztatása

RCP/MSU (különtartozék) csatlakoztatása

Kapcsolódás RCP/MSU eszközzel

Egy-az-egyhez kapcsolat az egység és egy RCP között

Az egység használata többkamerás környezetben MSU/kameratávvezérlő szoftver alkalmazásával

A támogatott funkciók listája

Az egység használata a (különtartozék) RM-IP500 távvezérlővel

Az egység használata a (különtartozék) RM-IP500 távvezérlővel

RM-IP500 távvezérlő csatlakoztatása

Szinkronizálás külső eszközzel

Szinkronizálás külső eszközzel

A videojel fázisának szinkronizálása (Genlock)

Az időkód más eszközökhöz zárása

Külső mikrofon vagy hangeszköz csatlakoztatása

Klipek számítógépes kezelése/szerkesztése

Optikai jel kiadása fényvezetőre

Tally jel csatlakoztatása

Követési adatok (free-d) kiadása

Objektívvezérlő csatlakoztatása

Zoomolás objektívvezérlővel

A használattal kapcsolatos figyelmeztetések

Kimeneti formátumok és korlátozások

Hibaelhárítás

Hibaüzenetek/figyelmeztetések
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Menüpontok jegyzéke

Előbeállított helyzet elmentett elemei

Tömbvázlatok

E-bajonettes objektív szoftverének frissítése

Az objektívkioldó gomb védőfedelének felhelyezése

Licencek

Műszaki adatok

Védjegyek
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A rendszer felépítése

Ez az egység perifériás eszközökkel kombinálható különböző rendszerkonfigurációk kialakításához.

E-bajonettes objektív1.

LA-EA3 / LA-EA4 A-bajonett adapter2.

Infra távvezérlő (tartozék)3.

CFexpress Type A memóriakártyák / SDXC memóriakártyák4.

CFexpress Type A kártyaolvasó/ SD kártyaolvasó5.

ECM-680S, ECM-678*, ECM-674* mikrofon6.
EC-0.5X3F5M 3-érintkezős → 5-érintkezős XLR adapterkábel szükséges.*

Hálózati tápegység (tartozék)7.

Videofigyelő8.

RM-IP500 távvezérlő9.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Egy egység vezérlése a mellékelt infra távvezérlővel

A mellékelt infra távvezérlővel egy egységet vezérelhet.

 Videojel
 Jeláram

5-041-958-53(1) Copyright 2022 Sony Corporation

Infra távvezérlő (tartozék)1.

Videofigyelő2.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Egy egység vezérlése táblagéppel vagy számítógéppel

Táblagépet vagy számítógépet csatlakoztathat a készülékhez, majd a készüléket webböngészővel vezérelheti.

 Videojel
 Távvezérlő jel

  Jeláram

5-041-958-53(1) Copyright 2022 Sony Corporation

Videofigyelő1.

Táblagép2.

Számítógép3.

Hozzáférési pont4.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Egy egység vezérlése külső távvezérlővel

Külső távvezérlővel is vezérelhető az egység.

 Videojel
 Távvezérlő jel

  Jeláram

5-041-958-53(1) Copyright 2022 Sony Corporation

Videofigyelő1.

RM-IP500 távvezérlő2.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Több egység vezérlése külső távvezérlővel

Egyetlen külső távvezérlővel legfeljebb 100 egység vezérelhető.

 Videojel
 Távvezérlő jel
 Tally/érintkező jel

  Jeláram

5-041-958-53(1) Copyright 2022 Sony Corporation

Videofigyelő1.

Video kapcsoló2.

Ethernet hub3.

RM-IP500 távvezérlő4.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Elölnézet

Ez a témakör az egység előlapján található elemek helyét és szerepét ismerteti.

Tipp

Az ismertetésben a készüléken nincs csatlakoztatott objektív.

Kamerafej

Megjegyzés

Védje a kamerafejet az erős ütésektől.

1.

Felvétel/állapot jelzőlámpa
Ha felvétel jelzőlámpaként van beállítva, akkor a memóriakártyára történő felvételkor pirosan világít. A lámpa villog,
ha csekély a felvételi adathordozó maradék kapacitása vagy ha hiba történt.

2.
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Részletek: „Hibaüzenetek/figyelmeztetések”.

Ha tally (állapot) jelzőlámpaként van beállítva, akkor piros vagy zöld színnel világít, a külső tally jeltől függően.

Részletek: „Tally jel csatlakoztatása”.
Képérzékelő

Megjegyzés

Ne érintse meg kézzel.

3.

Objektívkioldó gomb
Nyomja meg az objektív leszereléséhez.

Részletek: „Objektív leszerelése”.

4.

Az objektív jelérintkezői

Megjegyzés

Ne érintse meg kézzel.

5.

POWER jelzőlámpa6.

NETWORK jelzőlámpa
Az egység állapotát a POWER és NETWORK jelzőlámpa színe és világítási állapota (világít, villog, nem világít) jelzi.

7.

POWER
jelzőlámpa

NETWORK
jelzőlámpa A készülék állapota

Zölden világít*1
Zölden világít Bekapcsolva (csatlakozik a hálózatra)

Nem világít Bekapcsolva (nem csatlakozik a hálózatra)

Zölden villog Nem világít Készül a bekapcsolódásra

Narancssárgán
világít

Nem világít Készenléti állapotban van

Sárgán villog Nem világít Szoftverfrissítés folyik

Lassú
narancssárga
villogás*2

Lassú zöld
villogás*2

Valami probléma van az egység működésével. Részletek a
rendszernaplóban találhatók. Ha a probléma az egység készenléti
üzemmódba helyezése vagy kikapcsolása, majd újra bekapcsolása után is
fennáll, keresse meg a Sony szervizt.

Gyors
narancssárga
villogás*3

Gyors zöld
villogás*3 Meghibásodott az egység. Keresse meg a Sony szervizt.

Zölden villog, ha parancsot kapott a tartozék infra távvezérlőtől.*1

Lassú villogás: másodpercenként egy villanás*2

Gyors villogás: másodpercenként négy villanás*3

Infra távvezérlő érzékelő
A tartozék infra távvezérlő parancsait veszi.

8.

Levegő bemenet9.
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Kapcsolódó témák

Hibaüzenetek/figyelmeztetések

Tally jel csatlakoztatása

Objektív leszerelése

5-041-958-53(1) Copyright 2022 Sony Corporation

Megjegyzés

Ne akadályozza a levegő áramlását. Ez meghibásodást eredményezhet.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Hátulnézet

Ez a témakör az egység hátoldalán található elemek helyét és szerepét ismerteti.

Kapcsolódó témák

Oldalnézet

5-041-958-53(1) Copyright 2022 Sony Corporation

A kamerafej zárókarja
Zárolja a kamerafej előre/hátra mozgását.

Megjegyzés

Ha nem cserél optikát, mindig állítsa a zárolt helyzetbe.

Az egység szállítása előtt mindig távolítsa el az objektívet és állítsa zárolt helyzetbe.

Ujjbecsípődéses balesetek elkerüléséhez a zárókar működtetése előtt kapcsolja ki az egységet és rögzítse vízszintesen a
kamerafejet a pásztázó/döntő zárókarral. A pásztázó/döntő zárókarral kapcsolatos részletek az „Oldalnézet” cím
„Pásztázó/döntő zárókar” pontjában találhatók.

1.

Csúszótalp2.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Csatlakozótömb

Ez a témakör az egység csatlakozótömbjének helyét és szerepét ismerteti.

 (földelés) csatlakozó
Csatlakoztassa dugalj védőföld kapcsához vagy földelőrúdhoz.

1.

DC IN csatlakozó (szabványos egyenáramú dugalj)
Csatlakoztassa hálózati tápegységhez.

Megjegyzés

Csak az egységhez adott tápegységet csatlakoztassa ide. Más tápegység csatlakoztatása tüzet vagy működési hibát
eredményezhet.

2.

 LAN (adathálózati) csatlakozó (RJ-45)
Hálózati kommunikációhoz és PoE++* tápláláshoz csatlakoztasson (legalább 5e kategóriájú) adatkábelt ide.

A sebességjelző LED állapota
A hálózati adatsebességet jelzi.

3.

PoE++: Power over Ethernet Plus Plus. IEEE802.3bt (4. típus, 8. osztály) kompatibilis. A csatlakoztatásról részletek a tápellátó eszköz
kezelői utasításaiban találhatók.

*
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A Link/ACT LED állapota
A hálózati kapcsolat állapotát jelzi.

Megjegyzés

Ha az internetre kapcsolja ezt a terméket, iktasson közbe védelmi funkciót, például útválasztót vagy tűzfalat. Ilyen védelem
nélkül veszélyeztetheti a termék biztonságát.

Kijelzés  Hálózati adatsebesség

Nem világít
10 Mbit/s-os kapcsolat

100 Mbit/s-os kapcsolat

Narancssárgán világít 1000 Mbit/s-os kapcsolat

Kijelzés  Kapcsolat állapota

 Nem világít Nincs kapcsolat

Zölden villog Van kapcsolat, aktív az adatforgalom

Zölden világít Aktív az adatforgalom

TC IN csatlakozó
Külső referencia időkód jel beadására szolgál.

Részletek: „Az időkód más eszközökhöz zárása”.

4.

HDMI csatlakozó
Az egység videojelét HDMI jelként adja ki.

Részletek: a „Külső monitorok és felvevők csatlakoztatása” rész „HDMI csatlakozó (Type A csatlakozó)” pontja.

5.

A HDMI-kábeltartó lemez rögzítőcsavarja
A HDMI-kábel kihúzás elleni védelméhez rögzítse a mellékelt HDMI-kábeltartó lemezt a mellékelt rögzítőcsavarral
(M2,6×6), és rögzítse a HDMI-kábelt kábelkötegelővel vagy szalaggal.

A HDMI-kábeltartó lemez rögzítéséről részletek: „Kábelek csatlakoztatása”.

6.

OPTION csatlakozó
Külső eszköz vagy objektívvezérlő tally jelének csatlakoztatására szolgál.

Részletek: „Tally jel csatlakoztatása” és „Objektívvezérlő csatlakoztatása”.

7.

Kábelbilincs
A hálózati tápegység vezetékének rögzítésére szolgál.

8.

RESET kapcsoló
Az egység gyári alapértelmezett értékeinek visszaállításához nyomja legalább 5 másodpercig toll hegyével vagy
hasonlóval.
A SETUP 1. kapcsolójával beállíthatja, hogy csak a hálózati kapcsolat beállításait állítsa vissza vagy minden
beállítást visszaállítson.

9.

OPTICAL kimeneti csatlakozó
Optikai formátumra alakított SDI jelet ad ki, ha van csatlakoztatott SFP+ modul (különtartozék).

Részletek: „Optikai jel kiadása fényvezetőre”.

10.
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SETUP kapcsolók

A következő beállításokat konfigurálják.
1. kapcsoló: a RESET kapcsoló megnyomásakor mely beállítások álljanak vissza.

2. kapcsoló: a +48 V tápfeszültség (fantom tápellátás) be/ki kapcsolása hangbemeneti eszköz csatlakoztatásakor. A
beállítás azonnal érvényesül.
Ez a funkció engedélyezve van, ha a kameramenü [Audio] > [Audio Input] > [AUDIO IN Select] pontjának beállítása
[MIC].

Megjegyzés

Ha a 2. kapcsoló ON állásában +48 V-os áramforrással nem kompatibilis mikrofont csatlakoztat, tönkremehet a
csatlakoztatott eszköz. Az eszköz csatlakoztatása előtt ellenőrizze a beállítást.

3. kapcsoló: VISCA over IP kommunikáció engedélyezése/letiltása. A beállítások a kamera bekapcsolásakor
érvényesülnek.
Az egység távvezérlős (RM-IP500) használatakor állítsa ON helyzetbe.

Megjegyzés

Ha nincs beállítva rendszergazda jelszó, a VISCA over IP kommunikáció nem működik, függetlenül a kapcsoló beállításától.
Rendszergazda jelszó beállítása: „Az egység inicializálása.”

4. kapcsoló: az infra távvezérlő pásztázó/döntő sebességének állítása. A beállítás azonnal érvényesül.

11.

Beállítás Magyarázat

OFF
(alapértelmezés)

Csak a hálózati beállítások visszaállítása. Az egység hálózati beállításai, biztonsági
beállításai és felhasználói adatai (felhasználónév és jelszó) lesznek visszaállítva.

ON Minden beállítás visszaállítása gyári alapértelmezésre.

Beállítás Magyarázat

OFF
(alapértelmezés)

Nincs +48 V táplálás (fantom tápellátás). Külső hangjel-szolgáltató eszköz (például keverő),
dinamikus mikrofon vagy saját elemről táplált mikrofon csatlakoztatásakor használja.

ON
+48 V tápfeszültség (fantom tápellátás) kiadása az AUDIO IN csatlakozóra (CH-1 vagy CH-
2) kötött fantom-kompatibilis mikrofonra.

Beállítás Magyarázat

OFF (alapértelmezés) Nem reagál a VISCA over IP parancsokra.

ON Fogadja a VISCA over IP parancsokat.
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Kapcsolódó témák

Az időkód más eszközökhöz zárása

Külső monitorok és felvevők csatlakoztatása

Kábelek csatlakoztatása

Tally jel csatlakoztatása

Objektívvezérlő csatlakoztatása

Optikai jel kiadása fényvezetőre

Az egység inicializálása

A videojel fázisának szinkronizálása (Genlock)

Külső mikrofon vagy hangeszköz csatlakoztatása

5-041-958-53(1) Copyright 2022 Sony Corporation

Beállítás Magyarázat

OFF (alapértelmezés) Normál sebesség.

ON Maximális sebesség.

SDI OUT csatlakozó
Az egység videojelét 12G/6G/3G/HD-SDI jelként adja ki.
Az egység beállítható RAW jel kiadására.

Részletek: a „Külső monitorok és felvevők csatlakoztatása” cím „SDI OUT csatlakozó (BNC típus)” pontjában.

12.

 Infra távvezérlő érzékelő (hátul)
A tartozék infra távvezérlőhöz tartozó infra érzékelő.

13.

Ventilátor/levegő kimenet
Eltávolítja az egységben keletkezett hőt.

Megjegyzés

Ne takarja le a levegőkimenetet. Ez meghibásodást eredményezhet.

Felhívjuk figyelmét, hogy a levegő kimenet körüli terület felforrósodhat.

14.

GENLOCK csatlakozó
Külső szinkronjel beadására szolgál.

Részletek: „A videojel fázisának szinkronizálása (Genlock)”.

15.

AUDIO IN csatlakozó (XLR típusú, 5 érintkezős aljzat)
Külső mikrofon vagy audio eszköz jelének beadására szolgál.
AUDIO IN CH-1 vagy AUDIO IN CH-2 csatlakozóként működik.

Részletek: „Külső mikrofon vagy hangeszköz csatlakoztatása”.

16.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Oldalnézet

Ez a témakör az egység oldalán található elemek helyét és szerepét ismerteti.

Tipp

Az ismertetésben a készüléken nincs csatlakoztatott objektív.

A pásztázó/döntő zárókarja
Lezárja az egység pásztázó/döntő szerkezetét. A következő esetekben használja.

Az egység szállításakor vagy becsomagolásakor.
Objektív fel- vagy leszerelésekor. Részletek: „Objektív felszerelése” vagy „Objektív leszerelése”.
Pásztázó/döntő mozgást nem támogató objektív (például Sony SEL100400GM / SEL200600G / SEL400F28GM /
SEL600F40GM objektív) használatakor.
Az egység szállítása előtt mindig távolítsa el az objektívet és állítsa zárolt helyzetbe.

Tipp

1.
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Kapcsolódó témák
Objektív felszerelése

Objektív leszerelése

Memóriakártyák behelyezése

A webes alkalmazás elérése webböngészőből

5-041-958-53(1) Copyright 2022 Sony Corporation

A pásztázó/döntő mozgás rögzíthető a következő szöghelyzetekben.

Csúszótalp2.

Menetes furatok külső eszközökhöz (4 helyen)
Legfeljebb 6 mm hosszú M3-as csavarokhoz.

Megjegyzés

Ne használjon 6 mm-nél hosszabb csavarokat. Ez meghibásodást eredményezhet.

3.

A hozzáférésjelző4.

B hozzáférésjelző
Felvételi adathordozó behelyezése esetén világít vagy villog.

Részletek: „Memóriakártyák behelyezése”.

5.

CFexpress Type A / SD kártyahely (A)6.

CFexpress Type A / SD kártyahely (B)
Felvételi adathordozók behelyezéséhez használható.

Részletek: „Memóriakártyák behelyezése”.

7.

Hálózati kapcsolat QR-kódja
A kezdeti beállítások konfigurálására szolgál.

Részletek: „A webes alkalmazás elérése webböngészőből”.

8.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Felülnézet

Ez a témakör az egység tetején található elemek helyét és szerepét ismerteti.

Tipp

Az ismertetésben a készüléken nincs csatlakoztatott objektív.

5-041-958-53(1) Copyright 2022 Sony Corporation

Menetes furatok külső eszközökhöz (2 helyen)
Állvány 1/4-20 UNC csavarjaihoz.
Legfeljebb 6 mm hosszúak lehetnek.

1.

ɸ (imager jel)
Az imager jel a képérzékelővel azonos síkban áll.
Az egység és a téma közötti távolság pontos méréséhez használja referenciapontként ezt a jelet.

2.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Alulnézet

Ez a témakör az egység alján található elemek helyét és szerepét ismerteti.

Tipp

Az ismertetésben a készüléken nincs csatlakoztatott objektív.

A mennyezeti konzol rögzítőcsavarjai (6 helyen, 5,5 mm tényleges menetmélység)
Ha az egységet mennyezetre vagy magas polcra szereli, erősítse a (különtartozék) testtartó konzolt a készülék
aljához az ezekbe a csavarfuratokba helyezett hat testtartó rögzítőcsavarral.

Felszerelési részletek: „Felerősítés magas, mozdulatlan helyre, álló helyzetben” és „Mennyezetre szerelés”.

1.

Állványcsavarok (2 helyen)
Az egység kameraállványhoz rögzítésére szolgálnak (különtartozék, legfeljebb 5,5 mm hosszú 1/4-20 UNC
csavarokhoz).

Megjegyzés

2.
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Kapcsolódó témák

Felerősítés magas, mozdulatlan helyre, álló helyzetben

Mennyezetre szerelés

5-041-958-53(1) Copyright 2022 Sony Corporation

Ne használjon 5,5 mm-nél hosszabb csavarokat. Ez meghibásodást eredményezhet.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objektívtámasztó

Ez a témakör az egység objektívtámasztójának a helyét és szerepét ismerteti.

Tipp

Az ismertetésben a készüléken nincs csatlakoztatott objektív.

Objektívtámasztó rúd (2)
Az objektív megtámasztására szolgál.
Általános, Ø15 rudas tartozékok felerősítéséhez is használható.

1.
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5-041-958-53(1) Copyright 2022 Sony Corporation

Objektívtámasztó egység
Az objektívtámasztó az objektívnak megfelelően előre/hátra csúsztatható, majd rögzíthető.

2.

Objektívtámasztó talapzat rögzítőcsavarja
Erősítse az objektívtámasztó talapzatra. A csavar fel/le állítható, az objektívtámasztó talapzat magassága szerint.

3.

Objektívtámasztó rúd bilincs szorítókar (2 helyen)
Az objektívtámasztó egység elülső/hátulsó helyzetének biztosítására szolgál.

4.

Az objektívtámasztó talapzat rögzítőcsavar bilincsének szorítókarja
Az objektívtámasztó talapzat rögzítőcsavar függőleges helyzetének biztosítására szolgál.

Tipp

Ha valamelyik bilincskar olyan helyzetben áll, hogy nehezen forgatható, lazítsa meg a szorítókart, és fordítsa olyan
szöghelyzetbe, ahol könnyebben működtethető. A kívánt helyzet beállítását követően zárja a bilincskart.

A: az objektívtámasztó talapzat rögzítőcsavar bilincsének szorítókarja
B: objektívtámasztó rúd bilincs szorítókar

Megjegyzés

Ha nem használja az objektívtámasztó egységet és nem szeretné, hogy az egység zavarja a pásztázás/döntés műveletét,
tolja fel az objektívtámasztó egységet a kamerafejhez, és állítsa az objektívtámasztó talapzat rögzítőcsavarját a
legmagasabb (az objektívhez legközelebbi) helyzetbe.

5.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Az infra távvezérlő (tartozék) részeinek helye és szerepe

Ez a témakör az infra távvezérlő (tartozék) részeinek helyét és szerepét ismerteti.

REC● (felvétel START/STOP) gomb
Megnyomása elindítja vagy leállítja a felvétel készítését.

1.

MENU gomb
Megnyomása megjeleníti vagy elrejti a kamera menüjét.

2.

GUI kezelőgombok
Megnyomásukkal végezhetők műveletek a kamera menüjében, gombokat tartalmazó üzenet párbeszédekben és
egyéb képernyőkijelzős funkciókban.

3.

CANC./BACK gomb
Megnyomásával törölni lehet egy beállítást vagy vissza lehet lépni az egység kameramenüje előző képernyőjére.

4.
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Az infra távvezérlőbe való elemek

Az infra távvezérlő két AA (LR6) elemmel működik.
Az alábbi ábra szerint helyezze be őket az infra távvezérlőbe.

Pásztázó és döntő kezelőgombok
A nyíl gombokkal vezérelhető a kamera pásztázó/döntő mozgása. A HOME gombbal állítható vissza előre néző
helyzetbe a kamera.

5.

Előbeállított helyzet kezelőgombjai
A PRESET gomb lenyomásával és nyomva tartásával és az 1 – 3 gomb megnyomásával a gombra programozható a
kamera irány-, nagyítás- és fókuszbeállítása.
A programozott állapot a kívánt számgomb megnyomásával hívható le.

6.

Fókusz kezelőgombok
A fókuszálást állítják.
A fókusz automatikus állításához nyomja meg az AF gombot.
A fókusz kézi állításához nyomja meg az MF gombot, majd a F (Távol) gombot távoli vagy a N (Közel) gombot közeli
témákra fókuszáláshoz.

7.

Programozható gombok, 1 – 3
Végrehajtja a programozható gombokhoz rendelt funkciókat, a kamera menüje használatával.
Ha programozható gombhoz rendeli a [Direct Menu] funkciót, a GUI kezelőgombokkal állíthatja az expozíciót,
fehéregyensúlyt és más beállításokat.

A kamera menüjének használatával történő hozzárendeléssel kapcsolatos részletek a „Programozható gombok”
cím alatt találhatók.

A közvetlen menüvel kapcsolatos részletek „A közvetlen menü használata” cím alatt találhatók.

8.

 (ki-be kapcsoló) gomb
Bekapcsolja az egységet vagy készenléti állapotba állítja a táplálást.

9.

THUMBNAIL gomb
Megjeleníti a készülék memóriakártyáján rögzített klipeket mutató miniatűrök képernyőt.

A miniatűrök képernyőjéről további részletek: „A miniatűrök képernyője”.

A GUI kezelőgombokkal klipeket választhat ki és kezelheti a lejátszást a miniatűrök képernyőjén.

Részletek klipek kiválasztásáról és a lejátszás kezeléséről: „Felvett klipek lejátszása” és „Rögzített klipeken
végezhető műveletek”.

10.

SLOT SEL (memóriakártya-hely (A)/(B) választó) gomb
Ha két memóriakártya van a kamerában, ezzel a gombbal válthatók felvételek rögzítéséhez.
A memóriakártyák közötti váltáshoz ezt a gombot nyomja meg, amikor a miniatűrök képernyője látható.

11.

P/T RESET (pásztázás/döntés visszaállító) gomb
Visszaállítja a pásztázó/döntő funkciókat. Akkor nyomja meg ezt a gombot, amikor egyszerre villog a POWER
jelzőlámpa és a NETWORK jelzőlámpa, vagy ha az [Execute Pan-Tilt Reset] látható a webes alkalmazás
keretezésvezérlő panelén.

12.

Zoom kezelőgombok
A közelítéshez nyomja meg a T (Telephoto) gombot.
A távolításhoz nyomja meg a W (Wide) gombot.

13.
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Megjegyzés

Csak mangános vagy alkáli elemet használjon, mert a más típusúak felrepedhetnek.

Az elhasznált elemeket országa vagy régiója törvényei és rendelkezései szerint ártalmatlanítsa.

Kapcsolódó témák

Programozható gombok

A közvetlen menü használata

A miniatűrök képernyője

Felvett klipek lejátszása

Rögzített klipeken végezhető műveletek

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A webes alkalmazás képernyőjének áttekintése

Táblagép vagy számítógép csatlakoztatásával pásztázó/döntő mozgatást vezérelhet, nagyíthat/kicsinyíthet, felvételt
készíthet, felvett videót lejátszhat és konfigurálhatja az egységet webes böngészőről (a továbbiakban ezt a funkciót
„webes alkalmazás” nevezzük).

Részletek a webes alkalmazás elindításáról: „A webes alkalmazás elérése webböngészőből”.

Megjegyzés

A webes alkalmazás nem támogatja a kamera hangkimenetét.

A webes alkalmazás elindulását követően megjelenik a következő élő működtető képernyő.

Élő működtető képernyő

Részletek az élő működtető képernyőről: „Az élő működtető képernyő felépítése”.
Az élő működtető képernyő és a lejátszásvezérlő képernyő közös gombjai és ikonjai a képernyő tetején jelennek
meg.

Részletek a képernyők közös területéről: „A képernyők közös területének felépítése”.
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Képernyők közötti váltáshoz nyomja meg a közös terület képernyőváltó füleit.

Lejátszásvezérlő képernyő

A lejátszásvezérlő képernyő megjelenítéséhez nyomja meg a [Playback] fület.

Részletek a lejátszásvezérlő képernyőről: „A lejátszásvezérlő képernyő felépítése”.

Beállító képernyő

A beállító képernyő (továbbiakban: webes menü) a [Settings] fül megnyomásával jeleníthető meg.
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Megjegyzés

A webes menüben a beállítások csak a [OK] gomb megnyomása után érvényesülnek. Ha olyan oldalon módosítja a beállításokat,
amelyen [OK] gomb van, mindenképpen nyomja meg az [OK] gombot.

Részletek a beállító képernyőről: „A beállító képernyő felépítése”.
Ebben a Súgó útmutatóban a webes alkalmazás beállító képernyőjét webes menünek nevezzük.

Kapcsolódó témák
A webes alkalmazás elérése webböngészőből

Az élő működtető képernyő felépítése

A képernyők közös területének felépítése

A lejátszásvezérlő képernyő felépítése

A beállító képernyő felépítése

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A képernyők közös területének felépítése

Ez a témakör a képernyők közös területének felépítését ismerteti.

A kamera neve
Itt látható a kamera neve.
A kamera neve a webes menü [Network] > [Camera Name] pontjában módosítható.
A háttérszín a külső tally jel szerint változik.

1.

POWER kapcsoló
Ha be van kapcsolva az egység, itt [Power ON] látható. Az egység tápellátásának készenléti állapotba állításához
nyomja meg a kapcsolót és válassza a [Power Standby] lehetőséget.
Ha itt [Power Standby] látható, az egység tápellátásának bekapcsolásához nyomja meg a kapcsolót és válassza a
[Power ON] lehetőséget.

2.

A működtetőképernyő-kapcsoló fülek
A kívánt működtető képernyő megjelenítéséhez nyomjon meg egy fület.
[Live] fül: az élő működtető képernyőt jeleníti meg.
[Playback] fül: a lejátszásvezérlő képernyőt jeleníti meg.
[Settings] fül: a beállító képernyőt (webes menüt) jeleníti meg.

3.

Értesítési jel
Üzenet érkezésekor a jel az alábbiak szerint módosul.

 (Értesítések „be”)
Tegye meg a szükséges lépéseket a kamerakép-panelen megjelenő üzenet szerint.

Megjegyzés

Nem jelennek meg az üzenetek, ha a webes menü [Monitoring] > [Output Display] > [HDMI/Stream] pontjának beállítása
[Off]. Üzenetek tartalmának ellenőrzéséhez állítsa [On] értékre.

4.

 (Kameraállapot) gomb
A gomb megnyomása külön képernyőn megjeleníti a kamerával felvett kép/kimeneti képjel adatait, az objektív adatait
és az objektívvezérlő (különtartozék) állapotát.

5.
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Az objektívvezérlővel (különtartozék) kapcsolatos értesítés esetén a jelzés az alábbiak szerint megváltozik.

A képernyő használatát zároló kapcsoló
 (Működés feloldása): a kapcsoló balra tolása engedélyezi az élő működtető képernyő és a lejátszásvezérlő

képernyő használatát.
 (Működés zárolása): a kapcsoló jobbra tolása letiltja az élő működtető képernyő és a lejátszásvezérlő képernyő

használatát, a véletlen működtetés megakadályozása végett.

6.

43



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Az élő működtető képernyő felépítése

Ez a témakör az élő működtető képernyő felépítését ismerteti.

Előbeállított helyzet vezérlőpanelje
Miniatűrön mutatja egy előbeállítás regisztrált helyzetét. A miniatűrre való dupla rákoppintással visszaállítható az
előbeállításban tárolt helyzet.

Előbeállított helyzet részletei: „A pásztázó/döntő és zoom helyzet elmentése/visszaállítása a webes alkalmazás
használatával”.
A PTZ trace részletes ismertetése a „Kamera keretezési műveletek rögzítése a webes alkalmazással” cím alatt
található.

1.

Kamerakép-panel
A kamera pillanatnyi képét és az egység állapotát jeleníti meg.
Ugyanaz a kép látható itt, mint a HDMI kimeneten.
A következő állapotadatok láthatók a kép felett. A vett külső tally jeltől függően piros vagy zöld keret látható a kép
körül.

2.
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[Display] gomb
A kamera adatainak a képen való megjelenítéséhez nyomja meg ezt a gombot.
Ha láthatóak a kamera adatai, elrejtésükhöz nyomja meg ismét.

A markereken kívül néhány autofókusz-jelző és -üzenet is megjelenik, az állapottól függően, és ezek nem rejthetők el
a [Display] gomb megnyomásával.

A megjelenített kameraadatok részletes ismertetése: „Kameraképernyő”.

Valós idejű követő AF állj gomb
Téma követésének leállításához nyomja meg a gombot.

Sz. Kijelzés Magyarázat

2-1 Fókusz üzemmód jelző Lásd: „Fókusz üzemmód jelző” a „Kameraképernyő” cím alatt.

2-2
Felvételi üzemmód, A/B kártyahely,
Interval Rec felvételi intervallum jelző

Lásd: „Felvételi üzemmód, A/B kártyahely, Interval Rec felvételi
intervallum jelző” a „Kameraképernyő” cím alatt.

2-3 Streamelési állapot jelző
Streamelés közben jelenik meg (csak a [Stream Setting] [RTMP]
vagy [SRT-Caller] beállításakor).

2-4 RAW kimeneti műveletállapot jelző
A RAW jel kimeneti állapotát jeleníti meg. RAW részletek: „RAW
videó rögzítése”.

2-5 Adathordozó maradék kapacitás jelző Lásd: „Adathordozó maradék kapacitás jelző” a „Kameraképernyő”
cím alatt.

2-6 Zoom helyzet jelző
Lásd: „Zoom helyzet jelző” a „Kameraképernyő” cím alatt.
Objektívvezérlő (különtartozék) csatlakoztatásakor  jelenik meg.
Az objektívvezérlő (különtartozék) hibája esetén  jelenik meg.

2-7 AE üzemmód/AE szint jelző Lásd: „AE üzemmód/AE szint jelző” a „Kameraképernyő” cím alatt.
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Részletek: „Megadott téma követése (Valós idejű követő AF)”.
Felvétel START/STOP gomb
Felvétel indításához nyomja meg a gombot. Felvétel közben pirosan világít a felvétel START/STOP gomb.
Folyó felvétel leállításához nyomja meg a gombot.
A Hold kapcsoló Hold (Befagyasztás) helyzetbe állításával megelőzhető a felvétel START/STOP gomb véletlen
működtetése.

3.

A kamera alapkonfiguráló panele
Megjeleníti a gombok fényképezéshez szükséges alapfunkcióinak beállításait. Nyomjon meg egy gombot az egyes
funkciókhoz tartozó beállítási képernyő megjelenítéséhez a kamera alapkonfigurációjának alábbi beállítási paneljén
(5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

További részletek az egyes funkciók magyarázata alatt találhatók.

4.

Funkció Hivatkozás

FPS „Lassított és gyorsított felvétel”

ISO/Gain
„A bázisérzékenység beállítása”, „Az erősítés automatikus állítása” és „Az erősítés kézi állítása”
itt: „Az erősítés beállítása”

Exposure
Index

„A bázisérzékenység beállítása” és „Sötét és világos területek eloszlásának módosítása a
rögzített képen”

Shutter „A záridő automatikus állítása” és „A záridő kézi állítása” itt: „A záridő beállítása”

Iris „A fényrekesz automatikus állítása” és „A fényrekesz kézi állítása” itt: „A fényrekesz beállítása”

ND Filter „Az ND szűrőről” itt: „A megvilágítási szint (ND szűrő) állítása”

Scene File „A megjelenés áttekintése” és más témakörök itt: „Felvételkészítés kívánt megjelenéssel”

Base
Look/LUT

„Felvételkészítés a megjelenés állításával az utófeldolgozás során”

White
Balance

„Fehéregyensúly állító képernyő”
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Programozható gombok/A kamera alapkonfigurációjának beállítási panelje
Megjeleníti a programozható gombokat normál működés közben. A beállítandó elemek a kamera alapkonfiguráló
panel gombjainak (4. elem) megnyomásával jeleníthetők meg. A programozható gombok képernyőjére
visszalépéshez nyomja meg a [X] gombot vagy a kamerabeállító panel gombját.

A programozható gombok részletezése a „Programozható gombok” cím alatt található.
A kamera alapkonfigurációjának beállítási paneljéről további részletek az egyes funkciók leírása alatt találhatók.

5.

Keretezésvezérlő panel / GUI vezérlőpanel
A keretezésvezérlő panel / GUI vezérlőpanel a felső fülekkel váltogatható.
A véletlen működtetés megelőzésére elrejtheti a vezérlőpanelt a képernyő jobb felső sarkában található  (Bezár)
gomb megnyomásával. Ha nem jelenik meg a vezérlőpanel, jelenítse meg az  (Megnyitás) gomb megnyomásával.
A keretezés állításához használja a keretezésvezérlő panelt. A keretezésvezérlő panel megjelenítéséhez nyomja meg
a  (Pásztázás/döntés/zoom) fület.

Használati részletek: „A keretezés beállítása”.

Tipp

A keretezésvezérlő panel botkormány része az alábbiak szerint jelenik meg, ha le van tiltva a pásztázás/döntés és
pásztázás/döntés inicializálást kell végezni.

Ha a pásztázás/döntés zárolva van a pásztázó/döntő zárókarral

Ha a pásztázás/döntés nincs inicializálva

6.
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Ha vissza kell állítani a pásztázást/döntést

Ha le van tiltva a pásztázás/döntés

Ha nincs inicializálva vagy visszaállítandó a pásztázás/döntés művelet, gyorsan elérhető a kamera vezérlőpanel 
(Pásztázás/döntés visszaállítása) gombja a botkormány alatti üzenet megnyomásával.

Használja a GUI vezérlőpanelt a kameramenü, klip lejátszás és más funkciók használatához. A GUI vezérlőpanel
megjelenítéséhez nyomja meg a  (Kamera GUI vezérlőpanel) fület.

További részletek: „A kameramenü használata” és „Felvett klipek lejátszása”.
Kamera vezérlőpanel
Itt konfigurálhatók a kamera használatához szükséges funkciók.
A megjelenítendő képernyők a felső fülekkel váltogathatók.
A véletlen működtetés megelőzésére elrejtheti a vezérlőpanelt a képernyő jobb felső sarkában található  (Bezár)
gomb megnyomásával. Ha nem jelenik meg a vezérlőpanel, jelenítse meg az  (Megnyitás) gomb megnyomásával.

7.
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Részletek az egyes funkciók magyarázata alatt találhatók.

  (Main) fül
Gyakran használt funkciók beállítási elemeit jeleníti meg.
A felső és alsó csúszka funkcióinak módosításához nyomja meg a [▼] gombot és válasszon a megjelenő listáról. A
következő funkciók választhatók.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

  (Focus) fül
A fókusszal kapcsolatos beállítási elemeket jeleníti meg.

  (Audio) fül

A hanggal kapcsolatos beállítási elemeket jeleníti meg.

A menübeállításoknak megfelelően jelenik meg.*
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 (Stream) fül
A streameléssel kapcsolatos beállítási elemeket jeleníti meg.
A streamelési formátum beállítása határozza meg, mely elemek jelennek meg.
[RTMP] vagy [SRT-Caller] beállítás esetén a streamelés ezen a képernyőn indítható el/állítható le.

Részletek: „Streamelés” és egyéb témakörök itt: „A streamelés konfigurálása”.
Kapcsolódási hiba esetén hibaüzenet jelenik meg. A hibaüzenetre vonatkozó részletek a
„Hibaüzenetek/figyelmeztetések” cím alatt találhatók.

 (Others) fül
Az egyéb funkciókkal kapcsolatos beállítási elemeket jeleníti meg.
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Kapcsolódó témák

A pásztázó/döntő és zoom helyzet elmentése/visszaállítása a webes alkalmazás használatával

Kamera keretezési műveletek rögzítése a webes alkalmazással

Kameraképernyő

RAW videó rögzítése

Megadott téma követése (Valós idejű követő AF)

Lassított és gyorsított felvétel

A bázisérzékenység beállítása

Az erősítés automatikus állítása

Az erősítés kézi állítása

Sötét és világos területek eloszlásának módosítása a rögzített képen

A záridő automatikus állítása

A záridő kézi állítása

A fényrekesz automatikus állítása

A fényrekesz kézi állítása

Az ND szűrőről

A megjelenés áttekintése

Felvételkészítés a megjelenés állításával az utófeldolgozás során

Fehéregyensúly állító képernyő

Programozható gombok

Felvett klipek lejátszása

A kameramenü használata

Streamelés

Hibaüzenetek/figyelmeztetések

5-041-958-53(1) Copyright 2022 Sony Corporation

A [Full Screen Display] gomb megnyomása új fület nyit a webböngészőben és teljes képernyőn jeleníti meg a
kamerakép-panelt.
Csak a kép jelenik meg; az érintéses AF és más funkciók nem választhatók.

Megjegyzés

Az eredeti lapon levő élő működtető képernyő továbbra is működik. Ha nincs szüksége rá, javasoljuk, hogy csukja be a lapot,
az egyidejű kapcsolatok számának csökkentésére.

Az objektívvezérlő (különtartozék, harmadik féltől) inicializálásához nyomja meg a  (különtartozék,
harmadik féltől) gombot. Ez a gomb csak akkor van engedélyezve, ha a webes menü [Technical] > [Lens Controller] >
[Zoom] > [Setting] pontjának beállítása [On].
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A lejátszásvezérlő képernyő felépítése

Ez a témakör a lejátszásvezérlő képernyő felépítését ismerteti.

Kamerakép-panel
A lejátszott képet és kapcsolódó adatait jeleníti meg. A lejátszás leállításakor a kamerakép képernyő jelenik meg.

1.
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1-1 A felvétel készítési dátuma és időpontja
1-2 Lejátszási állapot jelző
1-3 Lejátszási formátum (képméret) jelző
1-4 Lejátszási formátum (kodek) jelző
1-5 Klipnév megjelenítés
1-6 Klipszám/a klipek összes száma
1-7 LUT név megjelenítése
1-8 Streamelési állapot jelző
1-9 Lejátszási formátum (képfrekvencia és letapogatási mód) jelző
1-10 Felvétel megjelenés jelző

Lejátszásvezérlő panel

A lejátszás kezelőgombjait jeleníti meg.

[Display] gomb
Megnyomása a kép képernyőn való két megjelenítése között vált.
[Thumbnail] gomb
Megjeleníti a kamerakép-panelen a memóriakártyára rögzített klipeket mutató miniatűröket.

2.

Gomb Funkció

 (Lejátszás/szünet) gomb Elindítja egy klip lejátszását. Lejátszás közben szüneteltet.

 (Gyors előre) gomb,  (Gyors
vissza) gomb

Gyorsan játssza le a klipet. Megnyomása három lépésben módosítja a
lejátszási sebességet.

 (Következő) gomb,  (Előző)
gomb

A klip vagy az előző/következő klip elejére ugrat.

 (Állj) gomb Leállítja a lejátszást.
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Kapcsolódó témák

A miniatűrök képernyője

Programozható gombok

Felvett klipek lejátszása

5-041-958-53(1) Copyright 2022 Sony Corporation

Ha a képernyője látható, a [Thumbnail] gomb bezárja a miniatűrök képernyőjét és visszaléptet a kamera képére.

A miniatűrök képernyőjéről további részletek: „A miniatűrök képernyője”.

[Slot Select] gomb
Ide-oda kapcsol a lejátszáshoz használandó adathordozók között.

Programozható gombok
A funkciókhoz rendelt programozható gombokat jeleníti meg.

A programozható gombok részletezése a „Programozható gombok” cím alatt található.

3.

GUI vezérlőpanel
Használja a GUI vezérlőpanelt a kameramenü, klip lejátszás és más funkciók használatához.

További részletek: „A kameramenü használata” és „Felvett klipek lejátszása”.

4.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A beállító képernyő felépítése

A beállító képernyőn az egység beállítási elemei (pl. kezdeti beállítások, hálózati beállítások, felvételkészítési/lejátszási
beállítások) konfigurálhatók, a webes menüvel.

Megjegyzés

A webes menüben a beállítások általában csak az [OK] gomb megnyomásakor érvényesülnek. Ha olyan oldalon módosítja a
beállításokat, amelyen [OK] gomb van, mindenképpen nyomja meg az [OK] gombot.

A beállító képernyő részletes leírása a „Webes menü és beállítási részletek” cím alatt található.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kamera menü

A kameramenünek a kamerakép-panelen való megjelenítéséhez nyomja meg az élő működtető képernyő vagy a
lejátszásvezérlő képernyő GUI vezérlőpaneljén található [Menu] gombot.

A kamera menüben konfigurálhatók a felvételkészítéshez és lejátszáshoz szükséges beállítások.
A kameramenü elrejtéséhez nyomja meg a [Menu] gombot, amikor a menü a képernyőn van.
A kameramenü a GUI vezérlőpanellel kezelhető.

A kamera menü részletes leírása a „Kameramenü és beállítási részletek” cím alatt található.

Megjegyzés

Ha a webes menü [Monitoring] > [Output Display] > [HDMI/Stream] pontjának beállítása Off (letiltja az adatmegjelenítést a
képernyőképen), a kameramenü nem jelenik meg a kamerakép-panelen. Ne feledje azonban, hogy a GUI vezérlőpanel
menüműveletei továbbra is aktívak. A véletlen műveletek elkerülése érdekében vigyázzon, hogy ne végezzen semmilyen
menüműveletet a GUI vezérlőpanel használatával, amikor a [HDMI/Stream] beállítása Off.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameraképernyő

Az egység állapota és beállításai a kamera képére szuperponálhatók. A webes menü [Monitoring] > [Output Display]
pontjában adhatók meg, hogy mely kimenetekre legyen engedélyezve a képernyős megjelenítés.
Az adatok a [Display] gombbal jeleníthetők meg/rejthetők el. Közvetlenmenü-műveletek esetén rejtett állapotban is
megjelennek.
Elemek egyenként a kameramenü [Monitoring] > [Display On/Off] pontjában jeleníthetők meg/rejthetők el.

A képernyőn felvételkészítés közben látható adatok

Feltöltés/hátralevő fájlok jelző

Fájlátvitellel kapcsolatos részletek: itt: „A fájlátvitelről” és egyéb témakörök a „Fájlok átvitele” alatt.

1.

Fókuszmező jelző
Megjeleníti az automatikus fókuszálás fókuszmezőjét.

Automatikus fókuszálással kapcsolatos részletek: „Automatikus állítás a webes alkalmazással” és egyéb
témakörök „Automatikus fókuszálás (Auto Focus) beállítása” alatt.

2.

Felvételi üzemmód, A/B kártyahely, Interval Rec felvételi intervallum jelző

Az Interval Rec részletezése: „Szakaszos videofelvétel készítés (Interval Rec)”.

3.

Kijelzés Jelentése

●Rec Felvétel

Stby Felvételi készenlét

Mélységélesség jelző4.

Imager scan üzemmód jelző5.
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 (ellentmondás) szimbólum jelenik meg, ha ellentmondás van az objektív képkörmérete és az Imager Scan Mode
beállításban megadott effektív képméret között.
Ha az Imager Scan Mode beállítása FF, „C” jel látható a keskenyebb látószögű (körülvágott) üzemmódokban.
Körülvágás a következő üzemmódokban jelentkezik:

Amikor a felvételi formátum 3840×2160 és az S&Q Motion képfrekvencia 100 fps vagy 120 fps
Ha a [Codec] paraméter beállítása RAW vagy RAW & XAVC-I és a RAW kimeneti formátum 3840×2160
Az Imager Scan Mode részletei: „Az Imager Scan Mode beállítása”, az „Alapvető használati konfigurálás” cím
alatt.

RAW kimeneti műveletállapot jelző
A RAW jel kimeneti állapotát jeleníti meg.

RAW részletek: „RAW videó rögzítése”.

6.

Slow & Quick Motion felvételkészítési képfrekvencia jelző

Slow & Quick Motion részletek: „Lassított és gyorsított felvétel”.

7.

Fókuszhelyzet jelző

A fókusz helyzetét jeleníti meg.

8.

Fókusz üzemmód jelző

Arc/szem érzékeléses AF

Részletek az arc/szem érzékeléses AF-ről: „Követés arc és szem érzékeléssel (Face/Eye Detection AF)”.

9.

Kijelzés Jelentése

Focus Hold Focus Hold üzemmód

MF MF üzemmód

AF AF üzemmód

 (Valós idejű követő AF üzemmód) Valós idejű követő AF üzemmód

Kijelzés Jelentése

 (Arc/szem érzékeléses AF) Az arc/szem érzékeléses AF aktív állapotát jelzi

 (Csak arc/szem AF) A csak arc/szem AF aktív állapotát jelzi

 (Elmentett követett arc) Azt jelzi, hogy van elmentett követett arc

 (Szünetelő AF) Az AF szüneteltetését jelzi*

Akkor jelenik meg, ha nincs elmentett követett arc és a kamera nem érzékel arcot, vagy ha van elmentett követett arc, de a kamera nem
érzékeli a követési célponti arcot.

*

Zoom helyzet jelző
A zoom helyzetet mutatja a 0 (nagy látószög) és 99 (telefotó) közötti tartományban (ha az aktuális objektív támogatja
a zoom helyzet megjelenítését).
A megjelenítés sáv- vagy fókusztávolság-kijelzőre is átállítható a kameramenü [Technical] > [Lens] > [Zoom Position
Display] pontjában.
A Clear Image Zoom engedélyezett állapotában a következő elemek is megjelennek a képernyőn.

10.

58



Zoom részletek: „A Zoom Type beállítása” és egyéb témakörök „A Zoom beállítása” alatt.

Kijelzés Jelentése

 (Engedélyezve van a Clear Image Zoom) Engedélyezve van a Clear Image Zoom

Nagyítási érték Clear Image Zoom használatakor

Képstabilizálási üzemmód jelző11.

SDI kimenet/HDMI kimenet Rec Control állapot jelző
A REC vezérlőjel kimeneti állapotát jeleníti meg.

Részletek: „Külső monitorok és felvevők csatlakoztatása”.

12.

Fókuszjelző

Részletek: „Kockázó automatikus fókuszálás használata (Push Auto Focus (AF-S))” „A fókuszálás beállítása”
alatt.

13.

Adathordozó maradék kapacitás jelző
 (védett) ikon jelenik meg, ha írásvédett a memóriakártya.

14.

Fehéregyensúly üzemmód jelző15.

Kijelzés Jelentése

 (ATW) Auto üzemmód

 (ATW Hold) Szüneteltetett Auto üzemmód

W:P Előbeállított üzemmód

W:A „A” memória üzemmód

Külső időkódhoz zárás jelző/időadat megjelenítés
Külső eszköz időkódjához zárás esetén „EXT-LK” látható.

Időkód részletek: „Időadatok megadása”.

16.

ND szűrő jelző

Az ND szűrőkkel kapcsolatos részletek: „A megvilágítási szint (ND szűrő) állítása”
A bokeh-vezérléssel kapcsolatos részletek: „A Bokeh (Bokeh Control Function) beállítása”.

17.

Kijelzés Jelentése

 (A) Auto üzemmód

 (B) Bokeh-vezérlés üzemmód

Jelenetfájl jelző

Jelenetfájllal kapcsolatos részletek: „A megjelenés áttekintése” és más témakörök a „Felvételkészítés kívánt
megjelenéssel” alatt.

18.

Fényrekesz jelző19.
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A fényrekesz helyzetét (F értékét) mutatja (ha az aktuális objektív támogatja a fényrekesz beállítás megjelenítését).

A fényrekesszel kapcsolatos részletek: „A fényrekesz automatikus állítása” és „A fényrekesz kézi állítása”.
Videoszint figyelmeztetés jelző20.

Erősítés jelző
Cine EI/Cine EI Quick üzemmódban az EI értéket jelzi ki.

Az erősítéssel kapcsolatos részletek: „Az erősítés automatikus állítása” és „Az erősítés kézi állítása”.
A Cine EI/Cine EI Quick üzemmód részletes ismertetése „A felvételi üzemmód beállítása” és az „Alapvető
használati konfigurálás” cím alatt található.

21.

Kijelzés Jelentése

 (A) Auto üzemmód

L Előbeállított L üzemmód

 (Ideiglenes beállítás üzemmód) Ideiglenes beállítás üzemmód

 (B) Bokeh-vezérlés üzemmód

Klipnév megjelenítés
Az éppen vett vagy a következő klip nevét jeleníti meg.
Ha villog, ütközés van a felvételi adathordozó utolsó klipje és a [Camera ID] vagy [Reel Number] beállítások között.
Részletek a [Clip Name Format] > [Auto Naming] leírás alatt.

22.

Záridő jelző

A záridővel kapcsolatos részletek: „A záridő automatikus állítása” és „A záridő kézi állítása”.

23.

AE üzemmód/AE szint jelző

Az automatikus expozícióval (AE) kapcsolatos részletek: „Automatikus fényerőállítás célszintjének beállítása”.

24.

Libella
A vízszintes szintet mutatja ±1° lépésekben, ±15°-ig.

25.

Hang kivezérlésmérő
Az egyes csatornák hangszintjét mutatja.

26.

Videojel figyelő
A hullámformát, vektorszkópot és hisztogramot jeleníti meg.
A narancssárga vonal a fényerőszint marker beállított értéke.
Log felvételi üzemmódokban a monitorozási cél LUT típusa látható a képernyő felett.

Részletek: „Videojel figyelő”.
A Log felvételi üzemmódok részletes ismertetése „A felvételi üzemmód beállítása” és az „Alapvető használati
konfigurálás” cím alatt található.

27.

Base Sensitivity jelző/Base ISO jelző
Custom üzemmódban a kamera alapkonfiguráló panele [ISO/Gain / Exposure Index] gombjával vagy a kameramenü
[Shooting] > [ISO/Gain/EI] > [Base Sensitivity] pontjában megadott bázisérzékenységet mutatja.
Log felvételi üzemmódokban a kamera alapkonfiguráló panel [ISO/Gain / Exposure Index] gombjával vagy a
kameramenü [Shooting] > [ISO/Gain/EI] > [Base ISO] pontjában beállított Base ISO érzékenységet jeleníti meg.

A bázisérzékenységgel kapcsolatos részletek: „A bázisérzékenység kiválasztása”.

28.
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A képernyőn lejátszás közben látható információk

A következő információk a lejátszott képre rétegződnek.

A Log felvételi üzemmódok részletes ismertetése „A felvételi üzemmód beállítása” és az „Alapvető használati
konfigurálás” cím alatt található.

Monitoring megjelenés jelző
Log felvételi üzemmódokban a monitor LUT beállítását jeleníti meg.

Részletek a LUT beállításról: „Felvételkészítés a megjelenés állításával az utófeldolgozás során” és kapcsolódó
témakörök.
A Log felvételi üzemmódok részletes ismertetése „A felvételi üzemmód beállítása” és az „Alapvető használati
konfigurálás” cím alatt található.

29.

Bázismegjelenés/felvételi megjelenés jelző
A bázismegjelenés beállítást jeleníti meg.
Log felvételi üzemmódokban a memóriakártyákra rögzítendő videojelet jeleníti meg.

A bázismegjelenéssel kapcsolatos részletek: „A megjelenés áttekintése” a „Felvételkészítés kívánt megjelenéssel”
alatt.
A Log felvételi üzemmódok részletes ismertetése „A felvételi üzemmód beállítása” és az „Alapvető használati
konfigurálás” cím alatt található.

30.

Proxy állapot jelző31.

Felvételi formátum (kodek) jelző
A memóriakártyákra való rögzítés formátumának nevét jeleníti meg.
A felvételi formátum (kodek) a webes menü vagy a kameramenü [Project] > [Rec Format] > [Codec] pontjában adható
meg.

32.

Felvételi formátum (képfrekvencia és letapogatási módszer) jelző33.

Felvételi formátum (képméret) jelző
A memóriakártyákra való rögzítés képméretét jeleníti meg.
A felvételi formátum (képméret) a webes menü vagy a kameramenü [Project] > [Rec Format] > [Codec] pontjában
adható meg.

34.

Tally jelző
A vett külső tally jeltől függően piros vagy zöld keretet rajzol a kép köré.

35.
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Kapcsolódó témák

A fájlátvitelről

Automatikus állítás a webes alkalmazással

Szakaszos videofelvétel készítés (Interval Rec)

Alapvető használati konfigurálás

RAW videó rögzítése

Lassított és gyorsított felvétel

Feltöltés/hátralevő fájlok jelző1.

Klip száma2.

Lejátszási állapot jelző3.

Lejátszási formátum (képfrekvencia és letapogatási módszer) jelző4.

Lejátszási formátum (képméret) jelző5.

Lejátszási formátum (kodek) jelző6.

Adathordozó jelző
 (védett) ikon jelenik meg, ha írásvédett a memóriakártya.

7.

Időadat megjelenítés8.

Klipnév megjelenítés9.

Gamma megjelenítés segítés jelző10.

Hang kivezérlésmérő
A lejátszási hang kivezérlést jeleníti meg.

11.

Bázismegjelenés/felvételi megjelenés jelző12.

Tally jelző13.
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Követés arc és szem érzékeléssel (Face/Eye Detection AF)

A Zoom Type beállítása

Külső monitorok és felvevők csatlakoztatása

Kockázó automatikus fókuszálás használata (Push Auto Focus (AF-S))

Időadatok megadása

A megjelenés áttekintése

A fényrekesz automatikus állítása

A fényrekesz kézi állítása

Az erősítés automatikus állítása

Az erősítés kézi állítása

A záridő automatikus állítása

A záridő kézi állítása

Automatikus fényerőállítás célszintjének beállítása

Videojel figyelő

Felvételkészítés a megjelenés állításával az utófeldolgozás során

Clip Name Format

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Felerősítés mozdulatlan helyre, álló helyzetben

Ez a témakör az egység asztalra vagy állványra erősítését ismerteti.

Telepítési megjegyzés
Az objektív és az egység objektívcsatlakozó tömbjének védelme érdekében tartsa az egység védősapkáját és
kupakját felhelyezve, amíg fel nem szereli az objektívet.
Az objektív meghibásodásának elkerülése érdekében munka közben ne fogja az objektív részeit.
Az egység meghibásodásának elkerülése érdekében munka közben ne fogja a kamerafej részeit.

Ellenőrizze a felerősítési helyet.

Asztalra szereléskor
Szerelje sík felületre ezt az egységet, figyelembe véve az objektív és a készülék hátulján lévő vezetékek
elfordulásához szükséges helyet.

Megjegyzés

Szerelje stabil, rezgés- és rázkódásmentes helyre. Rázkódásnak kitett helyek rázkódást okozhatnak a képen.

Ha az egységet ferde felületre kell felszerelni, tartsa a vízszinteshez képest ±15°-on belül, és megfelelő óvintézkedésekkel
akadályozza meg a készülék leesését.

Állványra erősítéskor
Csatlakoztassa az állványt az alsó állványcsavar furathoz.
Használjon olyan állványcsavart, amely a következő mértékben áll ki a tartófelületből, és kézi csavarhúzóval húzza
meg.

A: 1/4-20 UNC, ISO 1222 (6,35 mm-es) állványcsavarok
B: kinyúlás (4,5 mm – 5,5 mm)

1
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Utána szerelje fel az objektívet. Lásd: „Objektív felszerelése”, figyelembe véve a következő pontok információit:
„Óvintézkedések az objektív csatlakoztatásakor/eltávolításakor”, „Az objektív kapcsolóinak ellenőrzése” és
„Figyelmeztetések zoomos objektív használata esetére”.

Kapcsolódó témák

Óvintézkedések az objektív csatlakoztatásakor/eltávolításakor

Az objektív kapcsolóinak ellenőrzése

Figyelmeztetések zoomos objektív használata esetére

Objektív felszerelése

5-041-958-53(1) Copyright 2022 Sony Corporation

Ne használjon állványcsavarokat a készülék magas helyre szereléséhez.

Megjegyzés

Olyan állványt válasszon, amely nem borul fel az objektív elfordulásakor.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Felerősítés magas, mozdulatlan helyre, álló helyzetben

Ez a témakör az egység CIB-PCM1 (különtartozék) mennyezeti konzollal történő álló helyzetű felerősítését ismerteti,
magas, mozdulatlan helyre.

Az egység magas helyre szerelését bízza szakemberre.
Magas helyre szerelés esetén győződjön meg arról, hogy a tartófelület és a szerelési anyagok (a tartozékok
kivételével) legalább 200 kg teherbírásúak, és az egységet a jelen Súgó útmutatóban leírtak szerint szerelje fel. Ha a
rögzítés nem elég teherbíró, a készülék leeshet, és súlyos sérülést okozhat.
Kösse a leesésgátló sodronyt a (különtartozék) CIB-PCM1 mennyezeti konzolra, hogy le ne essen.
Az egység magas helyre szerelésekor évente ellenőrizze, hogy nem lazult-e ki a felerősítés. A használati
körülmények rövidebb ellenőrzési időszakot is indokolhatnak.

Telepítési megjegyzés
Az objektív és az egység objektívcsatlakozó tömbjének védelme érdekében tartsa az objektív és az egység
védősapkáját felhelyezve, amíg fel nem szereli az objektívet.
Az objektív meghibásodásának elkerülése érdekében munka közben ne fogja az objektív részeit.
Az egység meghibásodásának elkerülése érdekében munka közben ne fogja a kamerafej részeit.

Ellenőrizze a magas helyre szerelés tartozékait és a felerősítési helyet.

CIB-PCM1 mennyezeti konzol készlet (különtartozék)
A munka elkezdése előtt ellenőrizze a következők meglétét.

Testtartó konzol (1)
Mennyezeti konzol (1)
Objektívkioldó gomb védőfedél (1)
Leesésgátló sodrony (1)
+PSW M3×8 csavarok (9)
+PSW M4×8 rozsdamentes acél csavar a leesésgátló sodronyhoz (1)

1
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Megjegyzés

A leesésgátló sodronyt úgy tervezték, hogy megtartsa a függő egységet. Vigyázzon, hogy az egység súlyán kívül ne érje
más terhelés.

Felerősítési hely
A következő rajz szerint válassza ki a felerősítési helyet és irányt, és vegye figyelembe az objektív és a készülék
hátulján lévő vezetékek elfordulásához szükséges helyet.

A: a kamerafej mozgási tartománya (pl. SEL70200GM2 (csatlakoztatott SEL20TC-vel): Ø370)
B: mennyezeti konzol (furat a tartófelület oldalán (Ø150))
C: felerősítési illesztőfurat

Megjegyzés

Szerelje stabil, rezgés- és rázkódásmentes helyre. Rázkódásnak kitett helyek rázkódást okozhatnak a képen.

Ha az egységet ferde felületre kell felszerelni, tartsa a vízszinteshez képest ±15°-on belül, és megfelelő óvintézkedésekkel
akadályozza meg a készülék leesését.

Csúsztassa a pásztázó/döntő zárókart a LOCK helyzetbe a kamerafej lezárásához pásztázó/döntő mozgás
ellen.

2
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Megjegyzés

Ha a kamerafej pásztázó/döntő mozgása nem rögzült a zárókar LOCK helyzetében, mozgassa kézzel a helyére
rögzüléséig.

Erősítse a testtartó konzolt az egység aljára a mellékelt hat csavarral (M3×8).3
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Használja a tartozékként mellékelt csavarokat. Más csavarok használata károsíthatja az egység belsejét.

Erősítse a leesésgátló sodronyt a testtartó konzolhoz.4
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A: tartozék sodrony　
B: tartozék csillagfejű csavar (M4×8)
C: a sodrony bújtatóhídja

Használja a tartozékként mellékelt csavart. Más csavar használata ronthatja a sodrony védelmi hatékonyságát.

Erősítse a mennyezeti konzolt az egységet tartó felületre, például polcra.5
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A: fal　
B: △ jel (a kamera előre néző iránya)
C: a bekötőkábelek átbújtató furata
D: polc vagy más tartófelület

Erősítse a leesésgátló sodronyt a tartófelülethez közeli ponthoz.

Keressen egy M5-ös (3/16 hüvelykes) belső hatlapfejű imbuszcsavart (különtartozék), és rögzítse egy tárgyhoz a
polc vagy a mennyezeti konzol tartófelülete közelében.

6

71



A: sodrony　
B: belső hatlapfejű imbuszcsavar (M5, 3/16 hüvelyk)

Igazítsa a testtartó konzol 〇 csavarfuratát a mennyezeti konzol ◇ furatához, helyezze be az egységet és
ideiglenesen rögzítse a testtartó konzolt a mennyezeti konzolban az egység jobbra (az óramutató járása
szerinti) fordításával.

7
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A: 〇 furat
B: ◇ furat

Erősítse egymáshoz a testtartó konzolt és a mennyezeti konzolt a tartozékként adott három
rögzítőcsavarral (M3×8).

8
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Utána szerelje fel az objektívet. Lásd: „Objektív felszerelése”, figyelembe véve a következő pontok információit:
„Óvintézkedések az objektív csatlakoztatásakor/eltávolításakor”, „Az objektív kapcsolóinak ellenőrzése” és
„Figyelmeztetések zoomos objektív használata esetére”.

Megjegyzés

Ellenőrizze a felszerelt objektív előírásszerű rögzülését.
Az objektív nincs védve leesés ellen. A Sony nem vállal felelősséget az objektívnek az egységről való leeséséért.

Kapcsolódó témák

Óvintézkedések az objektív csatlakoztatásakor/eltávolításakor

Az objektív kapcsolóinak ellenőrzése

Figyelmeztetések zoomos objektív használata esetére

Objektív felszerelése

Ellenőrizze a felerősítés állapotát.

Különösen a következőket ellenőrizze. 

A rögzítőcsavarok megfelelő rögzülését.
A leesésgátló sodrony előírásszerű csatlakoztatását és csavarodásmentességét.
Az egység felfekvését (ferdeség vagy billegés nélkül).
Az egység a forgatáskor nem forog szabadon.

9
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Mennyezetre szerelés

Ez a témakör az egység CIB-PCM1 (különtartozék) mennyezeti konzollal történő mennyezetre erősítésének menetét
ismerteti.

Az egység mennyezetre szerelését bízza szakemberre.
Mennyezetre szerelés esetén győződjön meg arról, hogy a tartófelület és a szerelési anyagok (a tartozékok
kivételével) legalább 200 kg teherbírásúak, és az egységet a jelen Súgó útmutatóban leírtak szerint szerelje fel. Ha a
rögzítés nem elég teherbíró, a készülék leeshet, és súlyos sérülést okozhat.
Kösse a leesésgátló sodronyt a (különtartozék) CIB-PCM1 mennyezeti konzolra, hogy le ne essen.
Az egység mennyezetre szerelésekor évente ellenőrizze, hogy nem lazult-e ki a felerősítés. A használati
körülmények rövidebb ellenőrzési időszakot is indokolhatnak.

Telepítési megjegyzés
Az objektív és az egység objektívcsatlakozó tömbjének védelme érdekében tartsa az objektív és az egység
védősapkáját felhelyezve, amíg fel nem szereli az objektívet.
Az objektív meghibásodásának elkerülése érdekében munka közben ne fogja az objektív részeit.
Az egység meghibásodásának elkerülése érdekében munka közben ne fogja a kamerafej részeit.

Ellenőrizze a mennyezetre szerelési tartozékokat és a felerősítési helyet.

CIB-PCM1 mennyezeti konzol készlet (különtartozék)
A munka elkezdése előtt ellenőrizze a következők meglétét.

Testtartó konzol (1)
Mennyezeti konzol (1)
Objektívkioldó gomb védőfedél (1)
Leesésgátló sodrony (1)
+PSW M3×8 csavarok (9)
+PSW M4×8 rozsdamentes acél csavar a leesésgátló sodronyhoz (1)

1
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Megjegyzés

A leesésgátló sodronyt úgy tervezték, hogy megtartsa a függő egységet. Vigyázzon, hogy az egység súlyán kívül ne érje
más terhelés.

Felerősítési hely
A következő rajz szerint válassza ki a felerősítési helyet és irányt, és vegye figyelembe az objektív és a készülék
hátulján lévő vezetékek elfordulásához szükséges helyet.

A: a kamerafej mozgási tartománya (pl. SEL70200GM2 (csatlakoztatott SEL20TC-vel): Ø370)
B: mennyezeti konzol (furat a mennyezet felőli oldalon (Ø150))
C: felerősítési illesztőfurat

Megjegyzés

Szerelje megfelelő szilárdságú (például beton) mennyezetre.

Ha nem elég szilárd a mennyezet, gondoskodjon kellő erősítésről.

Szerelje stabil, rezgés- és rázkódásmentes helyre. Rázkódásnak kitett helyek rázkódást okozhatnak a képen.

Ha az egységet ferde felületre kell felszerelni, tartsa a vízszinteshez képest ±15°-on belül, és megfelelő óvintézkedésekkel
akadályozza meg a készülék leesését.

A mennyezeti konzol △ furatával szemközti oldal a felvételkészítési irány (a kamera elülső oldala).

Csúsztassa a pásztázó/döntő zárókart az UNLOCK helyzetbe, hogy kioldja a kamerafej rögzítését, és
fordítsa el a kamerafejet 180°-kal a döntési síkban.

2

Csúsztassa a pásztázó/döntő zárókart a LOCK helyzetbe a kamerafej lezárásához pásztázó/döntő mozgás
ellen.

3

77



A 180°-kal elfordított kamerafej

Megjegyzés

Ha a kamerafej pásztázó/döntő mozgása nem rögzült a zárókar LOCK helyzetében, mozgassa kézzel a helyére
rögzüléséig.

Erősítse a testtartó konzolt az egység aljára a mellékelt hat csavarral (M3×8).4
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Használja a tartozékként mellékelt csavarokat. Más csavarok használata károsíthatja az egység belsejét.

Erősítse a mennyezeti konzolt szerelőlapra (különtartozék) és rögzítse a szerelőlapot a mennyezetre.5
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A: mennyezeti konzol
B: mennyezet
C: szerelőlap
D: △ furat
Csatlakoztassa a konzolt a mennyezeti konzol tájolásának megfelelően
Felhívjuk figyelmét, hogy mennyezetre szereléskor a kamera elülső része a mennyezeti konzol ellentétes oldalán
van a normál álló rögzítéshez képest. Szerelje fel helyesen, a szerelési irányt jelző ábra alapján.

A: elülső rész álló rögzítés esetén (a △ furat tájolása)
B: elülső rész mennyezeti rögzítés esetén

Megjegyzés

A tartófelület anyagának helyes megválasztása az ügyfél felelőssége.

Erősítse a leesésgátló sodronyt a mennyezethez.6
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A: mennyezeti konzol
B: belső hatlapfejű imbuszcsavar (M5, 3/16 hüvelyk)
C: sodrony (tartozék)
D: szerelőlap
E: mennyezet

Bújtassa át a leesésgátló sodronyt a mennyezeti konzol középső nyílásán, és erősítse a testtartó
konzolhoz.

Bújtassa át a leesésgátló sodronyt a testtartó konzol bújtatóhídján, és rögzítse jól a konzolhoz a mellékelt
rozsdamentes acél csavarral (M4×8).

A: tartozék sodrony
B: tartozék csillagfejű csavar (M4×8)
C: a sodrony bújtatóhídja

7
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Használja a tartozékként mellékelt csavart. Más csavar használata ronthatja a sodrony védelmi hatékonyságát.

Megjegyzés

Javasoljuk, hogy egy személy tartsa az egységet a következő ábrán látható módon, míg egy másik személy felszereli azt.

Az egység felszerelése közben ne fogja a kamerafejet vagy az objektívtámasztót. A leejtett vagy leeső egység megsérülhet
és sérülést okozhat.

Vigyázzon az elektromos csatlakozók és vezetékek bekötésekor, hogy a leesésgátló sodrony ne zárja rövidre a
vezetékeket.

A tartó legfeljebb 8,8 kg felfüggesztett tömeget bír el (az objektívvel együtt). Az egység leesésének megelőzése végett ne
lépje túl a maximális várt tömeget.

Igazítsa a testtartó konzol csavarfuratát (A) a mennyezeti konzol ◇ furatához (B), helyezze be az egységet,
és fordítsa el kb. 60 fokkal jobbra (az óramutató járása szerint), hogy egybeessen az (A) és (C) csavarfurat.

8
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A: a testtartó konzol csavarfurata
B: a mennyezeti konzol csavarfurata (◇ furat)
C: csavarfurat
D: mennyezet
E: szerelőlap

Erősítse egymáshoz a testtartó konzolt és a mennyezeti konzolt a tartozékként adott három
rögzítőcsavarral (M3×8).

9
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Utána szerelje fel az objektívet. Lásd: „Objektív felszerelése”, figyelembe véve a következő pontok információit:
„Óvintézkedések az objektív csatlakoztatásakor/eltávolításakor”, „Az objektív kapcsolóinak ellenőrzése” és
„Figyelmeztetések zoomos objektív használata esetére”.

Megjegyzés

A mennyezetre erősített egység pásztázó/döntő mozgásának hibátlan működtetéséhez állítsa a webes menü [Pan-Tilt] >
[Direction] > [Ceiling] pontját [On] értékre.

Ellenőrizze a felszerelt objektív előírásszerű rögzülését.
Az objektív nincs védve leesés ellen. A Sony nem vállal felelősséget az objektívnek az egységről való leeséséért.

Kapcsolódó témák
Óvintézkedések az objektív csatlakoztatásakor/eltávolításakor

Ellenőrizze a felerősítés állapotát.

Különösen a következőket ellenőrizze.

A rögzítőcsavarok megfelelő rögzülését.
A leesésgátló sodrony előírásszerű csatlakoztatását és csavarodásmentességét.
Az egység felfekvését (ferdeség vagy billegés nélkül).
Az egység a forgatáskor nem forog szabadon.

10
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Az objektív kapcsolóinak ellenőrzése

Figyelmeztetések zoomos objektív használata esetére

Objektív felszerelése

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Óvintézkedések az objektív csatlakoztatásakor/eltávolításakor

Vigyázzon, hogy az objektív ne nézzen a Napba. A közvetlen napsugárzást az objektív az egység belsejébe fókuszálja,
ami ott tüzet okozhat.

Megjegyzés

Az objektívet a készülék kikapcsolt állapotában szerelje fel/le.

Az objektív precíziós termék. Ne helyezze csupasz bajonettjével semmilyen felületre. Helyezzen hátsó védősapkát rá.

Tipp

Az egységre helyezhető objektívekről felvilágosítást a Sony szervizektől kérhet.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Az objektív kapcsolóinak ellenőrzése

Az objektív típusától függően a következő ellenőrzésekre és beállításokra van szükség.

Fókusz üzemmód kapcsolós objektív esetén

Állítsa a kapcsolót AF/MF vagy AF helyzetbe.
Ha az objektív fókuszkapcsolójának beállítása MF vagy Full MF, a fókusz csak az objektív gyűrűjével állítható.

Megjegyzés

A-bajonettes objektív használatakor előfordulhat, hogy a távvezérlős kézi vezérlés nem működik.

Zoom kapcsolós objektív esetén

Állítsa a kapcsolót SERVO helyzetbe.
Ha a kapcsoló MANUAL helyzetben áll, a zoom csak az objektív gyűrűjével állítható. Az egységről jövő zoom parancsok
hatástalanok.

Auto Iris kapcsolós objektív esetén

Állítsa a kapcsolót AUTO helyzetbe.
Ha nem AUTO helyzetben áll, a fényrekesz csak az objektív gyűrűjével állítható. Az egységről nem működtethető a
fényrekesz.

Képstabilizáló kapcsolós objektív esetén

Állítsa a kapcsolót OFF helyzetbe.
A kapcsoló ON helyzetében váratlan viselkedés fordulhat elő a pásztázás/döntés használatakor.

SELP28135G

A: állítsa a fókuszgyűrűt elülső helyzetbe (AF/MF üzemmód).
B: állítsa a ZOOM kapcsolót a SERVO helyzetbe.
C: állítsa a fényrekesz gyűrűt az „A”, az IRIS LOCK kapcsolót pedig a LOCK helyzetbe.
D: állítsa a képstabilizáló kapcsolót OFF helyzetbe.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Figyelmeztetések zoomos objektív használata esetére

Motorzoomos zoomoló objektív használatakor a zoom helyzet a felszerelési környezettől függően változhat. Rögzítse a
zoomgyűrűt a helyére szalaggal, a felhasználási célnak megfelelően.

Rugalmas fóliaszalag: 471 BLA 50 vagy egyenértékű

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objektív felszerelése

Ez a témakör E-bajonettes vagy A-bajonettes objektív felszerelését ismerteti.

Megjegyzés

Ne szállítsa az egységet, ha rajta van az objektív.

A-bajonettes objektív használatakor a fényrekeszállítás kézi és a fókusz beállítása MF.

Csúsztassa a pásztázó/döntő zárókart a LOCK helyzetbe a kamerafej lezárásához pásztázó/döntő mozgás
ellen.

Megjegyzés

Ha a kamerafej pásztázó/döntő mozgása nem rögzült a zárókar LOCK helyzetében, mozgassa kézzel a helyére
rögzüléséig.

1

A csavarlezárás feloldásához forgassa az objektívtámasztó talapzat rögzítőcsavarjának bilincs szorítókarját
balra (az óramutató járásával szemben), majd állítsa az objektívtámasztó talapzat rögzítőcsavarját olyan
helyzetbe, hogy ne akadjon össze az objektívval.

2
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A: helyes
B: helytelen

A kamerafej zárásának feloldásához fordítsa el a nyíllal jelölt irányba a kamerafej zárókarját.

Megjegyzés

Amíg a kamerafejet nem rögzíti újra, fennáll a veszély, hogy a kamerafej a saját súlya miatt elmozdul. A feladat
végrehajtása közben kezével támassza meg a kamerafejet.

3

Csúsztassa a kamerafejet ütközésig előre.4
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A kamerafej lezárásához fordítsa el a nyíllal jelölt irányba a kamerafej zárókarját.

Megjegyzés

Vigyázzon, hogy a kamerafej zárókarja ne érintkezzen más részekkel, hogy ne zavarja a döntési mozgást.

5

Vegye le az egység és az objektív vázsapkáját és védősapkáját.6

Igazítsa egymáshoz az objektív és az egység (fehér) pozicionáló jelét, óvatosan illessze be és fordítsa
jobbra (az óramutató járásával egyező irányba) az objektívet, amíg a helyére nem kattan.

A: pozicionáló jelek (fehér)

Megjegyzés

A-bajonettes objektív használatához először csatlakoztasson az egységre egy bajonettadaptert (különtartozék), és ehhez
csatlakoztassa az A-bajonettes objektívet.

7

A kamerafej zárásának feloldásához fordítsa el a nyíllal jelölt irányba a kamerafej zárókarját.8
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Megjegyzés

Amíg a kamerafejet nem rögzíti újra, fennáll a veszély, hogy a kamerafej a saját súlya miatt elmozdul. A feladat
végrehajtása közben kezével támassza meg a kamerafejet.

Tartsa fenn a kamerafej előre/hátra egyensúlyát úgy, hogy a csúszótalp vízszintes legyen.

Ha a következő objektívek valamelyikét használja, akkor az egységet és az objektívet nagyjából kiegyensúlyozhatja
a csúszótalpon lévő skála alapján.

9

Skálaérték Az objektív neve

0,5 SEL70200GM (felhelyezett SEL20TC-vel)

1,7 SEL70200GM

2,0 SEL70200GM2 (felhelyezett SEL20TC-vel)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Megjegyzés

Használja a csúszótalp skáláját referenciaként a durva egyensúlyozáshoz.

Az objektív felszerelésekor állítsa át az egyensúlyt, hogy az egység ne dőljön előre vagy hátra.

Az egyensúlyt vízszintes felületen állítsa be.

A SELC1635G használatakor távolítsa el az objektívtámasztó egységet.

Skálaérték Az objektív neve

5,0 vagy nagyobb SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

A kamerafej lezárásához fordítsa el a nyíllal jelölt irányba a kamerafej zárókarját.

Megjegyzés

Vigyázzon, hogy a kamerafej zárókarja ne érintkezzen más részekkel, hogy ne zavarja a döntési mozgást.
Így ellenőrizze: tolja a pásztázó/döntő zárat az UNLOCK helyzetbe, kézzel fordítsa el a kameratömböt, hogy felfelé nézzen,
és szemrevételezéssel ellenőrizze, hogy tényleg nem érintkezik-e más részekkel. Ha érintkezik, fordítsa el ismét a
kamerafej zárókarját a nyíllal jelölt irányba.

10

Az objektívtámasztó egység rögzítésének feloldásához fordítsa el objektívtámasztó bilincs szorítókarokat
az óramutató járásával ellentétes irányba (balra).

11
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A: objektívtámasztó rúd bilincs szorítókar (2 helyen)
B: objektívtámasztó egység

Az objektívtámasztó egység mozgatásával állítsa az objektívtámasztó talapzatot az objektívtámasztó
talapzat rögzítőcsavarjához, majd a csavar jobbra (óramutató járása szerinti) forgatásával rögzítse az
objektívtámasztó talapzatot.

Megjegyzés

Ellenőrizze, hogy az objektívtámasztó talapzat merőlegesen áll-e az objektívtámasztó talapzat rögzítőcsavarjára, és húzza
meg, ha igen.

12

Az objektívtámasztó talapzat rögzítőcsavarjának rögzítéséhez fordítsa el jobbra (az óramutató járásával
egyező irányba) az objektívtámasztó talapzat rögzítőcsavar bilincs szorítókarját.

A: objektívtámasztó talapzat rögzítőcsavar
B: rögzítő csavarfurat
C: az objektívtámasztó talapzat rögzítőcsavar bilincs szorítókarja

Tipp

Ha valamelyik bilincskar olyan helyzetben áll, hogy nehezen forgatható, lazítsa meg a szorítókart, és fordítsa olyan
szöghelyzetbe, ahol könnyebben működtethető. A kívánt helyzet beállítását követően zárja a bilincskart.

13
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Kapcsolódó témák

E-bajonettes objektív kalibrálása

5-041-958-53(1) Copyright 2022 Sony Corporation

A: az objektívtámasztó talapzat rögzítőcsavar bilincsének szorítókarja
B: objektívtámasztó rúd bilincs szorítókar

Az objektívtámasztó egység rögzítéséhez fordítsa el jobbra (az óramutató járásával egyező irányba) a két
objektívtámasztó rúd bilincs szorítókart.

14

Ellenőrizze, hogy mindkét kar szorul-e (nem laza-e), az objektív jól van-e felhelyezve, és hogy az objektíven
levő kapcsolók jól vannak-e beállítva.

Ha laza valamelyik kar vagy az objektív rosszul van felhelyezve, az objektív leeshet és megsérülhet.
E-bajonettes motorzoomos objektív használata esetén az objektívet külön is kalibrálni kell a fényképezőgépben
előre beállított pozícióként tárolt zoom helyzetek pontos visszaállításához. Részletek: „E-bajonettes objektív
kalibrálása”.

15
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objektív leszerelése

Az objektív leszereléséhez végezze el fordított sorrendben a felszerelési eljárást.

Megjegyzés

Határozottan fogja az objektívet, hogy le ne essen.

Ha nem szerel fel rögtön egy másik objektívet, mindig helyezze fel a vázsapkát.

Kapcsolódó témák

Objektív felszerelése

5-041-958-53(1) Copyright 2022 Sony Corporation

Ellenőrizze, hogy le van-e zárva a pásztázás/döntés.1

A lezárás feloldásához forgassa az objektívtámasztó talapzat rögzítőcsavarjának bilincs szorítókarját balra
(az óramutató járásával ellenkező irányban).

2

Távolítsa el az objektívtámasztó egység rögzítőcsavarját, és állítsa olyan helyzetbe, hogy ne akadjon össze
az objektívval.

3

Oldja ki a kamerafej lezárását és tolja a kamerafejet ütközésig előre.

Részletek: „Objektív felszerelése”, 3.–5. lépés.

4

Fogja meg jól az objektívet, nyomja be és tartsa nyomva az objektívkioldó gombot, majd forgassa balra az
objektívet.

5

Igazítsa egymáshoz a kamera és az objektív (fehér) pozicionáló jelét, és húzza le az objektívet.6
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Kábelek csatlakoztatása

Ez a témakör a kábelek csatlakoztatását ismerteti.

5-041-958-53(1) Copyright 2022 Sony Corporation

Csatlakoztassa a szükséges kábeleket a hátoldali csatlakozókhoz.

A HDMI-kábel kihúzás elleni védelméhez csavarja ki a HDMI-kábeltartó lemez rögzítőcsavarját (M2,6×6) a
csatlakozótömbből, majd rögzítse a helyére a HDMI-kábeltartó lemezt a csavarral. Erősítse a HDMI-kábelt a HDMI-
kábeltartó lemezhez kereskedelmi kábelkötegelővel vagy szalaggal.

A: a HDMI-kábeltartó lemez rögzítőcsavarja (M2,6×6, fekete)
B: kereskedelmi kábelkötegelő vagy szalag
C: HDMI-kábeltartó lemez (tartozék)

1
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Az egység hálózati eszközhöz csatlakoztatása vezetékkel

Ez a témakör az egység hálózati eszközhöz való vezetékes csatlakoztatását ismerteti.

5-041-958-53(1) Copyright 2022 Sony Corporation

5e vagy jobb kategóriájú LAN-kábellel csatlakoztassa az egységet a hálózati eszközhöz (például Wi-Fi
hozzáférési ponthoz vagy kapcsoló hubhoz).

1
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Használat hálózati feszültségről

Ez a témakör az egység hálózati feszültségről való táplálását ismerteti.

Csúsztassa a pásztázó/döntő zárókart a LOCK helyzetbe a kamerafej lezárásához pásztázó/döntő mozgás
ellen.

1

Dugaszolja a hálózati tápegység (tartozék) egyenáramú tápkábelének csatlakozóját az egység DC IN
aljzatába, és dugaszolja a tápegység hálózati vezetékét (tartozék) egy konnektorba.

A: DC IN csatlakozó
B: hálózati vezeték
C: hálózati tápegység

2

Rögzítse a hálózati tápegység egyenáramú tápkábelét a kábelbilinccsel, nehogy kihúzódjon.

Nyissa fel a kábelbilincset, helyezze bele a tápkábelt az alábbi ábra szerint, majd zárja le a kábelbilincset.

3
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Megjegyzés

Csak az egységhez adott tápegységet használja, más tápegységet vagy tápvezetéket ne kössön az egységre. Más tápegység
vagy tápvezeték csatlakoztatása tüzet vagy működési hibát eredményezhet.

Ne csatlakoztassa és ne használja a hálózati tápegységet szűk helyen, pl. fal és bútor között.

Ne zárja rövidre a hálózati tápegység egyenáramú csatlakozójának fém részeit. Ez meghibásodást eredményezhet.

Dugaszolja a hálózati tápegység hálózati vezetékét a legközelebbi konnektorba. Ha működés közben gondot észlel, azonnal
húzza ki a hálózati vezetéket a konnektorból.

A: kábelbilincs
B: kábelbilincs zár
C: egyenáramú tápkábel

Ellenőrizze, hogy az egység előlapján a POWER jelzőlámpa villogó zöldről folyamatos zöldre váltott-e, és
lezárult-e az indítási folyamat.

Ha az egység hibátlanul bekapcsolódott és a hálózatra csatlakozott, a NETWORK jelzőlámpa zölden világít.

Pásztázás/döntést nem támogató objektív használata esetén zárja le a pásztázó/döntő zárókart és ugorja át a
következő lépéseket. A pásztázó/döntő mozgatást támogató objektívekről felvilágosítást a Sony szervizektől
kérhet.

4

Oldja fel a kamerafej pásztázó/döntő mozgását a pásztázó/döntő zárókar UNLOCK helyzetbe tolásával.5

Állítsa vissza a pásztázást/döntést.

Részletek: „A pásztázás/döntés visszaállítása”.

6
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A hálózati tápegység dugaszát a dugasztestnél fogva, egyenesen húzza ki. A kábel/vezeték húzása meghibásodást okozhat.

Kapcsolódó témák
A pásztázás/döntés visszaállítása

5-041-958-53(1) Copyright 2022 Sony Corporation
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A PoE++ táplálás használata

Ha az egység PoE++ kompatibilis tápforrásra van kötve, a táplálást kereskedelmi forgalomban kapható hálózati
adatkábelen át kapja.
Ez lehetővé teszi az egység külön tápegység nélküli táplálását olyan helyeken, ahol nincs konnektor a környéken.

Csúsztassa a pásztázó/döntő zárókart a LOCK helyzetbe a kamerafej lezárásához pásztázó/döntő mozgás
ellen.

1

Kösse az egységet a PoE++ kompatibilis tápforrásra kereskedelmi forgalomban kapható hálózati
adatkábellel.

A: hálózati adatkábel
B: PoE++ kompatibilis tápforrás

2

Ellenőrizze, hogy az egység előlapján a POWER jelzőlámpa villogó zöldről folyamatos zöldre váltott-e, és
lezárult-e az indítási folyamat.

Ha az egység hibátlanul bekapcsolódott és a hálózatra csatlakozott, a NETWORK jelzőlámpa zölden világít.

Megjegyzés

3
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Megjegyzés

Az egység IEEE802.3bt (4. típus, 8. osztály) kompatibilis. Az ellenőrzötten kompatibilis PoE++ tápforrásokról felvilágosítást a
Sony szervizektől kérhet.

A készülék kompatibilis a lágy hitelesítéssel (LLDP), de szükség lehet a (IEEE802.3bt kompatibilis) hálózati eszközök
konfigurálására.

Ne csatlakoztasson hálózati tápegységet, ha a PoE++ tápellátást lágy hitelesítést (LLDP) engedélyezve használja.

Ha hálózati tápegység és PoE++ tápforrás egyidejűleg van csatlakoztatva, a tápellátás a hálózati tápegységről történik.

PoE++ tápláláshoz használjon 5e vagy magasabb kategóriájú hálózati adatkábelt.

PoE++ táplálás használatakor várjon körülbelül 10 másodpercet, miután újra bekapcsolta a készüléket.

PoE++ táplálás használatakor kösse védőföldeléshez a földelő csatlakozót.

PoE++ tápellátásos csatlakoztatáskor ne vezesse a vezetékeket kültéren.

Kapcsolódó témák

A pásztázás/döntés visszaállítása

5-041-958-53(1) Copyright 2022 Sony Corporation

PoE++ tápellátás esetén a kezdeti hitelesítés az indítás befejezéséig tartó időintervallumban történik.

Pásztázás/döntést nem támogató objektív használata esetén zárja le a pásztázó/döntő zárókart és ugorja át a következő
lépéseket. A pásztázó/döntő mozgatást támogató objektívekről felvilágosítást a Sony szervizektől kérhet.

Oldja fel a kamerafej pásztázó/döntő mozgását a pásztázó/döntő zárókar UNLOCK helyzetbe tolásával.4

Állítsa vissza a pásztázást/döntést.

Részletek: „A pásztázás/döntés visszaállítása”.

5
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A pásztázás/döntés visszaállítása

A pásztázás/döntés a következő eljárással állítható vissza, például objektívcsere esetén.

5-041-958-53(1) Copyright 2022 Sony Corporation

Tolja a pásztázó/döntő zárókart UNLOCK helyzetbe, és ellenőrizze, hogy feloldódott-e a kamerafej
pásztázás/döntési mozgásának lezárása.

1

Hajtsa végre a pásztázás/döntés visszaállítási funkcióját.

A pásztázás/döntés visszaállítható az infra távvezérlővel, a webes alkalmazással vagy a (különtartozék) RM-IP500
távvezérlővel.

Visszaállítás az infra távvezérlővel: nyomja meg a P/T RESET gombját.
Visszaállítás a webes alkalmazással: nyomja meg az élő működtető képernyő kamera vezérlőpanelje 
(Others) fülén található  (Pásztázás/döntés visszaállítása) gombot.
Visszaállítás az RM-IP500 távvezérlővel: az RM-IP500 kezelői utasításai szerint.

Megjegyzés

A pásztázás/döntés visszaállítása során a kamerafej és az objektív elfordul. A visszaállítás előtt ellenőrizze, hogy semmi
sem akadályozza az objektív mozgását.

Az egységnek van pásztázási/döntési tartományt korlátozó funkciója, de ez nem működik az egység bekapcsolása és a
pásztázás/döntés visszaállítása során.

Tipp

A pásztázás/döntés visszaállításának befejeztével az egység visszatér a visszaállítást megelőző helyzetbe.

2
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A webes alkalmazás elérése webböngészőből

Az egység táblagépre vagy számítógépre kötését követően az egység webböngészőből működtethető és konfigurálható.

Ellenőrizze, hogy táblagépe vagy számítógépe támogatja-e a webes alkalmazás műveleteit.

Megjegyzés

Az előírt környezet hiánya vagy a táblagép/számítógép bizonyos használata hátrányosan befolyásolhatja a
webböngészőben történő video megjelenítést.

Az egység webes alkalmazása JavaScript-et használ. Ha vírusirtó szoftvert használ táblagépén/számítógépén,
előfordulhat, hogy a weboldal nem jelenik meg helyesen.

1

Elem Követelmény

Kijelzés
1080×810 képpont vagy több ajánlott
A táblagép képernyőmérete: 10 hüvelyk vagy
nagyobb ajánlott

Támogatott operációs rendszer és
webböngésző

Windows
Oprendszer Windows 10 vagy újabb

Webböngésző Google Chrome

Mac

Oprendszer macOS 10.15 vagy újabb

Webböngésző
Google Chrome
Safari

iPad

Oprendszer iPadOS 15 vagy újabb

Webböngésző
Google Chrome
Safari

Android
Oprendszer Android 12 vagy újabb

Webböngésző Google Chrome

Ellenőrizze, hogy be van-e kapcsolva az egység, a táblagép vagy számítógép és a perifériás eszközök.2

Ellenőrizze, hogy csatlakozik-e helyi hálózathoz Wi-Fi vagy vezetékes kapcsolattal a táblagép vagy
számítógép.

3

Csatlakoztassa az egységet táblagépe vagy számítógépe webböngészőjéből.

Kapcsolódás QR-kóddal
A táblagép kamerájával olvassa be az egység oldalán levő médiaburkolatra nyomtatott QR-kódot.

4

106



Megjegyzés

Ha a HTTP port számát átállították az alapértelmezett 80-ról, akkor a címsorba a „http://az egység IP címe:portszám” címet írja.

Ha a csatlakoztatást QR-kód beolvasásával vagy a webböngésző címsorában URL cím megadásával végzi, használjon olyan
eszközt, amely támogatja az mDNS-t*.

Tipp

A továbbiakban az egységet könnyen elérheti a webböngésző könyvjelző funkciójának használatával.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyissa meg a megjelenő hivatkozást a táblagépen.
Ezután elindul a táblagép webböngészője és megjeleníti az egység webes alkalmazásának képernyőjét.

Csatlakoztatás URL cím megadásával a webböngésző címsorában
Indítson el egy webböngészőt a táblagépen vagy számítógépen és írja be az egység oldalán levő médiaburkolatra
nyomtatott URL címet.
Ezután a webböngészőn meg kell jelenjen az egység webes alkalmazásának képernyője.

Csatlakoztatás az egység IP-címének megadásával webböngésző címsorában
Indítson el egy webböngészőt táblagépén vagy számítógépén és írja a „http://az egység IP címe” címet a
címsorába.
Ezután a webböngészőn meg kell jelenjen az egység webes alkalmazásának képernyője.

mDNS: az IP-címnek a helyi hálózati host névből történő meghatározására használt kommunikációs protokoll.*
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Az egység inicializálása

Az egység első használatba vételekor a következő eljárással konfigurálja az egységet.

Tipp

Ha teljesen lemerült a memóriaőrző akkumulátor, az inicializálást újra el kell végezni.

Csatlakoztassa az egységet táblagép vagy számítógép webböngészőjéből, és indítsa el a webes
alkalmazást.

Az első használatba állításkor az egység felhasználónevet és jelszót kér a webböngészőben. Adja meg a következő
beállításokat.

Felhasználónév: admin
Jelszó: (hagyja üresen)

Az inicializáláshoz kövesse a képernyőn megjelenő utasításokat.

1

Írja be a rendszergazda (Administrator) felhasználónevét és jelszavát, majd nyomja meg az [OK] gombot.

1: A rendszergazda felhasználónevének megadása.
2: A rendszergazda jelszavának megadása.
3: Megerősítésként adja meg még egyszer ugyanazt a jelszót.

Megjegyzés

A következő karakterek használhatók a felhasználónévben és jelszóban. A jelszó legyen 8–64 karakter hosszú és legyen
benne legalább egy nagybetű, egy kisbetű és egy szám.

Alfanumerikus karakterek

2
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Megjelenik a felvételkészítési műveletek élő képernyője. Folytassa az egység alapvető használati konfigurálását, az
üzemmód szerint.

Tipp

Egyes esetekben, például az egység táblagéppel párosított használatakor, egyszerűbb lehet a rögzített IP-cím használata az
egységhez.

Szimbólumok (!$%`*+-./<=>?@[]^_{|}~)

A webböngésző újratöltődik és ismét bekéri a felhasználónevet és jelszót.

Írja be a 2. lépésben konfigurált felhasználónevet és jelszót.

Megjelenik a nyelv és az óra beállító képernyője.

3

Adja meg a következő adatokat, majd nyomja meg az [OK] gombot.

[Language]
Válassza ki a webes alkalmazásban és a kamera képernyőjén használni kívánt nyelvet. A nyelv megváltoztatásával
a webes alkalmazás megjelenítési nyelve is megváltozik.
[Date & Time Format]
Válassza ki a dátum és a pontos idő megjelenítési formátumát, a következő lehetőségek közül.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
„yyyy” az évet, „mm” a hónapot, „dd” a napot, „hh” az órát, „mm” a percet és „ss” a másodpercet jelöli.
[12 h/24 h]
Válassza ki a pontos idő [12 h] (12-órás) vagy [24 h] (24-órás) formátumát.
[Time Setting]
A dátum/pontos idő beállítási módja.
[Synchronize with PC]: a számítógép vagy táblagép dátum/idő értékének átvétele.
[Manual setting]: kézi beállítás. E módszer választásakor megjelenik a dátum és az idő beviteli ablaka.
[Time Zone]
Az időzóna kiválasztása.

4
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Rögzített IP-cím beállításához előbb kapcsolja ki a webes menü [Network] > [Wired LAN] > [IPv4] > [DHCP] pontja beállítását (a
tolókapcsoló bal oldalra tolásával).

Megjelennek a rögzített IP-címhez tartozó beállítási elemek. Állítsa be őket, majd nyomja meg a képernyő [OK] gombját.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Alapvető használati konfigurálás

Ez a témakör az egység alapvető használati konfigurálását ismerteti.

A felvételi üzemmód beállítása

Az egység felvételi üzemmódját kiválaszthatja a munkafeladat szerint.

Custom üzemmód: képek rugalmas létrehozása a felvételkészítés közben.
Log felvételi üzemmódok: S_Log tartalom rögzítése.

Flexible ISO üzemmód: az expozíciós beállításokat a felvett jelenetnek megfelelő ISO-értékek beállítása
határozza meg.
Cine EI üzemmód/Cine EI Quick üzemmód: használja az egységet filmes kamerához hasonlóan (nem kész
képeket felvéve), a képek utófeldolgozásával.

Cine EI Quick üzemmódban az egység automatikusan választja ki az Exposure index beállításának megfelelő
alapérzékenységet.
A felvételi üzemmódot a webes menü vagy a kameramenü [Project] > [Base Setting] > [Shooting Mode] pontjában
válthatja.

Custom üzemmód
Kiválaszthatja a videoszabványt.
A webes menü vagy a kameramenü [Project] > [Base Setting] > [Target Display] pontjában válthatja.

[SDR(BT.709)]: felvételkészítés a HD műsorszórási szabvány szerint
[HDR(HLG)]: felvételkészítés a következő generációs 4K műsorszórási szabvány szerint

Részletek: „A megjelenés áttekintése” és más témakörök a „Felvételkészítés kívánt megjelenéssel” alatt.

Log felvételi üzemmódok
(Flexible ISO üzemmód/Cine EI üzemmód/Cine EI Quick üzemmód)
Log felvételi üzemmódokban Ön választja ki a rögzített és kimeneti jelek bázis színterjedelmét. Az itt választott
színterjedelem a videó kimenet színtere a [LUT On/Off] [MLUT Off] beállításakor.
A színterjedelem a kameramenü [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] pontjában kapcsolható.

[S-Gamut3.Cine/SLog3]: könnyen beállítható színterjedelem digitális mozizáshoz (DCI-P3).
[S-Gamut3/SLog3]: Sony széles színterjedelem, amely lefedi az ITU-R BT.2020 színterjedelmet.

Részletek „Felvételkészítés a megjelenés állításával az utófeldolgozás során”
 
Az egyes felvételi üzemmódban támogatott funkciók a következő táblázatban tekinthetők át.
●: támogatott, –: nem támogatott

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –
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Tipp

Cine EI Quick és Cine EI üzemmódban a felvétel bázis ISO-érzékenységen készül, erősítés nélkül, a képérzékelő
teljesítményének maximalizálása érdekében. A fényerő beállítása a világítás és az ND-szűrő segítségével történik, a
képérzékelőre jutó fény mennyiségének beállításához.

A rendszerfrekvencia beállítása

A webes menü vagy a kameramenü [Project] > [Rec Format] > [Frequency] pontjában válthatja. Az átállítást automatikus
újraindulás követheti, a kiválasztott értéktől függően.

Megjegyzés

Felvétel vagy lejátszás közben nem változtatható a rendszerfrekvencia.

Az Imager Scan üzemmód beállítása

Beállíthatja az effektív képméretet és a képérzékelő felbontását.
A webes menü vagy a kameramenü [Project] > [Rec Format] > [Imager Scan Mode] pontjában válthatja.
[FF]: teljes képkocka méret.
[S35]: Super 35 mm méret.

Megjegyzés

Felvétel vagy lejátszás közben nem változtatható az Imager Scan Mode.

S35 beállítása esetén a videoformátum csak 1920×1080 lehet.

A kodek beállítása

Itt a felvételhez használt kodeket adhatja meg.
A webes menü vagy a kameramenü [Project] > [Rec Format] > [Codec] pontjában válthatja.

Megjegyzés

Felvétel vagy lejátszás közben nem változtatható a kodek.

A videoformátum beállítása

Itt a felvétel és a kamera kimenet videoformátumát állíthatja be.

Custom Flexible ISO Cine EI Cine EI Quick

Base ISO – ● ● ● (EI-hez kapcsolt)

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(Base Look kivételével)

● – – –
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A felvételi videoformátum a webes menü vagy a kameramenü [Project] > [Rec Format] > [Video Format] pontjában
állítható be.
Az SDI OUT és HDMI OUT csatlakozón kiadott videó formátumának átállításához használja a webes menü vagy a
kameramenü [Monitoring] > [Output Format] pontját.

Megjegyzés

Felvétel vagy lejátszás közben nem változtatható a videoformátum.

A videoformátum beállítástól függően az SDI OUT és HDMI OUT csatlakozó jeleire korlátozások vonatkozhatnak.

Kapcsolódó témák

A megjelenés áttekintése

Felvételkészítés a megjelenés állításával az utófeldolgozás során

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Támogatott memóriakártyák

Az egység a kártyahelyeken levő (külön vásárolható) CFexpress Type A vagy SDXC memóriakártyákra tud hangot és
képet rögzíteni. A memóriakártyák proxy felvételek készítésére is szolgálnak.

CFexpress Type A memóriakártyák

Az egységben használja az „Ajánlott felvételi adathordozók” alatt felsorolt Sony CFexpress Type A memóriakártyákat*.
Más gyártók adathordozóiról további információk az adathordozók kezelői utasításaiban és gyártóik tájékoztatóiban
találhatók.

SDXC memóriakártyák

Az egységben használja az „Ajánlott felvételi adathordozók” alatt felsorolt SDXC memóriakártyákat*.

Ajánlott felvételi adathordozók

A garantált üzemi feltételek a Rec Format és Recording beállításoktól függnek.

CFexpress Type A
VPG400-kompatibilis
Az egység minden felvételi formátumához használható.

SDXC
A következő táblázat feltételei szerint használható. „●”: ellenőrzötten működik, „–”: a működése nem garantálható.

RAW Out & XAVC-I, 4096×2160 Class 300, Normál mód

RAW Out & XAVC-I, 3840×2160 Class 300, Normál mód

Súgó útmutatónkban „CFexpress kártyák” néven szerepelnek.*

Súgó útmutatónkban „SD kártyák” néven szerepelnek.*

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●
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RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (60 fps vagy kevesebb)

RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Ellenőrzött adathordozó nem áll rendelkezésre.

XAVC-I, 4096×2160 Class 300, Normál mód

XAVC-I, 4096×2160 Class 300, S&Q (60 fps vagy kisebb)

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●
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XAVC-I, 3840×2160 Class 300, Normál mód

XAVC-I, 3840×2160 Class 300, S&Q (60 fps vagy kisebb)

XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Ellenőrzött adathordozó nem áll rendelkezésre.

XAVC-I, 1920×1080 Class 100, Normál mód

XAVC-I, 1920×1080 Class 100, S&Q (60 fps vagy kisebb)

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 Class 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Class 100, S&Q (150 fps, 180 fps)
Ellenőrzött adathordozó nem áll rendelkezésre.

XAVC-I, 1920×1080 Class 100, S&Q (200 fps, 240 fps)
Ellenőrzött adathordozó nem áll rendelkezésre.

XAVC-L, 3840×2160 420, Normál mód

XAVC-L, 3840×2160 420, S&Q (60 fps vagy kisebb)

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, Normál mód

XAVC-L, 1920×1080 HD50, S&Q (60 fps vagy kisebb)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, Normál mód

XAVC-L, 1920×1080 HD35, S&Q (60 fps vagy kisebb)

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-958-53(1) Copyright 2022 Sony Corporation

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Rendszerfrekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Memóriakártyák behelyezése

Ez a témakör a memóriakártyák behelyezésekor alkalmazandó óvintézkedéseket ismerteti.

Nyissa fel a kártyahely-rész adathordozó-fedelét.1

Helyezzen be egy memóriakártyát.

CFexpress kártya címkéje nézzen felfelé.

Megjegyzés

Mennyezetre szerelt egység esetén a címke nézzen lefelé.

SD kártya címkéje nézzen lefelé.

Megjegyzés

Mennyezetre szerelt egység esetén a címke nézzen felfelé.

A hozzáférésjelző pirosan kezd világítani, majd zöldre vált, ha használható a kártya.

2
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Megjegyzés

Megsérülhet a memóriakártya, a memóriakártya-hely és a kártyán levő adatok, ha a kártyát rossz oldalával kívánják
beerőszakolni.

Ha az A és B CFexpress Type A / SD kártyahelyen is kíván felvételt rögzíteni, a felvétel formátumához ajánlott adathordozót
helyezzen mindkét kártyanyílásba.

5-041-958-53(1) Copyright 2022 Sony Corporation

Megjegyzés

Ha a hozzáférésjelző folyamatosan piros fénnyel villog és nem vált zöldre, rövid időre kapcsolja ki az egységet, vegye ki és
helyezze vissza a memóriakártyát.

Csukja rá az adathordozó-fedelet.3
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Memóriakártya kivétele

Nyissa fel a kártyahely-rész adathordozó-fedelét és óvatosan nyomja le a kivenni kívánt memóriakártyát.

Megjegyzés

Ha memóriakártya írása vagy olvasása közben kapcsolják ki az egységet vagy veszik ki a memóriakártyát, akkor nem
garantálható a kártyán lévő adatok sértetlensége. A kártyán rögzített összes adat elveszhet. Az egység kikapcsolása vagy a
memóriakártya kivétele előtt mindig győződjön meg arról, hogy a hozzáférésjelző zölden vagy egyáltalán nem világít.

Ha közvetlenül felvétel rögzítése után veszi ki a memóriakártyát, az még forró lehet; ez nem rendellenes.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Memóriakártyák formázása (inicializálása)

Formázatlan vagy más specifikáció szerint formázott memóriakártya behelyezésekor a kamerakép-panelen a következő
üzenet jelenik meg: „Media Needs to be Formatted”.
A következő eljárással formázza meg a kártyát.

Megjegyzés

Memóriakártya formázása töröl minden adatot a kártyáról, tehát a videofelvételeket és a beállító fájlokat is.

A végrehajtás során üzenetek jelenhetnek meg, a formázási folyamat időtartamától függően.

Ha sikertelen a formázás
Az egység által nem támogatott memóriakártyák nem formázhatók a kamerában.
Ezt figyelmeztető üzenet jelzi. Az utasítások szerint cserélje ki a kártyát támogatott típusúra.

Az egységben megformázott kártya használata más eszköz kártyahelyén
Készítsen másolatot a kártyáról, majd formázza meg a kártyát a másik eszközben.

5-041-958-53(1) Copyright 2022 Sony Corporation

Válassza a kameramenü [TC/Media] > [Format Media] pontját.1

Válassza a Media(A) (A kártyahely) vagy Media(B) (B kártyahely), lehetőséget, majd válassza ki a formázás
módját (Full Format vagy Quick Format).

Megerősítő üzenet jelenik meg.
[Full Format]: teljes inicializálást végez az adathordozón, ami kiterjed az adatrégióra és az adatkezelési
információkra is.
[Quick Format]: csak az adatkezelési információkat inicializálja az adathordozón.

2

Válassza az [Execute] lehetőséget.

Formázás közben üzenet olvasható és pirosan világít a hozzáférésjelző.
A formázás befejeződését üzenet tudatja.

3
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A maradék felvételrögzítési idő ellenőrzése

Felvétel készítése (felvétel/készenlét) során a kamerakép-panel A/B kártyahely jelzőjén figyelemmel kísérheti a
memóriakártya maradék kapacitását.
A kamera a maradék felvételrögzítési időt az egyes kártyák maradék kapacitásából és a pillanatnyi felvételi formátumból
(felvételi bitsebességből) számítja ki és percben adja meg.

Memóriakártya-csere időzítés
Ha a két memóriakártya együttes maradék felvételrögzítési ideje 5 perc alá csökken, megjelenik a „Media Near Full”
(Csaknem megtelt az adathordozó) üzenet, és villogni kezd a felvétel/állapot jelzőlámpa.
Cserélje ki a kártyát több szabad kapacitásúra.
Ha a maradék felvételrögzítési idő nullára fogyásáig folytatja a felvételkészítést, megjelenik a „Media Full” (Megtelt az
adathordozó) üzenet és a felvétel leáll.

Megjegyzés

Egy memóriakártyára kb. 600 klip rögzíthető.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Memóriakártyák visszaállítása

Ha valamilyen okból hiba jelentkezik egy memóriakártyán, a kártyát használat előtt vissza kell állítani.
Ha olyan memóriakártyát tölt be, amelyet vissza kell állítani, a kamerakép-panelen megjelenik egy üzenet, amely
megkérdezi, hogy vissza kívánja-e állítani.

Kártya visszaállításához
A GUI vezérlőpanel nyíl gombjaival válassza az [Execute] lehetőséget, majd nyomja meg a [Set] gombot.
Formázás közben üzenet olvasható, előrehaladás-jelző (%) fut és pirosan világít a hozzáférésjelző.
A visszaállítás befejeződését üzenet tudatja.

Ha sikertelen a visszaállítás
Memóriahibás memóriakártyák nem állíthatók vissza. Ezt figyelmeztető üzenet jelzi. Az utasítások szerint cserélje ki a
memóriakártyát.
Memóriahibás memóriakártyák újraformázás után használhatóvá válhatnak.
Előfordulhat, hogy egyes klipek visszaállíthatók, mások nem. A visszaállított klipek hiba nélkül lejátszhatók.

Megjegyzés

Az ezzel az egységgel felvett anyagok visszaállítását ugyanezzel az egységgel végezze.

Más típusú vagy azonos típusú de eltérő verziószámú egységgel felvett anyagok nem biztos, hogy visszaállíthatók ezzel az
egységgel.

2 másodpercnél rövidebb klipek nem állíthatók vissza.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Felvétel elindítása/leállítása

Ez a témakör a felvétel elindítását/leállítását ismerteti.

Csatlakoztassa a szükséges eszközöket és ellenőrizze, hogy kap-e tápfeszültséget az egység és a perifériás
egységek.

1

Helyezze be a memóriakártyá(ka)t.2

Ellenőrizze az egység táplálási állapotát a webes alkalmazás képernyő bal felső részén.

Ha be van kapcsolva az egység
Ha be van kapcsolva az egység, [Power ON] látható a webes alkalmazás képernyő tápkapcsolóján.

Az egység előlapján világít a POWER jelzőlámpa és a webes alkalmazás élő működtető képernyőjén a kamera
képe látható.

Megjegyzés

Ha nincs konfigurálva a rendszergazda jelszó, megjelenik a konfigurálását kérő képernyő. Lásd: „Az egység inicializálása”.

Ha készenléti üzemmódban áll az egység
Ha készenléti üzemmódban áll az egység, [Power Standby] látható a webes alkalmazás tápkapcsolóján.

Ebben az állapotban nyomja meg a tápkapcsolót és válassza a [Power ON] lehetőséget. Az egység bekapcsol,
előlapján kigyullad a zöld POWER jelzőlámpa és a webes alkalmazás élő működtető képernyőjén megjelenik a
kamera képe.

Tipp

Az egység a mellékelt infra távvezérlő power gombjával is bekapcsolható.

3
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Az egység táplálásának készenléti állapotba állítása
Az egység tápellátásának készenléti állapotba állításához nyomja meg a webes alkalmazás tápkapcsolóját és válassza a
[Power Standby] lehetőséget.

Tipp

Az egység táplálása a mellékelt infra távvezérlő power gombjával is készenléti állapotba kapcsolható.

Kapcsolódó témák

Az egység inicializálása

Nyomja meg a felvétel START/STOP gombot.

Elindul a felvétel és kigyullad az egység felvétel/állapot jelzőlámpája (2 helyen).
Felvétel közben világít a felvétel START/STOP gomb. Megjelenik a felvételhez használt adathordozó ikonja és a
[●Rec] ikon is.

4

A felvétel leállításához nyomja meg ismét a felvétel START/STOP gombot.

Leáll a felvétel és kialszik az egység felvétel/állapot jelzőlámpája (2 helyen).
Felvétel készenléti állapotában a felvétel START/STOP gomb nem világít. Megjelenik a felvételhez használt
adathordozó ikonja és a [Stby] ikon is.

Tipp

A felvétel a mellékelt infra távvezérlő START/STOP gombjával is elindítható és leállítható.

5
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Átkapcsolás memóriakártyák között

Ha két memóriakártya van a kamerában, a webes alkalmazás lejátszásvezérlő panelje [Slot Select] gombjával válthatók.

Tipp

A memóriakártyák a mellékelt infra távvezérlő SLOT SEL (A)/(B) memóriakártya-hely választó gombjával is válthatók.

Reléfelvételezés

A rögzítés automatikusan a második memóriakártyára kapcsol át, kicsivel mielőtt az első kártya maradék kapacitása
teljesen lefogy (reléfelvétel). Kártyaváltásos felvételkészítésnél szünet nélkül folytathatja a felvételt és új kártyára
cserélheti a megteltet.

Megjegyzés

Lejátszás közben nem lehet átkapcsolni memóriakártyák között. Az A és B kártyahely között megoszló felvétel sem játszható le
folyamatosan.

Rögzített adatok

A felvételkészítés leállításakor a felvett kép, hang és kísérőadatok egyetlen „klipre” kerülnek a memóriakártyán.

A rögzített adatok klipneve

Az egység automatikusan ad nevet a klipeknek, a kameramenü [TC/Media] > [Clip Name Format] pontjában beállított
formátum szerint.

A klipek legnagyobb megengedett időtartama

Egy klip legfeljebb 6 óra hosszú lehet.
A folyamatos felvétel legnagyobb megengedett időtartama azonos a klip max. időtartamával. Ha a felvételi idő ezt
meghaladja, a kamera automatikusan új klipet hoz létre és folytatja a rögzítést. Az új klip külön klipként jelenik meg a
miniatűrök képernyőjén.
Reléfelvétel során egymás után jönnek létre az új klipek, de kb. 24 óra elteltével a felvétel automatikusan leáll.

Megjegyzés

Ne vegye ki a memóriakártyát, miközben adatok íródnak rá. Felvételkészítés közben csak azt a memóriakártyát cserélje,
amelynek hozzáférésjelzője nem világít.

Amikor az aktív memóriakártya maradék kapacitása egy perc alá csökken és a másik kártyahelyen van használható kártya,
megjelenik a „Will Switch Slots Soon” üzenet. Az átkapcsolás megtörténtekor eltűnik az üzenet.

Előfordulhat, hogy a reléfelvétel nem működik, ha a memóriakártya maradék kapacitása kisebb egy percnél. A reléfelvétel
megfelelő működése érdekében a felvétel indítása előtt ellenőrizze, hogy a memóriakártya maradék kapacitása több-e egy
percnél.

Reléfelvétel funkcióval készített videó nem játszható le egyvégtében az egységen.

Az egység reléfelvétel funkciójával készített videó egyesítéséhez használja a „Catalyst Browse” szoftvert.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A hang ellenőrzése

Az egység a hangot az SDI és a HDMI csatlakozón adja ki. A HDMI csatlakozón kiadott hangcsatornák kombinációja a
kameramenü [Audio] > [Audio Output] > [HDMI/Stream Output CH] pontjában állítható be.
CH1/CH2: a CH1 és CH2 kombinációja
CH3/CH4: a CH3 és CH4 kombinációja
A bejövő hangnak a webes alkalmazásban való monitorozásakor használja a kamerakép jobb alsó sarkában levő hang
kivezérlésmérőt.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Időadatok megadása

Ez a témakör az időadatok megadását ismerteti.

Az időkód beállítása

A rögzítendő időkód a kameramenü [TC/Media] > [Timecode] pontjában állítható be.

A felhasználói bitek beállítása

Felhasználói bitként 8-jegyű hexadecimális számot adhat a rögzített képhez. A felhasználói biteket a pontos időre is
állíthatja. A kameramenü [TC/Media] > [Users Bit] pontjában állíthatja be.

Az időadatok megjelenítése

A megjelenítendő időkód a kameramenü [TC/Media] > [TC Display] > [Display Select] pontjában állítható be.
A [DURATION/TC/U-BIT] funkcióra programozott gomb nyomogatása az időkód, felhasználói bitek és időtartam kijelzést
pörgeti körbe.

5-041-958-53(1) Copyright 2022 Sony Corporation
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A felvétel megtekintése (Rec Review)

A legutóbbi klipet megtekintheti a képernyőn (felvétel megtekintése).

Megjegyzés

A Rec Review nem működik, ha a klip felvétele után megváltoztatják a videoformátumot.

A Rec Review kezdőpontjának megadása

A kameramenü [Technical] > [Rec Review] pontjában a lejátszás kezdőhelyzetét a következők egyikére állíthatja.

a klip utolsó 3 másodperce,
a klip utolsó 10 másodperce,
a klip eleje.

Tipp

Ha több klip felvétele után egy meghatározott klipet kíván megtekinteni, a [Thumbnail] gombbal nyissa meg a miniatűrök
képernyőjét és ott válassza ki a lejátszandó klipet.

A miniatűrök képernyője a mellékelt infra távvezérlő THUMBNAIL gombjával is megnyitható.

A felvétel megtekintése (Rec Review)

Az alapkonfiguráció beállítási panelen előzetesen rendelje programozható gombhoz a Rec Review funkciót.

Hozzárendeléssel kapcsolatos részletek: a „Hasznos funkciók” cím „Programozható gombok” pontja alatt.

Állítsa le a felvételt, és a felvett klip lejátszásának elindításához nyomja meg a Rec Review funkcióra programozott
gombot.
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A klip lefut, a Rec Review befejeződik és az egység visszaáll Stby (készenlét) üzemmódba.

A Rec Review leállítása
Nyomja meg a Rec Review funkcióra programozott gombot vagy a [Cancel/Back] gombot.
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Tipp

A Rec Review funkció a mellékelt infra távvezérlő [Cancel/Back] gombjával is leállítható.

Kapcsolódó témák

Programozható gombok

5-041-958-53(1) Copyright 2022 Sony Corporation
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Keretezés állító képernyő

A keretezés az élő működtető képernyő következő részein állítható.

Megjegyzés

A kamera irányától, az objektív gyújtótávolságától és a zoom helyzettől függően az egység egy része vagy a csatlakozótömbre
kötött kábelek belelóghatnak a képbe. Felvételkészítés előtt ellenőrizze az objektív látómezőjét és gyújtótávolságát. A
pásztázási/döntési tartományt vezérelheti a webes menü [Pan-Tilt] > [P/T Range Limit] pontjában is. Az egység figyelmen kívül
hagyja ezt a tartománykorlátozást a bekapcsolás és a pásztázás/döntés visszaállítása után. Részletek a webes menü [Pan-Tilt] >
[P/T Range Limit] pontjában találhatók.

Tipp

A keretezés a mellékelt infra távvezérlővel is állítható.

5-041-958-53(1) Copyright 2022 Sony Corporation

Előbeállított helyzet vezérlőpanelje1.

 (Main) fül /  (Others) fül2.

Keretezésvezérlő panel3.
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Interchangeable Lens Digital Camera
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A felvételkészítési irány állítása a webes alkalmazással

A kamera vízszintes irányú mozgatását pásztázásnak, a függőleges irányú mozgatását pedig döntésnek nevezzük.
A felvételkészítési irány pásztázó/döntő műveletekkel állítható.

Tipp

Ha a botkormány alatt [Execute Pan-Tilt Reset] látható, akkor következetlenség lépett fel az egység pásztázó/döntő vezérlésének
alaphelyzet-adataiban. Az alaphelyzet-adatok visszaállításához hajtsa végre a pásztázás/döntés visszaállítási funkcióját.
Részletek: „A pásztázás/döntés visszaállítása”.

A kamera előre nézésének visszaállítása
Nyomja meg a kamera vezérlőpanel  (Others) fülén a  (Pásztázás/döntés kezdőhelyzet) gombot.

Megjegyzés

A kamera irányától, az objektív gyújtótávolságától és a zoom helyzettől függően az egység egy része vagy a csatlakozótömbre
kötött kábelek belelóghatnak a képbe. Felvételkészítés előtt ellenőrizze az objektív látómezőjét és gyújtótávolságát. A
pásztázási/döntési tartományt vezérelheti a webes menü [Pan-Tilt] > [P/T Range Limit] pontjában is. Az egység figyelmen kívül
hagyja ezt a tartománykorlátozást a bekapcsolás és a pásztázás/döntés visszaállítása után. Részletek a webes menü [Pan-Tilt] >
[P/T Range Limit] pontjában találhatók.

Kapcsolódó témák

A pásztázás/döntés visszaállítása

A botkormány megjelenítéséhez nyomja meg a keretezésvezérlő panel  (Pásztázás/döntés/zoom)
fülét.

1

A kamerakép-panel figyelése közben húzza a botkormány közepét abba az irányba, amerre a kamerát
mozgatni szeretné.

A kamera mozgási iránya és gyorsasága a húzás iránya és erőssége szerint változik.
A pásztázó/döntő mozgás finom állításához nyomja meg a botkormány kerületi részeit.

2
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A pásztázó/döntő mozgás sebességének állítása

A pásztázó/döntő mozgás gyorsasága a kamera vezérlőpanel [Pan-Tilt Speed] csúszkájával módosítható, a
keretezésvezérlő panel botkormánya működtetésével.

Megjegyzés

Ha fal vagy más akadály van a kamera mozgási tartományán belül, vigyázzon, hogy a kamera vagy az objektív ne ütközzön nekik
a pásztázás/döntés közben.

A pásztázási/döntési gyorsulás fizikai jellemzőktől, például az objektív súlyegyensúlyától függ. A gyorsulás beállítását webes
menü vagy a kameramenü [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] pontjában módosíthatja.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg a kamera vezérlőpanel  (Main) fülét.1

Válassza a listán a [Pan-Tilt Speed] csúszkát.

Ha nem látható a [Pan-Tilt Speed] csúszka, megjelenítheti a két csúszkafunkció-választó gomb bármelyikének
választásával.

2

Tolja a csúszka gombját balra vagy jobbra.

A balra tolás csökkenti, a jobbra tolás növeli a mozgási sebességet.

3
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A pásztázó/döntő mozgás gyorsulásának állítása

A gyorsulás a webes menü vagy kameramenü [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] pontjában állítható, kilenc
lépcsőben. A sebesség gyorsabb változtatásához növelje, lassúbb változtatásához csökkentse a gyorsulás számértékét.
Gyorsabb reagáláshoz válasszon 7 és 9 közötti értéket.
A mozgás kezdetén/végén az előre beállított helyzet pontosabb eléréséhez válasszon 1 és 6 közötti értéket.

Az előbeállított helyzettel kapcsolatos részletek: „A pásztázó/döntő és zoom helyzet elmentése/visszaállítása”.

Megjegyzés

Nagy érték beállításakor előfordulhat, hogy a funkció nem működik megfelelően, ha nehéz objektív van csatlakoztatva. A
tényleges használat előtt ellenőrizze a működést.

A [Ramp Curve] beállítás és a pásztázó/döntő mozgás közötti kapcsolat

Pásztázó/döntő mozgatáskor

Előre beállított helyzet lehívásakor
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A felvételkészítési irány állítása a mellékelt infra távvezérlővel

A felvételkészítési irány a mellékelt infra távvezérlő pásztázó/döntő gombjaival állítható.

A kamera előre nézésének visszaállítása
Nyomja meg a HOME gombot.

Megjegyzés

A kamera irányától, az objektív gyújtótávolságától és a zoom helyzettől függően az egység egy része vagy a csatlakozótömbre
kötött kábelek belelóghatnak a képbe. Felvételkészítés előtt ellenőrizze az objektív látómezőjét és gyújtótávolságát. A
pásztázási/döntési tartományt vezérelheti a webes menü [Pan-Tilt] > [P/T Range Limit] pontjában is. Az egység figyelmen kívül
hagyja ezt a tartománykorlátozást a bekapcsolás és a pásztázás/döntés visszaállítása után. Részletek a webes menü [Pan-Tilt] >
[P/T Range Limit] pontjában találhatók.

5-041-958-53(1) Copyright 2022 Sony Corporation

Pásztázó/döntő mozgatáshoz nyomja meg a nyíl gombokat.

A kamerakép figyelése közben nyomja meg a kívánt irányba mozgató gombot.
Kis távolságú mozgatáshoz rövid ideig nyomja a nyíl gombot.
Nagy távolságú mozgatáshoz tartsa nyomva a nyíl gombot.
Átlós irányú mozgatáshoz egyidejűleg nyomja le és tartsa nyomva a  (fel nyíl) vagy  (le nyíl) és a  (bal nyíl)
vagy  (jobb nyíl) gombot.

1
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A Zoom Type beállítása

A zoomolás típusát a kameramenü [Technical] > [Zoom] > [Zoom Type] pontjában állítsa be.
A zoomolás típusa a csatlakoztatott objektív típusától függ.

Megjegyzés

Nem használható a Clear Image Zoom a következő esetekben:

Ha a [Shooting] > [S&Q Motion] > [Setting] pont beállítása On és a kameramenü [Frame Rate] beállítása nagyobb, mint 60 fps
Ha a kameramenü [Project] > [Rec Format] > [Codec] pontjának beállítása [RAW] vagy RAW-t tartalmazó lehetőség

Az objektív SERVO/MANUAL választó kapcsolójának működtetése visszaállítja 1× értékre a Clear Image Zoom nagyítását.

Az AF-S nem támogatott a Clear Image Zoom közben.

Clear Image Zoom

A készülék rendelkezik a Clear Image Zoom nevű, képjelfeldolgozást alkalmazó zoom funkcióval. A Clear Image Zoom
engedélyezett állapotában rögzített fókuszú objektívekkel is lehet zoomolni. Motorzoomos objektíven a tartomány optikai
tartományon túli kiterjesztésére is használható.
A Clear Image Zoom maximális zoomaránya a rögzítési felbontástól függ:

QFHD/4K felbontásnál 1,5×
HD felbontásnál 2×

5-041-958-53(1) Copyright 2022 Sony Corporation

A csatlakoztatott objektív típusa
[Zoom Type] beállítás

[Optical Zoom Only] [On(Clear Image Zoom)]

Rögzített fókuszú objektív/kézi
zoomolásos objektív

A zoomolás nincs támogatva. Támogatott a Clear Image Zoom.

Motorzoomos objektív
Csak az optikai zoomolás van
támogatva.

Támogatott az optikai zoom és a Clear
Image Zoom.
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A zoom állítása a webes alkalmazással

Az egység zoom értéke optikai zoomolással vagy a Clear Image Zoom segítségével állítható. Ez a témakör a zoom
webes alkalmazással történő állítását ismerteti. A Clear Image Zoom részletes ismertetése a „A Zoom Type beállítása”
cím alatt található.

Megjegyzés

A kamera irányától, az objektív gyújtótávolságától és a zoom helyzettől függően az egység egy része vagy a csatlakozótömbre
kötött kábelek belelóghatnak a képbe. Felvételkészítés előtt ellenőrizze az objektív látómezőjét és gyújtótávolságát. A
pásztázási/döntési tartományt vezérelheti a webes menü [Pan-Tilt] > [P/T Range Limit] pontjában is. Az egység figyelmen kívül
hagyja ezt a tartománykorlátozást a bekapcsolás és a pásztázás/döntés visszaállítása után. Részletek a webes menü [Pan-Tilt] >
[P/T Range Limit] pontjában találhatók.

A pillanatnyi zoomolási sebesség és pontosság az objektívtől függ. A használat előtt ellenőrizze a működést.

Tipp

Kézi zoomolásos objektív zoomolását az ezzel az egységgel kompatibilis objektívvezérlővel (különtartozék) vezérelheti.
Részletek: „Objektívvezérlő csatlakoztatása” és „Zoomolás objektívvezérlővel”.

Kapcsolódó témák

A Zoom Type beállítása

Objektívvezérlő csatlakoztatása

Zoomolás objektívvezérlővel
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A pásztázó/döntő vezérlőpanel megjelenítéséhez nyomja meg a keretezésvezérlő panel 
(Pásztázás/döntés/zoom) fülét.

1

A zoom érték állításához tolja a [Zoom] csúszka gombját a [T] (Telephoto) vagy a [W] (Wide) irányba.

A zoomolási sebesség a csúszka mozgatásával változik.

2
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A zoomolási sebesség beállítása

A zoomolás gyorsasága a keretezésvezérlő panel [Zoom] csúszkájával módosítható, a kamera vezérlőpanel [Zoom
Speed] csúszkája használatával.

Megjegyzés

A pillanatnyi zoomolási sebesség és pontosság az objektívtől függ. A használat előtt ellenőrizze a működést.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg a kamera vezérlőpanel  (Main) fülét.1

Válassza a listán a [Zoom Speed] csúszkát.

Ha nem látható a [Zoom Speed] csúszka, megjelenítheti a két csúszkafunkció-választó gomb bármelyikének
választásával.

 

2

Tolja a [Zoom Speed] csúszka gombját balra vagy jobbra.

A balra tolás csökkenti, a jobbra tolás növeli a mozgási sebességet.

3
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A zoomolás állítása a mellékelt infra távvezérlővel

Az egység zoom értéke optikai zoomolással vagy a Clear Image Zoom segítségével állítható. Ez a témakör a mellékelt
infra távvezérlővel történő állítás mikéntjét ismerteti. Clear Image Zoom részletek: „A Zoom Type beállítása”.

Megjegyzés

A kamera irányától, az objektív gyújtótávolságától és a zoom helyzettől függően az egység egy része vagy a csatlakozótömbre
kötött kábelek belelóghatnak a képbe. Felvételkészítés előtt ellenőrizze az objektív látómezőjét és gyújtótávolságát. A
pásztázási/döntési tartományt vezérelheti a webes menü [Pan-Tilt] > [P/T Range Limit] pontjában is. Az egység figyelmen kívül
hagyja ezt a tartománykorlátozást a bekapcsolás és a pásztázás/döntés visszaállítása után. Részletek a webes menü [Pan-Tilt] >
[P/T Range Limit] pontjában találhatók.

Tipp

Kézi zoomolásos objektív zoomolását az ezzel az egységgel kompatibilis objektívvezérlővel (különtartozék) vezérelheti.
Részletek: „Objektívvezérlő csatlakoztatása” és „Zoomolás objektívvezérlővel”.

Kapcsolódó témák

A Zoom Type beállítása

Objektívvezérlő csatlakoztatása

Zoomolás objektívvezérlővel

5-041-958-53(1) Copyright 2022 Sony Corporation

A zoomoláshoz nyomja meg a zoomoló gombot.

A zoom érték módosításához a képernyő figyelése közben nyomja meg a T (Telephoto) vagy a W (Wide) gombot.
A közelítéshez nyomja meg a T gombot.
A távolításhoz nyomja meg a W gombot.

1

147



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

E-bajonettes objektív kalibrálása

E-bajonettes motorzoomos objektív kalibrálása megszünteti az egyes objektívek szórásából adódó zoom helyzet
eltéréseket.
A zoom helyzet pontos kiszámításához az alábbi eljárással kalibrálja objektívjét, hogy korrigálja annak egyedi szórását.

Kalibrálási adatok
Az egység legfeljebb öt objektív kalibrálási adatait tudja tárolni. A hatodik és további kalibrálás adatai felülírják a
legrégebbieket.
Ha szeretné ellenőrizni, hogy a csatlakoztatott objektívhez rendelkezésre állnak-e kalibrációs adatok, a webes
alkalmazás képernyőjének közös területén nyomja meg a  (Kameraállapot) gombot, majd válassza a [Lens] >
[Calibration Data] lehetőséget.

5-041-958-53(1) Copyright 2022 Sony Corporation

Ha van az objektívon SERVO/MANUAL kapcsoló, állítsa SERVO helyzetbe.

Megjegyzés

A kapcsoló MANUAL helyzetében az objektív nem tudja fogadni az egység zoomolási utasításait.

1

Futtassa le a kalibrálást a kameramenü [Technical] > [Lens] > [Lens Calibration] pontjában.

A kalibrálás során a zoomobjektív automatikusan mozog és méri helyzetét.

2
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A pásztázó/döntő és zoom helyzet elmentése/visszaállítása a webes alkalmazás
használatával

A webes alkalmazással (preset position function) elmenthető és szükség esetén lehívható a pásztázás/döntés, a zoom
helyzet és a fókuszbeállítás.

Az elmenthető/visszaállítható elemek részletezése az „Előbeállított helyzet elmentett elemei” cím alatt található.

Megjegyzés

Előbeállított helyzet nem menthető el, ha a Clear Image Zoom tényező nagyobb mint 1×.

A webes menü [Pan-Tilt] > [P/T Direction] > [Ceiling] pontja beállításának módosítása törli az összes elmentett előbeállított
helyzetet.

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Pos.] értékre.

1

Pásztázással/döntéssel és zoomolással határozza meg az elmentendő helyzet.2

Nyomja meg az előbeállított helyzet vezérlőpanelje [+] gombját.

Az elmentett helyzetet tartalmazó kép megjelenik az előbeállított helyzet vezérlőpaneljén.

Tipp

Ha nem jelenik meg az előbeállított helyzet vezérlőpanelje, jelenítse meg az  (Megnyitás) gomb megnyomásával.

A helyzetek a [Preset1]-től emelkedő sorszámmal vannak elmentve.

Ha az előbeállítások sorozatán belül vannak fel nem használt előbeállítások, a helyzetek a fel nem használt
előbeállításokkal kezdődő előbeállításokba kerülnek mentésre. Például, ha az előbeállított helyzetek el vannak mentve a

3
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Előbeállított helyzet visszaállításának törlése
A visszaállítás törléséhez az előbeállított helyzet visszaállítása közben nyomja meg az előbeállított helyzet
vezérlőpaneljén található  (Visszaállítás törlése) gombot. A keretezés állításához használja a botkormányt és a [Zoom]
csúszkát.

[Preset1] és a [Preset3] helyre, de a [Preset2] helyre nem, akkor a következő előbeállított helyzetek a [Preset2], majd a
[Preset4] helyre lesznek mentve.

Legfeljebb 100 előbeállított helyzet menthető el.

Minden előbeállított helyzet átnevezhető. Részletek: „Előbeállított helyzetek átnevezése a webes alkalmazással”.

Elmentett helyzet visszaállítása.

A megfelelő helyzet visszaállításához kattintson duplán a visszaállítandó helyzet miniatűrjére az előbeállított helyzet
vezérlőpaneljén.

Tipp

Helyzet visszaállítható úgy is, hogy megnyomja a képét, megnyomja a megjelenő  (Előbeállított helyzet menü) gombot,
és kiválasztja a [Recall] lehetőséget.

Elmentett helyzetre állás gyorsaságát a webes menü [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt Speed for Common]
pontjának a helyzet elmentésekor érvényes beállítása határozza meg. Az átállási gyorsaság a mentés után is módosítható.
Részletek: „Az átállási gyorsaság (pásztázás-döntés/zoom/fókusz) módosítása előbeállított helyzet visszaállításakor”.

Előbeállított helyzetbe álláskor a pásztázási/döntési helyzet módosítások mértéke az átállási gyorsaság és [Ramp Curve]
beállításokkal módosítható. Részletek: „Az átállási gyorsaság (pásztázás-döntés/zoom/fókusz) módosítása előbeállított
helyzet visszaállításakor” és „A pásztázó/döntő mozgás gyorsulásának állítása”.

Ha előbeállított lejátszás közben másik előbeállítást hívnak le, leáll az első lehívott előbeállítás és elindul az utána lehívott
előbeállítás.

Megjegyzés

Ha a környezet hőmérséklete jelentősen megváltozott az előre beállított helyzet elmentése és a lejátszása között,
elállítódhat a keretezés.

Előbeállított helyzet visszaállítása közben az előbeállított helyzet visszaállításán vagy törlésén kívül más művelet nem
végezhető.

4
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Kapcsolódó témák

Előbeállított helyzet elmentett elemei

Előbeállított helyzetek átnevezése a webes alkalmazással

Az átállási gyorsaság (pásztázás-döntés/zoom/fókusz) módosítása előbeállított helyzet visszaállításakor

A pásztázó/döntő mozgás gyorsulásának állítása

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Előbeállított helyzetek átnevezése a webes alkalmazással

Elmentett előbeállított helyzetek átnevezhetők.

5-041-958-53(1) Copyright 2022 Sony Corporation

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Pos.] értékre.

1

Nyomja meg a visszaállítani kívánt előbeállított helyzetet.

A kép jobb felső sarkában megjelenik az  (Előbeállított helyzet menü) gomb.

2

Nyomja meg az  (Előbeállított helyzet menü) gombot és a megjelenő menün válassza a [Rename]
lehetőséget.

3

Írja be az új nevet.4
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Elmentett előbeállított helyzet lecserélése új helyzetre a webes alkalmazással

Elmentett előbeállított helyzet lecserélhető új helyzetre.

5-041-958-53(1) Copyright 2022 Sony Corporation

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Pos.] értékre.

1

Pásztázással/döntéssel és zoomolással határozza meg az elmentendő helyzet.2

Az előbeállított helyzet vezérlőpaneljén nyomja meg a lecserélendő helyzet képét.

A kép jobb felső sarkában megjelenik az  (Előbeállított helyzet menü) gomb.

3

Nyomja meg az  (Előbeállított helyzet menü) gombot és a megjelenő menün válassza a [Replace]
lehetőséget.

Az új helyzet a pillanatnyi beállítás helyére lép.

4
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Interchangeable Lens Digital Camera
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Elmentett előbeállított helyzet törlése a webes alkalmazással

Elmentett előbeállított helyzetek törölhetők.

5-041-958-53(1) Copyright 2022 Sony Corporation

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Pos.] értékre.

1

Az előbeállított helyzet vezérlőpaneljén nyomja meg a törlendő helyzet képét.

A kép jobb felső sarkában megjelenik az  (Előbeállított helyzet menü) gomb.

2

Nyomja meg az  (Előbeállított helyzet menü) gombot és a megjelenő menün válassza a [Delete]
lehetőséget.

Az elmentett helyzet törlődik.

3
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A pásztázás/döntés és a zoom/fókusz művelet szinkronizálása előbeállított helyzet
visszaállításakor

A keretezés működésének egyszerűsítéséhez a pásztázás/döntés és a zoom/fókusz művelet szinkronizálható
előbeállított helyzet visszaállításakor.

Tipp

Előre megadhatja az előbeállított helyzet regisztrálásához használt beállításokat. Állítsa a webes menü [Pan-Tilt] > [P/T Preset] >
[Default] > [Zoom Sync] pontját [On] értékre.

Ha a [Pan-Tilt] > [P/T Preset] > [Speed Select] beállítása [Common], minden előbeállított helyzet a [Pan-Tilt] > [P/T Preset] >
[Common Speed] használatával beállított gyorsasággal áll vissza.

A zoomolás befejeztével a kamera átáll az elmentett fókuszhelyzetre.

Az átállás megtörténtével [AF Transition Speed] visszatér eredeti beállítására.

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Pos.] értékre.

1

Nyomja meg annak az előbeállított helyzetnek a képét, amelynek átállási gyorsaságát módosítani kívánja.

A kép jobb felső sarkában megjelenik az  (Előbeállított helyzet menü) gomb.

2

Nyomja meg az  (Előbeállított helyzet menü) gombot és a megjelenő menün válassza a [Edit…]
lehetőséget.

Megjelenik a kiválasztott előbeállított helyzet beállító képernyője.

3

A [Zoom Sync] kapcsoló jobbra tolásával kapcsolja be a funkciót és nyomja meg az [OK] gombot.

Elmentett helyzet következő visszaállításakor a kamera az így konfigurált gyorsasággal fog mozogni.

4
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Az átállási gyorsaság (pásztázás-döntés/zoom/fókusz) módosítása előbeállított
helyzet visszaállításakor

Elmentett előbeállított helyzet visszaállításakor módosítható az átállási gyorsaság (pásztázás/döntés, zoomolás, fókusz).

Tipp

Ha a [Pan-Tilt] > [P/T Preset] > [Speed Select] beállítása [Common], minden helyzet a [Pan-Tilt] > [P/T Preset] > [Common
Speed] használatával beállított gyorsasággal áll vissza.

A zoomolás befejeztével a kamera átáll az elmentett fókuszhelyzetre.

Az átállás megtörténtével [AF Transition Speed] visszatér eredeti beállítására.

Állítsa a webes menü [Pan-Tilt] > [P/T Preset] > [Speed Select] pontját [Separate] értékre.1

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Pos.] értékre.

2

Nyomja meg annak az előbeállított helyzetnek a képét, amelynek átállási gyorsaságát módosítani kívánja.

A kép jobb felső sarkában megjelenik az  (Előbeállított helyzet menü) gomb.

3

Nyomja meg az  (Előbeállított helyzet menü) gombot és a megjelenő menün válassza a [Edit…]
lehetőséget.

Megjelenik a kiválasztott előbeállított helyzet beállító képernyője.

4

A csúszkákkal állítsa be a módosítandó átállási gyorsaságokat (pásztázás-döntés/zoom/fókusz) vagy
közvetlenül írja be az értékeket és nyomja meg az [OK] gombot.

Elmentett helyzet következő visszaállításakor a kamera az így konfigurált gyorsasággal fog mozogni.

5
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A pásztázó/döntő és zoom helyzet elmentése/visszaállítása a mellékelt infra
távvezérlővel

A pásztázó/döntő és zoom helyzet elmenthető és szükség esetén lehívható a mellékelt infra távvezérlővel.

Kapcsolódó témák

Az átállási gyorsaság (pásztázás-döntés/zoom/fókusz) módosítása előbeállított helyzet visszaállításakor

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa be a kamera pásztázását/döntését és zoomolását.1

A webes alkalmazásban az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ
assist üzemmódot [Pos.] értékre.

2

Nyomja be és tartsa nyomva a PRESET gombot és nyomja le az 1.–3. gomb egyikét.

A helyzet elmentődik.

3

Elmentett helyzet visszaállítása.

Az előbeállított helyzet visszaállításához nyomja meg az 1 ... 3 gomb egyikét.

Tipp

Előbeállított helyzet visszaállításakor az átállási gyorsaságot a webes menü [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed]
pontjának elmentett értéke határozza meg. Az átállási gyorsaság a mentés után is módosítható. Részletek: „Az átállási
gyorsaság (pásztázás-döntés/zoom/fókusz) módosítása előbeállított helyzet visszaállításakor”.

4
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kamera keretezési műveletek rögzítése a webes alkalmazással

A webes alkalmazással rögzíthet kamera keretezési műveleteket.

Állítsa be a kamera műveletkezdési helyzetét.1

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Trace] értékre.

2

Nyomja meg az előbeállított helyzet vezérlőpanelje [+] gombját.

Miniatűr jelenik meg és a kamera átvált felvételi készenlét állapotba.

Tipp

3
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Tipp

Felvétel készítése közben a maradék felvételrögzítési idő a kamerakép-panel tetején látható.

Megjegyzés

A rögzített keretezési műveletek törlődnek, ha átkapcsolnak mennyezetre rögzítési üzemmódra.

A rendszerfrekvencia átkapcsolása törölheti a rögzített keretezési műveleteket.

Objektívvezérlő csatlakoztatásakor a zoom művelet nem kerül rögzítésre.

Egy keretezési művelet legnagyobb rögzítési ideje 3 perc. A rögzítés automatikusan leáll a 3 perc elérésekor.

Nem indítható el keretezési művelet rögzítése, ha a Clear Image Zoom tényező nagyobb mint 1×.

Ha keretezési művelet rögzítése közben másik eszközről működtetik a kamerát, a másik eszközről végzett műveletek is
rögzítésre kerülnek. Harmadik féltől származó távvezérlővel végzett rögzítési műveletekkel kapcsolatos részletek a távvezérlő
gyártójától tudakolhatók meg.

Ez a funkció nem rögzíti a fókusz és képminőség beállításokat.

Keretezési művelet felvételekor rögzített pásztázás/döntés/zoom műveletek nem reprodukálhatók pontosan a keretezés
lejátszásakor.

A felvételi készenlét állapotból kilépéshez és a normál működés visszaállításához nyomja meg a miniatűr  (Bezár)
gombját.

Kezdje el a keretezést a botkormánnyal és a [Zoom] csúszkával.

A felvétel a keretezési művelet megkezdésének pillanatától indul.

4

A felvétel leállításához nyomja meg a miniatűr  (Felvétel állj) gombját.5
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Ha keretezési művelet rögzítése után a webes menü [Pan-Tilt] > [P/T Range Limit] pontjában beállítják a pásztázási/döntési
tartomány korlátozását, az nem lesz alkalmazva a keretezés lejátszásakor. Ha együtt kívánja használni a keretezési műveletet és
a pásztázás/döntés korlátozási műveletet, a keretezési művelet rögzítése előtt állítsa be a pásztázási/döntési tartomány korlátját.

Rögzített keretezési műveletek nem játszhatók le, ha ki van választva a RAW videó kimenőjel.

Rögzített keretezési műveletek nem játszhatók le, ha az egység a videojelet nem az SDI csatlakozón adja ki.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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Kamera keretezési műveletek lejátszása a webes alkalmazással

Rögzített kamera keretezési műveletek lejátszhatók a webes alkalmazással.

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Trace] értékre.

1

Válasszon miniatűrt a lejátszandó keretezési művelettel.

A miniatűrön megjelenik az  (Előkészít) gomb.

2

Nyomja meg az  (Előkészít) gombot.

A kamera a keretezési művelet kezdőhelyzetébe áll és lejátszási készenlét állapotba kapcsol.

3

Nyomja meg a miniatűr  (Lejátszás) gombját.4
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Tipp

Lejátszási készenlét állapotban és lejátszás közben törölhető a lejátszás és visszaállítható a normál működés az alábbi
műveletek bármelyikével.

Nyomja meg az  (Állj) gombot a miniatűrön vagy az előbeállított helyzet vezérlőpaneljén.
Használja a botkormányt.
Használja a [Zoom] csúszkát.

Lejátszás közben az eltelt felvételrögzítési idő a kamerakép-panel tetején látható.

Megjegyzés

Az egység kiszámíthatatlanul viselkedhet, ha nem ugyanaz a Clear Image Zoom beállítás a keretezési műveletek rögzítése és
lejátszása közben.

Objektívvezérlő csatlakoztatásakor a zoom művelet lejátszása nincs támogatva. A zoomolás leállítja a keretezési műveletek
lejátszását.

Keretezési művelet lejátszásakor a pásztázási/döntési tartomány korlátnak a webes menü [Pan-Tilt] > [P/T Range Limit]
pontjában való módosítása hatástalan. Keretezési művelet rögzítése előtt állítsa be a pásztázási/döntési tartomány korlátját.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elindul a keretezés lejátszása.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A kamera rögzített keretezési műveleteinek törlése a webes alkalmazással

A kamera rögzített keretezési műveletei törölhetők a webes alkalmazással.

5-041-958-53(1) Copyright 2022 Sony Corporation

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Trace] értékre.

1

Válasszon miniatűrt a törlendő keretezési művelettel.

A miniatűrön megjelenik az  (Trace menü) gomb.

2

Nyomja meg a  (Trace menü) gombot.

Megjelenik a menü.

3

A megjelenő menün válassza a [Delete] lehetőséget.

Törlődik a kiválasztott keretezési művelet.

4
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kamera keretezési műveletek rögzítése a mellékelt infra távvezérlővel

A mellékelt infra távvezérlővel rögzíthetők a kamera keretezési műveletei.

Részletek a rögzített keretezési műveletről a „Kamera keretezési műveletek lejátszása a mellékelt infra távvezérlővel”
cím alatt találhatók.

Megjegyzés

Egy keretezési művelet legnagyobb rögzítési ideje 3 perc. A rögzítés automatikusan leáll a 3 perc elérésekor.

Ha keretezési művelet rögzítése közben másik eszközről működtetik a kamerát, a másik eszközről végzett művelet is rögzítésre
kerül a keretezési művelet részeként.

Ha keretezési művelet rögzítése közben módosítják a képminőséget, a módosítás nem lesz rögzítve.

Kapcsolódó témák

Kamera keretezési műveletek lejátszása a mellékelt infra távvezérlővel

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyissa meg a webes alkalmazás élő működtető képernyőjét.1

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Trace] értékre.

2

Állítsa be a kamera műveletkezdési helyzetét az infra távvezérlővel.3

Nyomja be és tartsa nyomva a PRESET gombot és nyomja meg a POSITION1–3 gomb egyikét.

A kamera átvált felvételi készenlét állapotba.

4

Végezze el a rögzíteni kívánt keretezési műveletet.5

A rögzítés befejezéséhez nyomja be és tartsa nyomva a PRESET gombot és nyomja meg a 4. lépésben
választott POSITION gombot.

6
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kamera keretezési műveletek lejátszása a mellékelt infra távvezérlővel

Rögzített kamera keretezési művelet lejátszható a mellékelt infra távvezérlővel.

Megjegyzés

A kamera pásztázás/döntés/zoom működtetése leállítja a lejátszást.

Kapcsolódó témák

Kamera keretezési műveletek rögzítése a mellékelt infra távvezérlővel

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyissa meg a webes alkalmazás élő működtető képernyőjét.1

Az előbeállított helyzet vezérlőpanelje tetején található legördülő listán állítsa a PTZ assist üzemmódot
[Trace] értékre.

2

Nyomja be és tartsa nyomva a POSITION1–3 gomb egyikét, amelyre rögzítették a keretezési műveletet.

A kamera pásztázás/döntés/zoom működtetése a lejátszás kezdőhelyzetébe mozgat.

3

Ha a kamera beállt a lejátszás kezdőhelyzetébe, nyomja meg ismét ugyanazt a POSITION gombot.

Elindul a lejátszás.

4
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fókuszállító képernyő

A fókusz állítása az élő működtető képernyő következő részein történik.

5-041-958-53(1) Copyright 2022 Sony Corporation

Kamerakép-panel
A fókusz állításához érintse meg a kamera képét. Az érintéses művelet letiltható a webes alkalmazás kamera
vezérlőpanelje  (Focus) fülén levő [Touch Focus] kapcsoló kikapcsolásával.

1.

Kamera vezérlőpanel –  (Focus) fül2.

GUI vezérlőpanel3.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kézi állítás a webes alkalmazással

A fókusz kézzel is állítható, például a következő esetekben.

vízcseppek által részben eltakart témák,
a háttérhez képest kis kontrasztú témák,
a közelieknél távolabb levő témák.

Megjegyzés

Zoomolás közben a kézi fókuszálás nem állítható a webes alkalmazásból.

Tipp

Automatikus fókuszálást akkor is használhat, ha a fő fókuszbeállítási mód kézi. Részletek: „Az automatikus fókuszálási célpont
kézi beállítása (AF Assist) a webes alkalmazással”.

Kapcsolódó témák

Az objektív kapcsolóinak ellenőrzése

Az automatikus fókuszálási célpont kézi beállítása (AF Assist) a webes alkalmazással

5-041-958-53(1) Copyright 2022 Sony Corporation

Ha van az objektíven fókuszálásválasztó kapcsoló, állítsa „AF/MF” vagy „AF” helyzetbe.

Megjegyzés

E kapcsoló „Full MF” vagy „MF” helyzetében az egységgel nem vezérelhető a fókuszálás. Lásd: „Fókusz üzemmód
kapcsolós objektív esetén” az „Az objektív kapcsolóinak ellenőrzése” cím alatt.

1

Az automatikus fókuszálás kikapcsolásához tolja a kamera vezérlőpanel [Auto Focus] kapcsolóját a bal
helyzetbe.

Bekapcsol a kézi fókuszálásos üzemmód.

 (MF)

2

A  (Focus) fül alján található csúszkával állítsa be.3
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kézi állítás a mellékelt infra távvezérlővel

A fókusz a mellékelt infra távvezérlőn is állítható kézzel.

Tipp

Automatikus fókuszálást akkor is használhat, ha a fő fókuszbeállítási mód kézi. Részletek: „Kézi fókuszálás az automatikus
fókuszálás használatakor a mellékelt infra távvezérlővel”.

Kapcsolódó témák

Kézi fókuszálás az automatikus fókuszálás használatakor a mellékelt infra távvezérlővel

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg az infra távvezérlő MF gombját.1

A fókuszt kézzel az F (Far) és N (Near) gombbal állíthatja.

Távoli témára fókuszáláshoz nyomja meg az F gombot.
Közeli témára fókuszáláshoz nyomja meg az N gombot.

2
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fókuszálás fókuszhelyzet megadásával (Spot Focus)

Kézi fókuszálásos üzemmódban a kamerakép-panelen megadhatja a beállítandó fókuszhelyzetet.

Megjegyzés

A spot fókusz funkció nem működik, ha az objektív kézi fókuszálásra van állítva.

Tipp

Spot fókusz üzemmódban megnyomhat egy [Push AF/MF] funkcióra programozott gombot, hogy ideiglenesen leállítsa a spot
fókuszt és engedélyezze az automatikus fókuszálást a gomb lenyomva tartási idejére. A gomb felengedésekor visszaáll a kézi
fókuszálás.

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa a webes menü vagy kameramenü [Shooting] > [Focus] > [Touch Function in MF] pontját [Spot Focus]
értékre.

1

Bekapcsolásához tolja a jobb oldali helyzetbe a  (Focus) fül [Touch Focus] kapcsolóját.2

Kikapcsolásához tolja a bal oldali helyzetbe a  (Focus) fül [Auto Focus] kapcsolóját.3

Adja meg a fókuszhelyzetet.

Megjelenik a spot fókusz marker és a kép úgy módosul, hogy a megadott helyzetben legyen a fókusz.

Példa a helyzet megadására érintéses művelettel

4
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatikus fókuszálás ideiglenes használata (gombnyomásos automatikus
fókuszálás (AF))

Kézi fókuszálásos üzemmódban ideiglenesen áttérhet automatikus fókuszálásra a [Push AF/MF] gomb megnyomásával,
a nyomva tartás idejére.
Ez a lehetőség előnyösen használható a fókusz lassú áthelyezésére más témára kézi fókuszálás közben.

Megjegyzés

A gombnyomásos automatikus fókuszálás funkció nem működik, ha az objektív kézi fókuszálásra van állítva.

Tipp

Ugyanez a művelet elvégeztethető a [Push AF/MF] funkcióra programozott gombbal is.

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa a kameramenü [Shooting] > [Focus] > [Push AF Mode] pontját [AF] értékre.1

Kikapcsolásához tolja a bal oldali helyzetbe a  (Focus) fül [Auto Focus] kapcsolóját.2

Nyomja meg a [Push AF/MF] gombot.

A gomb nyomva tartása közben automatikus a fókuszálás.

A gomb felengedésekor felszabadul a gombnyomásos automatikus fókuszálás és visszaáll a kézi fókuszálás.

3
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Interchangeable Lens Digital Camera
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Kockázó automatikus fókuszálás használata (Push Auto Focus (AF-S))

Ha kézi fókuszálásos üzemmódban gyors automatikus fókuszálást kíván végezni, nyomja meg a [Push AF/MF] gombot.
Ez a funkció különösen jól használható téma felvétel indítása előtti befókuszálására.

Megjegyzés

A gombnyomásos automatikus fókuszálás funkció nem működik, ha az objektív kézi fókuszálásra van állítva.

A [Display] gomb használatakor a fókuszmező kerete nem rejtett.

Clear Image Zoom művelet során a [Focus Area (AF-S)] keret helyzete nem állítható be. Gombnyomásos automatikus fókuszálás
során az AF művelet elsőbbséget ad a középső résznek is.

Állítsa a webes menü vagy kameramenü [Shooting] > [Focus] > [Push AF Mode] pontját [Single-shot AF(AF-
S)] értékre.

1

A fókuszállítási helyzetet a kameramenü [Shooting] > [Focus] > [Focus Area (AF-S)] pontjában állíthatja be.

Tipp

A helyzet átállításához nyomja meg a [Focus Setting] funkcióra programozott gombot; ekkor a fókuszmező körül
narancssárga keret jelenik meg, ami érintéses művelettel mozgatható.

2

Kikapcsolásához tolja a bal oldali helyzetbe a  (Focus) fül [Auto Focus] kapcsolóját.3

Nyomja meg a [Push AF/MF] gombot.

Ha a fókuszálás befejeződése előtt elengedi a gombot, a gombnyomásos automatikus fókuszálás leáll.

Gombnyomásos automatikus fókuszálás közben a fókuszálás állapotát a fókuszjelző jelzi.
Világít: témára rögzült a fókusz.
Villog: nincs fókuszálás. Mivel az egység nem fókuszál automatikusan, a fókuszálás eléréséhez módosítsa a
kompozíciót és a fókuszbeállítást.
A gomb felengedésekor visszaáll a kézi fókuszálás.

4
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Tipp

Ugyanez a művelet elvégeztethető a [Push AF/MF] funkcióra programozott gombbal is.

Az [Push AF Mode] funkció gombra is programozható.

Az [Focus Area (AF-S)] funkció gombra is programozható.

A fókuszmező kerete a kameramenü [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] pontjában jeleníthető meg/rejthető
el.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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Automatikus állítás a webes alkalmazással

Az egység fázisérzékeléses AF-et használ a gyors, és kontrasztérzékeléses AF-et a pontos fókuszáláshoz.
A két AF módszer kombinálása egyszerre gyors és pontos automatikus fókuszálást biztosít.

Megjegyzés

Ehhez az automatikus fókuszálást támogató objektív szükséges.

A felvételi körülményektől függően előfordulhat pontatlanság.

A-bajonettes objektív használatakor a fókusz nem állítható automatikusan.

Tipp

Automatikusan fókuszáló üzemmódban a fókusz a kamera vezérlőpanel Focus csúszkájával állítható. Részletek: „Az automatikus
fókuszálási célpont kézi beállítása (AF Assist) a webes alkalmazással”.

Kapcsolódó témák
Az objektív kapcsolóinak ellenőrzése

Az automatikus fókuszálási célpont kézi beállítása (AF Assist) a webes alkalmazással

5-041-958-53(1) Copyright 2022 Sony Corporation

Ha van az objektíven fókuszálásválasztó kapcsoló, állítsa „AF/MF” vagy „AF” helyzetbe.

Megjegyzés

E kapcsoló „Full MF” vagy „MF” helyzetében az egységgel nem vezérelhető a fókuszálás. Lásd: „Fókusz üzemmód
kapcsolós objektív esetén” az „Az objektív kapcsolóinak ellenőrzése” cím alatt.

1

Bekapcsolásához tolja jobb oldali helyzetbe a kamera vezérlőpanel [Auto Focus] kapcsolóját.

Bekapcsolódik az automatikus fókuszáló üzemmód.

 (AF)

2
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Automatikus állítás a mellékelt infra távvezérlővel

Automatikus fókuszálást állíthat be a mellékelt infra távvezérlővel.

Megjegyzés

Automatikus fókuszálást akkor is használhat, ha a fő fókuszbeállítási mód kézi. Részletek: „Kézi fókuszálás az automatikus
fókuszálás használatakor a mellékelt infra távvezérlővel”.

Kapcsolódó témák
Kézi fókuszálás az automatikus fókuszálás használatakor a mellékelt infra távvezérlővel

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg az infra távvezérlő AF gombját.

A kamera automatikusan fókuszál a témára.

1
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Az automatikus fókuszálási mező/helyzet (fókuszmező) beállítása

Megadhatja az automatikus fókuszálás célmezőjét és beállíthatja a képélességet erre a területre.

A kameramenü megnyitásához nyomja meg a GUI vezérlőpanel [Menu] gombját.1

Adja meg az automatikus fókuszálás célmezőjét a kameramenü [Shooting] > [Focus] > [Focus Area]
pontjában.

[Wide]:
A kép széles látószögében keresi a témát a fókuszáláshoz. Keretet nem jelenít meg.

[Zone]:
Automatikusan megkeresi a fókusz helyét a megadott zónában.
A kiválasztást követően a GUI vezérlőpanel nyíl gombjaival adja meg a helyzetet.

A középhelyzetbe a [Set] gomb megnyomásával és nyomva tartásával térhet vissza.
[Flexible Spot]:
A kép megadott helyére fókuszál.

2
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Megjegyzés

A kamerakép-panel [Display] gombjának használatakor a fókuszmező kerete nem rejtett.

Clear Image Zoom használata közben a fókuszmező beállítása [Wide] (rögzített).

Tipp

A fókuszmező kerete a kameramenü [Monitoring] > [Display On/Off] > [Focus Area Indicator] pontjában jeleníthető meg/rejthető
el.

5-041-958-53(1) Copyright 2022 Sony Corporation

A kiválasztást követően a GUI vezérlőpanel nyíl gombjaival adja meg a helyzetet.

A középhelyzetbe a [Set] gomb megnyomásával és nyomva tartásával térhet vissza.
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A fókuszmező gyors átállítása (Focus Setting)

Felvétel készítése közben gyorsan módosíthatja az automatikus fókuszálási mező helyét és méretét a [Focus Setting]
funkció gombra programozásával.

A programozható gombok részletezése a „Programozható gombok” cím alatt található.

A funkció működése a fókuszmező beállítástól függ.

Amikor a kameramenü [Shooting] > [Focus] > [Focus Area] pontjának beállítása [Flexible
Spot] vagy [Zone]

A fókuszmező helyének átállításához nyomja meg a [Focus Setting] funkcióra programozott gombot és mozgassa a
fókuszmezőt a GUI vezérlőpanel nyíl gombjaival. A helyzet állítása közben a [Set] gomb megnyomásával állíthatja
vissza középre a fókuszmezőt.
A fókuszmező méretének átállításához nyomja meg és tartsa nyomva a [Focus Setting] funkcióra programozott
gombot. A méret módosítását követően a [Set] gomb megnyomásával módosíthatja a fókuszmező helyét. Ha végzett,
a [Focus Setting] funkcióra programozott gomb megnyomásával térhet vissza az eredeti képernyőre.

Amikor a kameramenü [Shooting] > [Focus] > [Focus Area] pontjának beállítása [Wide]

A fókuszmező mérete kizárólag a [Focus Setting] funkcióra programozott gomb megnyomásával és nyomva tartásával
módosítható. A helyzetet úgy is módosíthatja, hogy előtte [Flexible Spot] vagy [Zone] értékűre módosítja a típust.

Tipp

Amikor a kameramenüben a [Shooting] > [Focus] > [Push AF Mode] beállítása [Single-shot AF(AF-S)] és az [Auto Focus]
kapcsoló ki van kapcsolva (kézi fókuszálásos üzemmód), módosítható a [Focus Area (AF-S)] fókuszmező helye.

A fókuszmező kerete narancssárga, ha a fókuszmező helyzete módosítható.

Kapcsolódó témák
Programozható gombok

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A fókuszmező keretének mozgatása érintéses művelettel (érintéses fókuszmező)

A fókuszmező helyének átállításához nyomja meg a [Focus Setting] funkcióra programozott gombot; ezt követően a
fókuszmező keretének színe narancssárgára vált és a fókuszmező kerete érintéses művelettel mozgatható a
kamerakép-panelen.
Koppintson a képernyőn arra a helyre, ahová a fókuszmező középpontját át kívánja helyezni. Húzza a fókuszmezőt az
ujjával a kívánt helyre.

Tipp

A felvételi képernyőn az érintéses fókuszmezőt a [Focus Setting] funkcióra programozott gombbal engedélyezheti/letilthatja.

Koppintson valahová.

A megkoppintott hely lesz a fókuszmező középpontja.

1

Ujjával elhúzhatja máshová a fókuszmezőt.2
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Megjegyzés

Ha az állítási tartományon túli helyre koppint vagy oda húzná a fókuszmezőt, az az állítási tartomány felső/alsó/bal/jobb
szegélyéhez áll.

Nem használható ez a funkció a következő esetekben:

ha ki van kapcsolva a kamera vezérlőpanel [Touch Focus] kapcsolója,
ha a fókuszmező kerete ki van szürkítve vagy egyáltalán nem látható.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Az automatikus fókuszálás működésének állítása (AF átállási gyorsaság, AF
témaelmozdulási érzékenység)

Az automatikus fókuszálás működése az átállási gyorsaság és a témaelmozdulási érzékenység módosításával állítható.

Az AF átállási gyorsaság állítása

A fókuszáló hajtás témaváltozásra reagálási gyorsasága a kamera vezérlőpanel [AF Transition Speed] gombjával
állítható.

A gyorsaság [Speed 1]-től (lassú) [Speed 7]-ig (gyors) állítható, egységnyi lépésekben. Az érték (gyorsaság) a < gombbal
csökkenthető (lassítható) és a > gombbal növelhető (gyorsítható).
Kis gyorsaság beállításakor a fókuszváltás új témára lassan megy végbe; lenyűgöző hatású felvételek készíthetők így.
Nagy gyorsaság beállításakor a fókusz gyorsan vált témát. Az alábbi példán a fókusz gyorsan vált a háttérben levő
épületről az előtérben gyalogló emberre. A keretbe lépő témára azonnal ráfókuszál a kamera. Ez a beállítás ezért
dokumentumfelvételek készítésénél ideális, ahol fontos a gyors fókuszálás a témára.

AF témaelmozdulási érzékenység

A témaváltási érzékenység a kamera vezérlőpanel [AF Subj. Shift Sens.] gombjával állítható be.
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Az érzékenység [Sens 1]-től (állandó) [Sens 5]-ig (reagáló) állítható, egységnyi lépésekben. A váltási gyorsaság a <
gombbal csökkenthető és a > gombbal növelhető.
Kis érzékenység beállításakor a fókusz akkor is hajlamos a régi témán maradni, ha másik téma áll eléje.

Nagy érzékenység beállításakor a kamera gyorsan átfókuszál a régi téma elé mozduló új témára.

Tipp

Ha az [AF Speed/Sens.] funkció gombra van programozva, az értékállító szintsávok a következő sorrendben váltják egymást a
kamerakép-panelen a gomb lenyomásakor, lehetővé téve az AF átállási gyorsaság és AF témaelmozdulási érzékenység
módosítását.
AF átállási gyorsaság → AF témaelmozdulási érzékenység → Nincs kijelzés …

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Az automatikus fókuszálási célpont kézi beállítása (AF Assist) a webes alkalmazással

A fókusz kézi áthelyezése és beállítása után a fókusz finombeállítását átadhatja az automatikus fókuszálásnak.

Megjegyzés

AF Assist állapotban a fókusz nehezebben helyezhető át, függetlenül a kameramenü [Shooting] > [Focus] > [AF Subj. Shift Sens.]
beállításától.

Az AF Assist állapotot törlik a következők:

ha a [Focus] csúszkával befókuszált téma már nem látható,
átkapcsolás kézi fókuszra,
A valós idejű követő AF üzemmód indításakor

Tipp

Az AF Assist állapot gyorsan törölhető [Push AF/MF] funkcióra programozott gombbal.

A valós idejű követő AF leáll a [Focus] működtetésekor.

Face/Eye Only AF üzemmódban a kamera a [Focus] csúszkához legközelebb eső arcra fókuszál automatikusan.

Állítsa a kameramenü [Shooting] > [Focus] > [AF Assist] pontját [On] értékre.1

Állítsa a webes menü [Shooting] > [Focus] > [AF Assist Control] pontját [On] értékre.2

Bekapcsolásához tolja jobb oldali helyzetbe a kamera vezérlőpanel [Auto Focus] kapcsolóját.

Bekapcsolódik az automatikus fókuszáló üzemmód.

3

Állítsa be a célfókuszt kamera vezérlőpanel [Focus] csúszkájával.

[Near]: közeli témára fókuszálás.
[Far]: távoli témára fókuszálás.

AF Assist állapotban a kamera automatikusan ráfókuszál a [Focus] csúszkával beállított távolságú témára.

4
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kézi fókuszálás az automatikus fókuszálás használatakor a mellékelt infra
távvezérlővel

Ha a kameramenü [Shooting] > [Focus] > [AF Assist] pontjának beállítása [On], automatikus fókuszálás használatakor is
kézzel fókuszálhat a kívánt témára a mellékelt infra távvezérlő F (Távol) és N (Közel) gombjával.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kézi fókuszálás ideiglenes használata automatikus fókuszálás közben
(gombnyomásos kézi fókuszálás)

Automatikus fókuszáló üzemmódban a [Push AF/MF] gomb lenyomásával kézzel fókuszálhat a gomb nyomva tartása
közben. A gomb felengedésekor visszaáll az automatikus fókuszálás.
Ez a lehetőséggel leállíthatja az automatikus fókuszálást és kézzel ráfókuszálhat az eredeti téma elé kerülő új témára.

Tipp

Ugyanez a művelet elvégeztethető a [Push AF/MF] funkcióra programozott gombbal is.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Követés arc és szem érzékeléssel (Face/Eye Detection AF)

Az egység követendő célként képes felismerni emberek arcát és szemét, és ezekre tud fókuszálni a fókuszmezőben.
Arcok érzékelésekor szürke arc/szem érzékelési keretek jelennek meg. Ha lehetséges az automatikus fókuszálás, a
keretek színe fehérre vált és elindul a követés. Szemek érzékelése és a fókusz állítása során az arc/szem érzékelési
keret a szemeken jelenik meg. Több személy észlelésekor a fő témát automatikusan választja ki a kamera.
Ez a funkció csak az AF fókusz üzemmódban és gombnyomásos automatikus fókuszálásnál működik.

Tipp

Ha a fókuszmező beállítása [Zone] vagy [Flexible Spot], és arcok vagy szemek átfedődnek a megadott fókuszmezőben, az
arc/szem érzékelési keretek fehér színűre változnak és az egység automatikusan ezekre az arcokra/szemekre fókuszál.

(AF-S) gombnyomásos automatikus fókuszálás használatakor a fókuszba állt arcok/szemek érzékelési keretei zöldre váltanak.

Állítás a kamera vezérlőpanel [Face/Eye Detection AF] gombjával

Nyomja meg a [Face/Eye Detection AF] gombot és állítsa be az arc/szem érzékeléses AF működést.

[Face/Eye Only AF]: a kamera érzékeli a témák (személyek) arcait/szemeit és csak ezekre fókuszál és ezeket követi.
Ha nincs érzékelt arc vagy szem, az AF átmenetileg szünetel, és a  (Face/Eye Only AF üzemmód automatikus
fókuszálás szünetelés) ikonja jelenik meg. Ez az üzemmód csak akkor működik, ha csak arcok/szemek automatikus
fókuszálását és követését igényli.
[Face/Eye Priority AF]: a kamera érzékeli a témák (személyek) arcait/szemeit és elsősorban ezeket fókuszálja/követi.
Ha nincs érzékelt arc vagy szem, a fókuszálás AF üzemmódban működik (alapértelmezett beállítás).
[AF]: le van tiltva az arc/szem érzékeléses AF funkció.

Megjegyzés

Gombnyomásos automatikus fókuszálás használatakor a [Face/Eye Priority AF] akkor is működésbe lép, ha pillanatnyilag a
[Face/Eye Only AF] van kiválasztva.

Az [Auto Focus] kapcsoló kikapcsolt helyzetében az arc/szem érzékeléses AF le van tiltva (kivéve a gombnyomásos automatikus
fókuszálás közben).

Ha a [Face/Eye Only AF] kiválasztott állapotában kapcsolja ki a videokamerát, a következő bekapcsolásakor [Face/Eye Priority
AF] üzemmódban ébred fel.

Tipp
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Az arc/szem érzékeléses AF működés a kameramenü [Shooting] > [Focus] > [Face/Eye Detection AF] pontjában állítható be.

Arc/szem érzékelési keretek elrejtése
Az arc/szem érzékelési keretek a kameramenü [Monitoring] > [Display On/Off] > [Face/Eye Detection Frame] pontjában
jeleníthetők meg/rejthetők el.

Megjegyzés

Az arc/szem érzékelési keretek zöld színűek a gombnyomásos automatikus fókuszálással (AF-S) fókuszált arcok és szemek
körül, és a [Display] gomb megnyomása vagy a [Face/Eye Detection Frame] menüpont [Off] beállítása sem rejti el őket.

Az arc/szem érzékeléses AF működés kapcsolása programozható gombbal
Programozza gombra a [Face/Eye Detection AF] funkciót. Utána a gomb nyomogatása [Face/Eye Priority AF], [Face/Eye
Only AF] és [AF] sorrendben körbe pörgetheti az arc/szem érzékeléses AF üzemmódokat.

Beállítás a közvetlen menüben

Az arc/szem érzékeléses AF működést a közvetlen menüben is beállíthatja.

A közvetlen menüvel kapcsolatos részletek „A közvetlen menü használata” cím alatt találhatók.

Kapcsolódó témák

A közvetlen menü használata

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Megadott téma követése (Valós idejű követő AF)

Témára fókuszálás a téma érintéssel történő megadásával vagy a kamera vezérlőpanelen arc érzékelési keret
kiválasztásával tartható fenn.
Téma kiválasztásakor fehér követőkeret jelenik meg, és megkezdődik a követés.

Tipp

A követés a teljes képterületre kiterjed, függetlenül a fókuszmező beállításától.

Ha a webes menü vagy kameramenü [Shooting] > [Focus] > [Touch Function in MF] pontjának beállítása [Tracking AF], a valós
idejű követő AF akkor is támogatott, ha a fókuszálási mód MF.

Az arc/szem érzékeléses AF működési módtól függően a következő műveletek végezhetők a követési célpontra
vonatkozóan.

[Face/Eye Only AF] vagy [Face/Eye Priority AF]: a megadott téma fókuszálására és követésére használható.
Ha a követési célpont személy, és a kamera arcot/szemet észlel, akkor erre az arcra/szemre fókuszál.
Ha követési célpont arcát/szemét észleli, elmenti a követési célpont arcát. Elmentése után  (elmentett követett arc
ikon) jelenik meg.

Megjegyzés

Ha a követő AF-et kézi fókuszálás közben indítják el, a követési célpont arc nem kerül mentésre.

[AF]: adott téma befókuszálása és követése. Nincs arc/szem érzékelés, még akkor sem, ha a követési célpont személy.

Megjegyzés

A valós idejű követő AF funkció nem működik, ha az objektív kézi fókuszálásra van állítva.

Valós idejű követő AF üzemmód indítása

Ha adott témát jelölnek meg követési célpontként, akkor megkezdődik a célpont követése.

Megadás érintéses művelettel
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Bekapcsolásához tolja jobb oldali helyzetbe a kamera vezérlőpanel  (Focus) lapján található [Touch Focus] kapcsolót,
majd koppintson a célponti témára annak követéséhez a következő állapotok bármelyikében.

Kézi fókuszálás vagy gombnyomásos kézi fókuszálás közben, és amikor a webes menü vagy kameramenü
[Shooting] > [Focus] > [Touch Function in MF] pontjának beállítása [Tracking AF]
Automatikus fókuszálás vagy gombnyomásos automatikus fókuszálás (AF) közben

Megadás arc érzékelési keretes választással
A GUI vezérlőpanel nyíl gombjaival állítsa a követendő célponti témára az arcválasztó kurzort (narancssárga aláhúzást),
majd nyomja meg a [Set] gombot.

A: arc érzékelési keretek (szürke)
B: követő keret
C: arcválasztó kurzor (narancssárga)

Megjegyzés

Kézi fókuszálás közben nem indítható követés arc érzékelési keret kiválasztásával.

Tipp

A követendő célpont a valós idejű követési AF alatt is megváltoztatható.

Valós idejű követő AF leállítása

Nyomja meg a  (valós idejű követő AF állj) gombot.

Tipp

A valós idejű követő AF leáll a következő esetekben:

Az objektív [Auto Focus] kapcsolójának vagy AUTO/MANUAL kezelőszervének átkapcsolásakor
A fókusz üzemmód átállításakor
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AF Assist végrehajtásakor
A fókuszmező beállítás vagy az arc/szem érzékeléses AF működés módosításakor
[Push AF/MF] funkcióra programozott gomb megnyomásakor
Ha egy követési célpont a felvételi képernyőn kívülre esik vagy ha a téma pár másodpercre fókuszálatlanná válik

Követett arc mentése után (amikor látható a  (elmentett követett arc ikon)), a valós idejű követő AF folytatódik az elmentett
követett arc képterületre lépésekor. Követett arc törléséhez állítsa le a valós idejű követő AF-et a fent leírtak szerint.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fényerő állító képernyő

A fényerő állítható a fényrekesszel, erősítéssel, záridővel, és a fényszint ND szűrőkkel való módosításával, a webes
alkalmazás élő működtető képernyőjének a következő vezérlőmezőiben. A fényerő állítható automatikusan is.

Megjegyzés

Az erősítés nem állítható, ha a [Shooting Mode] beállítása [Cine EI Quick] vagy [Cine EI]. A fényerő a záridővel sem állítható
automatikusan, ha a beállítás [Cine EI Quick] vagy [Cine EI]. Fényrekesszel és ND szűrővel a fényerő automatikusan is állítható.

Tipp

Cine EI üzemmódban a felvétel bázisérzékenységgel készül, erősítés nélkül, a képérzékelő teljesítményének maximalizálása
érdekében. A fényerő beállítása a világítás és az ND-szűrő segítségével történik, a képérzékelőre jutó fény mennyiségének

Kamera vezérlőpanel –  (Main) lap1.

A kamera alapkonfiguráló panele
Megjeleníti a gombokon a felvételkészítéshez szükséges alapfunkciók beállítási állapotát. Az egyes funkciók
beállítási képernyőjének megjelenítéséhez nyomja meg a kamera alábbi alapkonfiguráció beállítási panelének egyik
gombját.

2.

A kamera alapkonfiguráció beállítási panele
Megjeleníti a kamera alapkonfiguráló panelén kiválasztott beállítási elem állítópanelét.

3.
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beállításához. Az Exposure Index (EI) részletes ismertetése: „Sötét és világos területek eloszlásának módosítása a rögzített
képen”.

Kapcsolódó témák

Sötét és világos területek eloszlásának módosítása a rögzített képen

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A bázisérzékenység beállítása

A bázisérzékenységet beállíthatja a fényerő állítása előtt.

Amikor a [Shooting Mode] beállítása [Custom]

Nyomja meg a kamera alapkonfiguráló panel [ISO/Gain] gombját, és állítsa az ISO/Gain állító panelen a [Base
Sensitivity] elemet [High] vagy [Low] értékre.
A [Low] értéket normál fényviszonyok esetén, a [High] értéket gyenge fényviszonyok esetén válassza.
Képernyő az [AGC] kikapcsolt beállításakor

Képernyő az [AGC] bekapcsolt beállításakor

Amikor a [Shooting Mode] beállítása [Flexible ISO] vagy [Cine EI]

Nyomja meg a kamera alapkonfiguráló panel [Base ISO/Exposure Index] gombját, és állítsa az Base ISO/Exposure
Index állító panel [Base ISO] elemét [ISO 12800] vagy [ISO 800] értékre.
A [ISO 800] értéket normál fényviszonyok esetén, a [ISO 12800] értéket gyenge fényviszonyok esetén válassza.

Tipp
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Ezt a beállítást a kamera vezérlőpanel  (Main) fülén is elvégezheti.

A kameramenü [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] vagy [Base ISO] pontjában is beállítható.

Az [Base ISO/Sensitivity] funkció gombra is programozható.

[Cine EI Quick] felvételi üzemmódban a bázisérzékenység beállítása automatikus, az exposure index beállítása szerint.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatikus fényerőállítás célszintjének beállítása

Automatikus fényerőállítás célszintje a kamera vezérlőpanel [AE Level] csúszkájával állítható.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg a kamera vezérlőpanel  (Main) fülét.

Ha nem látható az [AE Level] csúszka, válassza a két csúszkafunkció választó gomb valamelyikét és válassza a
listán az [AE Level] csúszkát.

Megjelenik az [AE Level] csúszka.

1

Állítsa be a célszintet a csúszkával.

A csúszka balra tolása sötétíti a képet. A csúszka jobbra tolása világosítja a képet.

Tipp

A kameramenü [Shooting] > [Auto Exposure] > [Level] pontjában is beállítható.

2
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A fényrekesz automatikus állítása

A fényrekesz automatikusan a témához állítható. Kompatibilis objektívet igényel.

Megjegyzés

A-bajonettes objektív használatakor a fényrekesz nem állítható automatikusan.

Tipp

Az [Auto Iris] funkció gombra is programozható.

5-041-958-53(1) Copyright 2022 Sony Corporation

Ha az objektíven van Auto Iris kapcsoló, állítsa AUTO helyzetbe.1

Nyomja meg a kamera alapkonfiguráló panele [Iris] gombját.

Az [Iris] gomb kerete narancssárga színűre vált.

Megjelenik az Iris állító panele.

2

Jobbra tolással kapcsolja be az [Auto] kapcsolót.

A fényrekesz automatikus állítású üzemmódba kapcsol. A kapcsoló jobb oldalán megjelenik az automatikusan
beállított fényrekesz érték.

3
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A fényrekesz kézi állítása

A fényerő beállítható kézzel.

A fényrekesz ideiglenes automatikus állítása
Az Iris állító panel [Push Auto] gombjának megnyomásával automatikussá válik a fényrekesz beállítása a gomb nyomva
tartása idejére.

Ha az objektíven van Auto Iris kapcsoló, állítsa AUTO helyzetbe.

Megjegyzés

Ha az objektív Auto Iris kapcsolója MANUAL állásban áll, az egység [Auto Iris] és [Push Auto Iris] funkciója hatástalan. Az
egység kézi fényrekesz állítása sem működik.

1

Nyomja meg a kamera alapkonfiguráló panele [Iris] gombját.

Az [Iris] gomb kerete narancssárga színűre vált.

Megjelenik az Iris állító panele.

2

Balra tolásával kapcsolja ki az [Auto] kapcsolót.

A fényrekesz kézi beállítási módba kapcsol.

3

A fényrekesz az [Iris] csúszkával vagy az [Iris] állítógombokkal állítható.

Tipp

A csúszka és az állítógombok össze vannak kapcsolva egymással.

A fényrekesz hozzárendelhető a kamera vezérlőpanel  (Main) fülének csúszkájához is.

4
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Tipp

A fényrekesz ideiglenes automatikus állításához nyomja meg és tartsa lenyomva [Push Auto Iris] funkcióra programozott gombot.
A gomb elengedésekor a fényrekesz visszatér kézi üzemmódba.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Az erősítés automatikus állítása

Amikor a [Shooting Mode] beállítása [Custom] vagy [Flexible ISO], a fényerő automatikusan állítható az erősítés beállítás
használatával.

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa a webes menü vagy kameramenü [Project] > [Shooting Mode] pontját [Custom] értékre.1

Nyomja meg a kamera alapkonfiguráló panele [ISO/Gain] gombját.

A [ISO/Gain] gomb kerete narancssárga színűre vált.

Megjelenik a ISO/Gain állító panele.

2

Jobbra tolással kapcsolja be az [AGC] kapcsolót.

Az erősítés automatikus állítású üzemmódba kapcsol. A kapcsoló jobb oldalán megjelenik az automatikusan
beállított erősítés érték.

Tipp

Ugyanez a beavatkozás elvégezhető a kameramenü [Shooting] > [Auto Exposure] > [AGC] pontjának [On] értékre
kapcsolásával is.

Az [AGC] funkció gombra is programozható.

3
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Az erősítés kézi állítása

A fényerőt kézzel állíthatóvá teheti az erősítés beállítás használatával, ha a [Shooting Mode] beállítása [Custom] vagy
[Flexible ISO].
Akkor alkalmazza az erősítés kézi állítását, ha fix fényrekesz beállítás mellett kívánja állítani az expozíciót vagy nem
akarja, hogy az AGC megnövelje az erősítést.

Az erősítés ideiglenes kézi állítása
Az erősítés ideiglenesen kézzel állíthatóvá tételéhez programozza az [ISO/Gain] funkciót csúszkafunkció választó
gombra a kamera vezérlőpanel  (Main) fülén; ezt követően az erősítést a csúszkával állíthatja.
Ennek használata akkor előnyös, ha a mélységélesség módosítása nélkül kívánja egy lépésnyit változtatni az expozíciót.
A beállítás eredménye visszatér az [ISO/Gain<L>] használatával konfigurált előbeállított értékre a következő műveletek
bármelyikének végrehajtásakor.

Állítsa a webes menü vagy kameramenü [Project] > [Shooting Mode] pontját [Custom] értékre.1

Nyomja meg a kamera alapkonfiguráló panele [ISO/Gain] gombját.

A [ISO/Gain] gomb kerete narancssárga színűre vált.

Megjelenik a ISO/Gain állító panele.

2

Balra tolásával kapcsolja ki az [AGC] kapcsolót.

Az erősítés kézi beállítási módba kapcsol.

3

Állítsa be a kívánt erősítést az [ISO/Gain] csúszkával vagy az [ISO/Gain] állítógombokkal.

Tipp

A csúszka és az állítógombok össze vannak kapcsolva egymással.

4
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az ISO/Gain állítóelemek átállítása,
a bázisérzékenység átkapcsolása,
az AGC kapcsoló be helyzetbe kapcsolása,
az egység táplálásának készenléti állapotba kapcsolása.

Az erősítés ideiglenes automatikus állítása programozható gombbal
A erősítés ideiglenes automatikus állításához nyomja meg és tartsa lenyomva a [Push AGC] funkcióra programozott
gombot.
A gomb elengedésekor az erősítés visszatér kézi üzemmódba.
A beállítás eredménye visszatér az [ISO/Gain<L>] használatával konfigurált előbeállított értékre a következő műveletek
bármelyikének végrehajtásakor.

az ISO/Gain állítóelemek átállítása,
a bázisérzékenység átkapcsolása,
az AGC kapcsoló be helyzetbe kapcsolása,
az egység táplálásának készenléti állapotba kapcsolása.

Megjegyzés

Ez a funkció nem működtethető, amikor a kameramenü [Shooting] > [Iris] > [Bokeh Control] pontjának beállítása [On].

5-041-958-53(1) Copyright 2022 Sony Corporation
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A záridő automatikus állítása

A záridő beállítását hozzáautomatizálhatja a kép fényerejéhez.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg a kamera alapkonfiguráló panele [Shutter] gombját.

Az [Shutter] gomb kerete narancssárga színűre vált.

Megjelenik a Shutter állító panele.

1

Nyomja meg az [Shutter Type] gombot és válassza a lista [Auto] elemét.

Tipp

Ugyanez a beavatkozás elvégezhető a kameramenü [Shooting] > [Auto Exposure] > [Auto Shutter] pontjának [On] értékre
kapcsolásával is.

Az [Auto Shutter] funkció gombra is programozható.

2
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A záridő kézi állítása

A záridő kézzel állítható.

Nyomja meg a kamera alapkonfiguráló panele [Shutter] gombját.

A [Shutter] gomb kerete narancssárga színűre vált.

Megjelenik a Shutter állító panele.

1

Nyomja meg a [Shutter Type] gombot és válassza a lista [Speed] elemét.2

Állítsa be a kívánt záridőt a [Speed] csúszkával vagy a [Speed] állítógombokkal.

Az expozíciós időnek a képintervallumhoz igazításához a 2. lépésben válassza az [Off] értéket. Az [ECS]
(frekvencia) használatával rögzített értéket is adhat, vagy automatikusan állíthatja az [Auto] lehetőség
használatával.
Példa: beállítás az [ECS] (frekvencia) használatával

Tipp

A csúszka és az állítógombok össze vannak kapcsolva egymással.

A [Speed] vagy [Off] helyett az [Angle] használatához állítsa a kameramenü [Shooting] > [Shutter] > [Mode] pontját [Angle]
értékre.

3
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Az ND szűrőről

Ha túl erős a megvilágítás, csökkentheti a szintjét az ND (semleges sűrűség) szűrővel.
Erősen megvilágított téma vételekor a fényrekesz túlzott beszűkítése diffrakciós elmosódást okozhat, miáltal a kép kezdi
elveszíteni élességét (tipikus jelenség kameráknál). ND szűrővel ez a jelenség elnyomható és jobb kép készíthető.
Az egység a következő ND szűrő üzemmódokat kínálja.
Előbeállított üzemmód

Lásd: „Beállítás előbeállított üzemmódban”.

Változó üzemmód (automatikus beállítás)

Lásd: „Automatikus beállítás változó üzemmódban”.

Változó üzemmód (kézi beállítás)

Lásd: „Kézi beállítás változó üzemmódban”.

Kapcsolódó témák

Beállítás előbeállított üzemmódban

Automatikus beállítás változó üzemmódban

Kézi beállítás változó üzemmódban

5-041-958-53(1) Copyright 2022 Sony Corporation
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Beállítás előbeállított üzemmódban

Az ND szűrő átbocsátási tényezőjének értékeit előre meghatározhatja és felvétel közben gyorsan váltogathatja az
értékeket.

Tipp

[ND Filter Position] funkcióra programozott gomb megnyomásakor az ND szűrő beállításai a következő sorrendben pörögnek
körbe: [Clear] → [Preset1] → [Preset2] → [Preset3] → [Clear].

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa a kameramenü [Shooting] > [ND Filter] > [Mode] pontját [Preset] értékre.1

Nyomja meg a kamera alapkonfiguráló panele [ND Filter] gombját.

Az [ND Filter] gomb kerete narancssárga színűre vált.

Megjelenik az ND Filter állító panele.

2

Nyomja meg az [ND Filter] gombot és válassza a következő listaelemek egyikét.

[Clear]: nincs ND szűrő.
[Preset1]: a kameramenü [Shooting] > [ND Filter] > [Preset1] pontjában beállított átbocsátási tényező.
[Preset2]: a kameramenü [Shooting] > [ND Filter] > [Preset2] pontjában beállított átbocsátási tényező.
[Preset3]: a kameramenü [Shooting] > [ND Filter] > [Preset3] pontjában beállított átbocsátási tényező.

A [Preset1] – [Preset3] ND szűrő beállítás egyikének választásakor az átbocsátási tényező értéke megjelenik az ND
szűrő neve mellett.

3

208



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatikus beállítás változó üzemmódban

ND szűrő használatakor engedélyezhető az automatikus expozíció beállítás.

Megjegyzés

Ha az ND szűrőt felvételkészítés közben kapcsolják [Clear] beállításba be vagy onnét ki, megjelenik az ND szűrő keret a képen
és megszólal egy hangjelzés.

Tipp

Az [Auto ND Filter] funkció gombra is programozható és e gomb megnyomásával váltogatható az [Auto] és [Manual] üzemmód.

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa a kameramenü [Shooting] > [ND Filter] > [Mode] pontját [Variable] értékre.1

Nyomja meg a kamera alapkonfiguráló panele [ND Filter] gombját.

Az [ND Filter] gomb kerete narancssárga színűre vált.

Megjelenik az ND Filter állító panele.

2

Nyomja meg az [ND Filter] gombot és válassza a lista [Auto] elemét.

Az ND szűrő automatikusan beállított átbocsátási tényező értéke megjelenik az [ND Filter] gomb mellett.

3
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Kézi beállítás változó üzemmódban

ND szűrő használatakor kézzel is beállítható az expozíció.

Ideiglenes automatikus állítás
A [Push Auto ND] funkció gombra is programozható, amelynek megnyomása ideiglenesen aktiválja (On) az auto ND
szűrő beállítást. A gomb felengedésekor az auto ND szűrő beállítása visszaáll Off-ra.
Állítsa az ND szűrőt [Manual] értékre.

Megjegyzés

Ha az ND szűrőt felvételkészítés közben kapcsolják [Clear] beállításba be vagy onnét ki, megjelenik az ND szűrő keret a képen
és megszólal egy hangjelzés.

Állítsa a kameramenü [Shooting] > [ND Filter] > [Mode] pontját [Variable] értékre.1

Nyomja meg a kamera alapkonfiguráló panele [ND Filter] gombját.

Az [ND Filter] gomb kerete narancssárga színűre vált.

Megjelenik az ND Filter állító panele.

2

Nyomja meg az [ND Filter] gombot és válassza a lista [Manual] elemét.3

Az ND szűrő átbocsátási tényezőjének értéke az [ND Filter] csúszkával vagy az [ND Filter] állítógombokkal
állítható be.

Tipp

A csúszka és az állítógombok össze vannak kapcsolva egymással.

Az ND szűrő a kamera vezérlőpanel  (Main) fülén is beállítható.

4
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Tipp

Az [ND Filter Position] funkció gombra is programozható és e gomb megnyomásával váltogatható az [Manual] és [Clear]
üzemmód.

Az ND Filter állító panel [Push Auto] gombjának megnyomásakor bekapcsol az auto ND szűrő a gomb nyomva tartása idejére.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Fehéregyensúly állító képernyő

A fehéregyensúlynak a webes alkalmazás élő működtető képernyőjén való beállításával a képet természetesebb
megjelenésűvé teheti.

5-041-958-53(1) Copyright 2022 Sony Corporation

A kamera alapkonfiguráló panele1.

A kamera alapkonfiguráció beállítási panele
Megjeleníti a kamera alapkonfiguráló panelén kiválasztott beállítási elem állítópanelét.

2.
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A fehéregyensúly automatikus állítása

A fehéregyensúlyt mindig megfelelőre állíthatja az ATW (a fehéregyensúly automatikus követése) használatával.
Ha engedélyezve van az ATW, a fehéregyensúly automatikusan követi a fényforrás színhőmérsékletének minden
változását.

Megjegyzés

Az ATW nem használható, ha [Shooting Mode] beállítása [Cine EI] vagy [Cine EI Quick].

A megvilágítástól és a téma adottságaitól függően előfordulhat, hogy nem állítható be a megfelelő szín az ATW-vel.
Példák:

Amikor a témát egyetlen szín uralja, pl. ég, tenger, talaj vagy virág vételekor.
Amikor szélsőségesen magas vagy alacsony a színhőmérséklet.

Ha az ATW túl kicsi automatikus követési sebessége miatt vagy más okból nem érhető el a kívánt hatás, a [WB SET] gomb
lenyomásával indítsa el az automatikus fehéregyensúly állítást.

Tipp

A kameramenü [Shooting] > [White Setting] > [ATW Speed] pontjában öt fokozat (1, 2, 3, 4, 5) egyikével megadhatja, milyen
gyorsan reagáljon az ATW üzemmód. Minél nagyobb számot választ, annál gyorsabban reagál.

Befagyaszthatja a pillanatnyi fehéregyensúly beállítást az [ATW Hold] funkció gombra programozásával és e gomb
megnyomásával az ATW üzemmód ideiglenes szüneteltetéséhez.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg a kamera alapkonfiguráló panele [White Balance] gombját.

A [White Balance] gomb kerete narancssárga színűre vált.

Megjelenik a White Balance állító panele.

1

Nyomja meg az [White Mode] gombot és válassza a lista [ATW] elemét.2
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A fehéregyensúly kézi beállítása

A fehéregyensúly beállítható kézzel.

Nyomja meg a kamera alapkonfiguráló panele [White Balance] gombját.

A [White Balance] gomb kerete narancssárga színűre vált.

Megjelenik a White Balance állító panele.

1

Nyomja meg a [White Mode] gombot és válassza a következő listaelemek egyikét.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

A fehéregyensúly a csúszkákkal vagy az állítógombokkal állítható.

Tipp

A csúszka és az állítógombok össze vannak kapcsolva egymással.

A [Memory A(T/T)] és a [Memory A(R/B)] abban különbözik, hogy más az állítási tengelyük, de állítási eredményeik össze
vannak kapcsolva egymással.

A [Memory A(T/T)] esetén
Ez az üzemmód a színhőmérséklettel (Temp) és a színárnyalattal (Tint) állítja be az „A” memóriában tárolt
fehéregyensúlyt.

3
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A színhőmérséklet 2000 K és 5600 K 20 K lépésekben állítható. 5600 K felett az értékek az 5580 K és 5600 K
közötti színváltozás (mired) mértékével egyenlő intervallumokban állítható.
A [Temp] vagy [Tint] jobb oldalán található [Reset] gomb megnyomása visszaállítja alapértelmezésre az érintett
beállítást.
A [Memory A(R/B)] esetén
Ez az üzemmód az R Gain és B Gain erősítésértékkel állítja be az „A” memóriában tárolt fehéregyensúlyt.
A [Reset] gomb megnyomása visszaállítja alapértelmezésre az érintett erősítés beállítását.
A [Preset] esetén
Ez az üzemmód előbeállított értékre állítja a színhőmérsékletet.
A beállítási érték 100 K lépésekben változtatható.
Preset üzemmódban a [Preset White Select] funkciót gombra is programozhatja és e gomb megnyomásával
visszaállíthatja az előbeállított értéket.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Automatikus fehéregyensúly állítás lefuttatása

„A” memória üzemmódban az elmentendő fehéregyensúly beállítása automatikus.

Nyomja meg a kamera alapkonfiguráló panele [White Balance] gombját.

A [White Balance] gomb kerete narancssárga színűre vált.

Megjelenik a White Balance állító panele.

1

Nyomja meg a [White Mode] gombot és válassza a [Memory A(T/T)] vagy [Memory A(R/B)] lehetőséget a
listán.

[Memory A(T/T)]

[Memory A(R/B)]

2

Helyezzen fehér papírt (vagy más tárgyat) a témáéval egyező fényforrású és megvilágítottságú helyre és
közelítsen rá, hogy a képernyőn fehér látszódjon.

3

Állítsa be a fényerőt.

Állítsa be a fényrekeszt „A fényrekesz kézi állítása” eljárással.

4

Nyomja meg a [WB SET] gombot a fehéregyensúlyt állító panelen.

[Memory A(T/T)]

5
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Megjegyzés

Ha nem sikerült a beállítás, a képernyőn kb. három másodpercig hibaüzenet jelenik meg. Ha a hibaüzenet visszatér a
rákövetkező fehéregyensúly-beállítási próbálkozások során, keresse meg a Sony szervizt.

Tipp

Az állítás ATW módban is futtatható. Akkor célszerű használni, ha ATW működés közben gyorsan kívánja beállítani a
fehéregyensúlyt. A beállítást követően az üzemmód visszatér a normál ATW működésre.

Kapcsolódó témák

A fényrekesz kézi állítása

5-041-958-53(1) Copyright 2022 Sony Corporation

[Memory A(R/B)]

Ha az automatikus fehéregyensúly állítás memória módban fut, az automatikus beállítás eredménye az „A”
memóriába kerül.
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Hang konfiguráló képernyő

A webes alkalmazás élő működtető képernyőjén beállíthatja az egység felvételi hang kivezérlését. A kapcsolókat a
készülék csatlakozótömbjén, a hangot a kameramenüben vagy webes menüben konfigurálja.

5-041-958-53(1) Copyright 2022 Sony Corporation

Kamera vezérlőpanel –  (Audio) fül1.
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A hangbemeneti eszköz kiválasztása

A következő kapcsolókat az AUDIO IN csatlakozóra kötött eszköztől függően állítsa be.

Megjegyzés

A kamera nem vesz hangot az Interval Rec vagy Slow & Quick Motion üzemmódban.
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Ha mikrofon csatlakozik, állítsa be az egység hátoldalán levő csatlakozótömb SETUP 2 kapcsolóját.

A CH-1 és CH-2 beállítása közös.

1

Beállítás Magyarázat

OFF
(alapértelmezés)

Dinamikus mikrofon vagy elemmel működő mikrofon használatakor válassza. Kikapcsolja a
+48 V-os táplálást és a LINE vagy MIC bemenetet állítja be CH-1 és CH-2 hangforrásként.

ON
+48 V-os táplálással kompatibilis mikrofon használata esetén válassza. Bekapcsolja a
+48 V-os táplálást és a fantom táplálással kompatibilis mikrofont állítja be CH-1 és CH-2
hangforrásként.

A csatlakoztatott eszköz típusát a kameramenü [Audio] > [Audio Input] > [AUDIO IN Select] pontjában állítsa
be.

2

Válassza ki a hangbemenetet a webes menü vagy kameramenü [Audio] > [Audio Input] > [CH1 Input Select]
– [CH4 Input Select] pontjában.

3
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A felvételi hangszint automatikus állítása

Állítsa azt a csatornát, amelyen automatikusan kívánja állítani a felvételi hangszintet [Auto] értékre a webes menü
[Audio] oldalán vagy a kameramenü [Audio] > [Audio Input] > [CH1 Level Control] – [CH4 Level Control] pontjában.
Az automatikus hangszintre állított csatornákat  (Auto) ikon jelöli az élő működtető képernyő  (Audio) fülén az
érintett csatornák mellett.

5-041-958-53(1) Copyright 2022 Sony Corporation
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A felvételi hangszint kézi állítása

A felvételi hangszint beállítható kézzel.

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa azt a csatornát, amelyen kézzel kívánja állítani a felvételi hangszintet [Manual] értékre a webes menü
[Audio] oldalán vagy a kameramenü [Audio] > [Audio Input] > [CH1 Level Control] – [CH4 Level Control]
pontjában.

1

Nyomja meg a kamera vezérlőpanel  (Audio) fülét.2

A kamera vezérlőpanel [Audio] képernyőjén állítsa be a felvételi hangszintet annak a csatornának a
csúszkájával vagy állítógombjaival, amelynek felvételi hangszintjét kézzel kívánja állítani.

Megjegyzés

Az  (Auto) ikonnal jelölt csatornák állítása automatikus. Az értékek csúszkával vagy gombokkal történő módosítása nem
érinti a felvett hangot.

Tipp

Az egyes sorok csúszka és állítógomb beállításai össze vannak kapcsolva egymással.

A bemeneti hangszintet valós időben figyelheti a felvételi képernyő hang kivezérlésmérőjén.

3

221



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A közvetlen menü használata

Az egység állapota és beállításai a kamera képére rétegződve figyelhetők; a beállításokat az infra távvezérlő GUI
kezelőgombjaival választhatja ki és módosíthatja.
A következő elemek konfigurálhatók:
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
[ND Filter] érték
[Auto Iris]
[Iris] érték
[AGC]
[Gain] érték
[ISO] érték
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter] érték
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] és [Frame Rate]

Tipp

Ugyanezt elvégezheti programozható gombbal és a webes alkalmazás GUI vezérlőpanelével is.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg a [Direct Menu] funkcióra programozott gombot az infra távvezérlőn.

A [Direct Menu] funkció gyári alapértelmezésben az 1. programozható gombra van telepítve.
Csak a közvetlen menün a narancssárga kurzorral választható elemek jelennek meg.

1

A GUI vezérlőpanel nyíl gombjaival állítsa a kurzort a beállítandó elemre, és nyomja meg a [Set] gombot.

Megjelenik egy menü vagy fehér alapon az elem.

2

A nyíl gombokkal válasszon beállítást, és nyomja meg a [Set] gombot.

Eltűnik a menü vagy a fehér alap és narancssárga kurzorral megjelenik az új beállítás.
A közvetlen menüből kilépéshez nyomja meg ismét a [Direct Menu] funkcióra programozott gombot vagy várjon
3 másodpercet bármilyen beavatkozás nélkül.

3
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Programozható gombok

Az egység webes alkalmazásában tíz programozható gomb található, amelyekhez funkciókat rendelhet.
A programozható gombok az élő működtető képernyőn és a lejátszásvezérlő képernyőn láthatók.

Megjegyzés

A programozható gombok listája nem jelenik meg a beállítások konfigurálásakor a kamera élő működtető képernyője alapvető
használati panelén. A művelet befejezéséhez nyomja meg a beállító panel jobb felső sarkában található [X] gombot.

A programozható gombok gyári alapértelmezett funkciói a következők.
1. gomb: [Direct Menu]
2. gomb: [Focus Setting]
3. gomb: [Rec Review]

Az 1. – 3. gomb egyenértékű a mellékelt infra távvezérlő azonos számú gombjával.

4. gomb: [Push Auto ND]
5. gomb: [Crop Select]
6. gomb: [Marker]
7. gomb: [Video Signal Monitor]
8. gomb: [Clip Flag OK]
9. gomb: [Color Bars]
Focus Hold gomb: [Focus Hold]

A Focus Hold gomb egyenértékű az E-bajonettes objektívek Focus Hold gombjával.

Gomb funkciójának módosítása
Használja a kameramenü [Project] > [Assignable Button] pontját.
Hozzárendelés módosítása megváltoztatja a programozható gombok listáját.
A programozható funkciók részletes leírása a „Kameramenü és beállítási részletek” cím „Assignable Button” pontjában
található.

Kapcsolódó témák

Assignable Button

5-041-958-53(1) Copyright 2022 Sony Corporation
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Lassított és gyorsított felvétel

A felvételi formátum következő beállításaiban megadhatja a felvételkészítési és lejátszási képfrekvencia értékét.
A beállítható képfrekvenciákat a következő táblázat adja meg.

Rendszerfrekvencia: 59.94/50/29.97/25/23.98, Imager Scan üzemmód: FF

Rendszerfrekvencia: 59.94/50/29.97/25/23.98, Imager Scan üzemmód: S35

Rendszerfrekvencia: 24, Imager Scan üzemmód: FF

Megjegyzés

A Slow & Quick Motion nem állítható be felvétel, lejátszás és a miniatűrök képernyője kijelzése közben.

Slow & Quick Motion üzemmódban nincs hangfelvétel.

Slow & Quick Motion üzemmódban le van tiltva az automatikus fényrekeszállítás és az automatikus záridőállítás.

Az automatikus fókuszálásra a következő korlátozások vonatkoznak a Slow & Quick Motion üzemmódban.

Az objektív típusa, a rendszerfrekvencia és a felvételi képfrekvencia miatti korlátozások

Kodek Videoformátum Beállítható képfrekvenciák

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Kodek Videoformátum Beállítható képfrekvenciák

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Kodek Videoformátum Beállítható képfrekvenciák

XAVC-I 4096×2160P 1–60

Sony objektív Rendszerfrekvencia AF használhatósága

Nem SEL16F28 – 7 fps vagy nagyobb
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Az automatikus fókuszálás átmenetileg le van tiltva F18 vagy nagyobb fényrekesz beállításakor.

RAW kimenettel kapcsolatos részletek: „RAW videó rögzítése”.

Kapcsolódó témák
RAW videó rögzítése

5-041-958-53(1) Copyright 2022 Sony Corporation

Sony objektív Rendszerfrekvencia AF használhatósága

SEL16F28

59.94/29.97/23.98 30, 60, 120, 240 fps

50,00/25,00 25, 50, 100, 200 fps

24,00 Nem támogatott
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Szakaszos videofelvétel készítés (Interval Rec)

Az Interval Rec funkcióval szakaszos videofelvételt készíthet az egység beépített memóriájába. Ezzel a funkcióval
hatékonyan készíthetők gyorsított felvételek lassan mozgó témákról.
Felvétel közben az egység automatikusan adott számú képkockát (Number of Frames) rögzít adott időközönként
(Interval Time).

A: felvételkészítési időköz (Interval Time)
B: az egy menetben vett kockák száma (Number of Frames)

Megjegyzés

Egyidejűleg csak egy különleges felvételi funkció, pl. Interval Rec, használható.

Ha az Interval Rec használata közben másik különleges felvételi üzemmódot kapcsolnak be, az Interval Rec automatikusan
kikapcsol.

A rendszerbeállítások, pl. a videoformátum módosítása is automatikusan kikapcsolja az Interval Rec üzemmódot.

Az Interval Rec beállításai nem módosíthatók felvétel, lejátszás vagy a miniatűrök képernyője kijelzése közben.

Korlátozások felvételkészítés közben
Hangfelvétel nem készül.
A felvétel megtekintése (Rec Review) nem lehetséges.

Ha kikapcsolják az egységet felvétel készítése közben
Az egység tápegységének készenléti állapotában az egység először az adathordozóra írja a memóriájában addig
tárolt képeket, és csak ez után vált automatikusan készenléti állapotba.
Ha kimarad a tápellátás, mert kihúzták az egyenáramú tápkábelt vagy a hálózati tápegység hálózati vezetékét vagy
mert kimaradt a PoE++ tápfeszültség, az addig készült felvételek elveszhetnek (legfeljebb 10 másodpercnyi anyag).
Legyen óvatos.

A képkockák számának és időközének beállítása
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Állítsa a webes menü [Project] > [Interval Rec] > [Setting] pontját [On] értékre, és állítsa be a [Number of Frames] és az
[Interval Time] értékét.
Az egység a kikapcsolásakor kilép az Interval Rec üzemmódból, de megőrzi [Number of Frames] és [Interval Time]
beállítását. Amikor legközelebb Interval Rec felvételt készít, ezeket a paramétereket nem kell újra beállítania.

Tipp

A kameramenü [Project] > [Interval Rec] pontjában is beállítható.

A felvétel elindítása

A felvétel indításához nyomja meg a felvétel START/STOP gombot. Felváltva megjelenik az „Int●Rec” és az „Int●Stby”.

A felvétel leállítása

Állítsa le a rögzítést.
A leállításkor a kamera a beépített memóriában addig tárolt videoadatokat az adathordozóra írja.
Az Interval Rec üzemmódból a következő két módon léphet ki.

Állítsa készenléti üzemmódba az egység tápegységét.
Felvételi készenlét üzemmódban állítsa a [Project] > [Interval Rec] > [Setting] menüpontot [Off] értékre.

Az egység újraindításakor az Interval Rec üzemmód automatikusan bont.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Gyorsítótárazott képek rögzítése (Picture Cache Rec)

A Picture Cache Rec funkcióval a felvétel megkezdésekor visszamenőlegesen rögzíthet videót azáltal, hogy a
felvételkészítés során meghatározott időtartamú belső gyorsítótárat tart fenn.

A gyorsítótár méretének beállítása

Állítsa a webes menü [Project] > [Picture Cache Rec] > [Setting] pontját [On] értékre, és állítsa be gyorsítótár méretét a
[Cache Size] pontban.

Megjegyzés

A Picture Cache Rec nem használható együtt Interval Rec-el, 2-kártyahelyes egyidejű felvétellel és proxy felvétellel. A Picture
Cache Rec On állapotba állítása Off állapotba kényszeríti ezeket a különleges felvételi üzemmódokat.

A Picture Cache Rec üzemmód nem választható felvétel vagy Rec Review közben.

Ha a Picture Cache Rec On állapotú, az időkód [Free Run] üzemmódban rögzül, akkor is, ha beállítása [Regen] vagy [Rec Run].

Előfordulhat, hogy az [Output Format] beállítás nem konfigurálható a Picture Cache Rec üzemmódban. Konfigurálásához
kapcsolja ki (Off) átmenetileg a Picture Cache Rec üzemmódot, és utána változtassa meg a beállítást.

Tipp

A gyorsítótár ideje rövidebb is lehet, a felvételi formátumtól függően. Ellenőrizze a megjelenített időértéket a webes menü
[Project] > [Picture Cache Rec] > [Cache Rec Time] pontjában.

A kameramenü [Project] > [Picture Cache Rec] pontjában is beállítható.

A [Picture Cache Rec] programozható gombbal is be- (On) és ki (Off) kapcsolható.

A Picture Cache Rec elindítása

A [Picture Cache Rec] On beállítása esetén „●Cache” látható (a ● zöld színű).
A felvétel START/STOP gomb megnyomásakor elindul a felvétel és a videó a gyorsítótárban tárolt videótól kezdődően a
memóriakártyákra íródik.

Megjegyzés

A felvételi formátum vagy a bázismegjelenés módosítása törli az addig a pontig a gyorsítótárban tárolt videót, és elindítja az új
videó gyorsítótárazását. Következésképpen a formátumváltás előtti képek nem rögzülnek a gyorsítótárba, még akkor sem, ha a
formátumváltás után azonnal megkezdi a rögzítést.

Ha közvetlenül a memóriakártya behelyezése után kapcsolják On vagy Off értékre a Picture Cache Rec-t, előfordulhat, hogy a
gyorsítótár-adatok nem kerülnek rögzítésre a kártyára.

[Cache Size] beállítás Gyorsítótár idő (közelítőleg)

[Short] 5 másodperc

[Medium] 10 másodperc

[Long] 20 másodperc

[Max] Az egyes felvételi formátumok legnagyobb értéke
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A video a gyorsítótárban tárolódik, ha a Picture Cache Rec funkció beállítása On. A funkció bekapcsolása (On) előtti videó nem
kerül gyorsítótárazásra.

A videót nem tárolja a gyorsítótár a memóriakártyához való hozzáférés, például lejátszás, Rec Review vagy a miniatűr képernyő
megjelenítése közben. Ezen idő alatt kép gyorsítótárba nem rögzíthető.

A Picture Cache Rec törlése

Állítsa a webes menü [Project] > [Picture Cache Rec] > [Setting] pontját [Off] értékre, vagy nyomjon meg a [Picture
Cache Rec] funkcióra programozott gombot.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Egyidejű rögzítés az „A” és „B” memóriakártyára (2-slot Simul Rec)

Az „A” és „B” memóriakártyára egyidejűleg is rögzíthet felvételt; ehhez állítsa a webes menü vagy a kameramenü
[Project] > [Simul Rec] > [Setting] pontját [On] értékre.

Külön-külön rögzítés az A és a B memóriakártyára

Az egyes memóriakártyákra történő rögzítést a felvétel START/STOP gombbal vagy az  (Others) fül [2nd Rec
START/STOP] gombjával egymástól függetlenül indíthatja el/állíthatja le.
Gyárilag mindkét gomb úgy van beállítva, hogy az A és B memóriakártyára történő egyidejű rögzítést indítsa el/állítsa le.
Ha a gombok különböző memóriakártyák felvételének vezérlésére vannak beállítva, az [SDI/HDMI Rec Control] felvétel
start/stop az „A” kártyahely felvételi állapotát követi.

A beállítás módosítása

Állítsa be a következőket a kameramenü [Project] > [Simul Rec] > [Rec Button Set] pontjában.

5-041-958-53(1) Copyright 2022 Sony Corporation

[Rec Button Set]
beállítás Nyomógombok és memóriakártyák

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:<Slot
A> <Slot B>

Bármelyik gomb elindítja/leállítja az egyidejű rögzítést az A és B memóriakártyára.

Rec Button:<Slot A>
2nd Rec Button:<Slot
B>

A felvétel START/STOP gomb az A memóriakártyán, az  (Others) fül [2nd Rec
START/STOP] gombja a B memóriakártyán indítja el/állítja le a rögzítést.

Rec Button:<Slot B>
2nd Rec Button:<Slot
A>

A felvétel START/STOP gomb a B memóriakártyán, az  (Others) fül [2nd Rec
START/STOP] gombja az A memóriakártyán indítja el/állítja le a rögzítést.
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Videojel figyelő

Ez a témakör a kamerakép-panelen megjelenő videojel kép típusát hullámformára, vektorszkópra vagy hisztogramra
állíthatja a kameramenü [Monitoring] > [Video Signal Monitor] > [Setting] pontjában.
A narancssárga vonal a [Level Marker 1] és a [Level Marker 2] beállított értéke.
A [Video Signal Monitor] funkció gombra is programozható.

A monitorozási cél megjelenítése
Log felvételi üzemmódokban a színterjedelem beállítási vagy monitor LUT beállítási információk láthatók a videojel
monitor jobb felső sarkában, a monitorozási cél jelzéséhez.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Klipjelölők

Kliphez [OK] klipjelölőt rendelhet [Clip Flag OK] funkcióra programozott gomb megnyomásával és az [Add OK] lehetőség
kiválasztásával.
[OK] klipjelölő törléséhez nyomja meg kétszer a gombot és válassza a [Delete Clip Flag] lehetőséget.

Tipp

Klipjelölő hozzáadásához használja a kameramenü [Thumbnail] > [Set Clip Flag] pontját.

A miniatűrök képernyője megjeleníthető klipjelölő típus szerint rendezve (szűrt klipminiatűrök képernyő). Részletek a „A
miniatűrök képernyője” témakör „Rögzített klipeken végezhető műveletek”.

Kapcsolódó témák

Rögzített klipeken végezhető műveletek

5-041-958-53(1) Copyright 2022 Sony Corporation
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Légzéskompenzálás

Az objektívra a légzéskompenzálást a kameramenü [Technical] > [Lens] > [Breathing Compensation] pontjában állíthatja
be.
Ez a funkció korrigálja azt a jelenséget, amikor a látószög változik a fókusz helyének változásával.
Légzéskompenzáláskor a kép egy része elektronikusan levágásra kerül, hogy állandó maradjon a látószög, és a
légzésjelenség ne jelenjen meg.

Megjegyzés

Ha engedélyezve van a légzéskompenzáció, kissé megváltozhat a látószög és a képminőség.

Az objektívtől függően előfordulhat, hogy nem lehet korrigálni a látószög változását a légzéskompenzáció engedélyezett
állapotában.

A kompenzáció nem lehetséges, ha olyan objektív van csatlakoztatva, amely nem támogatja a légzéskompenzációt.

Ez a funkció Off (rögzített) állapotú a következő esetekben.

Amikor a kameramenü [Technical] > [Lens] > [Distortion Comp.] pontjának beállítása [Off]
Amikor a webes menü vagy kameramenü [Shooting] > [S&Q Motion] > [Setting] pontjának beállítása [On]
Amikor a webes menü vagy kameramenü [Project] > [Rec Format] > [Codec] pontjának beállítása [RAW] vagy [RAW & XAVC-I]

5-041-958-53(1) Copyright 2022 Sony Corporation
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A proxy felvétel áttekintése

Ezzel a funkcióval egyidejűleg vehet fel kis felbontású proxy adatokat és nagy felbontású eredeti videót.

Részletek a támogatott memóriakártyákról, formázásukról és maradék kapacitásuk ellenőrzéséről a „Memóriakártyák
előkészítése” cím „Támogatott memóriakártyák” pontjában találhatók.

A rögzített fájlról
A fájlnév kiterjesztése „.mp4”.
Egyidejűleg az időkód is rögzül.

A rögzített fájl tárolási célhelye
A rögzített fájl a következő könyvtárban tárolódik.

A fájl nevéről
A fájl neve a memóriakártyára felvett klipnévből és az „S03” utótagból áll.
Klipnév információk a kameramenü [TC/Media] > [Clip Name Format] pontjában találhatók.

Kapcsolódó témák

Támogatott memóriakártyák

5-041-958-53(1) Copyright 2022 Sony Corporation

Adathordozó Mappaelérési útvonal

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Proxy felvételkészítés

A felvétel akkor indítható, ha engedélyezve van proxy videó rögzítése.

A felvétel leállítása
Állítsa le a rögzítést.

A hangcsatorna beállítása proxy felvételre
A kameramenü [Project] > [Proxy Rec] > [Audio Channel] pontjában állítsa a hangcsatornát proxy adatok rögzítésére.

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa a webes menü vagy kameramenü [Project] > [Proxy Rec] > [Setting] pontját [On] értékre.1

Helyezzen memóriakártyát egy CFexpress Type A / SD kártyahelyre.

CFexpress kártya címkéje nézzen felfelé.
SD kártya címkéje nézzen lefelé.

Megjegyzés

Nem lehet egyidejűleg On értékű a Proxy Rec és az S&Q Motion vagy az Interval Rec. A Proxy Rec paraméter On értékre
állítása Off-ra kényszeríti e két másik felvételi üzemmód értékét.

2

Nyomja meg a felvétel START/STOP gombot.

Elindul a proxy felvétel készítése.

Megjegyzés

Ha memóriakártya írása vagy olvasása közben kapcsolják ki az egységet vagy veszik ki a memóriakártyát, akkor nem
garantálható a kártyán lévő adatok sértetlensége.
A memóriakártyán levő összes adat elveszhet. Az egység kikapcsolása vagy memóriakártya kivétele előtt mindig győződjön
meg arról, hogy a memóriakártya hozzáférésjelzője nem világít.

Vigyázzon, hogy a memóriakártya ne ugorjon ki a behelyezéskor vagy kivételkor.

3
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A megjelenés áttekintése

Az egység Custom üzemmódjában a fekete, mátrix és más paraméterek beállításával a bázismegjelenésre épülő
„megjelenést” hozhat létre.

A beállítási kombinációk jelenetfájlokba mentésével gyorsan kiválaszthatja a kívánt megjelenést.
A egység hét előbeállított megjelenést tartalmaz.

5-041-958-53(1) Copyright 2022 Sony Corporation

236



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Megjelenés (Look) kiválasztása

Ez a témakör megjelenés kiválasztását ismerteti.

Ellenőrizze, hogy a webes menü vagy kameramenü [Project] > [Base Setting] > [Shooting Mode] pontjának
beállítása [Custom]-e.

Tipp

[Custom] üzemmódban az [ISO/Gain] gomb és a [Scene FileScene File] gomb elérhető a kamera alapkonfiguráló panelén.

1

Nyomja meg a kamera alapkonfiguráló panele [Scene File] gombját.

A [Scene File] gomb kerete narancssárga színűre vált.

Megjelenik a Scene File állító panele.

2

Nyomja meg az állítópanel [Scene File] gombját és válasszon a listán kívánt megjelenésű jelenetfájlt.

A következő előbeállítások gyári alapértelmezettek.

Tipp

A kameramenü [Paint/Look] > [Scene File] > [Recall] pontjában is választhat megjelenést. Előbeállított megjelenés a [Scene
File] > [Preset Recall] használatával is lehívható.

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

1. jelenetfájl [S-Cinetone] [HLG Live]

2. jelenetfájl [Standard] [HLG Natural]

3. jelenetfájl [Still] (Nincs regisztrálva)

4. jelenetfájl [ITU709] (Nincs regisztrálva)

5. jelenetfájl [709tone] (Nincs regisztrálva)

6.–16. jelenetfájl (Nincs regisztrálva) (Nincs regisztrálva)

237



5-041-958-53(1) Copyright 2022 Sony Corporation

Megjegyzés

A 2.0 és későbbi szoftver-verziókban az 5-ös jelenetfájl előbeállítása [709tone]. A webes menü [Maintenance] > [Reset] >
[Factory Default] pontjának végrehajtásakor jelenik meg.
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Kívánt bázismegjelenés importálása

Bázismegjelenésként importálhat számítógépen vagy más eszközök létrehozott 3D LUT fájlt. Legfeljebb 16 fájl
importálható.
Fájlformátum: CUBE file (*.cube) 17- vagy 33-rácsos, Catalyst Browse programmal létrehozott 3D LUT-hoz; RAW Viewer
vagy DaVinci Resolve* (a Blackmagic Design Pty. Ltd. cégtől).

Bemeneti színterjedelem/gamma: [S-Gamut3.Cine/S-Log3] vagy [S-Gamut3/S-Log3]

Állítás alulexponálás esetén

Ellenőrizve a következőkkel: Resolve V9.0, V10.0 és V11.0.*

Mentse el a 3D LUT fájlt a webes alkalmazást futtató eszközön.1

Nyissa meg a webes menü [Paint/Look] > [Base Look] pontját.

Megjelenik a regisztrált bázismegjelenések listája.

2

Nyomja meg az [Import] gombot abban a sorban, ahol importálni kívánja a fájlt.

Megjelenik a fájlválasztó párbeszédablak.

3

Válassza ki az előkészített 3D LUT fájlt.

Az importált 3D LUT fájl lesz az egység bázismegjelenése.

4

Válassza ki az importált 3D LUT fájlt a kameramenü [Paint/Look] > [Base Look] > [Select] pontjában.5

Konfigurálja a kameramenü [Paint/Look] > [Base Look] > [Input] és [Output] pontját az importált 3D LUT fájl
attribútumai szerint.

6
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Ha automatikus expozíció kiválasztásakor az importált bázismegjelenés használatakor fennáll az alulexponálás
veszélye, a webes menü [Paint/Look] > [Base Look] > [AE Level Offset] pontjában állítsa át a megjelenést.

Megjegyzés

A 3D LUT fájl importálása önmagában nem befolyásolja a képet. Töltse be az importált 3D LUT fájlt a kameramenü [Paint/Look] >
[Base Look] > [Select] pontjában.

Ha nincs kellően beállítva az [Input], nem jön létre a kívánt megjelenés.

Az [Input], [Output] és [AE Level Offset] menüpont beállítások a [Select] használatával alkalmazhatók a kiválasztott
bázismegjelenésre. Több 3D LUT fájl importálása esetén válassza mindegyiket külön-külön a [Select] ponttal és egyenként állítsa
be rájuk az [Input], [Output] és [AE Level Offset] értéket.

A konfigurált [Input], [Output] és [AE Level Offset] beállítások elmentődnek az egyes 3D LUT fájlokhoz.

Az importált 3D LUT fájlok bázismegjelenés/LUT kiválasztás lehetőségei azonosak az [SDR(BT.709)], [HDR(HLG)] és a Log
felvételi üzemmódokban, de nem történik meg a színterjedelem és a gamma konvertálása ezekre az üzemmódokra.

A 3D LUT fájlok nem törlődnek a webes menü [Maintenance] > [Reset] > [All Reset (except for Network Settings)] pontjának
végrehajtásakor.

A [Base Look Name] kijelzés előtt megjelenő  (3D LUT fájl csatolási hiba) azt jelzi, hogy nem csatolhatók 3D LUT fájlok Log
felvételi üzemmódokban rögzített klipekhez. Importálja ismét a 3D LUT fájlt.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Megjelenés testre szabása

A bázismegjelenés alapján testre szabható a megjelenés a kamera alapkonfiguráló panel Scene File állító panele
[Master Black], [R Black] és [B Black] csúszkájával és a kameramenü [Paint/Look] > [Matrix] és egyéb beállítási
pontjaiban.
Kösse az egységet TV készülékre vagy monitorra és az ott megjelenő kép figyelésével állítsa be a kép minőségét.

1: [R Black] csúszka/állítógombok
2: [B Black] csúszka/állítógombok
3: [Master Black] csúszka/állítógombok

Megjegyzés

3D LUT fájl importálása és képre alkalmazása esetén a 3D LUT fájlban definiált megjelenés nem áll elő, ha módosítják a
kameramenüben a [Paint/Look] > [Matrix] és a bázismegjelenési beállítások kivételével bármely más beállítás értékét.

Minden testre szabott beállítás visszaállítható a kameramenü [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look]
pontjában.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Megjelenés elmentése

A pillanatnyi megjelenést jelenetfájlként elmentheti a beépített memóriába a kameramenü [Paint/Look] > [Scene File] >
[Store] pontjában.
Elmentett megjelenés gyorsan lehívható a Scene File állító panellel vagy közvetlen menü műveletekkel.

Megjegyzés

Ha a pillanatnyi megjelenés elmentése nélkül választ másik megjelenést, a pillanatnyi megjelenés elveszik.

Tipp

Az előbeállított jelenetfájlokat felülírhatja. Előbeállított jelenetfájl visszaállításához töltse be a visszaállítandó megjelenést a
kameramenü [Paint/Look] > [Scene File] > [Preset Recall] pontjában, majd mentse el a jelenetfájlt a [Scene File] > [Store]
pontban.

Elmentett megjelenés törlése
A beépített memóriába mentett jelenetfájl a kameramenü [Paint/Look] > [Scene File] > [Delete] pontjában törölhető.

Tipp

A törölt fájl már nem jelenik meg a Scene File állító panelen vagy a közvetlen menüben.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Bázismegjelenés törlése

Importált 3D LUT fájlok egyenként törölhetők a kameramenü [Paint/Look] > [Base Look] > [Delete] pontjában.
Az összes importált 3D LUT fájl együtt törölhető a kameramenü [Paint/Look] > [Base Look] > [Delete All] pontjában.

Megjegyzés

Törlés előtt ellenőrizze, hogy egy jelenetfájl sem használja-e a bázismegjelenést. Ha használatban levő bázismegjelenést töröl, a
hozzá tartozó jelenetfájlok elromlanak.

Az importált 3D LUT fájlok nem törlődnek a webes menü [Maintenance] > [Reset] > [All Reset (except for Network Settings)]
pontjának végrehajtásakor.

Törölt bázismegjelenés már nem használható LUT-ként Log felvételi üzemmódokban.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Felvételkészítés a megjelenés állításával az utófeldolgozás során

Az egység Log felvételi üzemmódokban*1 való használatával és a sötéttől a világos területekig terjedő gradációk
egyenletes rögzítésével finombeállításokat végezhet, például az utófeldolgozás során helyileg visszaállíthatja sötét és
világos területek gradációit.
Ha azonban a rögzített felvételeket hagyományos monitoron nézi, az általános kontraszt alacsony lesz, ami megnehezíti
a fókusz és expozíció beállításokat.
LUT-ot monitor célhelyre alkalmazhat az egységen felvétel közben végzendő beállítások megkönnyítésére. A
felvételkészítéskor használt LUT-ot automatikusan alkalmazhatja a lejátszáskor is, hogy gyorsan ellenőrizze a kész
eredményt.
LUT-ok alkalmazása a következő rendszer szerint történik. Azonban csak egy LUT alkalmazható.

SDI kimenet
HDMI kimenet és streamelés
Felvételi adathordozóra rögzített proxy klip
Felvételi adathordozóra rögzített nagyfelbontású (fő) proxy klip
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Általános kifejezés a Flexible ISO üzemmódra/Cine EI üzemmódra/Cine EI Quick üzemmódra*1
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LUT alkalmazása HDMI kimenetre és streamelésre

LUT alkalmazható HDMI kimenetre és streamelésre.

Megjegyzés

A streamelt képben a webes alkalmazás kamerakép-panele is szerepel.

Tipp

Ez a kameramenü [Shooting] > [LUT On/Off] > [HDMI/Stream] pontjában is beállítható.

Az SDI kimenet ugyanígy állítható.

A felvételi adathordozón levő videóhoz ez a kameramenü [Shooting] > [LUT On/Off] > [Internal Rec] és [Proxy] pontjában adható
meg.

A [Base Look/LUT] kijelzés előtt megjelenő  (3D LUT fájl csatolási hiba) azt jelzi, hogy nem csatolhatók 3D LUT fájlok Log
felvételi üzemmódokban rögzített klipekhez. Importálja ismét a 3D LUT fájlt.
Ez az ikon akkor is megjelenik, ha a csatolás átmeneti feldolgozási torlódás miatt nem sikerül.

Ellenőrizze, hogy a webes menü vagy kameramenü [Project] > [Base Setting] > [Shooting Mode] pontjának
beállítása [Flexible ISO], [Cine EI] vagy [Cine EI Quick]-e.

Tipp

Log felvételi üzemmódokban az [Base ISO/Exposure Index] gomb és a [Base Look/LUT] gomb elérhető a kamera
alapkonfiguráló panelén.

1

Nyomja meg a kamera alapkonfiguráló panele [Base Look/LUT] gombját.

A [Base Look/LUT] gomb kerete narancssárga színűre vált.

Megjelenik a Base Look/LUT állító panele.

2

Válassza a [HDMI/Stream] > [MLUT] lehetőséget.3
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LUT módosítása

Az alkalmazandó LUT módosítható.

Tipp

A készülék előbeállított LUT-ként a következőket kínálja: [s709], [709(800%)] és [S-Log3].

3D LUT fájl is importálható és alkalmazható. Részletek: „Kívánt bázismegjelenés importálása” és „Bázismegjelenés törlése”.

Ez a kameramenü [Paint/Look] > [Base Look] > [Select] pontjában is beállítható.

Kapcsolódó témák

Kívánt bázismegjelenés importálása

Bázismegjelenés törlése

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg a kamera alapkonfiguráló panele [Base Look/LUT] gombját.

A [Base Look/LUT] gomb kerete narancssárga színűre vált.

Megjelenik a Base Look/LUT állító panele.

1

Nyomja meg a [Base Look/LUT] gombot és válassza ki az alkalmazandó bázismegjelenést.2
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Sötét és világos területek eloszlásának módosítása a rögzített képen

Cine EI és Cine EI Quick felvételi üzemmódban a bázisérzékenységben az Exposure Index módosításával módosíthatja
a sötét és világos területek eloszlását, például ha a sötét területeket kívánja hangsúlyozni a világosakkal szemben.

Nyomja meg a kamera alapkonfiguráló panele [Base Look/LUT] gombját.

A [Base Look/LUT] gomb kerete narancssárga színűre vált.

Megjelenik a Base Look/LUT állító panele.

1

Válassza a [HDMI/Stream] > [MLUT] lehetőséget.

A LUT a HDMI kimenetre és streamelésre érvényesül.

2

Nyomja meg a kamera alapkonfiguráló panele [Base ISO/Exposure Index] gombját.

A [Base ISO/Exposure Index] gomb kerete narancssárga színűre vált.

Megjelenik a Base ISO/Exposure Index állító panele.

3

Az [Exposure Index] csúszkával vagy az [Exposure Index] állítógombjaival állítsa be az expozíciós indexet a
sötét és világos területek kívánt eloszlásának létrehozásához.

A [Cine EI] esetén

A [Cine EI Quick] esetén
A bázisérzékenység beállítása automatikus, az exposure index beállítása szerint.

4
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Tipp

Ez a kameramenü [Shooting] > [ISO/Gain/EI] > [Exposure Index] pontjában is beállítható.

Az SDI kimenet ugyanígy használható.

A beállítás második számértéke azt jelzi, hány lépcsőnyi világosság-információ rendelődik a világos (18% szürkénél világosabb)
területekhez. Az ennél világosabb területek túlexponáltak lesznek.
Pl. „400EI/5.0E,” esetén 5,0 lépcső van kiosztva a világos oldalon.

Használhatja ezt iránymutatóként is, a sötét és világos területek tónusának ellenőrzésére felvételkészítés közben. Az expozíció
ellenőrzése után térjen vissza az eredeti EI értékre. A Cine EI Quick üzemmódban arra is ügyeljen, hogy ne befolyásolja
hátrányosan a bázisérzékenységet.

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa be a megvilágítást és/vagy az ND szűrőt úgy, hogy a kamera [HDMI/Stream] kimeneti képének
expozíciója megfelelő legyen.

5
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RAW videó rögzítése

Az egység SDI OUT csatlakozójáról a kimeneti RAW videojelet támogatott külső felvevőre küldheti.
Az alábbi táblázat a támogatott RAW formátumokat adja meg.

Rendszerfrekvencia [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Kössön külső RAW felvevőt az egység SDI OUT csatlakozójára.1

Állítsa a webes menü vagy kameramenü [Project] > [Base Setting] > [Shooting Mode] pontját [Cine EI],
[Cine EI Quick] vagy [Flexible ISO] értékre.

2

A (csak FF) látószöget a webes menü vagy a kameramenü [Project] > [Rec Format] > [Imager Scan Mode]
pontjában állítsa be.

3

Állítsa a webes menü vagy kameramenü [Project] > [Rec Format] > [Codec] pontját [RAW] értékre.

A [RAW & XAVC-I] lehetőség választásakor az egység egyidejűleg rögzít videót külső RAW felvevőre és a belső
memóriakártyákra.

4

A felbontást a webes menü vagy a kameramenü [Project] > [Rec Format] > [RAW Output Format] pontjában
állítsa be.

5

Ellenőrizze, hogy be van-e kapcsolva a külső felvevő, majd nyomja meg a felvétel START/STOP gombot az
élő működtető képernyőn.

A RAW videó jelrögzítési állapotát ikon jelzi a kamerakép-panelen.

6
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Megjegyzés

Ha nem az élő működtető képernyő felvétel START/STOP gombjával indítják el a külső felvevőn a felvételt, előfordulhat, hogy a
klipek felvétele nem sikerül.

5-041-958-53(1) Copyright 2022 Sony Corporation

Megjegyzés

Bár a felvételellenőrzési jel kiadásra kerül az egység SDI OUT csatlakozóján, a külső felvevő állapota nem állapítható meg.
Ezért az egység akkor is folyó RAW videó felvételt jelezhet, amikor a külső felvevő valójában nem vesz. A külső felvevő
állapota csak a felvevő kijelzőjén látható.
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RAW videó rögzítése lassított és gyorsított felvétel üzemmódban

RAW videó rögzíthető lassított és gyorsított felvétel üzemmódban.

A támogatott felvételi képfrekvenciákról részletek a „Lassított és gyorsított felvétel” cím alatt találhatók.

Kapcsolódó témák

Lassított és gyorsított felvétel

5-041-958-53(1) Copyright 2022 Sony Corporation
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A bokeh-vezérlési funkció be/ki kapcsolása

A bokeh mértékét könnyen beállíthatja az ND szűrő és az erősítés, valamint az írisz működésének összekapcsolásával.

A bokeh-vezérlési funkció be/ki kapcsolása

Ez a funkció csak az expozíció manuális beállításakor engedélyezhető. Állítsa az ND szűrőt változó üzemmódra, majd a
fényrekeszt, az erősítést, a záridőt és az ND szűrőt kézi beállításra.
A bokeh-vezérlési funkció a kameramenü [Shooting] > [Iris] > [Bokeh Control] pontjában kapcsolható be/ki.
A bokeh-vezérlési funkció On (bekapcsolt) állapotában  (B) ikon látható az ND szűrő és erősítés jelzőn.

Megjegyzés

Ez a funkció csak a készülékkel kommunikálni képes E-bajonettes objektíveknél engedélyezett.

E funkció maximális hatása Sony E-bajonettes objektív használatával érhető el.

A bokeh-vezérlési funkciót Off állapotba állítja a következők bármelyike.

Ha ki van kapcsolva az egység
Ha a fényrekesz, az erősítés, a záridő vagy az ND szűrő bármelyikének beállítása Auto
A felvételi üzemmód átkapcsolásakor
Ha az ND-szűrő tiszta vagy előbeállított üzemmódban van
Ha nincs objektív a gépen
Amikor az egység újraindul, például frekvenciaváltás után

Tipp

A [Bokeh Control] funkció gombra is programozható és e gomb megnyomásával a bokeh-vezérlési funkció On (be) és Off (ki)
kapcsolható.

5-041-958-53(1) Copyright 2022 Sony Corporation
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A bokeh mértékének állítása

A beállításokat a 2.-4. lépésben módosítsa, szükség szerint.

Megjegyzés

A megjelenés a működési sebességtől, az objektívtől, a fényképezési beállításoktól és a témától függően változhat, és a fényerő
is változhat. Nyomatékosan javasoljuk kamerapróba végzését felvételkészítés előtt.

A fényerő megváltozhat a fényrekesz működtetési irányának megváltozásakor, például amikor a fényrekeszt szűkítés után nyitja,
vagy nyitás után szűkíti. Ilyenkor állítson be a szükségesnél valamivel többet, majd egy kicsit vegyen vissza, ellenőrizze a
fényerőt, és utána indítsa a felvételkészítést. Ha például F8-as rekeszértékre kívánja nyitni az íriszt és elmosni a hátteret, először
zárja a rekeszt F8-on túlra, majd vegye vissza F8-ra, ellenőrizze a fényerőt, és így indítsa a felvételkészítést.

Lassan végezze el a bokeh-vezérlési műveleteket. Ha fel kell gyorsítania a műveletet, próbálja meg fokozatosan beállítani,
miközben ellenőrzi a kép változását.

Tipp

Ha a bokeh-vezérlési funkció beállítása On, az ND szűrő és az erősítés az együttesen ellensúlyozza az írisz állítása miatti
expozícióváltozásokat, lehetővé téve a bokeh mértékének megváltoztatását.

A bokeh-vezérlés először az ND szűrővel reagál az írisz állítására. Ha az ND szűrő már nem állítható, az erősítés végzi az
ellensúlyozást.

Javasoljuk, hogy az MF üzemmódban először a fényrekeszt nyissa, és utána állítsa a fókuszt.

Ha a bokeh-vezérlési funkció helyett az auto ND szűrőt használja, az ND szűrő a téma világosságának változását követi.

Kijelzés az erősítési kapcsolat működése közben
Ha a bokeh-vezérlési funkció beállítása On, a fényrekesz állításakor módosulhat az erősítés.
Ha aktív az erősítési kapcsolat és megváltozik az erősítés, üzenet jelenik meg a képernyő tetején és villog az erősítés
jelző  (B) ikonja.

Állítsa a bokeh-vezérlési funkció értékét On-ra.1

Nyissa ki teljesen a fényrekeszt.2

Állítsa az ND szűrőt 1/128 értékre.3

Állítsa az erősítést 0 dB-re és a világítással állítsa be a pontos expozíciót.4

Állítsa be fókuszt.5

Állítsa be a fényrekeszt.

A bokeh mértéke megváltozik.

6
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Konfigurációs adatok elmentésének és betöltésének áttekintése

A webes alkalmazással konfigurációs adatok formájában elmentheti az egység beállításait. Ezáltal gyorsan lehívhatja az
aktuális helyzetnek megfelelő menübeállításokat.
Ezzel az egységgel a kamera szinte minden beállítása ALL fájlba menthető, az alábbi megjegyzésben jelzett kivétellel.

Megjegyzés

A hálózati funkció beállítások és a hitelesítési információk nem kerülnek mentésre. Az elmentett elemekkel kapcsolatos részletek:
„Menüpontok jegyzéke.”

Kapcsolódó témák

Menüpontok jegyzéke

5-041-958-53(1) Copyright 2022 Sony Corporation
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ALL fájl mentése

Ez a témakör ALL fájl mentését ismerteti.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyissa meg a webes menü [Project] > [All File] pontját.1

Nyomja meg a [Save All File] > [Save] gombot.

A webböngésző letölt egy all-file.ALL nevű fájlt.

2

Adjon nevet és mentési helyet a letöltött all-file.ALL fájlnak, és mentse el.

A fájlműveletekről részleteket eszköze kezelői utasításaiban talál.

3
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ALL fájl betöltése

Ez a témakör ALL fájl betöltését ismerteti.

Megjegyzés

A konfigurációs adatok betöltését követően az egység automatikusan újraindul. Az újraindítást követően töltse be újra az oldalt a
webböngészőben.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyissa meg a webes menü [Project] > [All File] pontját.1

Nyomja meg a [Load All File] > [Load] gombot.

Megjelenik a fájlmegnyitási párbeszédpanel a webes alkalmazást futtató eszközön.

2

Nyissa meg a betöltendő fájlt.

A fájlműveletekről részleteket eszköze kezelői utasításaiban talál.

3

A betöltendő fájl nevének megerősítését kérő képernyőn nyomja meg az [OK] gombot.4

A végrehajtási eredmény képernyő megjelenésekor nyomja meg az [OK] gombot.5

Várja meg az egység újraindulását, majd csatlakoztassa vissza a webes alkalmazást.6
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A fájlátvitelről

Az egységen felvett proxy fájlok vagy eredeti fájlok feltölthetők az interneten vagy helyi hálózaton működő szerverre.

Megjegyzés

A tápellátás készenléti állapotában a fájlátvitel szünetel akkor is, ha az egység kap tápfeszültséget.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Fájlátviteli célhely regisztrálása

Fájl átvitele előtt regisztrálhatja az átviteli célhely szerverét.

Válassza a webes menü [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (vagy
[Server Settings2], [Server Settings3]) pontját.

Tipp

A választási lehetőség neve a következő lépésben konfigurált [Display Name] beállítástól függ.

1

A webes menüben konfigurálja a [Network] > [FTP Server 1] – [FTP Server 3] következő elemeit.

[Display Name]
Adja meg az átvitelifeladat-listán megjelenítendő szervernevet átviteli célszerver választásakor.
[Service]
A szerver típusát jeleníti meg.
[FTP]: FTP szerver
[Host Name]
Adja meg a szerver címét vagy host nevét.
[Port]
Írja be a szerver portszámát, amelyre csatlakozni kíván.
[User Name]
Írja be a felhasználónevet.
[Password]
Írja be a jelszót.
[Passive Mode]
Kapcsolja be/ki a passzív üzemmódot.
[Destination Directory]
Írja be a célszerver könyvtárának nevét.

Megjegyzés

Ha a [Destination Directory] paraméterbe a célszerveren érvénytelen karaktereket ír, a fájlok a felhasználó
kezdőkönyvtárába kerülnek át. A szervertől függ, hogy melyek az érvénytelen karakterek.

[Using Secure Protocol]
Itt állíthatja be, hogy biztonságos legyen-e az FTP átvitel.
[Root Certificate]
Tanúsítvány betöltése/törlése.
[Load]: CA tanúsítvány betöltése. PEM-formátumú tanúsítványokat tölt be.
[Clear]: a CA tanúsítvány törlése.
[None]: ne töltsön be vagy töröljön tanúsítványt.

Megjegyzés

CA tanúsítvány betöltése előtt állítsa be a pontos időt az egység óráján.

XAVC-I 4096×2160P/3840×2160P 59.94/50P formátumú felvétel esetén a [Load] nem választható.

[Root Certificate Status]: a tanúsítvány betöltési állapotát jelzi.

2
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[Reset]: alapértelmezettre állítja vissza a Server Settings beállításokat.
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Memóriakártyán levő proxy fájl feltöltése a miniatűrök képernyőjéről

Memóriakártyán levő proxy fájlok egyenként tölthetők fel a miniatűrök képernyőjéről.

Megjegyzés

Legfeljebb 200 átviteli feladat regisztrálható.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg a webes alkalmazás élő működtető képernyőjén a [Thumbnail] gombot.

A képernyőn a kamera képét felváltja a miniatűrök képernyője.

1

Válassza a kameramenü [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] pontját.

Ha az összes proxy fájlt egyszerre kívánja átküldeni, válassza a [Transfer Clip (Proxy)] > [All Clips] lehetőséget.
Klipek átküldhetők a miniatűrök képernyőjéről vagy a szűrt miniatűrök képernyőjéről.

2

A [Set] gombbal válassza ki az átküldendő klipet, majd nyomja meg a [Menu] gombot.

Megjelenik az átküldést megerősítő képernyő.

3

Válassza az [Execute] lehetőséget.

A kiválasztott klipnek megfelelő proxy fájl átküldési feladatként regisztrálódik és elindul a feltöltés.
Az átviteli feladat sikeres regisztrálását követően megjelenik az átviteli eredmény képernyője.

4

Nyomja meg a [OK] gombot.5
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Memóriakártyán levő eredeti fájl feltöltése a miniatűrök képernyőjéről

Memóriakártyán levő eredeti fájl feltölthető a miniatűrök képernyőjéről.

Megjegyzés

Legfeljebb 200 átviteli feladat regisztrálható.

5-041-958-53(1) Copyright 2022 Sony Corporation

Nyomja meg a webes alkalmazás élő működtető képernyőjén a [Thumbnail] gombot.

A képernyőn a kamera képét felváltja a miniatűrök képernyője.

1

Válassza a kameramenü [Thumbnail] > [Transfer Clip] > [Select Clip] pontját.

Ha az összes eredeti fájlt egyszerre kívánja átküldeni, válassza a [Transfer Clip] > [All Clips] lehetőséget.
Klipek átküldhetők a miniatűrök képernyőjéről vagy a szűrt miniatűrök képernyőjéről.

2

A [Set] gombbal válassza ki az átküldendő klipet, majd nyomja meg a [Menu] gombot.

Megjelenik az átküldést megerősítő képernyő.

3

Válassza az [Execute] lehetőséget.

A kiválasztott klip eredeti fájlja átküldési feladatként regisztrálódik és elindul a feltöltés.
Az átviteli feladat sikeres regisztrálását követően megjelenik az átviteli eredmény képernyője.

4

Nyomja meg a [OK] gombot.5
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A fájlátviteli állapot ellenőrzése

A fájlátvitel állapotának ellenőrzéséhez válassza ki a kameramenü [Network] > [File Transfer] > [View Job List] pontját.

Megjegyzés

Legfeljebb 200 átviteli feladat regisztrálható.

Az egység készenléti állapotba kapcsolásakor az átviteli feladatok megmaradnak, de akár 10 percnyi friss haladási információ is
elveszhet a táplálás bármilyen más kimaradásakor.

Ha fájlátátvitel során hiba történik, az átvitt klip nevével azonos nevű klip átvitelének folytatása megszakadhat, az átviteli
célszerver beállításaitól és állapotától függően. Ebben az esetben ellenőrizze az átviteli célszerver beállításait és állapotát.

Tipp

Ha a kameramenü [Network] > [File Transfer] > [Auto Upload (Proxy)] pontjának beállítása [On] és van hálózati kapcsolat, a
felvétel végeztével a proxy fájlok automatikusan feltöltődnek a [Default Upload Server] pontban megadott szerverre.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Feltöltés Secure FTP protokollal

Fájlokat titkosítva is feltölthet, ha a célhely fájlszerveréhez kapcsolódásnál Explicit üzemmódban FTPS protokollt használ
(FTPES).
Biztonságos FTP átvitelhez a célhely fájlszerverén a [Using Secure Protocol] értékét állítsa [On]-ra és töltsön be
tanúsítványt.

Konfigurálási részletek: „Fájlátviteli célhely regisztrálása”.

Kapcsolódó témák

Fájlátviteli célhely regisztrálása

5-041-958-53(1) Copyright 2022 Sony Corporation
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Streamelés

Az egység egyidejűleg tudja streamelni a HDMI csatlakozóról kiadott kép és hang jelet.

Megjegyzés

Ha fő videóként a streamelést kívánja használni, állítsa a webes menü [Monitoring] > [Output Display] > [SDI] pontját [On] és a
[HDMI/Stream] pontot [Off] értékre, és figyelje a kamera állapotát SDI monitoron.

Ha a HDMI csatlakozóra kötött monitor nem támogatja a webes menü vagy a kameramenü [Monitoring] pontjában beállított HDMI
kimeneti formátumot, előfordulhat, hogy a kamera képe nem jelenik meg a webes alkalmazásban. Streaming videó sem adható
ki.

A streamelési felbontás nem állítható nagyobbra a HDMI kimenőjel felbontásánál.

A kodek beállításoktól függően a kép torzulhat, ha több felhasználó nézi.

Az egység a következő streamelési módokat támogatja. A választható videó kodekek zárójelben szerepelnek.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Konfigurálja a formátum, videó kodek és hang kodek beállítást, ebben a sorrendben.

●: engedélyezve, –: letiltva

Tipp

A webes alkalmazás kamerakép-panele szintén streamelt rendszerű.

Streamelési formátum
Kodek beállítás

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Webes alkalmazás – – ● –

RTMP akkor választható, amikor a webes menü [Stream] > [Audio Stream] pontjának beállítása [On].*1

Ha a rendszerfrekvencia 59.94 vagy 50 és a HDMI kimeneti formátum 3840×2160 vagy nagyobb, a video 2 kimenet nem választható.*2
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A streamelési formátum beállítása

Állítsa be a streamelési formátumot a webes menü [Stream] > [Stream] > [Stream Setting] > [Setting] pontjában.

Amikor a [Setting] beállítása [RTSP]

RTSP streamelés esetén egy kamera képét egyszerre legfeljebb öt felhasználó nézheti.
Legfeljebb két videó kodek üzemmód állítható be.
[Port Number]
Az RTSP streameléshez használandó portszám beállítására szolgál. Az alapértelmezett érték 554.
A beállítás módosítása újraindítja az RTSP szervert.
[Time Out]
RTSP streamelés Keep-Alive parancsa időkorlátjának megadására szolgál. Az időkorlát 0 és 600 másodperc közötti
értékre állítható. Az alapértelmezés 60 másodperc.
0 másodperc beállításakor a Keep-Alive parancsnak nincs időkorlátja.
[Authentication]
Itt adható meg, hogy legyen-e hitelesítés.
[Video Port Number 1], [Video Port Number 2]
Az RTSP unicast streameléshez használandó képadat-kommunikációs port számának beállítására szolgál. A Video Port
Number 1 gyári alapértelmezett értéke 51000. A Video Port Number 2 gyári alapértelmezett értéke 53000. Írjon be egy
páros számot, 1024 és 65534 között. Az itt beírt szám, és az 1 hozzáadásával kapott következő, páratlan szám a kép
adatkommunikációjához és vezérléséhez használt két port száma.
[Video Port Number 1] és [Video Port Number 2] megfelel ennek [Stream] > [Video Stream] > [Video Stream 1] és ennek
[Video Stream 2].
[Audio Port Number]
Az RTSP unicast streameléshez használt hangadat-kommunikációs port számának beállítására szolgál. Az
alapértelmezett érték 57000. Írjon be egy páros számot, 1024 és 65534 között. Az itt beírt szám, és az 1 hozzáadásával
kapott következő, páratlan szám a hang adatkommunikációjához és vezérléséhez használt két port száma.

Amikor a [Setting] beállítása [RTMP]

RTMP-hez csak H.264 videó kodek üzemmód használható. RTMP használatához a webes menü [Stream] > [Audio
Stream] pontjának beállítása [On] kell, hogy legyen.
[Server URL]
A feltöltési célhely URL címének megadására szolgál. Írjon be „rtmp://” vagy „rtmps://” kezdetű karakterláncot.
[Stream Key]
Írja be az Ön által használt webhelyről kapott stream kulcsot. A [Clear] gomb törli a beírt értéket.

Megjegyzés

Kezelje bizalmasan a stream kulcsot. Ha külső fél megismeri, meghamisíthatja a streamet.

[Root Certificate]
RTMPS protokollal importálja a streameléshez szükséges gyökértanúsítványt. Gyökértanúsítvány importálásához
nyomja meg a [Load] gombot és válasszon gyökértanúsítványt a képernyőn. A kiválasztott fájlnak az egységbe
importálásához nyomja meg az [OK] gombot a fájlválasztó párbeszédablakban. Ha van importált gyökértanúsítvány az
egységben, a gyökértanúsítvány frissül. Importált gyökértanúsítvány törléséhez nyomja meg a [Delete] gombot a beállító
képernyőn. A gyökértanúsítvány állapotát a [Root Certificate Status] mutatja.

Megjegyzés
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Importálja a streamelési szolgáltatáshoz szükséges gyökértanúsítványt.

Amikor a [Setting] beállítása [SRT-Caller] vagy [SRT-Listener]

A videó kodek üzemmódja csak H.264.
[Destination]
Akkor látható, ha a streamelési mód beállítása [SRT-Caller]. A kapcsolat célhelye URL címének megadására szolgál.
[Port Number]
Akkor látható, ha a streamelési mód beállítása [SRT-Listener]. A hallgatásra használt port számának megadására
szolgál. Az alapértelmezett érték 4201.
[Latency]
A késés megadására szolgál, 20 ms és 8000 ms között. Az alapértelmezett érték 120.
[TTL]
A TTL érték megadására szolgál, 1 és 255 között. Az alapértelmezett érték 64.
[Encryption]
A titkosítási mód kiválasztására szolgál. Válassza az Off, AES128 vagy AES256 lehetőséget. Az alapértelmezés Off.
[Passphrase]
A titkosítási jelszó megadására szolgál. A [Clear] gomb megnyomása visszaállítja a beállított jelszót.
[ARC]
Az Adaptive Rate Control funkció engedélyezéséhez állítsa On értékre.
Az Adaptive Rate Control funkció engedélyezésével csökkenthető a kommunikációs torlódás miatti kép akadozások
gyakorisága.

Amikor a [Setting] beállítása [NDI|HX]

Az egység kompatibilis a NewTek NDI|HX 2. verziójával.
Az NDI|HX használatához licenckulcsot kell vásárolni.
Licenckulcs vásárlása
A NewTek következő URL címén vásárolja meg.
https://www.newtek.com/ndihx/products/upgrade/

Megjegyzés

Töltse le a legújabb NDI|HX illesztőprogramot és telepítse NewTek termékre.

Az NDI|HX regisztrálásáról és használatáról részletek a NewTek termék kezelői utasításaiban találhatók.

[License]
Engedélyezett licenc adatait jeleníti meg.
[Source Name]
A forrás nevét jeleníti meg.
[Group]
Az NDI csoportosító funkció engedélyezéséhez állítsa On értékre.
[Group Name]: az NDI csoport nevének beállítására szolgál. Több beállítás is megadható, vesszővel elválasztva.
[Discovery Server 1], [Discovery Server 2]
Az NDI discovery server 1 és NDI discovery server 2 beállítására szolgál.
[Reliable UDP Mode]
Reliable UDP üzemmód engedélyezéséhez állítsa On értékre.
[Multicast Mode]
Csoportcímes streamelés engedélyezéséhez állítsa On értékre.
[Multicast Prefix]: a csoportcímes streameléshez használandó előtag beállítására szolgál.
[Multicast Netmask]: a csoportcímes címtartományt meghatározó hálózati maszk megadására szolgál.
[Multicast TTL]: a csoportcímes streamelés TTL értékének megadására szolgál, az 1–256 tartományban. Az
alapértelmezett érték 3.
[Multi-TCP Mode]
Multi-TCP üzemmód engedélyezéséhez állítsa On értékre.
[Unicast UDP Mode]
Unicast UDP üzemmód engedélyezéséhez állítsa On értékre.
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Külsős szolgáltatásokról és szoftverekről
Különböző használati feltételek vonatkozhatnak rájuk.

Szolgáltatások és szoftverfrissítések esetenként előzetes figyelmeztetés nélkül felfüggeszthetők vagy
megszüntethetők.
A szolgáltatások és szoftverek leírása előzetes értesítés nélkül változhat.
Külön regisztrálást és előfizetést igényelhetnek.

A Sony nem vállal felelősséget a felhasználók vagy harmadik felek által más cégek szolgáltatásainak és szoftverének
használata miatt támasztott igényekért.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A streamelési videó kodek beállítása

A videó kodek a webes menü [Stream] > [Video Stream] pontjában állítható be.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Legfeljebb három kép kodek üzemmód állítható be. A következő beállításokat külön-külön adja meg az egyes kép
üzemmódokra.
[Video Stream 3] a webes alkalmazás kamerakép-panel megjelenítésére szolgál.

Megjegyzés

Amikor [Stream] > [Stream Setting] > [Setting] beállítása [RTMP], [SRT-Caller] vagy [SRT-Listener], a [Video Stream 1], [Video
Stream 2] és [Video Stream 3] beállítások némelyikének ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode])
alapértelmezett értéke van.

[Codec 1], [Codec 2], [Codec 3]
Válassza a [H.264], [H.265] vagy [Off] lehetőséget. Ne feledje, hogy a [Codec 1] nem állítható [Off] értékre. A [Codec 3]
pedig rögzítetten [JPEG] értékű.

Megjegyzés

A következő tünetek jelentkezhetnek különböző beállítások, például a [Codec 1], [Codec 2] és [Codec 3] képmérete,
képfrekvenciája és bitsebessége kombinációjától függően.

nagyobb videó késés,
képkocka kimaradás videó lejátszáskor,
szakadozott hang,
a kamera lassú reagálása parancsokra,
a kamera lassú reagálása a távvezérlőre,
lassú monitorkép megjelenítés és konfigurálás.

Tünetek jelentkezésekor csökkentse a képméret, képfrekvencia ás bitsebesség paraméterek értékét, vagy módosítsa más
beállítási paraméterek értékét.

Amikor [Stream] > [Stream Setting] > [Setting] beállítása [RTMP], [SRT-Caller] vagy [SRT-Listener], [Codec 1] beállítása
rögzítetten [H.264]. [Codec 2] beállítása rögzítetten [Off].

A HDMI kimenet képméretének vagy rendszerfrekvenciájának módosításakor a [Codec 2] beállítása [Off] lesz.

[Size 1], [Size 2], [Size 3]
A kamera streamelt képmérete kiválasztására szolgál.
A választható képméret lehetőségek a HDMI kimenet képméretétől függnek.

Megjegyzés

A HDMI kimenet képméretének vagy rendszerfrekvenciájának módosításakor a legnagyobb képméret áll be.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
A képfrekvencia beállítására szolgál.
Az „fps” jelentése: a másodpercenként streamelt képkockák száma.
A választható képfrekvencia értékek a HDMI kimenet képméretétől függnek.

Megjegyzés
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A HDMI kimenet képméretének vagy rendszerfrekvenciájának módosításakor a legnagyobb képfrekvencia áll be.

[I-Picture Mode 1], [I-Picture Mode 2]
Az I-kép beillesztési intervallum H.264-hez és H.265-höz való megadási módját [Time]-ra vagy [Frame]-re állítja.
Nem állítható be a [Codec 3]-ra.
[Time]: az I-kép beillesztési intervallum idő értékkel való megadására szolgál.
[Frame]: az I-kép beillesztési intervallum képkocka számmal való megadására szolgál.
[I-Picture Interval 1], [I-Picture Interval 2]
Az I-kép beillesztési intervalluma megadására szolgál, másodpercben. 1 és 5 másodperc közötti érték adható meg. Az
alapértelmezés 1 másodperc.
Nem állítható be a [Codec 3]-ra.
[I-Picture Ratio 1], [I-Picture Ratio 2]
Az I-kép beillesztési intervalluma megadására szolgál H.264 és H.265 esetén, képkocka számmal; 15 és 300 közötti
érték adható meg. Az alapértelmezés 300 képkocka.
Nem állítható be a [Codec 3]-ra.
[Profile 1], [Profile 2]
A H.264 vagy H.265 kép kodek profiljának megadására szolgál.
[H.264]: válassza a [high], [main] vagy [baseline] profilt.
[H.265]: válassza a [main] vagy [main10] profilt. Ha két videó kodek van engedélyezve, csak a [main] profilválasztási
lehetőség választható.
A képtömörítés hatékonysága a [high], [main], [baseline] sorrendben nő. Válasszon a rendszere által támogatott profilt.
Ha a [H.265] beállítása [main10], a működés [main10], ha a HDMI kimenet YCrCb, vagy [main], ha a HDMI kimenet
RGB.
Nem állítható be a [Codec 3]-ra.
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Válassza a [CBR] vagy [VBR] lehetőséget.
Állandó bitsebesség tartásához válassza a [CBR] lehetőséget. A képminőség tartásához válassza a [VBR] lehetőséget.
Nem állítható be a [Codec 3]-ra.

Megjegyzés

A ténylegesen streamelt képfrekvencia és bitsebesség eltérhet a beállított értéktől, a képméret, felvételi jelenet, hálózati
környezet és egyéb tényezők függvényében.

Amikor [Stream] > [Stream Setting] > [Setting] beállítása [RTMP], [SRT-Caller] vagy [SRT-Listener], [Bit Rate Compression Mode
1] beállítása rögzítetten [CBR].

[Bit Rate 1], [Bit Rate 2]
A [Bit Rate Compression Mode] [CBR] beállítása esetén beállítható a videó streamenkénti bitsebesség. Nagyobb
bitsebességgel jobb minőségű videó streamelhető.
Nem állítható be a [Codec 3]-ra.
[Quality 1], [Quality 2], [Quality 3]
A képminőség megadására szolgál, 1 és 10 között. A 10 jelenti a legjobb képminőséget. Az alapértelmezett érték 6.
A [Quality 1] és [Quality 2] H.264 képminőségre állítható a [Bit Rate Compression Mode] [VBR] értékre és a [Codec]
[H.264] értékre állításával. A képminőség H.265 értékre állítható a [Bit Rate Compression Mode] [VBR] értékre és a
[Codec] [H.265] értékre állításával.

5-041-958-53(1) Copyright 2022 Sony Corporation

272



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A streamelési hang kodek beállítása

A hang kodek a webes menü [Stream] > [Audio Stream] pontjában állítható be.
[Setting]
Hang streamelés engedélyezéséhez állítsa On értékre.

Megjegyzés

RTMP választása előtt mindig állítsa be az On értéket.

[Codec]
Hang streameléshez használandó kodek típusának kiválasztására használható.
[AAC (256kbps)]: akkor válassza, ha a hangminőség a fő szempont.
[AAC (128kbps)]: akkor válassza, ha az adatkapacitás a fő szempont.
Ez a beállítás nem befolyásolja az egység által rögzített klipet vagy a HDMI/SDI jelbe beágyazott hang jelet.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A streamelés elindítása/leállítása

[RTSP], [SRT-Listener] és [NDI|HX] formátum esetén

Az egység streamelés adási kérésre vár.
Indítson ügyfél alkalmazást a streamelés nézéséhez és nyissa meg a következő táblázat szerinti URL címet.
Írja be az egységen konfigurált felhasználónevet és jelszót.

<camera_address>: az egység IP-címe
<Port>: a [Port Number] alatt konfigurált figyelő port

Megjegyzés

Nem garantálható a lejátszás működése minden alkalmazásban vagy eszközön.

[RTMP] és [SRT-Caller] formátum esetén

A streamelés elindításához nyomja meg az élő működtető képernyő  (Stream) fülén a [Stream now] gombot. A gomb
felirata [Stop stream]-re vált és megjelenik a [Stream] ikon a kamerakép-panel tetején.
A streamelés leállításához nyomja meg a [Stop stream] gombot streamelés közben. A gomb felirata [Stream now]-re vált
és eltűnik a [Stream] ikon a kamerakép-panel tetejéről.

Megjegyzés

Nem garantálható a lejátszás működése minden alkalmazásban vagy eszközön.

5-041-958-53(1) Copyright 2022 Sony Corporation

Streamelési formátum URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX Lapozza fel az NDI|HX-kompatibilis kliens kezelői utasításait.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A miniatűrök képernyője

A lejátszásvezérlő képernyő [Thumbnail] gombja vagy az infra távvezérlő THUMBNAIL gombja megnyomásakor a
memóriakártyán levő klipek megjelennek a kamerakép-panelen. A kamerakép-panel e nézetét a miniatűrök
képernyőjének nevezzük.
A miniatűrök képernyőjén kiválaszthat és lejátszásra elindíthat klipeket.
Ha a képernyőjének megjelenítése közben megnyomja a [Thumbnail] gombot, a miniatűrök képernyője bezárul és
visszatér a felvételkészítési kép képernyője.

Megjegyzés

A miniatűrök képernyőjén csak a pillanatnyilag kiválasztott felvételi formátumú klipek jelennek meg. Ha egy tudottan meglevő klip
nem jelenik meg, ellenőrizze a felvételi formátumot. Adathordozó formázása (inicializálása) előtt fokozottan figyeljen erre.

Képernyőelrendezés

Kiválasztott klip miniatűrje narancssárga hátterű.
A kiválasztott klip adatai a képernyő alján olvashatók.
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Kiválasztott memóriakártya
Jobb oldalt lakat ikon jelenik meg, ha írásvédett a memóriakártya.

1.

Klipszám/a klipek összes száma2.

Miniatűr (indexkép)
Klip indexképe. A klip első képkockája az indexkép.
A klipre/képkockára vonatkozó információk a miniatűr alatt jelennek meg. A megjelenített információk a kameramenü
[Thumbnail] > [Customize View] > [Thumbnail Caption] pontjában válthatók.

3.

Klipnév
A kiválasztott klip nevét jeleníti meg.

4.

Felvételi formátum
A kiválasztott klip fájlformátumát jeleníti meg.

5.

Speciális felvételi információ
A felvételi üzemmódot jeleníti meg, de csak akkor, ha a klipet speciális felvételi üzemmóddal készítették.
Slow & Quick Motion klipek képfrekvenciája a jobb oldalon jelenik meg.

6.

A klip időtartama7.

Létrehozási dátum8.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Felvett klipek lejátszása

Az egység felvétel készenléti (Stby) üzemmódjában lejátszhatók a felvett klipek.
Ez a témakör rögzített klipek GUI vezérlőpanellel való lejátszását ismerteti.

Helyezze be a lejátszandó memóriakártyát.1

Nyomja meg a [Thumbnail] gombot.

Megjelennek a klipek miniatűrjei.

2

A GUI vezérlőpanel nyíl gombjaival állítsa a kurzort a lejátszani kívánt klip miniatűrjére.3
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Megjegyzés

Klipek közötti átmenetnél pillanatnyi képtöredezés jelentkezhet vagy állókép jelenhet meg. E közben nem működtethető az
egység.

Amikor a miniatűrök képernyőjén kiválaszt egy klipet és elindítja a lejátszását, a lejátszás képtorzulással indulhat. A klip elejének
torzulásmentes megtekintéséhez szüneteltesse a lejátszást, az  (Előző) gombbal ugrasson a klip elejére, és ott indítsa el
ismét a lejátszást.

5-041-958-53(1) Copyright 2022 Sony Corporation

Megjegyzés

A klipek nem választhatók érintéses művelettel.

Nyomja meg a GUI vezérlőpanel [Set] gombját.

Elindul a lejátszás a kiválasztott klip elejétől.

4

Használja a lejátszásvezérlő panelt szükség szerint.

Tipp

A működést a GUI vezérlőpanellel is kezelheti.

Lejátszás: nyomja meg a [Set] gombot.
Lejátszás szüneteltetés: lejátszás közben nyomja meg a [Set] gombot. A lejátszás folytatásához nyomja meg ismét.
Ugrás az előző/következő klip elejére: nyomja meg a bal/jobb gombot.
Gyors előre/vissza: nyomja meg és tartsa nyomva a bal/jobb gombot. A gomb felengedésekor visszaáll a normál
lejátszási sebesség.
Lejátszás leállítása: nyomja meg a [Cancel/Back] gombot.

5

Gomb Funkció

 (Lejátszás/szünet) gomb Elindítja egy klip lejátszását. Lejátszás közben szüneteltet.

 (Gyors előre) gomb,  (Gyors
vissza) gomb

Gyorsan játssza le a klipet. Megnyomása három lépésben módosítja
a lejátszási sebességet.

 (Előző) gomb,  (Következő)
gomb

A klip vagy az előző/következő klip elejére ugrat.

 (Állj) gomb Leállítja a lejátszást átvált a felvételi képernyőre.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rögzített klipeken végezhető műveletek

A miniatűrök képernyőjén a kameramenü [Thumbnail] menüjével kezelheti a klipeket és ellenőrizheti tulajdonságaikat.
A kameramenü kamerakép-panelen való megjelenítéséhez nyomja meg a lejátszásvezérlő képernyő [Menu] gombját.
A következő műveleteket végezheti el a kameramenü [Thumbnail] menüjében.
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Tipp

A kameramenü megjeleníthető az élő működtető képernyő [Menu] gombjával is.

A kameramenü [Thumbnail] menüjével végezhető műveletek
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A GUI vezérlőpanel nyíl gombjaival válassza ki a használni kívánt funkciót, majd nyomja meg a [Set] gombot.
Az előző képernyő visszaállításához nyomja meg a [Cancel/Back] gombot.

Megjegyzés

A menü megjelenítésekor fennálló állapottól függően előfordulhat, hogy egyes elemek nem választhatók.

Klipműveletek menüpontjai

A kameramenü [Thumbnail] menüjében a következő klipműveleti menüpontok találhatók.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Az egyes menüpontokról részletek a „[Thumbnail] menü” cím alatt találhatók.

A klipek tulajdonságait kijelző képernyő
A klipek tulajdonságait kijelző képernyő megjelenítéséhez válassza a kameramenü [Thumbnail] > [Display Clip
Properties] pontját.
Az előző/következő klipre ugratáshoz nyomja meg a  (Előző) vagy  (Következő) gombot.

Klipjelölők hozzáadása
Klipekhez klipjelölőket adhat (OK, NG vagy KP) megjelenítésük jelölő szerinti szűréséhez.
Válassza ki a klipjelölővel megjelölni kívánt klip miniatűrjét, majd a kameramenü [Thumbnail] > [Set Clip Flag] pontjában
válassza ki a klipjelölőt.

Tipp

Klipjelölő hozzáadásához használhat klipjelölő funkcióra programozott gombot is.

A szűrt klipminiatűrök képernyőjének megjelenítése
A kameramenü [Thumbnail] > [Filter Clips] pontjában válassza ki a klipjelölő típusát, hogy csak az így jelölt klipek
jelenjenek meg.
Minden klip megjelenítéséhez válassza az [All] lehetőséget.
A miniatűrök jelölők szerint rendezett megjelenítése a [Display] gomb megnyomásával is elvégezhető.

Klipek törlése
A memóriakártyákról törölhet klipeket.
Válassza a kameramenü [Thumbnail] > [Delete Clip] > [Select Clip] vagy [All Clips] pontját.
[Select Clip]: törli a kiválasztott klipet. Egyszerre több klipet is választhat.
[All Clips]: törli az összes megjelenített klipet.

A miniatűrök képernyőjén megjelenő információk kiválasztása

Beállítás Hozzáadott klipjelölő

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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Beállíthatja, hogy a miniatűr alatt a klip/képkocka milyen információi jelenjenek meg.
Válassza a kameramenü [Thumbnail] > [Customize View] > [Thumbnail Caption] pontját és válassza ki a megjeleníteni
kívánt adatokat.
[Date Time]: a klip létrehozásának és legutóbbi módosításának dátumát és idejét jeleníti meg.
[Time Code]: az időkódot jeleníti meg.
[Duration]: a klip időtartamát jeleníti meg.
[Sequential Number]: a sorszámot jeleníti meg az egyes miniatűrökön.
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A kamera menü felépítése

A GUI vezérlőpanel [Menu] gombjának vagy az infra távvezérlő MENU gombjának megnyomásakor a kamerakép-
panelen megjelenik s kameramenü, ahol a felvételkészítéshez és lejátszáshoz szükséges beállítások konfigurálhatók.

A menü a következő menüket tartalmazza.

A menü felépítése

[User] menü
A felhasználó által konfigurált menüpontokat tartalmazza.
Itt szerkeszthető: [Edit User Menu].
[Edit User] menü
Menüpontokat tartalmaz a [User] menü szerkesztéséhez.
[Shooting] menü
A felvételkészítéshez tartozó beállításokat tartalmazza.
[Project] menü
A projekt alapbeállításait tartalmazza.
[Paint/Look] menü
A képminőséggel kapcsolatos beállításokat tartalmazza.
[Pan-Tilt] menü
A pásztázó/döntő mozgásokra vonatkozó beállításokat tartalmazza.
[TC/Media] menü
Az időkódokkal és felvételi adathordozókkal kapcsolatos beállításokat tartalmazza.
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[Monitoring] menü
A videó kimenettel és a képernyős megjelenítéssel kapcsolatos beállításokat tartalmazza.
[Audio] menü
A hanggal kapcsolatos beállításokat tartalmazza.
[Thumbnail] menü
A miniatűrök megjelenítésével kapcsolatos beállításokat tartalmazza.
[Technical] menü
A technikai elemek beállításait tartalmazza.
[Network] menü
A hálózatokkal kapcsolatos beállításokat tartalmazza.
[Maintenance] menü
Az eszköz beállításait, pl. óra és nyelv, tartalmazza.

A kamera konfigurációja és hierarchiája

1. szint 2. szint

User
(gyári beállítások)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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1. szint 2. szint

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

285



1. szint 2. szint

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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1. szint 2. szint

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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A kameramenü használata

A GUI vezérlőpanel [Menu] gombjának vagy az infra távvezérlő MENU gombjának megnyomásakor a kamerakép-
panelen megjelenik s kameramenü, ahol a felvételkészítéshez és lejátszáshoz szükséges beállítások konfigurálhatók.
A menü a GUI vezérlőpanel gombjaival kezelhető.

[Menu] gomb: a kameramenüt jeleníti meg. A menü elrejtéséhez nyomja meg ismét, amikor látható a kamera menü.
Nyíl gombok: menüpontok vagy beállítások választásához a nyíl gombokkal mozgatható a kurzor fel/le/balra/jobbra a
kamera menüben.
[Set] gomb: a kiválasztott elem alkalmazásához nyomja meg.
[Cancel/Back] gomb: az előző menüre visszalépéshez nyomja meg. Törli a befejezetlen módosításokat.

Megjegyzés

A menü megjelenítésekor fennálló állapottól függően előfordulhat, hogy egyes elemek nem választhatók.

Menüpontok beállítása

A GUI vezérlőpanel nyíl gombjaival állítsa a kurzort a beállítandó elemre, és nyomja meg a [Set] gombot a beállítás
alkalmazásához.

A menüpont-választó területen nyolc sor számára van hely. Ha egy elem összes lehetősége nem jeleníthető meg
egyszerre, görgesse fel/le a kijelzést.
Nagy beállítási tartományú (pl. –99 és +99 közötti) részelemek (alpontok) esetén a beállítási terület nem jelenik meg.
A pillanatnyi beállításon kiemelés jelzi az érték módosíthatóságát.
Adott funkciónál az [Execute] választása végrehajtja a funkciót.
A végrehajtás előtt megerősítést igénylő elem kiválasztása átmenetileg elrejti a menüt és megjeleníti a megerősítő
üzenetet. Olvassa el az üzenetet és válassza a funkció végrehajtását vagy a visszalépést.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Karakterlánc beírása

Karakterek beírását igénylő elem, pl. fájlnév választásakor megjelenik a karakterbeviteli képernyő.
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A GUI vezérlőpanel nyíl gombjaival válassza ki a karaktertípust, és érvényesítse a beállítást.

[ABC]: nagybetűk
[abc]: kisbetűk
[123]: számjegyek
[!#$]: speciális karakterek

1

Válasszon ki egy karaktert és a [Set] gomb megnyomásával érvényesítse a beállítást.

A kurzor a következő mezőre lép.
[Space]: szóközt ír a kurzor helyére.
[←] [→]: mozgatja a kurzort.
[BS]: (backspace), törli a kurzortól balra álló karaktert.

2

Ha befejezte, a [Done] gomb megnyomásával érvényesítse a beállítást.

Ez nyugtázza a karakterláncot és bezárja a karakterbeviteli képernyőt.

3
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User

Ez a témakör az egyes menüpontok funkcióját és beállításait ismerteti.

Megjegyzés

Az [Edit User] menüvel menüpontok vehetők fel a [User] menübe és távolíthatók el onnét. Legfeljebb 20 elem konfigurálható.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Magyarázat

Base Setting Project > Base Setting elem

Focus Shooting > Focus elem

S&Q Motion Shooting > S&Q Motion elem

LUT On/Off Shooting > LUT On/Off elem

Simul Rec Project > Simul Rec elem

Proxy Rec Project > Proxy Rec elem

Interval Rec Project > Interval Rec elem

Picture Cache Rec Project > Picture Cache Rec elem

Assignable Button Project > Assignable Button elem

Scene File Project > Scene File elem

Base Look Paint/Look > Base Look elem

P/T Acceleration Pan-Tilt > P/T Acceleration elem

Clip Name Format TC/Media > Clip Name Format elem

Format Media TC/Media > Format Media elem

Video Signal Monitor Monitoring > Video Signal Monitor elem

Marker Monitoring > Marker elem

Zoom Technical > Zoom elem

Lens Technical > Lens elem

Edit User Menu Az Edit User menüt jeleníti meg.
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Edit User

Ha a [User] menüben az [Edit User Menu] pont van kiválasztva, az [Edit User] menü a legfelső szinten jelenik meg.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Add Item
Menüpont hozzáadása a
[User] menühöz

– –
2. szintű menüpontot ad hozzá a [User]
menühöz.

Customize Reset
A [User] menü pontjainak
visszaállítása

– –
Gyári alapértelmezésre állítja vissza a [User]
menüben regisztrált menüpontokat.

Szerkesztéskor kiválasztott 2.
szintű menüpont

Delete –
Törli a regisztrált 2. szintű menüpontot a [User]
menüből.

Move –
Átrendezi a regisztrált menüpontokat a [User]
menüben.

Edit Sub
Item

–
Szerkeszti (regisztrálja/törli) a regisztrált 3.
szintű menü-alpontot a [User] menüben.
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ISO/Gain/EI

Az erősítésbeállítások megadására szolgál.

Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Mode ISO/dB dB
Az erősítésbeállítási mód
megadása.

ISO/Gain<L>

A beállításokkal kapcsolatos
részletek a „ISO/Gain beállítások és
alapértelmezett értékek” cím alatt
találhatók.

–
Az erősítés előbeállítása <L>
értékre.

Exposure
Index<L>

Amikor Base ISO beállítása ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Amikor Base ISO beállítása ISO
12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Amikor Base ISO
beállítása ISO 800:
800EI / 6.0E
Amikor Base ISO
beállítása ISO 12800:
12800EI / 6.0E

Az Exposure Index<L> értékét
állítja be.

Shockless
Gain

On / Off Off
A Shockless Gain funkció
be/ki kapcsolása.

Base
Sensitivity

High / Low Low
A Custom üzemmód
bázisérzékenységét állítja be.
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Kapcsolódó témák
ISO/Gain beállítások és alapértelmezett értékek
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Base ISO ISO 12800 / ISO 800 ISO 800
A Cine EI/Flexible ISO
üzemmód ISO
bázisérzékenységét állítja be.
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ND Filter

Az ND szűrő előbeállított értékeinek kiválasztására szolgál.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Mode Preset / Variable Variable Az ND szűrő üzemmódjának választása.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Az ND szűrő előbeállított értéke 1 lesz.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Az ND szűrő előbeállított értéke 2 lesz.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Az ND szűrő előbeállított értéke 3 lesz.
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Shutter

Az elektronikus zár működésének beállítása.
Gyorsan mozgó témák éles vételére szolgál.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Mode Speed / Angle Speed

A záridő másodpercben
(Speed) vagy zárszögként
(Angle) való beállítási
üzemmódját állítja.

Shutter
Speed
On/Off

On / Off Off

Azt adja meg, hogy Speed
üzemmódban az expozíciós idő
a [Shutter Speed] értékét
kövesse-e vagy teljes
expozícióra álljon.

Shutter
Speed

64F – 1/8000
A választható értékkészlet a kiválasztott
videoformátum képfrekvenciájától függ.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 / 1/96
/ 1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

A záridőt állítja, ha a Speed
üzemmód van kiválasztva.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
360.0° / 300.0° / 270.0° / 240.0° / 216.0° / 210.0°
/ 180.0° / 172.8° / 150.0° / 144.0° / 120.0° / 90.0°
/ 86.4° / 72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

180.0°
A zárszöget állítja, ha az Angle
üzemmód van kiválasztva.

ECS On/Off On / Off Off
Az Extended Clear Scan
funkció be/ki kapcsolása.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

ECS
Frequency

23.99 – 8000
A választható beállítások a kiválasztott felvételi
formátum rendszerfrekvenciájától függnek.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

ECS frekvencia a Mode ECS
beállításában.
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Iris

A fényrekesz értékeit állítja.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Bokeh Control On / Off Off A bokeh-vezérlési funkció be/ki kapcsolása.
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Auto Exposure

Az automatikus expozíció beállítására szolgál.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 /
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 /
±0 / −0.25 / −0.5 / −0.75 / −1.0 / −1.25 /
−1.5 / −1.75 / −2.0 / −2.25 / −2.5 / −2.75 /
−3.0

±0
Az automatikusan érzékelt expozíció
világossági szintje.

Mode Backlight / Standard / Spotlight Standard

Az automatikus expozíció-állítás
üzemmódja.
Backlight: háttérvilágításos üzemmód
(háttérvilágítás esetén csökkenti a
téma sötétítését)
Standard: szokásos üzemmód
Spotlight: szpotfény üzemmód
(szpotfény használatakor csökkenti a
vakított fehér részeket)

Speed −99 – +99 ±0
Az automatikus expozíció-állítás
gyorsasága.

AGC On / Off Off
Az AGC (automatikus
erősítésszabályozás) funkció be/ki
kapcsolása.

AGC Limit

A beállításokkal kapcsolatos részletek
a „AGC Limit beállítások és
alapértelmezett értékek” cím alatt
találhatók.

– Az AGC funkció maximális erősítése.

AGC Point F2.8 / F4 / F5.6 F2.8
Az a fényrekesz-érték, amelynél elindul
az AGC működése, ha On értékre van
állítva az AGC.

Auto
Shutter

On / Off Off
Az automatikus záridő vezérlési funkció
be/ki kapcsolása.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Az automatikus záridő funkció
legkisebb zárideje.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11 Az a fényrekesz-érték, amelynél elindul
az automatikus záridő beállítás.

Clip High
light

On / Off Off

Nagy fényerősség esetén laposabb
reagálással a legfényesebb helyeket
figyelmen kívül hagyó funkció be/ki
kapcsolása.
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Kapcsolódó témák

AGC Limit beállítások és alapértelmezett értékek
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

A téma fényereje szerinti automatikus
expozíció-állítás fénymérési
tartományának beállítása. (Kézi
expozíció állítás esetén nem
választható.)

Detect
Window
Indication

On / Off Off
A fénymérési tartomány jelzés be/ki
kapcsolása.

Custom
Width

40 – 999 500
A fénymérési tartomány szélességének
beállítása.

Custom
Height

70 – 999 500
A fénymérési tartomány
magasságának beállítása.

Custom H
Position

−479 – +479 ±0
A fénymérési tartomány vízszintes
helyzetének beállítása.

Custom V
Position

−464 – +464 ±0 A fénymérési tartomány függőleges
helyzetének beállítása.
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White

Fehéregyensúly beállítások.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Preset
White

2000K –
15000K

3200K A fehéregyensúly előbeállított értéke.

Color
Temp <A>

2000K –
15000K

3200K

A fehéregyensúly A memóriában tárolt színhőmérséklete.

Megjegyzés

Mivel R Gain/B Gain működéskor a kamera a Color Temp-et 2000K és
15000K értéken lekorlátozza, előfordulhat, hogy nem lehet megjeleníteni
az R Gain/B Gain értékhez tartozó helyes Color Temp értéket.

Tint<A> −99 – +99 ±0

A fehéregyensúly A memóriában tárolt színárnyalat értéke.

Megjegyzés

Mivel az R Gain/B Gain működéskor a kamera a Tint-et ±99 értéken
lekorlátozza, előfordulhat, hogy nem lehet megjeleníteni az R Gain/B
Gain értékhez tartozó helyes színárnyalat értéket.

R Gain
<A>

–99.0 –
+99.0

±0.0 A fehéregyensúly A memóriában tárolt R erősítés értéke.

B Gain
<A>

–99.0 –
+99.0

±0.0 A fehéregyensúly A memóriában tárolt B erősítés értéke.

300



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

White Setting

Fehéregyensúly beállítások.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Shockless
White

Off / 1 / 2 / 3 2

A fehéregyensúly reagálási gyorsasága fehéregyensúly
üzemmód kapcsolásakor.
Off: azonnal kapcsol.
1 – 3: minél nagyobb a szám, annál lassabban kapcsol.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Reagálási gyorsaság ATW üzemmódban.
A legnagyobb reagálási gyorsaság 1, a legkisebb 5.
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Offset White

Fehéregyensúly eltolási beállítások.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Offset White <A> On / Off Off
Eltolási érték hozzáadása az A memóriában tárolt
fehéregyensúlyhoz; On hozzáad, Off nem ad hozzá.

Offset Color
Temp<A>

−99 – +99 ±0
Az A memóriában tárolt fehéregyensúlyhoz hozzáadott
színhőmérséklet eltolás, amikor az [Offset White <A>]
beállítása On.

Offset Tint<A> −99 – +99 ±0
Az A memóriában tárolt fehéregyensúlyhoz hozzáadott
színárnyalat érték eltolás, amikor az [Offset White <A>]
beállítása On.

Offset
White<ATW>

On / Off On
Eltolási érték hozzáadása az ATW fehéregyensúlyhoz; On
hozzáad, Off nem ad hozzá.

Offset Color
Temp<ATW>

−99 – +99 ±0
Az ATW fehéregyensúlyhoz hozzáadott színhőmérséklet
eltolás, amikor az [Offset White<ATW>] beállítása On.

Offset Tint<ATW> −99 – +99 ±0
Az ATW fehéregyensúlyhoz hozzáadott színárnyalat érték
eltolás, amikor az [Offset White<ATW>] beállítása On.
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Focus

A fókusz beállítások megadására szolgál.

Kapcsolódó témák

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 /
5 / 6 / 7(Fast)

5
A fókuszmotor témakövetési gyorsasága a téma
megváltozásakor automatikus fókuszálás közben.

AF Subj.
Shift Sens.

1(Locked On) / 2 / 3
/ 4 / 5(Responsive)

5(Responsive)
Témafókuszálás-váltási érzékenység automatikus
fókuszálás közben.

Focus Area
Wide / Zone /
Flexible Spot Wide

Automatikus fókuszálás és gombnyomásos automatikus
fókuszálás (AF) célmezőjét állítja be.

Lásd: „Automatikus fókuszálás (Auto Focus) beállítása”
és „Az automatikus fókuszálási mező/helyzet
(fókuszmező) beállítása”.

Wide: a kép széles látószögében keresi a témát a
fókuszáláshoz.
Zone: automatikusan megkeresi a fókusz helyét a megadott
zónán belül.
Flexible Spot: A kép egy adott helyére fókuszál.

Focus Area
(AF-S)

Flexible Spot Flexible Spot Gombnyomásos automatikus fókuszálás (AF-S) célmezője.

Face/Eye
Detection
AF

Face/Eye Only AF /
Face/Eye Priority
AF / Off

Face/Eye Priority
AF

Arcérzékeléses AF engedélyezése/letiltása.

Lásd: „Követés arc és szem érzékeléssel (Face/Eye
Detection AF)”.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF
Gombnyomásos automatikus fókuszáló üzemmód
beállítása.

Touch
Function in
MF

Tracking AF / Spot
Focus Tracking AF

Beállítja, hogy mi történjen a kamerakép megérintésekor a
webes alkalmazás élő működtető képernyőjén, MF
üzemmódban.

AF Assist On / Off On

On beállítása esetén az automatikus fókuszálás átmenetileg
felülbírálható kézi fókuszálással.

Lásd: „Az automatikus fókuszálási célpont kézi beállítása
(AF Assist) a webes alkalmazással” és „Kézi fókuszálás
az automatikus fókuszálás használatakor a mellékelt
infra távvezérlővel”.
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Az automatikus fókuszálási mező/helyzet (fókuszmező) beállítása

Követés arc és szem érzékeléssel (Face/Eye Detection AF)

Az automatikus fókuszálási célpont kézi beállítása (AF Assist) a webes alkalmazással

Kézi fókuszálás az automatikus fókuszálás használatakor a mellékelt infra távvezérlővel

5-041-958-53(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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S&Q Motion

A Lassított és gyorsított felvétel üzemmód beállításai állíthatók itt (lásd: „Lassított és gyorsított felvétel”).

Kapcsolódó témák
Lassított és gyorsított felvétel

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting On / Off Off
A lassított és gyorsított felvétel üzemmód be/ki
kapcsolása.

Frame
Rate

1fps – 60fps / 100fps / 120fps
/ 150fps / 180fps / 200fps /
240fps

–

Lassított és gyorsított felvétel képfrekvencia
beállítása.

Megjegyzés

A választható beállítások a kiválasztott
rendszerfrekvenciától, kodektől és videoformátumtól
függnek.
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LUT On/Off

LUT beállítások.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

SDI MLUT On / MLUT Off MLUT Off
Itt állítható be a Monitor LUT alkalmazása az
SDI kimenet videójára.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Itt állítható be a Monitor LUT alkalmazása az
HDMI és a streamelt kimenet videójára.

Proxy MLUT On / MLUT Off MLUT Off
Itt állítható be a Monitor LUT alkalmazása a
proxy felvétel videójára.

Internal Rec MLUT On / MLUT Off MLUT Off
Itt állítható be a Monitor LUT alkalmazása a fő
felvétel videójára.

LUT On/Off Button
Target

SDI / HDMI/Stream / SDI
& HDMI/Stream

HDMI/Stream
LUT On/Off funkcióra programozott gombbal
vezérelt célkimenet beállítására szolgál.
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Interchangeable Lens Digital Camera
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Noise Suppression

Zajelnyomás beállításai.

Tipp

A [Setting(Custom)] és [Level(Custom)] beállítások tükröződnek a [Target Display] beállításában.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Setting(Custom) On / Off On
A zajelnyomási funkció be/ki kapcsolása Custom
üzemmódban.

Level(Custom)
Low / Mid /
High

Mid
A zajelnyomási szint beállítása a Custom
üzemmódban.

Setting (Cine EI/Flex.
ISO)

On / Off Off
A zajelnyomási funkció be/ki kapcsolása Log
felvételi üzemmódban.

Level (Cine EI/Flex.
ISO)

Low / Mid /
High

Mid
A zajelnyomási szint beállítása Log felvételi
üzemmódban.
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Flicker Reduce

Vibrálás elleni beállítások.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Mode Auto / On / Off Off A vibráláselhárító üzemmód beállítása.

Frequency 50Hz / 60Hz 60Hz A vibrálást okozó fényforrás frekvenciája.
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SteadyShot

Képstabilizálási beállítások.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Setting
Active /
Standard / Off

Off

A képstabilizálási funkció beállítása.

Megjegyzés

Kompatibilis objektív használatakor engedélyezett.

Active vagy Standard beállításában váratlan viselkedés fordulhat elő
a pásztázás/döntés használatakor.
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Interchangeable Lens Digital Camera
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Base Setting

Bázisbeállítások megadására szolgál.

Kapcsolódó témák

Alapvető használati konfigurálás
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

A felvételi üzemmódot állítja.

Lásd: „A felvételi üzemmód beállítása”
„Alapvető használati konfigurálás” cím alatt.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
A felvétel/kimenet színterjedelmét állítja be
Custom üzemmódban.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Format

Felvételi formátum beállítások.

[RAW Output Format] beállítások

Az alapértelmezett beállítások félkövéren vannak szedve.
Nincsenek feltüntetve azok a körülmények, amelyek esetén nem állítható a [RAW Output Format].

[Video Format] beállítások

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Rendszerfrekvencia.

Imager Scan
Mode

FF / S35 FF Az imager méret kiválasztása.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

A klip felvételi/lejátszási kodek beállítása.

Megjegyzés

Ha az [Imager Scan Mode] beállítása
[S35], [RAW] és [RAW & XAVC-I] nem
választható.

RAW Output
Format

A választható beállítások a
[Frequency] beállítástól függnek.

Lásd: „[RAW Output Format]
beállítások”, lent.

–

Külső RAW felvevőre kiadott RAW kép
méretének méretét állítja.

Megjegyzés

Ha a [Codec] beállítása [RAW & XAVC-I], a
[Video Format] beállítás a [RAW Output
Format] beállítással összhangban
kapcsolódik.

Video
Format

A választható beállítások a
[Frequency], [Imager Scan Mode]
és [Codec] beállítástól függnek.

Lásd: „[Video Format]
beállítások”, lent.

– A képméret és a bitsebesség beállítása.

Frequency Imager Scan Mode Codec Beállítás

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Az alapértelmezett beállítások félkövéren vannak szedve.

5-041-958-53(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Beállítás

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Interchangeable Lens Digital Camera
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Cine EI/Flex.ISO Set

A Log felvételi üzemmód beállítások megadására szolgál (Lásd: „A felvételi üzemmód beállítása” az „Alapvető használati
konfigurálás” cím alatt).

Kapcsolódó témák

Alapvető használati konfigurálás
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Log felvételi üzemmódok ([Flexible ISO], [Cine EI
Quick], [Cine EI]) színterjedelmének beállítására
szolgál.

Embed
LUT File

On / Off On
Be/ki kapcsolja a 3D LUT file (CUBE file)
metaadatok rögzítését.
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Interchangeable Lens Digital Camera
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Simul Rec

A 2-memóriakártyás egyidejű felvételi üzemmód beállítására szolgál (lásd: „Egyidejű rögzítés az „A” és „B”
memóriakártyára (2-slot Simul Rec)”).

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Setting On / Off Off
2-kártyahelyes egyidejű
felvételi funkció be/ki
kapcsolása.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec
Button:<Slot A> <Slot B> / Rec Button:<Slot
A> 2nd Rec Button:<Slot B> / Rec Button:
<Slot B> 2nd Rec Button:<Slot A>

Rec Button:<Slot A> <Slot
B> 2nd Rec Button:<Slot
A> <Slot B>

Hozzárendeli az egyes
felvételi adathordozók
vezérlésére használt felvételi
gombokat.
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Proxy Rec

A proxy felvételi üzemmód beállítására szolgál (lásd: „Proxy felvétel”).
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting On / Off Off A proxy felvételi üzemmód be/ki kapcsolása.

Audio
Channel

CH1/CH2 /
CH3/CH4

CH1/CH2
A proxy adatokhoz rögzítendő hangcsatorna
kiválasztása.
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Interchangeable Lens Digital Camera
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Interval Rec

Az Interval Recording felvételi üzemmód beállítására szolgál (lásd: „Szakaszos videofelvétel készítés (Interval Rec)”).
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Setting On / Off Off

Az Interval Recording üzemmód be/ki
kapcsolása. (Ennek az üzemmódnak
az On értékre állítása Off értékre állít
minden más speciális üzemmódot.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (másodperc)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (perc)
1 / 2 / 3 / 4 / 6 / 12 / 24 (óra)

1
Interval Rec felvételi üzemmódban a
felvételek közötti időköz (ha az
Interval Rec beállítása On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
A választható beállítások készlete a
kiválasztott videoformátum
képfrekvenciájától függ.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Interval Rec felvételi üzemmódban az
egyes felvételek képkocka száma (ha
az Interval Rec beállítása On).
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Interchangeable Lens Digital Camera
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Picture Cache Rec

A kép gyorsítótár rögzítési üzemmódjának állítására szolgál (lásd: „Gyorsítótárazott képek rögzítése (Picture Cache
Rec)”).

Kapcsolódó témák

Gyorsítótárazott képek rögzítése (Picture Cache Rec)
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting On / Off Off Be/ki kapcsolja a kép gyorsítótár funkciót.

Cache Size
Short / Medium /
Long / Max

Max
Beállítja a képek felhalmozási idejét a kép gyorsítótár
memóriában (a kép gyorsítótár rögzítési idejét).

Cache Rec
Time

– –
Megjeleníti a képek felhalmozási idejét a kép gyorsítótár
memóriában (a kép gyorsítótár rögzítési idejét).
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SDI/HDMI Rec Control

SDI/HDMI felvételvezérlési beállítások.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Csatlakoztatott külső eszköz felvétel indítás/leállítás vezérlése a
SDI/HDMI kimenőjellel.
Off: nem működik a távvezérlés.
SDI/HDMI Remote I/F: csatlakoztatott külső eszköz felvétel
indítás/leállítás vezérlése, ha nincs behelyezett adathordozó az
egységben. Nincs szinkronizálva képkocka pontossággal az
egységben levő adathordozóhoz.
Parallel Rec: csatlakoztatott külső eszköz felvétel indítás/leállítás
vezérlése, ha van behelyezett adathordozó az egységben.
Képkocka pontossággal szinkronizálva van az egységben levő
adathordozóhoz.

Megjegyzés

Vezérléshez a HDMI kimenőjel használatakor állítsa a kameramenü
[TC/Media] > [HDMI TC Out] > [Setting] pontját [On] értékre.
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Assignable Button

Funkciókat rendel a programozható gombokhoz (<1> – <9>) és [Focus Hold Button].
A következő funkciók rendelhetők gombokhoz.
[Off]: nincs funkció hozzárendelés.
[Base ISO/Sensitivity]: a képérzékelő bázisérzékenységét kapcsolja.
[AGC]: be/ki kapcsolja az AGC funkciót.
[Push AGC]: engedélyezi az AGC funkciót a gomb lenyomása idejére.
[ND Filter]

Változó üzemmódban: az ND szűrő átbocsátási tényezőjét állítja. A Clear/Manual/Auto közötti átkapcsoláshoz
nyomja le és tartsa nyomva.
Előbeállított üzemmódban: az előbeállítások közötti átkapcsoláshoz nyomja le és tartsa nyomva.

[ND Filter Position]: ND szűrőket kapcsol.
[Auto ND Filter]: be/ki kapcsolja az auto ND szűrő funkciót.
[Push Auto ND]: engedélyezi az auto ND szűrő funkciót a gomb lenyomása idejére.
[Auto Iris]: a fényrekesz funkciót kapcsolja be/ki.
[Push Auto Iris]: engedélyezi az automatikus fényrekesz funkciót a gomb lenyomása idejére.
[Bokeh Control]: a bokeh-vezérlés üzemmódot kapcsolja be/ki.
[Auto Shutter]: az automatikus záridő funkciót kapcsolja be/ki.
[AE Level/Mode]: az AE szintet állítja. Az AE üzemmód kapcsolásához nyomja le és tartsa nyomva.
[Backlight]: a Backlight és a Standard beállítást váltogatja.
[Spotlight]: a Spotlight és a Standard beállítást váltogatja.
[Preset White Select]: a fehéregyensúly előbeállított üzemmód értékét kapcsolja.
[ATW]: be/ki kapcsolja a ATW funkciót.
[ATW Hold]: szünetelteti az ATW funkció működését.
[AF Speed/Sens.]: az AF átállási gyorsaság és az AF témaelmozdulási érzékenység beállítását kapcsolja.
[Focus Setting]: a fókuszmezőt állítja.
[Face/Eye Detection AF]: az arcérzékeléses AF beállításokat kapcsolja.
[Push AF Mode]: a Push AF üzemmód beállítását kapcsolja.
[Push AF/MF]: MF fókuszálási üzemmódban aktiválja az AF-et a gomb lenyomása idejére. AF fókuszálási üzemmódban
az MF aktiválása a gomb lenyomása idejére.
[Focus Hold]: AF fókuszálási üzemmódban rögzíti a fókuszt a gomb lenyomása idejére.
[S&Q Motion]: be/ki kapcsolja a Slow & Quick Motion funkciót. Lenyomása és nyomva tartása esetén a felvételi
képfrekvenciát állítja.
[LUT On/Off]: be/ki kapcsolja a LUT funkciót. A kapcsolási cél a [Shooting] > [LUT On/Off] > [LUT On/Off Button Target]
menüpontban állítható be.
[SteadyShot]: az Active, Standard és Off beállítást váltogatja.
[Crop Select]: az Imager Scan Mode kapcsolására szolgál. A kapcsolás a tartományon belül van engedélyezve, a
felvételi formátum módosítása nélkül.
[Rec] elindítja/leállítja a felvételt.
[Picture Cache Rec]: be/ki kapcsolja a kép gyorsítótár rögzítési üzemmódját.
[Rec Review]: be/ki kapcsolja a felvétel megtekintése funkciót.
[Clip Flag OK]: végrehajtja az Add OK-t. Kétszer megnyomva végrehajtja a Delete Clip Flag funkciót.
[Clip Flag NG]: végrehajtja az Add NG-et. Kétszer megnyomva végrehajtja a Delete Clip Flag funkciót.
[Clip Flag Keep]: végrehajtja az Add KEEP-et. Kétszer megnyomva végrehajtja a Delete Clip Flag funkciót.
[Slot Select]: az (A) és (B) kártyahely között vált.
[Color Bars]: be/ki kapcsolja a színsávokat.
[DURATION/TC/U-BIT]: az Time Code, Users Bit és Duration beállítást váltogatja.
[Display]: be/ki kapcsolja a képernyő jelzőket.
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[Lens Info]: a mélységélesség jelzőt kapcsolja.
[Video Signal Monitor]: a videojel figyelőt (például hullámforma monitort) kapcsolja.
[Marker]: be/ki kapcsolja a marker funkciót.
[Thumbnail]: a miniatűrök képernyőjét jeleníti meg/lépteti ki.
[Auto Upload (Proxy)]: be/ki kapcsolja proxy fájl automatikus átvitelét.
[Direct Menu]: a közvetlen menüt jeleníti meg/lépteti ki.
[User Menu]: a User menüt jeleníti meg/lépteti ki.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Scene File

A jelenetfájlokkal kapcsolatos beállítások megadása (lásd: „Felvételkészítés kívánt megjelenéssel”).
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Recall – –
Beépített memóriában tárolt jelenetfájl
betöltése és a beállítások alkalmazása
aktuális képminőség beállításként.

Store – –
Az aktuális képminőség állapot
elmentése jelenetfájlként, beépített
memóriába.

Delete – –
Beépített memóriában tárolt jelenetfájl
törlése.

Preset
Recall

Amikor a Shooting Mode beállítása
Custom és a Target Display beállítása
SDR(BT.709): S-Cinetone / Standard / Still /
ITU709/ 709tone
Amikor a Shooting Mode beállítása
Custom és a Target Display beállítása
HDR(HLG): HLG Live / HLG Natural

–
Előbeállított (nem felülírható)
képminőség beállítások alkalmazása
aktuálisként.
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Base Look

A bázismegjelenéssel kapcsolatos beállítások megadása.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Select

Amikor a Shooting Mode beállítása
Custom és a Target Display
beállítása SDR(BT.709): S-Cinetone /
Standard / Still / ITU709 / 709tone /
User1 – User16
Amikor a Shooting Mode beállítása
Custom és a Target Display
beállítása HDR(HLG): HLG Live / HLG
Natural / User1 – User16
Amikor a Shooting Mode beállítása
Log felvételi üzemmódok: s709 /
709(800) / S-Log3 / User1 – User16

Amikor a Shooting Mode
beállítása Custom és a Target
Display beállítása
SDR(BT.709): S-Cinetone
Amikor a Shooting Mode
beállítása Custom és a Target
Display beállítása HDR(HLG):
HLG Live
Amikor a Shooting Mode
beállítása Log felvételi
üzemmódok: s709

Bázismegjelenés kiválasztása.

Delete – –
A kiválasztott bázismegjelenés
törlése.

Delete
All

– – Minden bázismegjelenés
törlése.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
A bemeneti terjedelmet állítja
be a [Select]-tel kiválasztott
bázismegjelenéshez.

Output BT.709 / HLG BT.709

A kimeneti színterjedelmet
állítja be a [Select]-tel
kiválasztott
bázismegjelenéshez.

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /
5/3EV / 2EV

0EV

Beállítja az expozíció
referenciaértékét a kiválasztott
bázismegjelenéshez, [Select]
használatával.
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Reset Paint Settings

A [Paint/Look] menübeállítások visszaállítására szolgál, a bázismegjelenés kivételével.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Reset without
Base Look

Execute /
Cancel

–
A [Paint/Look] menübeállítások visszaállítására szolgál, a
bázismegjelenés kivételével.
Execute: a végrehajtás funkció.
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Black

Fekete beállítások megadása.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Master Black –99.0 – +99.0 ±0.0 A master feketeszint beállítása.

R Black –99.0 – +99.0 ±0.0 Az R feketeszint beállítása.

B Black –99.0 – +99.0 ±0.0 A B feketeszint beállítása.
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Knee

Könyökkorrekciós beállítások megadása.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Setting

Amikor a Target Display
beállítása SDR(BT.709):
On / Off / ---
Amikor a Target Display
beállítása HDR(HLG): On /
Off / ---

Amikor a Target Display
beállítása
SDR(BT.709): Off
Amikor a Target Display
beállítása HDR(HLG): Off

A könyökkorrekciós funkció be/ki kapcsolása.

Megjegyzés

Csak akkor engedélyezett, ha [Base Look] >
[Select] beállítása [Standard], [ITU709],
[709tone], [HLG Live] vagy [HLG Natural].

Auto
Knee

Amikor a Target Display
beállítása SDR(BT.709):
On / Off / ---
Amikor a Target Display
beállítása HDR(HLG): On /
Off / ---

Amikor a Target Display
beállítása
SDR(BT.709): On
Amikor a Target Display
beállítása HDR(HLG): Off

Az automatikus könyökfunkció be/ki
kapcsolása.

Megjegyzés

Csak akkor engedélyezett, ha [Base Look] >
[Select] beállítása [Standard], [ITU709] vagy
[709tone].

Point 75% – 109% 90% A könyökpont beállítása.

Slope −99 – +99 ±0 A könyökmeredekség beállítása.
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Detail

A részletes beállítások megadása.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting On / Off On A részlet funkció be/ki kapcsolása.

Level −7 – +7 ±0 A részletszint beállítása.

Manual
Setting

On / Off / --- Off A kézi részletállítási funkció be/ki kapcsolása.

H/V Ratio −2 – +2 ±0

A vízszintes (H) részletek és a függőleges (V) részletek
egyensúlyának beállítása kézi részletállításhoz.

Megjegyzés

Ez az elem a szoftver verziójától függően változik.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Kis világosságú területek fekete (B) részletei és nagy
világosságú területek fehér (W) részletei egyensúlyának
beállítása kézi részletállításhoz.

Limit 0 – 7 7 A részlethatárolási szint beállítása kézi részletállításhoz.

Crispening 0 – 7 0 Az élesítési szint beállítása kézi részletállításhoz.

High Light
Detail 0 – 4 0

Nagy világosságú területek részletszint beállítása kézi
részletállításhoz.

A szoftver 1.00 verziójában a menüpont [V/H Balance]. A szoftver 1.10 vagy újabb verziójában a menüpont [H/V Ratio]. A beállítási tartomány
nem változik –2, 0 és +2 között, azonban a képminőségre gyakorolt hatás eltérő.
1.00 szoftver-verzió: nagyobb beállított érték nagyobb vízszintes (H) részletgazdagságot ad
1.10 vagy újabb szoftver-verzió: nagyobb beállított érték nagyobb függőleges (V) részletgazdagságot ad
1.00-ról 1.10 vagy újabb szoftver-verzióra frissítést követően az [All File], [Scene File] és más beállítások öröklődnek, de fordított polaritással (a
képminőség megmarad).
Ha regisztrálta a [V/H Balance] menüpontot a [User] menüben, akkor szoftverfrissítést követően a [User] menüben automatikusan [H/V Ratio]
menüpont jelenik meg helyette.

*1
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Matrix

Mátrixkorrekciós beállítások megadása.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

User Matrix On / Off Off
A felhasználói mátrixkorrekciós funkció be/ki
kapcsolása.

User Matrix
Level

−99 – +99 ±0 Az egész kép színtelítettségének állítása.

User Matrix
Phase

−99 – +99 ±0 Az egész kép színtónusának (fázisának) állítása.

User Matrix R-G −99 – +99 ±0
Felhasználó által definiált R-G felhasználói mátrix
beállítása.

User Matrix R-B −99 – +99 ±0
Felhasználó által definiált R-B felhasználói mátrix
beállítása.

User Matrix G-R −99 – +99 ±0
Felhasználó által definiált G-R felhasználói mátrix
beállítása.

User Matrix G-B −99 – +99 ±0
Felhasználó által definiált G-B felhasználói mátrix
beállítása.

User Matrix B-R −99 – +99 ±0
Felhasználó által definiált B-R felhasználói mátrix
beállítása.

User Matrix B-G −99 – +99 ±0
Felhasználó által definiált B-G felhasználói mátrix
beállítása.
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Multi Matrix

Multimátrix-korrekciós beállítások megadása.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting On / Off Off
A multimátrix-korrekciós funkció be/ki
kapcsolása.

Reset Execute / Cancel –
Az egyes tengelyszínek színárnyalatának és
telítettségének alapértelmezett értékre
állítása.

Axis
B / B+ / MG− / MG / MG+ / R / R+ /
YL− / YL / YL+ / G− / G / G+ / CY /
CY+ / B−

B A tengely kiválasztása.

Hue −99 – +99 ±0
A multimátrix-korrekcióhoz használt szín
árnyalatának beállítása.

Saturation −99 – +99 ±0
A multimátrix-korrekcióhoz használt szín
telítettségének beállítása.
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P/T Acceleration

Pásztázó/döntő műveletek gyorsulásával kapcsolatos beállítások megadására szolgál.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Ramp
Curve

1 – 9 8
Pásztázó/döntő műveletek gyorsulásának kiválasztására szolgál. A
nagyobb szám nagyobb gyorsulást jelent.
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Timecode

Időkód beállítások megadása.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Mode
Preset / Regen /
Clock

Preset

Az időkód futási üzemmódjának megadása.
Preset: előbeállított értékről indul.
Regen: az előző klip végén levő időkódtól indul.
Clock: a belső órát használja időkódként.

Run Rec Run / Free Run Rec Run
Rec Run: csak felvétel közben fut.
Free Run: mindig fut, a felvétel működésétől
függetlenül.

Setting – –
Az időkód tetszőleges értékre állítása.
Set: az érték beállítása.

Reset Execute / Cancel –
Az időkód visszaállítása 00:00:00:00 értékre.
Execute: a végrehajtás funkció.

TC
Format

DF / NDF DF
Az időkód formátumának beállítása.
DF: Drop Frame (keretkihagyásos)
NDF: Non-Drop Frame (keretkihagyás nélküli)
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TC Display

Időadat megjelenítési beállítások megadása.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Display Select Timecode / Users Bit / Duration Timecode Időadat megjelenítés kapcsolása.
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Users Bit

Felhasználói bitekkel kapcsolatos beállítások megadása.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Mode Fix / Time Fix

Felhasználói bit üzemmód beállítása.
Fix: tetszőleges rögzített érték használata a felhasználói bitekben.
Time: a pillanatnyi óra, perc és másodperc használata a
felhasználói bitekben.

Setting – – A felhasználói bitek tetszőleges értékre állítása.
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HDMI TC Out

HDMI használatakor kimenő időkóddal kapcsolatos beállítások megadása.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Setting On / Off Off
Kimenjen-e az időkód eszközökre egyéb célból, HDMI
használatával.
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Interchangeable Lens Digital Camera
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Clip Name Format

Klip elnevezéssel és törléssel kapcsolatos beállítások megadása.
Ha [Auto Naming] beállítása [Cam ID + Reel#], a klipek nevének első négy karaktere minden egyes felvételi
adathordozóhoz meg van határozva. Ha új felvételi adathordozót helyeznek be, vagy ha a felvételi adathordozón lévő
utolsó klip nem felel meg a [Camera ID] vagy [Reel Number] beállításoknak, a klip neve villogva jelzi ezt.
Ha az [Auto Naming] beállítása [Title], tetszőleges karakterláncot használhat a klipek nevének első részeként.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Auto
Naming

Cam ID + Reel# / Title

A klip elnevezési formátum kiválasztására szolgál.
Cam ID + Reel#: Camera ID + Reel Number + Shot
Number + dátum + random karakterlánc
Title: a [Title Prefix] + a klip száma által meghatározott
tetszőleges karakterlánc

Camera ID A – Z A

Klipnevek generálásakor az alkalmazott
kameraazonosítót adja meg.

Megjegyzés

Csak akkor konfigurálható, ha [Auto Naming] beállítása
[Cam ID + Reel#].

Reel
Number

001 – 999 001

Klipnevek generálásakor a tekercsszám részt adja meg.

Megjegyzés

Csak akkor konfigurálható, ha [Auto Naming] beállítása
[Cam ID + Reel#].

Camera
Position

C / L / R C

Klipnevek generálásakor az alkalmazott felvételszám
első karakterét adja meg.

Megjegyzés

Csak akkor konfigurálható, ha [Auto Naming] beállítása
[Cam ID + Reel#].

Title Prefix

nnn_(nnn a
sorozatszám utolsó 3
számjegye)
(legfeljebb 7-
számjegyes kijelzés)

nnn

A klipnév cím részének (4 – 46 karakter) beállítása.
Karakterlánc beíró képernyő megnyitása.

Részletek a címek beállításáról és a karakterbeviteli
képernyőről: „A cím megadásához” alább, és
„Karakterlánc beírása”.

Megjegyzés

Csak akkor konfigurálható, ha [Auto Naming] beállítása
[Title].
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[Title Prefix] beállítása

Kapcsolódó témák

Karakterlánc beírása
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Number
Set

0001 – 9999 0001

A klipnév 4-jegyű szám toldalékának megadása.

Megjegyzés

Csak akkor konfigurálható, ha [Auto Naming] beállítása
[Title].

A GUI vezérlőmező nyíl gombjaival válassza ki a karakterválasztó területen a [Title Prefix] terület
kurzorhelyén beszúrandó karaktert (a karakter kiemelt megjelenésűvé válik), és nyomja meg a GUI
vezérlőpanel [Set] gombját.

A kiválasztott karakter beszúródik és a kurzor jobbra lép.

1

A cím megadásához ismételje meg az 1. lépést.

Használja a [BS]-t szükség szerint.

2

A cím beállítása után zárja be a karakterbeviteli képernyőt a [Done] gomb megnyomásával.

Részletek a karakterbeviteli képernyő használatáról: „Karakterlánc beírása”.

A következő karakterek választhatók.
!#$%()+,-.;=@[ ]^_~ szóköz
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Frissíti a memóriakártyákon levő kezelőfájlt (lásd: „Memóriakártyák visszaállítása”).

Kapcsolódó témák

Memóriakártyák visszaállítása

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Media(A) Execute / Cancel –
Frissíti az „A” kártyahely memóriakártyáján levő kezelőfájlt.
Execute: a végrehajtás funkció.

Media(B) Execute / Cancel –
Frissíti a „B” kártyahely memóriakártyáján levő kezelőfájlt.
Execute: a végrehajtás funkció.
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Format Media

Memóriakártyák formázására (inicializálására) szolgál (lásd: „Memóriakártyák formázása (inicializálása)”).

Kapcsolódó témák

Memóriakártyák formázása (inicializálása)
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Media(A)
Full Format / Quick Format /
Cancel

–
Formázza az „A” kártyahely
memóriakártyáját.

Media(B)
Full Format / Quick Format /
Cancel

–
Formázza a „B” kártyahely
memóriakártyáját.
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Media Life

Megjeleníti memóriakártyák hátralevő élettartamát.

Megjegyzés

Olyan memóriakártyákat igényel, amelyek támogatják a hátralevő élettartam megjelenítését.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Media(A) – –
Megjeleníti az „A” kártyahely memóriakártyájának hátralevő
élettartamát.

Media(B) – –
Megjeleníti a „B” kártyahely memóriakártyájának hátralevő
élettartamát.
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Output Format

Kimeneti formátum beállítások megadása.

Kapcsolódó témák

Kimeneti formátumok és korlátozások
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

SDI Beállítások részletei: „Kimeneti formátumok
és korlátozások”.

– Az SDI és HDMI kimenet
felbontásának beállítása.HDMI –
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Display On/Off

Képernyőelem beállítások megadása.
Képernyőelem megjelenítéséhez válassza az On beállítást. Képernyőelem elrejtéséhez válassza az Off beállítást.

Elem Alpont beállítás Gyári alapértelmezés

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Elem Alpont beállítás Gyári alapértelmezés

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Videojel figyelési beállítások megadására szolgál.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Setting Off / Waveform / Vector / Histogram Off A videojel figyelő típusát állítja.

Level Marker 1 0% – 109% 70% Az 1. fényerőszint markert állítja.

Level Marker 2 0% – 109% 100% A 2. fényerőszint markert állítja.
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Marker

Markermegjelenítési beállítások megadása.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting On / Off On
Minden marker megjelenítésének be/ki
kapcsolása.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White A markerjel színének kiválasztása.

Center
Marker

1 / 2 / 3 / 4 / Off Off A középső marker kiválasztása.

Safety
Zone

On / Off Off A biztonságizóna-marker be/ki kapcsolása.

Safety Area 80% / 90% / 92.5% / 95% 90%
A biztonságizóna-marker méretének
kiválasztása (a teljes képernyőméret
százalékában).

Aspect
Marker

Line / Mask / Off Off Az aspektusmarker típusának kiválasztása.

Aspect
Mask

0 – 15 12 A markeren kívüli videojel szintjének beállítása.

Aspect
Safety
Zone

On / Off Off
Az aspektus biztonságizóna-marker be/ki
kapcsolása.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Az aspektus biztonságizóna-marker méretének
kiválasztása (a teljes képernyőméret
százalékában).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 /
16:9 / 17:9 / 1.66:1 / 1.85:1 /
2.35:1 / 2.39:1 / Custom

2.39:1
Üzemmód beállítása az aspektusmarker
megjelenítésekor.

Custom
Aspect
Ratio

Írjon be egy tetszőleges számot. 01.00:01.00

Az aspektusviszony (oldalarány) tetszőleges
értékre állítása.

Megjegyzés

Engedélyezve van, amikor az [Aspect Select]
beállítása [Custom].

Guide
Frame On / Off Off A vezetőkeret megjelenítés be/ki kapcsolása.
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alapértelmezés Magyarázat

100%
Marker

On / Off Off A 100% marker be/ki kapcsolása.

User Box On / Off Off
A felhasználóidoboz-marker megjelenítés be/ki
kapcsolása.

User Box
Width

3 – 479 240
A felhasználóidoboz-marker szélességének (a
középhelyzet bal és jobb szegélytől mért
távolságának) beállítása.

User Box
Height

3 – 269 135
A felhasználóidoboz-marker magasságának (a
középhelyzet felső és alsó szegélytől mért
távolságának) beállítása.

User Box H
Position

−476 – +476 0
A felhasználóidoboz-marker közepe vízszintes
helyzetének beállítása.

User Box V
Position

−266 – +266 0
A felhasználóidoboz-marker közepe függőleges
helyzetének beállítása.
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Audio Input

Hangbemeneti beállítások megadása.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

AUDIO IN
Select

MIC / LINE MIC Az AUDIO IN csatlakozóra kötött eszköz típusát választja.

Phantom
Power +48V

On / Off Off A +48 V-os fantom tápellátás állapotát jeleníti meg.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1 1. csatornán való felvétel bemeneti jelforrását jeleníti meg.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 2. csatornán való felvétel jelforrásának kapcsolása.

CH3 Input
Select

Off / AUDIO IN CH1 AUDIO IN CH1 3. csatornán való felvétel jelforrásának kapcsolása.

CH4 Input
Select

Off / AUDIO IN CH1
/ AUDIO IN CH2

AUDIO IN CH2 4. csatornán való felvétel jelforrásának kapcsolása.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Felvételi referenciaszint beállítása AUDIO IN CH1
csatornáról jövő XLR mikrofon bemenőjelhez.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Felvételi referenciaszint beállítása AUDIO IN CH2
csatornáról jövő XLR mikrofon bemenőjelhez.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
A bemeneti referenciaszint beállítása, amikor [AUDIO IN
Select] értéke LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB
Az 1 kHz-es referencia hangjel felvételi szintjének
kiválasztása.

CH1 Wind
Filter

On / Off Off
A szélzajcsökkentő szűrő engedélyezése/letiltása 1.
csatornás felvételnél.

CH2 Wind
Filter

On / Off Off
A szélzajcsökkentő szűrő engedélyezése/letiltása 2.
csatornás felvételnél.

CH3 Wind
Filter

On / Off Off
A szélzajcsökkentő szűrő engedélyezése/letiltása 3.
csatornás felvételnél.

CH4 Wind
Filter

On / Off Off A szélzajcsökkentő szűrő engedélyezése/letiltása 4.
csatornás felvételnél.

CH1 Level
Control

Auto / Manual Auto
Automatikus vagy kézi hang bemenőszint állítás
választása az 1. felvételi csatornához.
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alapértelmezés Magyarázat

CH2 Level
Control

Auto / Manual Auto
Automatikus vagy kézi hang bemenőszint állítás
választása a 2. felvételi csatornához.

CH3 Level
Control

Auto / Manual Auto
Automatikus vagy kézi hang bemenőszint állítás
választása a 3. felvételi csatornához.

CH4 Level
Control

Auto / Manual Auto
Automatikus vagy kézi hang bemenőszint állítás
választása a 4. felvételi csatornához.

CH1 Input
Level

0 – 99 49 Bemenőszint állítás a 1. felvételi csatornához.

CH2 Input
Level

0 – 99 49 Bemenőszint állítás a 2. felvételi csatornához.

CH3 Input
Level

0 – 99 49 Bemenőszint állítás a 3. felvételi csatornához.

CH4 Input
Level

0 – 99 49 Bemenőszint állítás a 4. felvételi csatornához.

Master Input
Level

0 – 99 99 A master bemeneti hangszint beállítására szolgál.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Limiter jellemzők kiválasztása nagy bemenőjeleknél, a
hang bemenőszint kézi állítása esetén.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Hangszint állítási üzemmód beállítása az 1. és 2. felvételi
csatornához. Stereo beállításnál az AGC
összekapcsolódik a csatornák között.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Hangszint állítási üzemmód beállítása a 3. és 4. felvételi
csatornához. Stereo beállításnál az AGC
összekapcsolódik a csatornák között.

AGC Spec
−6dB / −9dB /
−12dB / −15dB /
−17dB

−6dB AGC jellemzők választása.

1kHz Tone on
Color Bars

On / Off Off

Az 1 kHz-es referencia hangjel be/ki kapcsolása színsávok
megjelenítésekor.

Megjegyzés

[On] beállításakor az 1 kHz-es referencia hangjel van
beállítva felvételre a 3. és 4. csatornán, akkor is, ha a
[CH3 Input Select] és a [CH4 Input Select] beállítása [Off].
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Audio Output

Hangkimeneti beállítások.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Hangcsatornák kombinációjának beállítása a
HDMI/streamelés kimeneten.
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Display Clip Properties

A klipek tulajdonságait kijelző képernyő megjelenítése.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Display Clip
Properties

– –
A klipek tulajdonságait kijelző képernyő
megjelenítése.
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Set Clip Flag

Klipjelölő beállítások megadása.
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Add OK – – OK jelölő hozzáadása.

Add NG – – NG jelölő hozzáadása.

Add KEEP – – KEEP jelölő hozzáadása.

Delete Clip Flag – – Minden jelölő törlése.
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Lock/Unlock Clip

Klipvédelmi beállítások megadása.
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Select Clip – – Klip kiválasztása és zárolása/feloldása.

Lock All Clips – – Minden klip zárolása.

Unlock All Clips – – Minden klip feloldása.
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Delete Clip

Klipek törlése.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Select Clip – – A kiválasztott klip törlése.

All Clips – – Minden klip törlése.
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Transfer Clip

Klipek átvitele.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Select Clip – – Kiválasztott klipek átvitele.

All Clips – –

Minden klip átvitele.

Megjegyzés

Legfeljebb 200 átviteli feladat regisztrálható.
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Transfer Clip (Proxy)

Proxy klipek átvitele.
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Select Clip – – A kiválasztott klipeknek megfelelő proxy klipek átvitele.

All Clips – –

Az összes klipnek megfelelő proxy klipek átvitele.

Megjegyzés

Legfeljebb 200 átviteli feladat regisztrálható.
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Filter Clips

Megjelenítendő klipek beállításainak megadása.
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OK – – Csak OK jelölős klipek megjelenítése.

NG – – Csak NG jelölős klipek megjelenítése.

KEEP – – Csak KEEP jelölős klipek megjelenítése.

None – – Csak jelölő nélküli klipek megjelenítése.

All – – Minden klip megjelenítése, függetlenül jelölésüktől.
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Customize View

A miniatűrök képernyőjének kapcsolása.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
A miniatűrök alatt megjelenő
információk kapcsolása.
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Color Bars

Színsáv beállítások megadása.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Setting On / Off Off A színsávok be/ki kapcsolása.

Type ARIB / 100% / 75% / SMPTE ARIB A színsáv típusának kiválasztása.
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Genlock

A genlock állapotkijelzés konfigurálására szolgál (lásd: „A videojel fázisának szinkronizálása (Genlock)”).

Kapcsolódó témák

A videojel fázisának szinkronizálása (Genlock)
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Reference
Internal / External(HD) /
External(SD)

–
A Genlock referenciajel típusának
megjelenítésére szolgál.
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Tally

A felvétel/állapot jelzőlámpa beállítások megadására szolgál („Tally jel csatlakoztatása”).

Kapcsolódó témák
Tally jel csatlakoztatása

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Tally Lamp
Brightness

High / Low /
Off

High A felvétel/állapot jelzőlámpa fényereje.

G Tally Lamp
Enable /
Disable

Enable A G állapot jelzőlámpát engedélyezi/tiltja le.

Tally Control External /
Internal

Internal

Az egység felvétel/állapot jelzőlámpa-vezérlő információi
fogadási célhelyének kiválasztására szolgál.
External: tally vezérlés a kamerán kívülről.
Internal: vezérlés a kamera felvételi működése útján.
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Interchangeable Lens Digital Camera
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Rec Review

A felvétel megtekintése beállításai (lásd: „A felvétel megtekintése (Rec Review)”).

Kapcsolódó témák

A felvétel megtekintése (Rec Review)
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Setting 3s / 10s / Clip 3s
Imént felvett klipek megtekintésénél a lejátszási idő
kiválasztása.

359



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zoom

Zoom beállítások megadására szolgál („A Zoom beállítása”).
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only A zoomolás típusának beállítása.
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Lens

Az objektívekkel kapcsolatos beállítások megadása.

Kapcsolódó témák

Légzéskompenzálás
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Lens Calibration Execute / Cancel –
A motorzoomos objektívek egyéni eltérései miatti
zoom helyzet szóródást kiküszöbölő funkciót
futtatja.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

A zoomgyűrű működési irányának beállítása.

Megjegyzés

Csak zoomgyűrű irányváltást támogató E-
bajonettes objektív használatakor van
engedélyezve.

Shading
Compensation

Auto / Off Auto
Az automatikus árnyékolás-kompenzálás be/ki
kapcsolása.

Chroma
Aberration Comp.

Auto / Off Auto
Az automatikus színeltérés-kompenzálás be/ki
kapcsolása.

Distortion Comp. Auto / Off Auto
Az automatikus torzítás-kompenzálás be/ki
kapcsolása.

Breathing
Compensation

Auto / Off Off
Az objektív légzéskompenzáció beállítása.

Lásd: „Légzéskompenzálás”.

Distance Display Meter / Feet Meter
Objektívadatok és fókuszhelyzet kijelzés
mértékegységének beállítása.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length
Zoom helyzet megjelenítési formátumának
beállítása.
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APR

APR végrehajtása.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

APR
Execute /
Cancel –

Az APR (Automatic Pixel Restoration, automatikus képpont visszaállítás)
futtatása a képérzékelő automatikus állításához.
Execute: a végrehajtás funkció.

Megjegyzés

Az APR futtatása előtt mindenig helyezze fel az objektív védősapkáját.
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Wired LAN

Vezetékes hálózati kapcsolatokra vonatkozó beállítások megadása.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

HTTP Port – 80 Megjeleníti a HTTP elérési portot.

Detail
Settings

– –
Megjeleníti a vezetékes helyi hálózati kapcsolat
tulajdonságait.

DHCP
On / Off

On
Megjeleníti a DHCP engedélyezett (On) vagy kikapcsolt (Off)
állapotát.

IP Address – Az egység IP-címét jeleníti meg, ha [DHCP] beállítása [Off].

Subnet Mask –
Az egység alhálózati maszkját jeleníti meg, ha [DHCP]
beállítása [Off].

Gateway –
Az alapértelmezett átjárót jeleníti meg, ha [DHCP] beállítása
[Off].

DNS Auto
On / Off

On Megjeleníti a DNS automatikus meghatározási beállítását.
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File Transfer

A fájlátvitelekkel kapcsolatos beállítások megadására szolgál (lásd: „A fájlátvitelről”).

Kapcsolódó témák

A fájlátvitelről
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Auto Upload
(Proxy)

On / Off Off Proxy fájlok automatikus feltöltését kapcsolja be/ki.

Default
Upload Server

Server Settings1
– 3 > Display
Name

–

Fájlok feltöltési szerverének kiválasztása. Az itt kiválasztott
szerver lesz proxy fájlok és a miniatűrök képernyőjén
szereplő fájlok automatikus feltöltési célhelye.
Megjeleníti a [Display Name] [Server Settings1 – 3] alatt
konfigurált beállításait.

Clear
Completed
Jobs

Execute / Cancel –
Elvégzett átviteli feladatok törlése a listáról.
Execute: a végrehajtás funkció.

Clear All Jobs Execute / Cancel –
Minden átviteli feladat törlése a listáról.
Execute: a végrehajtás funkció.

View Job List – – Az átviteli feladatok listájának megjelenítése.

364



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Language

A képernyő nyelvének beállítása.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Select – –
A képernyő nyelvének beállítása.
Set: az érték beállítása.
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Clock Set

Belső óra beállítások megadása.

Megjegyzés

Ha ezt a beállítást a kameramenüből módosítja, utána kapcsolja ki az egység áramellátását, és indítsa újra az egységet. Váratlan
viselkedés fordulhat elő, ha a készenléti állapotot az infra távvezérlővel vagy a webes alkalmazással kezdeményezik.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Time
Zone

UTC − 12:00 – UTC +
14:00

–
Az UTC-től mért időeltérés beállítása, 30 perces
egységekben.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Dátumok megjelenítési formátumának
kiválasztása.
YYMMDD: év, hónap, nap
MMDDYY: hónap, nap, év
DDMMYY: nap, hónap, év

12H/24H 12H / 24H 24H
Az óra megjelenítési formátumának kiválasztása.
12H: 12-órás üzemmód
24H: 24-órás üzemmód

Date – –
Az aktuális dátum beállítása.
Set: az érték beállítása.

Time – –
Az aktuális idő beállítása.
Set: az érték beállítása.
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Hours Meter

A felhalmozott üzemidő megjelenítése.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Hours(System) – –
A felhalmozott üzemóraszám megjelenítése (nem állítható
vissza).

Hours(Reset) – –
A felhalmozott üzemóraszám megjelenítése
(visszaállítható).

Reset
Execute /
Cancel

–
Visszaállítja 0-ra a felhalmozott üzemidő értékét.
Execute: a végrehajtás funkció.

367



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ISO/Gain beállítások és alapértelmezett értékek

Az [ISO/Gain<L>] beállítások és alapértelmezett értékek tartománya a [Mode], [Base Look] > [Select] és [Base
Sensitivity] beállításoktól függ.
Az alapértelmezett beállítások félkövéren vannak szedve a táblázatokban.

Amikor a [Mode] beállítása [ISO]

Ha [Base Look] > [Select] beállítása [S-Cinetone], [Standard], [ITU709], [709tone] vagy [Still]

Ha [Base Look] > [Select] beállítása [HLG Live] vagy [HLG Natural]

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[Low]

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ha a [Base Look] > [Select] beállítása [User1] – [User16]

Amikor a [Mode] beállítása [dB]

−3dB és +30dB közötti érték konfigurálhatók, 1 dB lépésekben.
Az alapértelmezés 0dB.
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Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[Low]

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[Low]

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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AGC Limit beállítások és alapértelmezett értékek

Az [AGC Limit] menü beállításainak és alapértelmezett értékeinek tartománya a [Mode], [Base Look] > [Select] és [Base
Sensitivity] beállításoktól függ.
Az alapértelmezett beállítások félkövéren vannak szedve a táblázatokban.

Amikor a [Mode] beállítása [ISO]

Ha [Base Look] > [Select] beállítása [S-Cinetone], [Standard], [ITU709], [709tone] vagy [Still]

Ha [Base Look] > [Select] beállítása [HLG Live] vagy [HLG Natural]

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[Low]

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ha a [Base Look] > [Select] beállítása [User1] – [User16]

Amikor a [Mode] beállítása [dB]

3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB érték választható.
Az alapértelmezés 15dB.
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Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[Low]

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[Low]

Ha az [ISO/Gain/EI] > [Base Sensitivity] beállítása
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Az egyes felvételi üzemmódokhoz elmentett képminőség beállítások

A képminőséggel kapcsolatos konfigurációs elemek aktuális állapota elmentődik a következő felvételi üzemmódok
mindegyikénél. A felvételi üzemmód megváltoztatásakor a kamera a cél felvételi üzemmódra elmentett megfelelő
beállításokat alkalmazza.

Custom üzemmód SDR(BT.709) cél megjelenítése
Custom üzemmód HDR(HLG) cél megjelenítése
Log felvételkészítés (Cine EI, Cine EI Quick, Flexible ISO)

Az egyes felvételi üzemmódokhoz a képminőséggel kapcsolatban elmentett konfigurációs elemek a következő
táblázatokban láthatók.
Az „Igen” elmentett, a „Nem” nem elmentett beállítást jelöl. A több oszlopot átfogó „Igen” közös beállításokat jelöl.

Elem

Felvételi üzemmód

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Shooting
menü

ISO/Gain/EI

ISO/Gain Igen1) Igen Nem

Exposure Index Nem Nem Igen Igen

Base Sensitivity Igen Nem

Base ISO Nem Igen4) Nem3) Igen4)

White
Preset White Igen Igen

A fentiektől eltérő Igen

White Setting Igen

Offset White Igen Nem

LUT On/Off Nem Igen

Noise
Suppression

Setting(Custom) Igen Igen Nem

Level(Custom) Igen Igen Nem

Setting (Cine
EI/Flex. ISO) Nem Igen

Level (Cine EI/Flex.
ISO)

Nem Igen
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Elem

Felvételi üzemmód

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Paint/Look
menü

Base Look

Select Igen Igen Igen

Input2) Igen

Output2) Igen

AE Level Offset2) Igen

Black Igen Igen Nem

Knee
Auto Knee Igen Nem Nem

A fentiektől eltérő Igen Igen Nem

Detail Igen Igen Nem

Matrix Igen Igen Nem

Multi Matrix Igen Igen Nem

Külön ISO érzékenység beállítások vannak elmentve a Custom SDR(BT.709) és HDR(HLG) üzemmódra.1)

A beállítások minden bázismegjelenéshez el vannak mentve és függetlenek a felvételi üzemmódtól.2)

A Base ISO érzékenység az Exposure Index-szel együtt változik.3)

Közös beállítási érték a Flexible ISO és Cine EI felvételi üzemmódban.4)
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A webes menü felépítése

A beállító képernyő megjelenítéséhez nyomja meg a [Settings] művelet képernyő kapcsoló fület.
A beállító képernyőn az egység beállítási elemei (pl. kezdeti beállítások, hálózati beállítások, felvételkészítési/lejátszási
beállítások) konfigurálhatók, a webes menüvel.

A menü a következő menüket tartalmazza.

A menü konfigurációja és hierarchiája

1. szint Az 1. szint leírása 2. szint

Shooting A felvételkészítéshez tartozó beállításokat tartalmazza. Focus
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1. szint Az 1. szint leírása 2. szint

Project A projekt alapbeállításait tartalmazza.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look A képminőséggel kapcsolatos beállításokat tartalmazza. Base Look

Pan-Tilt A pásztázó/döntő mozgásokra vonatkozó beállításokat tartalmazza.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
A videó kimenettel és a képernyős megjelenítéssel kapcsolatos
beállításokat tartalmazza.

Output Format

Output Display

Audio A hanggal kapcsolatos beállításokat tartalmazza. Audio

Technical A technikai elemek beállításait tartalmazza.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network A hálózatokkal kapcsolatos beállításokat tartalmazza.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection
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Megjegyzés

Az [Accessibility] csak Észak-Amerika számára készült modelleken érhető el.

5-041-958-53(1) Copyright 2022 Sony Corporation

1. szint Az 1. szint leírása 2. szint

Stream A streameléshez tartozó beállításokat tartalmazza.

Stream

Video Stream

Audio Stream

Maintenance Az eszköz beállításait, pl. óra és nyelv, tartalmazza.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software

376



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Webes menü műveletek

A beállító képernyő megjelenítéséhez nyomja meg a [Settings] művelet képernyő kapcsoló fület az egység beállítási
elemei (pl. kezdeti beállítások, hálózati beállítások, felvételkészítési/lejátszási beállítások) konfigurálásához a webes
menüvel.
Konfigurálja a beállításokat táblagép webes menüjén érintéses műveletekkel vagy számítógépen egérműveletekkel.
Nyomja meg a konfigurálandó elemekhez tartozó menüt az elemek és beállításaik megjelenítéséhez.

Konfigurálási mód

Értékválasztás

1. szintű menü1.

2. szintű menü2.

Beállítások3.

377



Nyomja meg egy elem választógombját. Kiválasztott elem választógombja narancssárga színű.

Elem be/ki kapcsolása

Elem be/ki kapcsolásához nyomja meg a kapcsolóját. Az elem bekapcsolt állapotban narancssárga, kikapcsolt
állapotban fehér színű.

Értékválasztás listáról

Nyomja meg a legördítő gombot és a megjelenő menün válasszon elemet.

Számérték választás

A < vagy > gombbal módosítsa a számértéket. Ha alá van húzva a számérték, akkor közvetlenül be is írhat más
számértéket.

Karakter/szám beírása

Konfigurálás külön képernyőn
Nyomja meg a gombot a beállítások külön képernyőn való megadásához.

Tájékoztató üzenet

Egyes beállítások konfigurálását segítő információk és a felhasználó figyelmét felhívó üzenetek jelennek meg.

Beállítás elmentése

Ha elkészült egy beállítással, mentse el az [OK] gomb megnyomásával.
A [Cancel] gombbal eldobhatja a beállítás módosítását és visszatérhet az előző beállításra.
A képernyőkijelzés frissítéséhez nyomja meg a [Reload] gombot.

Megjegyzés

Ha egy beállítás elmentése előtt nyomja meg a [Reload] gombot, a beállítás módosítása elveszik.

Ha a beállítás elmentése előtt mási oldalra lép, a beállítás módosításai elvesznek.
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Focus

A fókusz beállítások megadására szolgál.

Kapcsolódó témák

Az automatikus fókuszálási célpont kézi beállítása (AF Assist) a webes alkalmazással
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Push AF
Mode

AF / Single-
shot AF(AF-S)

AF Gombnyomásos automatikus fókuszáló üzemmód beállítása.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Beállítja, hogy mi történjen a kamerakép képernyő
megérintésekor MF üzemmódban.

AF Assist
Control

On / Off On

Ha [On] értékre van állítva, automatikus fókuszálás közben a
webes alkalmazás fókusz csúszkájával módosíthatja a
fókuszhelyzetet.

Részletek: „Az automatikus fókuszálási célpont kézi
beállítása (AF Assist) a webes alkalmazással”.

Megjegyzés

Ez az elem csak akkor engedélyezett, ha a kameramenü [AF
Assist] pontjának beállítása [On].
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Base Setting

Bázisbeállítások megadására szolgál.

Kapcsolódó témák

Alapvető használati konfigurálás
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

A felvételi üzemmódot állítja.

Lásd: „Felvételi üzemmód” „Alapvető
használati konfigurálás” cím alatt.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
A felvétel/kimenet színterjedelmét állítja be
Custom üzemmódban.
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Rec Format

Felvételi formátum beállítások.

[RAW Output Format] beállítások

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Frequency
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59.94

Rendszerfrekvencia.

Megjegyzés

A frekvencia átállítását követően a kamera
újraindul. Az újraindítást követően töltse be
újra az oldalt a webböngészőben.

Imager Scan
Mode

FF / S35 FF Az imager méret kiválasztása.

Codec RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

A klip felvételi/lejátszási kodek beállítása.

Megjegyzés

Ha az [Imager Scan Mode] beállítása [S35],
[RAW] és [RAW & XAVC-I] nem választható.

RAW Output
Format

A választható beállítások a
[Frequency] beállítástól függnek.

Lásd: „[RAW Output Format]
beállítások”, lent.

–

Külső RAW felvevőre kiadott RAW kép
méretének méretét állítja.

Megjegyzés

Ha a [Codec] beállítása [RAW & XAVC-I], a
[Video Format] beállítás a [RAW Output
Format] beállítással összhangban
kapcsolódik.

Video
Format

A választható beállítások a
[Frequency], [Imager Scan Mode]
és [Codec] beállítástól függnek.

Lásd: „[Video Format]
beállítások”, lent.

– A képméret beállítása.

Frequency Imager Scan Mode Codec Beállítás

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Az alapértelmezett beállítások félkövéren vannak szedve.
Nincsenek feltüntetve azok a körülmények, amelyek esetén nem állítható a [RAW Output Format].

[Video Format] beállítások

Az alapértelmezett beállítások félkövéren vannak szedve.
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Frequency Imager Scan Mode Codec Beállítás

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

A 2-memóriakártyás egyidejű felvételi üzemmód beállítására szolgál (lásd: „Egyidejű rögzítés az „A” és „B”
memóriakártyára (2-slot Simul Rec)”).

Kapcsolódó témák

Egyidejű rögzítés az „A” és „B” memóriakártyára (2-slot Simul Rec)
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting On / Off Off
Az egyidejű felvételi funkció be/ki kapcsolása és a felvételi
cél-adathordozó beállítása.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Megjeleníti az egyes felvételi adathordozókhoz rendelt
felvételi gombokat.
A kameramenü [Project] > [Simul Rec] > [Rec Button Set]
pontját állítja be.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

A proxy felvételi üzemmód beállítására szolgál (lásd: „Proxy felvétel”).
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Setting On / Off Off A proxy felvételi üzemmód be/ki kapcsolása.
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Interval Rec

Az Interval Recording felvételi üzemmód beállítására szolgál (lásd: „Szakaszos videofelvétel készítés (Interval Rec)”).

Kapcsolódó témák
Szakaszos videofelvétel készítés (Interval Rec)
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Setting On / Off Off

Az Interval Recording üzemmód be/ki
kapcsolása. (Ennek az üzemmódnak
az On értékre állítása Off értékre állít
minden más speciális üzemmódot.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (másodperc)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (perc)
1 / 2 / 3 / 4 / 6 / 12 / 24 (óra)

1
Interval Rec felvételi üzemmódban a
felvételek közötti időköz (ha az
Interval Rec beállítása On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
A választható beállítások készlete a
kiválasztott videoformátum
képfrekvenciájától függ.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Interval Rec felvételi üzemmódban az
egyes felvételek képkocka száma (ha
az Interval Rec beállítása On).
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Picture Cache Rec

A kép gyorsítótár rögzítési üzemmódjának állítására szolgál (lásd: „Gyorsítótárazott képek rögzítése (Picture Cache
Rec)”).

Kapcsolódó témák

Gyorsítótárazott képek rögzítése (Picture Cache Rec)
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting On / Off Off Be/ki kapcsolja a kép gyorsítótár funkciót.

Cache Size
Short / Medium /
Long / Max

Max
Beállítja a képek felhalmozási idejét a kép gyorsítótár
memóriában (a kép gyorsítótár rögzítési idejét).

Cache Rec
Time

– –
Megjeleníti a képek felhalmozási idejét a kép gyorsítótár
memóriában (a kép gyorsítótár rögzítési idejét).
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Interchangeable Lens Digital Camera
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All File

ALL fájl műveleteket végez (lásd: „Konfigurációs adatok elmentése és betöltése”).
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Load All
File

– –

ALL fájlt tölt az egységbe a webes alkalmazást futtató eszközről.

Megjegyzés

Az ALL fájl egységbe töltését követően az egység újraindul. Az
újraindítást követően töltse be újra az oldalt a webböngészőben.

Save All
File

– –
ALL fájlként a webes alkalmazást futtató eszközre menti az egység
beállításait.
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Interchangeable Lens Digital Camera
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Base Look

Az egységbe bázismegjelenés tölthető.
A képernyőn megjelenik a választható bázismegjelenések listája. A pillanatnyilag alkalmazott bázismegjelenést a
bázismegjelenés szám bal oldalán feltüntetett ● marker jelöli.

[No.]: a bázismegjelenés száma
[Base Look Name]: a bázismegjelenés neve
[Input]: a bázismegjelenés bemenőjele
[Output]: a bázismegjelenés kimenőjele
[AE Level Offset]: a bázismegjelenés expozíciós hivatkozási értéke

Bázismegjelenés hozzáadása
Új bázismegjelenés importálásához nyomja meg az [Import] gombot. Kövesse a képernyőn megjelenő utasításokat.
Az importálást követően adjon megfelelő értéket az [Input], [Output] és [AE Level Offset] paraméternek. Részletek:
„Kívánt bázismegjelenés importálása”.

Kapcsolódó témák
Kívánt bázismegjelenés importálása

5-041-958-53(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Speed

A pásztázó/döntő mozgatás sebességével kapcsolatos beállítások megadására szolgál.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Speed
Step

Normal /
Extended

Extended

A pásztázó/döntő hajtás gyorsasági fokozatainak számát állítja.
Normal: a gyorsaság 24-lépéses tartományban adható meg. Ezt a
beállítást a meglévő Sony távvezérelt kamerákkal való
kompatibilitáshoz használja.
Extended: a gyorsaság 50-lépéses tartományban adható meg.

Speed
Mode

Normal /
Slow

Normal

A pásztázó/döntő hajtás gyorsasági üzemmódját állítja.
Csak akkor engedélyezett, ha [Speed Step] beállítása [Normal].
Normal: normál gyorsaság-tartományban működik (minimumtól
maximumig (60 fok/másodperc)).
Slow: kis gyorsaság-tartományban működik (minimumtól maximumig
(40 fok/másodperc)).
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Acceleration

A pásztázó/döntő mozgatás sebességével kapcsolatos beállítások megadására szolgál.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Acceleration 1 – 9 8
Pásztázó/döntő műveletek gyorsulásának kiválasztására szolgál.
A nagyobb szám nagyobb gyorsulást jelent.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Range Limit

A pásztázási/döntési tartomány korlátozásával kapcsolatos beállítások megadására szolgál.
A pásztázási/döntési tartomány korlátai a következő képernyőn állíthatók be.

Megjegyzés

Az egység figyelmen kívül hagyja ezt a tartománykorlátozást a bekapcsolás és a pásztázás/döntés visszaállítása után. Ez a
funkció nem használható az egység körüli akadályok kikerülésére.

Állítsa a [Setting] kapcsolót on (be) helyzetbe.

Ez engedélyezi a pásztázási/döntési tartomány korlátozási funkcióját.

1

Ellenőrizze a képet a kamera pásztázó/döntő kezelőszerveivel.2

A korlátozási pontok beállításához a beállítandó pontokban nyomja meg a [Left], [Right], [Up], [Down] > [Set
Current Value] gombot.

[Left]: a kamera bal oldala
[Right]: a kamera jobb oldala
[Up]: a kamera teteje

3
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Megjegyzés

Korlátpontokon kívüli kamerahelyzetek nem menthetők el előbeállításként.

A [Pan-Tilt] > [P/T Direction] > [Ceiling] beállítás módosítása visszaállítja gyári alapértelmezésre a beállított korlátpontokat.

A beállítás nem módosítható lejátszás és miniatűr kijelzése közben, pásztázási/döntési hiba esetén, valamint, ha a
pásztázás/döntés nincs inicializálva vagy zárolva van.
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[Down]: a kamera alja

A korlátozási pontok ezzel beállítódnak és számértékük (szöghelyzetük) megjelenik.
Korlát feloldásához nyomja meg a feloldandó pontok [Reset] gombját.

Nyomja meg a [OK] gombot.

A pásztázó/döntő mozgás a korlátpontok közötti területre korlátozódik.

4
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Direction

A pásztázási/döntési iránnyal kapcsolatos beállítások megadására szolgál.

Megjegyzés

Módosított [Ceiling] beállítás alkalmazásakor minden előbeállított helyzet törlődik, mert a pásztázási/döntési koordináták
megfordulnának.

A pásztázó/döntő hajtás mozgástartománya a [Ceiling] beállítástól függően az alábbi ábra szerint változik.

A: ha a [Ceiling] beállítása [Off]
B: ha a [Ceiling] beállítása [On]
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Ceiling On / Off Off
Az egység asztalra szerelésekor állítsa [Off] értékre. Az egység
mennyezetre szerelésekor állítsa [On] értékre. Ha a [Ceiling] beállítása
[On], [Pan Direction] beállítása automatikusan [Opposite] lesz.

Pan
Direction

Normal /
Opposite

Normal
A pásztázó hajtás pásztázási irányát állítja. A beállítás módosítása
megfordítja a hajtás irányát.

Tilt
Direction

Normal /
Opposite

Normal A döntő hajtás döntési irányát állítja. A beállítás módosítása
megfordítja a hajtás irányát.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Preset

A kamera előbeállításokkal kapcsolatos beállítások megadására szolgál.

Pan-Tilt
Az előbeállítások sebességének megadására szolgál.

Default
Előbeállított helyzet elmentésekor konfigurált alapértelmezett értékek beállítása.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Itt adható meg, hogy az előbeállított gyorsaságok külön-külön
legyenek-e konfigurálva vagy közös beállítás vonatkozzon-e
rájuk.

Pan-Tilt Speed
for Common

1 – 50 50

Az előbeállítások közös sebességének megadására szolgál.

Megjegyzés

25 vagy nagyobb érték megadásakor legfeljebb 24 lesz a
hajtási gyorsaság, ha a [Pan-Tilt] > [P/T Speed] > [Speed
Step] beállítása [Normal].

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Pan-Tilt Speed
for Separate

1 – 50 50
Az előbeállítások sebességének megadása, ha az előbeállított
sebesség választási módja [Separate].

Zoom Sync On / Off On
Annak megadása, hogy előbeállított helyzet visszaállításakor
szinkronban működjön-e a pásztázás/döntés és a zoomolás.

Zoom Speed 0 – 32767 32767 A zoomolási sebesség beállítása.

Focus Recall On / Off On
Annak megadása, hogy visszaállítódjanak-e a
fókuszbeállítások.

MF Speed 0 – 32767 32767 A kézi fókuszálás sebességének beállítása.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Format

Kimeneti formátum beállítások megadása.

Kapcsolódó témák

Kimeneti formátumok és korlátozások
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

SDI Beállítások részletei: „Kimeneti formátumok
és korlátozások”.

– Az SDI és HDMI kimenet
felbontásának beállítása.HDMI –
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Display

A kimenőjelekkel kapcsolatos beállítások megadására szolgál.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

SDI On / Off Off Itt állítható be a menü és állapot SDI kimenőjelbe ágyazása.

HDMI/Stream On / Off On

Itt állítható be a menü és állapot HDMI kimenőjelbe ágyazása.

Megjegyzés

Ez a beállítás egyaránt vonatkozik a HDMI kimenőjel, a streamelt
kimenőjel és a webes alkalmazás kamerakép-panel képére.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Input

A CH1 – CH4 hangbemenetre vonatkozó beállítások.

A master bemeneti hangszint beállítására szolgál. A master bemeneti hangszint az 1. – 4. csatornára együtt vonatkozik.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Level
Control

Auto / Manual Auto
Automatikus vagy kézi hang bemenőszint
állítás választása.

Level 0 – 99 49 A bemenőszint beállítása.

Input
Select

AUDIO IN CH1 / AUDIO IN
CH2 / Off

CH1 és CH3: AUDIO IN
CH1
CH2 és CH4: AUDIO IN
CH2

A hangbemenet forrását állítja.

Megjegyzés

CH1 beállítása [AUDIO IN CH1] (rögzített).

Wind Filter On / Off Off A szélzajcsökkentő szűrőt kapcsolja be/ki.

Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Master 0 – 99 99 A master bemenőszint beállítása.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

A hang kimenettel kapcsolatos beállítások megadása.

Megjegyzés

Ez a beállítás a streamelt hang kimenőjelre is vonatkozik.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Hangcsatornák kombinációjának beállítása a
HDMI/streamelés kimeneten.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tracking Data Output

A követési információk (free-d protokollal kompatibilis) outputjával kapcsolatos beállítások megadására szolgál.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Transfer Mode
Off / Always /
On Demand

Off A követési információ output módszer kiválasztása.

Camera ID 0 – 255 255 Az egység ID azonosítójának beállítására szolgál.

Destination
Address

IPv4 cím –
Ha [Transfer Mode] beállítása [Always], a követési
információk célhelyének IP-címét állítja be.

Destination
Port

1024 – 65534 40000 Ha a [Transfer Mode] beállítása [Always], a követési
információk célhelyének portszámát állítja be.

Listen Port 1024 – 65534 40000
Ha a [Transfer Mode] beállítása [On Demand], az
ügyfelektől érkező kéréseket fogadó egység portszámát
állítja be.

400



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

A felvétel/állapot jelzőlámpa beállítások megadására szolgál („Tally jel csatlakoztatása”).

Kapcsolódó témák

Tally jel csatlakoztatása
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Tally Lamp
Brightness

High / Low /
Off

High A felvétel/állapot jelzőlámpa fényereje.

G Tally Lamp
Enable /
Disable

Enable A G állapot jelzőlámpát engedélyezi/tiltja le.

Tally Control
External /
Internal

Internal
Az egység felvétel/állapot jelzőlámpa-vezérlő információi
fogadási célhelyének kiválasztására szolgál.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

IR Remote

A infra távvezérlővel kapcsolatos beállítások megadására szolgál.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Setting On / Off On
Engedélyezi/letiltja az egység működtetését az infra
távvezérlőről.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

RCP/MSU

Beállítás konfigurálása RCP/MSU (különtartozék) csatlakoztatása esetén.
Részletek: „RCP/MSU (különtartozék) csatlakoztatása”.

Megjegyzés

Szükség szerint konfigurálja a beállításokat az RCP/MSU eszközön.

Többkamerás rendszerhez MSU szükséges.

Több MSU egység használatakor állítson be egyet masterként, és az összes többit ügyfélként állítsa be.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

CNS Mode
Off / Bridge / MCS /
PC Control

Off Az RCP/MSU csatlakozási módjának beállítása.

Master IP
Address

IPv4 cím 0.0.0.0
A master eszköz IP-címének beállítása LAN-alapú
többkamerás rendszer kialakításakor.

Camera No. Camera No. (1–96) 1 Egyedi kameraszám beállítása a rendszerben LAN-alapú
többkamerás rendszer kialakításakor.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lens Controller

A csatlakoztatott objektívvezérlő (különtartozék) beállításainak megadására szolgál.
Részletek: „Objektívvezérlő csatlakoztatása”

Megjegyzés

[Setting] módosítását követően az egység újraindul. Töltse be újra az oldalt a webböngészőben.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Setting On / Off Off
Itt állítható be, hogy használni fogják-e az objektívvezérlőt
(különtartozék).

Mode 0 – 15 0

Az objektívvezérlő (különtartozék) üzemmódjának megadása.
0 és 15 közötti értékek állnak rendelkezésre, de a ténylegesen
választható értékek az objektívvezérlőtől (különtartozék) függnek.
Részletek az objektívvezérlő kezelői utasításaiban találhatók.

Reverse On / Off Off Megfordítja objektívvezérlő (különtartozék) forgásirányát.

Initialize – – Inicializálja az objektívvezérlőt (különtartozék).
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Camera Name

A kamera (az egység) nevével kapcsolatos beállítások megadása.

A következő karakterekből legfeljebb nyolc (0–8) írható be Camera Name-ként.
Alfanumerikus karakterek
Szimbólumok (szóköz !#$`*+-./;<=>?@[\]^_`{|})

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Camera Name – FR7 A kamera nevének beállítására szolgál.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

User

Az egység felhasználói elérhetőségével kapcsolatos beállítások megadása.

Rendszergazda (Administrator) felhasználók beállításai (kötelezőek)

Általános felhasználók (User 1 – User 9) beállításai (igény szerint)
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

User Name – admin Írja be a felhasználónevet.

Current Password – – Jelszó módosításakor írja be a pillanatnyi jelszót.

New Password – – Írja be az új jelszót.

Re-Type Password – – Megerősítésként írja be ismét az új jelszót.

Elem Alpont beállítás Gyári alapértelmezés Magyarázat

User Name – – Írja be a felhasználónevet.

Current Password – – Jelszó módosításakor írja be a pillanatnyi jelszót.

New Password – – Írja be az új jelszót.

Re-Type Password – – Megerősítésként írja be ismét az új jelszót.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wired LAN

Status
A hálózati állapotát jeleníti meg.

IPv4
A IPv4 hálózattal kapcsolatos beállítások megadására szolgál.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Host Name – – Az állomásnevet jeleníti meg.

MAC Address – – Az egység MAC címét jeleníti meg.

Ethernet Status – –
A pillanatnyi kommunikációs sebességet jeleníti
meg.

IP Address – – Az egység IP-címét jeleníti meg.

Subnet Mask – – Az egység alhálózati maszkját jeleníti meg.

Gateway – –
Az egység alapértelmezett IPv4 átjáróját jeleníti
meg.

Primary DNS Server – – Az egység elsődleges DNS szerverét jeleníti meg.

Secondary DNS
Server

– –
Az egység másodlagos DNS szerverét jeleníti
meg.

IPv6 Address 1 – – Az egység 1. IPv6 címét jeleníti meg.

IPv6 Address 2 – – Az egység 2. IPv6 címét jeleníti meg.

IPv6 Gateway – –
Az egység alapértelmezett IPv6 átjáróját jeleníti
meg.

Link-local IPv6
Address

– – Az egység IPv6 link-helyi címét jeleníti meg.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

DHCP On / Off On A [DHCP] funkció be/ki kapcsolása.

IP Address – – Az IPv4 cím megadása, ha a [DHCP] beállítása Off.

Subnet
Mask – – Az alhálózati maszk megadása, ha [DHCP] beállítása Off.

Gateway – –
Az alapértelmezett IPv4 átjáró megadása, ha a [DHCP]
beállítása Off.
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IPv6
A IPv6 hálózattal kapcsolatos beállítások megadására szolgál.

Common
IPv4/IPv6 hálózatok közös beállításainak megadására szolgál.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Obtain an IP Address
Automatically

On / Off On
IPv6 cím automatikus beszerzésének be/ki
kapcsolása.

IP Address – –
Az IPv6 címet állítja be, ha az [Obtain an IP Address
Automatically] beállítása Off.

Prefix Length – –
A prefix előtagot állítja be, ha az [Obtain an IP Address
Automatically] beállítása Off.

Gateway – –
Az IPv6 alapértelmezett átjárót állítja be, ha az [Obtain
an IP Address Automatically] beállítása Off.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

HTTP Port
80, 1024 –
65534

80 A HTTP portszám megadására szolgál.

DNS Auto On / Off On
Beállítja, hogy a DNS-címeket a DHCP-kiszolgálótól
kell-e beszerezni.

Primary DNS
Server

IPv4/IPv6 cím –
Az elsődleges DNS szervert állítja be, ha a [DNS Auto]
beállítása Off.

Secondary DNS
Server

IPv4/IPv6 cím –
A másodlagos DNS szervert állítja be, ha a [DNS Auto]
beállítása Off.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

File Transfer

Fájlátátvitellel kapcsolatos beállítások megadása.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Auto
Upload
(Proxy)

On / Off Off Proxy fájlok automatikus feltöltését kapcsolja be/ki.

Default
Upload
Server

Server Settings1 –
3 > Display Name Server Settings1

Fájlok feltöltési szerverének kiválasztása. Az itt kiválasztott
szerver lesz proxy fájlok és a miniatűrök képernyőjén
szereplő fájlok automatikus feltöltési célhelye.
Megjeleníti a [Display Name] [Server Settings1 – 3] alatt
konfigurált beállításait.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

FTP Server 1 – 3

FTP fájlátvitellel kapcsolatos beállítások megadása.
A beállítások közösek az FTP Server 1 – 3-hoz.
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Display Name – –
Az átviteli célhely beállítási menüjében látható
megjelenítési név beállítása.

Service – – A szerver típusának megjelenítése.

Host Name – – Az átviteli célszerver hostnevének beállítása.

Port 21, 990, 1024 –
65534

21 Az átviteli célszerver portszámának beállítása.

User Name – –
A felhasználónév beállítása az átviteli célszerveres
kapcsolat hitelesítéséhez.

Password – –
A jelszó beállítása az átviteli célszerveres kapcsolat
hitelesítéséhez.

Passive Mode On / Off Off A passzív üzemmódot kapcsolja be/ki.

Destination
Directory

– – Az átvitel célkönyvtárának beállítására szolgál.

Using Secure
Protocol

On / Off Off
Biztonságos FTP átvitel használata (On) vagy mellőzése
(Off).

Root Certificate – –

A biztonságos FTP átvitelhez szükséges
gyökértanúsítvány betöltésére szolgál.
Nyomja meg a [Load] gombot és a megjelenő képernyőn
válasszon gyökértanúsítványt.
A betöltött gyökértanúsítvány törléséhez nyomja meg a
[Delete] gombot.

Root Certificate
Status

– – A gyökértanúsítvány betöltési állapotát jeleníti meg.

Reset – –
Alapértelmezettre állítja vissza a [Server Settings]
beállításokat.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

SSL

SSL-el kapcsolatos beállítások megadása.

SSL
Az SSL funkció engedélyezése/letiltása.

SSL Server Authentication
SSL szerver hitelesítésével kapcsolatos beállítások megadására szolgál.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Function
Disable / Enable / Enable (Allow HTTP
connection for some clients)

Disable
Az SSL funkció
engedélyezése/letiltása.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Certificate
Options

Use a self-signed
certificate (For test use)
/ Use an external
certificate

–
Az SSL szerver tanúsítvány telepítési módja
állítható itt be.

Status – –
Megjeleníti az SSL szerver tanúsítvány
érvényességét, ha a [Certificate Options] beállítása
[Use a self-signed certificate (For test use)].

Issuer DN – –

Megjeleníti az SSL szerver tanúsítvány
kibocsátójának megkülönböztető nevét, ha a
[Certificate Options] beállítása [Use a self-signed
certificate (For test use)].

Subject DN – –

Megjeleníti az SSL szerver tanúsítvány alanyának
megkülönböztető nevét, ha a [Certificate Options]
beállítása [Use a self-signed certificate (For test
use)].

Available Period – –

Megjeleníti az SSL szerver tanúsítvány
érvényességi időszakát, ha a [Certificate Options]
beállítása [Use a self-signed certificate (For test
use)].

Extended Key
Usage

– –
Megjeleníti a kibővített kulcshasználat módszerét,
ha a [Certificate Options] beállítása [Use a self-
signed certificate (For test use)].
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Delete – –

Ez a gomb akkor látható, ha a [Certificate Options]
beállítása [Use a self-signed certificate (For test
use)].
Törli a telepített SSL szerver tanúsítványt.

Import – –
Külső SSL szerver tanúsítványt telepít listáról, ha a
[Certificate Options] beállítása [Use an external
certificate].

Private Key
Password

– –
Az SSL szerver tanúsítvány titkos kulcs
információjának jelszavát állítja be, ha a [Certificate
Options] beállítása [Use an external certificate].

Reset – –
Ez a gomb törli a titkos kulcs jelszavának
megjelenítését, új jelszó beírásához.

Self-Signed
Certificate
Generation

– –

Önaláírt tanúsítvány létrehozásához nyomja meg a
[Generate] gombot, ha a [Certificate Options]
beállítása [Use a self-signed certificate (For test
use)].
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Referer Check

A Referer ellenőrzésekkel kapcsolatos beállítások megadása.

Exception List
A Referer ellenőrzési kivétellistával kapcsolatos beállítások megadására szolgál.

Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Setting On / Off On A Referer ellenőrzési funkció engedélyezése/letiltása.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

No. 1 – 10 – A lista kivételszámának megadására szolgál.

Host
Name

– – A kivétel hostnevének beállítására szolgál.

Port
Number

– – A kivétel portszámának beállítására szolgál.

Set – – Nyomja meg a kivétellista konfigurált kivételének regisztrálásához.

Delete – –
Válasszon törlendő kivételt és a gomb megnyomásával törölje a
regisztrált kivételt a kivétellistáról.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Brute Force Attack Protection

Találgatásos támadás megelőzésével kapcsolatos beállítások megadására szolgál.

Támadó észlelésekor megjelenik a támadólista információ.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Setting On / Off On A [Brute Force Attack Protection] funkció be/ki kapcsolása.

Count 3 – 100 8
Annak a beállítására szolgál, hogy hány találgatási próbálkozás
minősüljön támadásnak.
Engedélyezve van, amikor a [Setting] beállítása On.

Release
Mode

Always /
Timer

Timer

A feloldási feltétel megadására szolgál.
Engedélyezve van, amikor a [Setting] beállítása On.
Always: ne törölje a támadólistáról.
Timer: törölje a támadólistáról a [Release Time] alatt beállított
feloldási idő leteltét követően.

Release
Time

30 – 86400 s 60

A feloldási idő.
Engedélyezve van, amikor a [Setting] beállítása On.
Ha a Release Mode beállítása [Timer], a támadólista elemei
törlődnek a feloldási idő leteltét követően.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Stream

A streamelési beállítások megadására szolgál (lásd: „Streamelés”).

Stream Setting
A streamelési protokollal kapcsolatos beállítások megadására szolgál.

Megjegyzés

RTMP használatához előzetesen állítsa [Stream] > [Audio Stream] > [Setting] beállítását [On] értékre.

RTSP
A következő elemek akkor láthatók, ha a [Stream Setting] beállítása [RTSP].
Az RTSP streameléssel kapcsolatos beállítások megadására szolgál.

RTMP
A következő elemek akkor láthatók, ha a [Stream Setting] beállítása [RTMP].
Az RTMP streameléssel kapcsolatos beállítások megadására szolgál.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener /
NDI|HX / Off

RTSP
A streamelési protokoll
kiválasztása.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Port Number
554, 1024 –
65534

554 Az RTSP portszám beállítására szolgál.

Time Out 0 – 600 60 Az RTSP streamelés Keep Alive parancsa időkorlátjának
megadására szolgál.

Authentication On / Off On Az RTSP hitelesítési funkció be/ki kapcsolása.

Video Port
Number 1

1024 – 65534 51000
Az RTSP unicast streameléshez tartozó video 1 adás
portszámának megadására szolgál.

Video Port
Number 2

1024 – 65534 53000
Az RTSP unicast streameléshez tartozó video 2 adás
portszámának megadására szolgál.

Audio Port
Number

1024 – 65534 57000
Az RTSP unicast streameléshez tartozó hang adás
portszámának megadására szolgál.
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SRT
A következő elemek akkor láthatók, ha a [Stream Setting] beállítása [SRT-Caller] vagy [SRT-Listener].
Az SRT streameléssel kapcsolatos beállítások megadására szolgál.

NDI|HX
A következő elemek akkor láthatók, ha a [Stream Setting] beállítása [NDI|HX].
Az NDI|HX-el kapcsolatos beállítások megadására szolgál.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Server URL – –
Az RTMP vagy RTMPS kapcsolat URL célcímének
megadására szolgál.

Stream Key – –
Az RTMP-szerver oldalról kapott stream kulcs beállítására
szolgál.

Root
Certificate

– –

Az RTMP-szerverhez kapcsolódáshoz szükséges
gyökértanúsítványt tölti be.
Nyomja meg a [Load] gombot és a megjelenő képernyőn
válasszon gyökértanúsítványt.
A betöltött gyökértanúsítvány törléséhez nyomja meg a
[Delete] gombot.
Az állapotot a [Root Certificate Status] mutatja.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Destination – –
A kapcsolat célhelye URL címének megadására
szolgál, ha az egység hívóként működik.

Port
Number

1024 – 65534 4201 A figyelési portszám megadására szolgál, ha az
egység figyelőként működik.

Latency 20 – 8000 ms 120 A késés megadására szolgál.

TTL 1 – 255 64 A TTL érték megadására szolgál.

Encryption Off / AES128 / AES256 Off
A titkosítás engedélyezésére/letiltására és a titkosítási
mód megadására szolgál.

Passphrase
0 vagy 10–79 karakterből
álló karakterlánc

0
A titkosítási jelszó megadására szolgál.
A megadott jelszó a Reset megnyomásával törölhető.

ARC On / Off On Az Adaptive Rate Control funkció be/ki kapcsolására
szolgál.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

License – – Az NDI licenckulcs állapotát jeleníti meg.

Source Name – – Az NDI forrás nevét jeleníti meg.

Group On / Off Off Az NDI csoportosító funkciót kapcsolja be/ki.
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Kapcsolódó témák

Streamelés
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Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Group Name – –
Akkor látható, ha az NDI csoportosító funkció beállítása
On.
A csoportnév beállítására szolgál.

Discovery
Server 1

– – Az NDI discovery server 1 beállítására szolgál.

Discovery
Server 2

– – Az NDI discovery server 2 beállítására szolgál.

Multicast Mode On / Off Off Be/ki kapcsolja a csoportcímes streamelést.

Multicast Prefix 239.255.0.0 239.255.0.0
Akkor látható, ha a [Multicast Mode] beállítása On.
A csoportcímes streameléshez használandó előtag
beállítására szolgál.

Multicast
Netmask

255.255.0.0 255.255.0.0
Akkor látható, ha a [Multicast Mode] beállítása On.
A csoportcímes címtartományt meghatározó hálózati
maszk megadására szolgál.

Multicast TTL 1 – 256 3
Akkor látható, ha a [Multicast Mode] beállítása On.
A csoportcímes streamelés TTL értéke megadására
szolgál.

Multi-TCP
Mode

On / Off Off A Multi-TCP üzemmód be/ki kapcsolására szolgál.

Unicast UDP
Mode

On / Off On Az Unicast UDP üzemmód be/ki kapcsolására szolgál.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Video Stream

A streamelési videó kodekekkel kapcsolatos beállítások megadására szolgál.

Video Stream 1
Az 1. videó kodekkel kapcsolatos beállítások megadására szolgál.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Codec 1 H.264 / H.265 H.264
Az 1. kép kodekének beállítására
szolgál.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080
Az 1. kép képméretének
beállítására szolgál.

Frame Rate 1

Részletek a támogatott
képfrekvenciákról: „A streamelési
videó kodek beállítása”.

–
Az 1. kép képfrekvenciájának
beállítására szolgál.

I-Picture Mode 1 Time / Frame Time

A 1. kép IDR-Frame beillesztési
intervalluma megadására szolgál,
idő vagy képkocka
mértékegységben.

I-Picture Interval
1 1 / 2 / 3 / 4 / 5 s 1

Akkor látható, ha a [I-Picture Mode
1] beállítása Time.
A H.264 és H.265 IDR-Frame
beillesztési intervalluma
megadására szolgál idő
mértékegységben.

I-Picture Ratio 1 15 – 300 képkocka 30

Akkor látható, ha a [I-Picture Mode
1] beállítása Frame.
A H.264 és H.265 IDR-Frame
beillesztési intervalluma
megadására szolgál képkocka
mértékegységben.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high
A H.264 vagy H.265 profil
beállítására szolgál.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Az 1. kép bitsebesség
kompressziós üzemmódjának
beállítására szolgál.
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Video Stream 2
A 2. videó kodekkel kapcsolatos beállítások megadására szolgál.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Bit Rate 1

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

16000

Akkor látható, ha a [Bit Rate
Compression Mode 1] beállítása
On.
A bitsebesség célérték beállítására
szolgál, ha a bitsebesség
kompressziós üzemmód beállítása
CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
A H.264 vagy H.265 minőség
beállítására szolgál.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Codec 2 H.264 / H.265 / Off Off
A 2. kép kodekének beállítására
szolgál.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080
A 2. kép képméretének beállítására
szolgál.

Frame Rate 2

Részletek a támogatott
képfrekvenciákról: „A streamelési
videó kodek beállítása”.

–

Akkor látható, ha a [Codec 2]
beállítása nem Off.
A 2. kép képfrekvenciájának
beállítására szolgál.

I-Picture Mode
2

Time / Frame Time

Akkor látható, ha a [Codec 2]
beállítása nem Off.
A 2. kép IDR-Frame beillesztési
intervalluma megadására szolgál,
idő vagy képkocka
mértékegységben.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Akkor látható, ha a [Codec 2]
beállítása nem Off és ugyanakkor [I-
Picture Mode 2] beállítása [Time].
A H.264 és H.265 IDR-Frame
beillesztési intervalluma
megadására szolgál idő
mértékegységben.

I-Picture Ratio 2 15 – 300 képkocka 30

Akkor látható, ha a [Codec 2]
beállítása nem Off és ugyanakkor [I-
Picture Mode 2] beállítása [Frame].
A H.264 és H.265 IDR-Frame
beillesztési intervalluma
megadására szolgál képkocka
mértékegységben.

Profile 2
H.264: high / main / baseline
H.265: main

–
A H.264 vagy H.265 profil
beállítására szolgál.
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Video Stream 3
A 3. videó kodekkel kapcsolatos beállítások megadására szolgál.

Kapcsolódó témák

A streamelési videó kodek beállítása

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Akkor látható, ha a [Codec 2]
beállítása nem Off.
A 2. kép bitsebesség kompressziós
üzemmódjának beállítására szolgál.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

8000

Akkor látható, ha a [Codec 2]
beállítása nem Off és ugyanakkor
[Bit Rate Compression Mode 2]
beállítása [On].
A bitsebesség célérték beállítására
szolgál, ha a bitsebesség
kompressziós üzemmód beállítása
CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Akkor látható, ha a [Codec 2]
beállítása H.264 és ugyanakkor [Bit
Rate Compression Mode 2]
beállítása Off.
A H.264 vagy H.265 minőség
beállítására szolgál.

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Codec 3 JPEG JPEG
A 3. kép kodekének beállítására
szolgál.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
A 3. kép képméretének
beállítására szolgál.

Frame
Rate 3

Részletek a támogatott képfrekvenciákról: „A
streamelési videó kodek beállítása”. –

A 3. kép képfrekvenciájának
beállítására szolgál.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 A minőség beállítására szolgál.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Stream

A streamelési hang kodekkel kapcsolatos beállítások megadására szolgál.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Setting On / Off Off A hang streamelési kimenetet kapcsolja be/ki.

Codec
AAC (128kbps) / AAC
(256kbps)

AAC (128kbps)
Akkor látható, ha a [Setting] beállítása On.
A streamelés hang kodekjének beállítására
szolgál.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Language

A képernyő nyelvének beállítása.

Megjegyzés

A beállítható nyelvek választéka az országtól vagy régiótól függ.
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Elem Alpont beállítás Gyári alapértelmezés Magyarázat

Language – – A képernyő nyelvének beállítása.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Accessibility

A hangos olvasással (szöveg felolvasással) kapcsolatos beállítások megadására szolgál.

Megjegyzés

Ez a funkció csak Észak-Amerika számára készült modelleken érhető el. A képernyőolvasó funkció csak akkor használható, ha a
nyelv beállítása (a kiadás időpontjában) angol.

Engedélyezze a webes alkalmazást futtató eszköz webböngészőjének képernyőolvasó funkcióját.
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Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Screen
Reader

On / Off Off 
A webes alkalmazás kamerakép-panel
képernyőolvasó funkcióját kapcsolja be/ki.

Speech
Rate

Slow2 / Slow1 / Normal /
Fast1 / Fast2 / Fast3 / Fast4

Normal
A képernyőolvasó beszédgyorsaságának
beállítására szolgál.
Szövegmintát olvas be a konfigurált gyorsasággal.

Speech
Volume

1 – 15 7
A webes alkalmazás képernyőolvasó funkciója
hangerejének beállítására szolgál.
Szövegmintát olvas be a konfigurált hangerővel.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clock Set

Belső óra beállítások megadása.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Current Date
& Time

– –
Az egységen beállított dátumot és időt jeleníti
meg.

PC Clock – –
A konfiguráláshoz használt táblagép vagy
számítógép idejét jeleníti meg.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-
yyyy hh:mm:ss / dd-mm-yyyy
hh:mm:ss

yyyy-mm-dd
A dátum és a pontos idő megjelenítési
formátumának beállítására szolgál.

12 h / 24 h 12 h / 24 h 24 h
Az idő 12 vagy 24 órás formátuma
beállítására szolgál.

Time Setting
Keep current setting /
Synchronize with PC / Manual
setting / Synchronize with NTP

–
A dátum és a pontos időkonfigurálási
módjának beállítására szolgál.

yy-mm-dd
hh:mm:ss

yy: 19 – 37
mm: 01 – 12
dd: 01 – 31
hh: 00 – 23
mm: 00 – 59
ss: 00 – 59 (másodperc)

–

Akkor látható, ha a [Time Setting] beállítása
Manual setting.
A dátum és a pontos idő kézi beállítására
szolgál.

NTP Auto On / Off Off

Akkor látható, ha a [Time Setting] beállítása
Synchronize with NTP.
Beállítja, hogy az NTP szerver IP-címét a
DHCP szervertől kell-e beszerezni.

NTP Server IPv4/IPv6 cím vagy hostnév –

Akkor látható, ha a [Time Setting] beállítása
[Synchronize with NTP] és ugyanakkor [NTP
Auto] beállítása Off.
Az idő szinkronizálására használt NTP
szerver megadására szolgál.

Time Zone UTC − 12:00 – UTC + 14:00 – Az időzóna kiválasztására szolgál.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Reset

Inicializálja az egységet.

Reboot
Újraindítja az egységet.

Reset
Visszaállítja az egység beállításait.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Reboot Execute –

Újraindítja az egységet.
Execute: a végrehajtás funkció.

Megjegyzés

Az újraindítást követően töltse be újra az oldalt a
webböngészőben.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

All Reset (except for
Network Settings)

Execute –

Visszaállítja az egység beállításait (a hálózati beállítások
kivételével).
Execute: a végrehajtás funkció.

Megjegyzés

Az importált bázismegjelenés és LUT fájlok nem törlődnek.

Network Reset Execute –

Visszaállítja az egység hálózati beállításait.
Execute: a végrehajtás funkció.

Megjegyzés

Network Reset végrehajtása után az egység újraindul. Az
újraindítást követően töltse be újra az oldalt a
webböngészőben.

Factory Default Execute –

Gyári alapértelmezésre állítja vissza az egység beállításait.
Execute: a végrehajtás funkció.

Megjegyzés

Factory Default végrehajtása után az egység újraindul. Az
újraindítást követően töltse be újra az oldalt a
webböngészőben.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Information

A kamera és az objektív adatait jeleníti meg. Szoftverfrissítésre is szolgál.

Camera
Megjeleníti a kamera adatait és frissíti a szoftvert.

Lens
Megjeleníti az objektív adatait és frissíti a szoftvert.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Model
Name

– – A kamera típusnevét jeleníti meg.

Serial
Number

– – A kamera gyári számát (sorozatszámát) jeleníti meg.

Version
Number – – A kamera szoftververzióját jeleníti meg.

Version Up – –

A kamera szoftverének frissítéséhez nyomja meg a [Choose File]
gombot és kövesse a képernyőn megjelenő utasításokat.

Megjegyzés

A frissítést követően az egység újraindul. Az újraindítást követően
töltse be újra az oldalt a webböngészőben.

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Model
Name

– – Megjeleníti az objektív típusnevét.

Serial
Number

– – Megjeleníti az objektív gyári számát.

Version
Number

– – Megjeleníti az objektív szoftververzióját.
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Kapcsolódó témák

E-bajonettes objektív szoftverének frissítése

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

Version Up – –

Az objektív szoftverének frissítéséhez nyomja meg a [Choose File]
gombot és kövesse a képernyőn megjelenő utasításokat.

Részletek: „E-bajonettes objektív szoftverének frissítése”.

Megjegyzés

Az objektív frissítését követően az egység újraindul. Az újraindítást
követően töltse be újra az oldalt a webböngészőben.
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Súgó útmutató

Interchangeable Lens Digital Camera
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System Log

A rendszernaplóval kapcsolatos beállítások megadására szolgál.

A megszerzett napló az alább látható módon jelenik meg.

Kapcsolódó témák

E-bajonettes objektív szoftverének frissítése

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical, Warning &
Info

A rendszernaplóhoz hozzáadandó rekord szintjének
beállítására szolgál.

Log Size 200 – 1024 1024
A rendszernaplóban elmentendő napló méretének
beállítására szolgál.

Download
as File

– –
Nyomja meg a [Download] gombot és mentse el a
rendszernaplót táblagépre vagy számítógépre a
megjelenő képernyőről.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

HTTP Access Log

A HTTP hozzáférési naplóval kapcsolatos beállítások megadására szolgál.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont beállítás Gyári
alapértelmezés Magyarázat

Log Level
Critical, Warning & Info
/ Critical & Warning /
Critical

Critical, Warning &
Info

A HTTP hozzáférési naplóhoz hozzáadandó rekord
szintjének beállítására szolgál.

Log Size 200 – 1024 1024
A HTTP hozzáférési naplóban elmentendő napló
méretének beállítására szolgál.

Download
as File

– –
Nyomja meg a [Download] gombot és mentse el a
HTTP hozzáférési naplót táblagépre vagy
számítógépre a megjelenő képernyőről.
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Interchangeable Lens Digital Camera
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Service

Eszközinformációt gyűjt be az egységről. A Sony szerviz kérheti.

5-041-958-53(1) Copyright 2022 Sony Corporation

Elem Alpont
beállítás

Gyári
alapértelmezés Magyarázat

I agree to
download device
information.

– –

Az eszközinformáció begyűjtéséhez való hozzájárulása
jeleként tegyen ide pipa jelet, majd nyomja meg az [OK]
gombot.
Nyomja meg a megjelenő [Download] gombot. A
webböngésző letölt egy deviceinformation.dat nevű fájlt.

Megjegyzés

A letöltés után az egység újraindul. Ha az automatikus
újraindítás nem indul el, indítsa újra az egységet kézzel. Az
újraindítást követően töltse be újra az oldalt a
webböngészőben.
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EULA

Megjeleníti az EULA (End User License Agreement) végfelhasználói licencszerződést.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Software

A szoftver licencet jeleníti meg.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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Külső monitorok és felvevők csatlakoztatása

Rögzített/lejátszott képek külső monitoron való megjelenítéséhez állítsa be a külső monitorhoz használandó videó
kimenet típusát és csatlakoztassa a monitort a hozzá való kábellel.
Csatlakoztathat külső felvevőt is, az egységről kiadott jel rögzítéséhez.
A kamerakép-panelen megjelenő információkat, például állapotinformációkat és menüket, külső monitoron is
megjelenítheti. A webes menü [Monitoring] > [Output Display] pontjában állítsa a képernyőképhez igényelt rendszertípust
On értékre.

Megjegyzés

Ha a HDMI csatlakozóra kötött monitor nem támogatja a webes menü vagy a kameramenü [Monitoring] pontjában beállított HDMI
kimeneti formátumot, előfordulhat, hogy a kamera képe nem jelenik meg a webes alkalmazásban. Streaming videó sem adható
ki.

Az [Output Display] > [SDI] és a [HDMI/Stream] egyaránt [Off] értékre állítható, de ekkor nem használható a kameramenü és nem
használhatók a képernyő megjelenítéstől függő funkciók. Ezenkívül az egység hibaüzenetei a készülék lámpáira (világítás vagy
villogás) és a jobb felső sarokban lévő értesítési jel megjelenítésére korlátozódnak a webes alkalmazásban. Részletes
állapotinformációk megjelenítéséhez állítsa a [Output Display] pontot [On] értékre.

Tipp

Gyári alapértelmezésben [Output Display] > [SDI] beállítása [Off] és [HDMI/Stream] beállítása [On]. Ha fő videóként a streamelést
kívánja használni, állítsa az [SDI] pontot [On] és a [HDMI/Stream] pontot [Off] értékre, és figyelje a kamera állapotát SDI
monitoron.

SDI OUT csatlakozó (BNC típusú)

Állítsa be a kimeneti formátumot a webes menü vagy a kameramenü [Monitoring] pontjában.
A csatlakoztatáshoz használjon kereskedelmi forgalomban kapható, 75 Ω-os koaxiális kábelt.

Megjegyzés

Az eszközök bekapcsolása előtt ellenőrizze, hogy földelve van-e az egység és a külső eszköz közötti kapcsolat.

Javasoljuk, hogy a készüléket és a külső eszközt csak a 75 Ω-os koaxiális kábel csatlakoztatása után kapcsolja
be.
Ha a külső eszközt az egység bekapcsolt állapotában kell csatlakoztatni, a 75 Ω-os koaxiális kábelt először a külső
eszközhöz csatlakoztassa, csak utána az egységhez.

Felvétel indítása egyidejűleg az egységen és külső eszközön
Az SDI jelkimenet engedélyezett állapotában állítsa a kameramenü [Project] > [SDI/HDMI Rec Control] > [Setting] pontját
[SDI/HDMI Remote I/F] vagy [Parallel Rec] értékre, hogy az SDI OUT csatlakozóra kötött külső eszközre kimehessen a
REC indítójel. Ez egymáshoz szinkronizálja a külső eszköz és az egység felvételét.

Megjegyzés

Ha a csatlakoztatott külső eszköz nem támogatja a Rec indítójel használatát, az eszköz nem működtethető.

Ha a kameramenüben a [Project] > [SDI/HDMI Rec Control] > [Setting] beállítása [SDI/HDMI Remote I/F], csak a REC indító jel
kerül kiadásra, amikor pillanatnyilag nincs behelyezett felvételi adathordozó és megnyomják a felvétel START/STOP gombot.
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HDMI OUT csatlakozó (Type A csatlakozó)

Állítsa be a kimenet On/Off beállítását és a kimeneti formátumot a kameramenü [Monitoring] menüjében.

Felvétel indítása egyidejűleg az egységen és külső eszközön
A HDMI jelkimenet engedélyezett állapotában állítsa a kameramenü [TC/Media] > [HDMI TC Out] > [Setting] pontját [On]
és [Project] > [SDI/HDMI Rec Control] > [Setting] pontját [SDI/HDMI Remote I/F] vagy [Parallel Rec] értékre, hogy a
HDMI OUT csatlakozóra kötött külső eszközre kimehessen a REC indítójel. Ez egymáshoz szinkronizálja a külső eszköz
és az egység felvételét.

Megjegyzés

Ha a csatlakoztatott külső eszköz nem támogatja a Rec indítójel használatát, az eszköz nem működtethető.

Ha a kameramenüben a [Project] > [SDI/HDMI Rec Control] > [Setting] beállítása [SDI/HDMI Remote I/F], csak a REC indító jel
kerül kiadásra, amikor pillanatnyilag nincs behelyezett felvételi adathordozó és megnyomják a felvétel START/STOP gombot.

5-041-958-53(1) Copyright 2022 Sony Corporation

436



Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kapcsolódás RCP/MSU eszközzel

Az egység egyes funkciói távolról is vezérelhetők egy távvezérlő panel (RCP), például az RCP-3500/3501, vagy egy
master setup unit (MSU), például az MSU-3500, LAN-kábeles csatlakoztatásával az egységhez.
A csatlakozási mód a kapcsolódó eszközök konfigurációjától és az alkalmazástól függ.

Az egység és egy RCP közötti egy-az-egyhez kapcsolat részletes ismertetése az „Egy-az-egyhez kapcsolat az
egység és egy RCP között” cím alatt található.
Több kamera MSU vagy kameravezérlő szoftver használatával történő csatlakoztatásának részletei e cím alatt
találhatók: „Az egység használata többkamerás környezetben MSU/kameratávvezérlő szoftver alkalmazásával”.

Kapcsolódó témák

Egy-az-egyhez kapcsolat az egység és egy RCP között

Az egység használata többkamerás környezetben MSU/kameratávvezérlő szoftver alkalmazásával

5-041-958-53(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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Egy-az-egyhez kapcsolat az egység és egy RCP között

Megjegyzés

Olvassa el „A támogatott funkciók listája” részt és konfigurálja az egységet úgy, hogy az megfeleljen a használni kívánt funkciók
üzemi feltételeinek, majd engedélyezze a kapcsolatot egy RCP-vel a következő eljárással.

Kapcsolódó témák
A támogatott funkciók listája

5-041-958-53(1) Copyright 2022 Sony Corporation

Kapcsolja be az eszközöket.1

Állítsa a webes menü [Technical] > [RCP/MSU] > [CNS Mode] pontját [Bridge] értékre.2

Konfigurálja a következő beállításokat az RCP-n.

A konfigurálásról részleteket az RCP kezelői utasításaiban talál.

3

Állítsa a csatlakozási módot Bridge értékre.1.
Regisztrálja a kamera IP-címét.2.
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Interchangeable Lens Digital Camera
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Az egység használata többkamerás környezetben MSU/kameratávvezérlő szoftver
alkalmazásával

Több kamera együtt használható MSU vagy kameratávvezérlő szoftver használatával.

Megjegyzés

Olvassa el „A támogatott funkciók listája” részt és konfigurálja az egységet úgy, hogy az megfeleljen a használni kívánt funkciók
üzemi feltételeinek, majd engedélyezze a kapcsolatot egy MSU vagy kameratávvezérlő szoftver használatával, a következő
eljárást követve.

Kapcsolódó témák

A támogatott funkciók listája
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Kapcsolja be az eszközöket.1

Konfigurálja a rendszer hálózati beállításait az MSU vagy a kameratávvezérlő szoftver használatával.

A konfigurálással kapcsolatos részletek az MSU vagy a kameratávvezérlő szoftver kezelői utasításaiban találhatók.

2

Konfigurálja a következő beállításokat a kamera webes menüje [Technical] > [RCP/MSU] pontjában.3

MSU használatakor állítsa a [CNS Mode] üzemmódot [MCS] értékre. Kameratávvezérlő szoftver használatakor
állítsa a [CNS Mode] üzemmódot [PC Control] értékre.

1.

Állítsa be a master MSU vagy a kameratávvezérlő szoftver IP-címét a [Master IP Address] pontban.2.
A [Camera No.] pontban állítsa be azt a kameraszámot, amellyel a kamera regisztrálva lesz.3.
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A támogatott funkciók listája

A következő táblázat a támogatott funkciókat és üzemi feltételeiket foglalja össze.

Használati
panel Az egység funkciói Üzemi feltételek

IRIS A fényrekesz kézi állítása –

AUTO IRIS Az Auto Iris be/ki kapcsolása –

ND
Az ND szűrő előbeállított helyzetének
átkapcsolása (Clear/Preset1 – Preset3)

Ez a funkció engedélyezve van, ha a
kameramenü [Shooting] > [ND Filter] > [Mode]
pontjának beállítása [Preset].

MASTER
GAIN

Az erősítés kézi állítása (3 dB-es lépésekben)

Akkor van engedélyezve, ha a felvételi üzemmód
beállítása Custom, és a kameramenü [Shooting]
> [ISO/Gain/EI] > [Mode] pontjának beállítása
[dB].

WHITE (R/B) A fehéregyensúly (R Gain/B Gain) kézi beállítása

Akkor van engedélyezve, ha [White Mode]
beállítása [Memory A(R/B)] vagy [Memory
A(T/T)].

WHITE
(Color Temp)

A fehéregyensúly (színhőmérséklet/színárnyalat)
kézi beállítása

RCP – [Color Temp]: fehéregyensúly
színhőmérséklet
RCP – [Balance]: fehéregyensúly színárnyalat
érték

ATW
Az ATW (Auto Tracing White Balance) funkció
be/ki kapcsolása

Engedélyezve van, amikor a felvételi üzemmód
beállítása Custom.

BLACK R/B A feketeegyensúly beállítása
Engedélyezve van, amikor a felvételi üzemmód
beállítása Custom.
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Megjegyzés

Konfigurálja az egységet úgy, hogy az megfeleljen a használni kívánt funkciók üzemi feltételeinek, majd engedélyezze a
kapcsolatot egy RCP/MSU eszközzel. Ha az üzemi feltételeket a kapcsolat engedélyezése után módosítják, nem kívánt
viselkedés léphet fel.

5-041-958-53(1) Copyright 2022 Sony Corporation

Használati
panel Az egység funkciói Üzemi feltételek

MASTER
BLACK

A master feketeszint beállítása

Engedélyezve van, amikor a felvételi
üzemmód beállítása Custom.
H/V Ratio és Crispening akkor van
engedélyezve, ha a kameramenü
[Paint/Look] > [Detail] > [Manual Setting]
pontjának beállítása [On].

DETAIL

A részlet funkció be/ki kapcsolása
A részletszint beállítása
Beállítás H/V Ratio
Beállítás Crispening

User Matrix

A felhasználói mátrixkorrekciós funkció be/ki
kapcsolása
A mátrixkorrekciós értékek (R-G/R-B/G-R/G-
B/B-R/B-G) beállítása

Multi Matrix

A multimátrix-korrekciós funkció be/ki
kapcsolása
A multimátrix-korrekcióhoz használt szín
árnyalatának és telítettségének beállítása

Knee
A könyökkorrekciós funkció be/ki kapcsolása
Az automatikus könyökfunkció be/ki kapcsolása
A könyökpont és a könyökmeredekség beállítása

BARS A színsávok be/ki kapcsolása

SHUTTER

A záridő funkció be/ki kapcsolása.
A záridő érték beállítása
(automatikus záridő be/ki kapcsolás, szög
záridő beállítás, lassú záridő beállítás, ECS
beállítás nem támogatott)

Megjegyzés

A konfigurált záridő értékétől függően
előfordulhat, hogy az RCP zárbeállítások
nem jelennek meg.

Ha a zár nem működtethető az RCP-ről,
előfordulhat, hogy az RCP zárbeállítások
nem jelennek meg.

Ha be van kapcsolva az automatikus záridő, az
akkor is működni fog, ha be/ki kapcsolják a zárat,
vagy módosítják a záridő értékét az RCP-ről.
Ha a záridő beállítása [Angle], nem működik a
zár be/ki kapcsolása és a záridőérték
módosítása az RCP-ről.
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Az egység használata a (különtartozék) RM-IP500 távvezérlővel

Az egység működtethető Sony RM-IP500 távvezérlővel, ha azon a szoftver 2.2 vagy újabb verziója fut. Az eszközök
VISCA over IP (LAN) protokollal kommunikálnak útján.
A működtetni kívánt céleszköztől függően szükség lehet az egység képernyőképének figyelésére. Készítsen elő a
képernyőkép figyelésére alkalmas monitort.
Az RM-IP500 távvezérlőről a következő műveletek végezhetők.

a célkamera kiválasztása,
a keretezés (pásztázás, döntés, zoomolás) állítása,
fókusz beállítása (érintéses művelettel nem),
előbeállított helyzetek regisztrálása és lehívása,
az egység menüjének működtetése (a webes menü kivételével),
a fényerő beállítása,
a fehéregyensúly beállítása,
a feketeegyensúly beállítása,
a bemeneti hangszint beállítása,
a felvétel elindítása/leállítása,
az egység gombra programozott funkcióinak futtatása.

Az RM-IP500 használatával kapcsolatos részletes tudnivalók az RM-IP500 kezelői utasításaiban találhatók.

Tipp

RM-IP500 használatakor használja az egységnek az RM-IP500 távvezérlőhöz adott paneltakaró lapját.

RM-IP500 (az egység paneltakaró lapjával)
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RM-IP500 távvezérlő csatlakoztatása

Funkciók hozzárendeléséről részletes tudnivalókkal az RM-IP500 kezelői utasításai szolgálnak.

5-041-958-53(1) Copyright 2022 Sony Corporation

VISCA over IP kommunikáció engedélyezéséhez állítsa az egység 3. SETUP kapcsolóját ON helyzetbe.

Megjegyzés

A kapcsoló új helyzete az egység következő bekapcsolásakor érvényesül.

1

Csatlakoztassa az RM-IP500 távvezérlőt ugyanahhoz a hálózathoz, amelyhez az egységet csatlakoztatta.2

Az RM-IP500 VISCA over IP (LAN) kapcsolatát konfigurálja az RM-IP500 kezelői utasításaiban leírt eljárással.

Az egység hozzárendelését végezze az RM menü > AUTO IP SETUP > ASSIGN CAM pontban.

3

Az RM-IP500 RM menüje pontjaiban rendelje ennek az egységnek a funkcióit gombokhoz és billentyűkhöz.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Szinkronizálás külső eszközzel

Több egységgel végzett felvételkészítés esetén az egységek a GENLOCK csatlakozójukra kötött referenciajelhez vagy
időkódhoz szinkronozhatók.

Részletes tudnivalók a genlockról: „A videojel fázisának szinkronizálása (Genlock)”.
Részletes tudnivalók az időkódok szinkronizálásáról: „Az időkód más eszközökhöz zárása”.

Kapcsolódó témák
A videojel fázisának szinkronizálása (Genlock)

Az időkód más eszközökhöz zárása

5-041-958-53(1) Copyright 2022 Sony Corporation
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A videojel fázisának szinkronizálása (Genlock)

A szinkronizáláshoz referenciajelet köthet a GENLOCK csatlakozóra.
Az alkalmas referenciajelek választéka a kiválasztott felvételi formátum rendszerfrekvenciájától függ.

A külső szinkronizálás állapota a kameramenü [Technical] > [Genlock] > [Reference] pontjában ellenőrizhető.

Megjegyzés

A genlock nem működik, ha nem stabil a referenciajel.

A segédvivő nem szinkronizálódik.

5-041-958-53(1) Copyright 2022 Sony Corporation

A felvételi formátum rendszerfrekvenciája Támogatott bemeneti referenciajelek

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Az időkód más eszközökhöz zárása

Állítsa az időkódot szolgáltató egységet olyan üzemmódba (pl. Free Run vagy Clock), amelyben folyamatosan
szolgáltatja az időkód jelet.

Megjegyzés

Ellenőrizze, hogy a beadott referencia időkód és a referencia videojel fáziskapcsolata megfelel-e az SMPTE időkód-szabvány
előírásainak.

Külső szinkronzár használatakor az időkód azonnal a külső időkódhoz zár, és az időadat megjelenítési területen megjelenik a
külső időkód. Ne indítsa azonban rögtön a felvételt. Várjon néhány másodpercet, hogy az időkód generátor stabilizálódjon.

Ha a referencia videojel frekvenciája és az egység képfrekvenciája eltér egymástól, szinkronzárás nem tud létrejönni és az
egység nem fog megfelelően működni. Ilyenkor az időkód nem zár a külső időkódhoz.

A külső időkód forrás lekötését követően az időkód óránként egy képkockával eltolódhat a referencia időkódhoz képest.

A külső szinkronzár bontása
Módosítsa a kameramenü [TC/Media] > [Timecode] pontjának beállítását.
A külső szinkron akkor is bont, ha megváltozik a rendszerfrekvencia vagy speciális felvételi üzemmódban (Slow & Quick
Motion vagy Interval Rec) kezd felvételt készíteni.

5-041-958-53(1) Copyright 2022 Sony Corporation

Állítsa be a következőket a kameramenü [TC/Media] > [Timecode] pontjában.

[Mode] pont: [Preset] értékre.
[Run] pont: [Free Run] értékre.

1

Az időkód képernyőn való megjelenítéséhez nyomja meg a [DURATION/TC/U-BIT] funkcióra programozott
valamelyik gombot.

2

Kössön HD vagy SD referencia videojelet a GENLOCK csatlakozóra és kösse a referencia időkódot a TC IN
csatlakozóra.

Az egység időkód generátora a referencia időkódhoz zár és a képernyőn megjelenik az „EXT-LK” felirat.
Kb. tíz másodperccel az időkód összezáródása után a külső szinkronzárt állapot a külső referencia időkód lekötése
után is fennmarad.

3
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Külső mikrofon vagy hangeszköz csatlakoztatása

Csatlakoztatható külső mikrofon vagy hangeszköz és hangjele beágyazható az egység rögzített vagy kiadott videó
jelébe.

Csatlakoztasson külső mikrofont vagy hangeszközt XLR kábellel.

Ha a kameramenü [Audio] > [Audio Input] > [AUDIO IN Select] pontjának beállítása [LINE], az AUDIO IN csatlakozó
AUDIO IN CH-1 és AUDIO IN CH-2 csatlakozóként működik.

1

Érintkező Funkció

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Kapcsolja ki az egységet és kösse az XLR kábelt az AUDIO IN csatlakozóra.2

A 2. SETUP kapcsolóval engedélyezze a fantom tápellátást, ha szükséges.

Kapcsolja be vagy ki a +48 V-os fantom tápellátást az alábbiak szerint.
2. kapcsoló
Ezzel kapcsolható be vagy ki a +48 V-os fantom tápellátás hangjel-szolgáltató eszköz csatlakoztatásakor.

3

Beállítás Magyarázat

OFF
(alapértelmezés)

Kikapcsolja a +48 V-os táplálást és a LINE vagy MIC bemenetet állítja be CH-1 és CH-2
hangforrásként.
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Megjegyzés

Ha e kapcsoló ON állásában +48 V-os áramforrással nem kompatibilis mikrofont csatlakoztat, tönkremehet a csatlakoztatott
eszköz. Az eszköz csatlakoztatása előtt ellenőrizze a beállítást.

Beállítás Magyarázat

ON
Bekapcsolja a +48 V-os táplálást és a fantom táplálással kompatibilis mikrofont állítja be
CH-1 és CH-2 hangforrásként.

Kapcsolja be az egységet és a kameramenü [Audio] > [Audio Input] > [AUDIO IN Select] pontjában állítsa be
a csatlakoztatott eszköz típusát.

4
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Klipek számítógépes kezelése/szerkesztése

Klipek kezelhetők és szerkeszthetők számítógéppel.

Klipek importálása kártyaolvasóval (különtartozék)

Kössön CFexpress Type A vagy SD kártyaolvasót számítógépére és importálja a klipeket az egység felvételi formátumát
támogató szoftverrel.

Nemlineáris montázsrendszer használata

Nemlineáris montázsrendszerekben az egységgel felvett formátumokat támogató szerkesztő (montírozó) szoftver
(különtartozék) szükséges.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Optikai jel kiadása fényvezetőre

Az egységről optikai formátumra alakított SDI jel adható ki SFP+ modul (különtartozék) csatlakoztatásával az egység
OPTICAL csatlakozójára. Használjon olyan SFP+ modult, amelyik kompatibilis az egyes formátumok jelsávjával.
Jelsáv

4K (59.94p, 50p): 12G
4K (59.94p, 50p nem): 6G
HD (59.94p, 50p): 3G
HD (59.94p, 50p nem): 1.5G

Megjegyzés

Használjon a következő szabványoknak megfelelő modult.

SFF szabványok
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI szabványok
ST297/ST292/ST424/ST425/ST2081/ST2082

Az SFP+ modul ugyanazt a jelet kapja, mint amelyik az SDI kimeneten rendelkezésre áll.

Az egység nem támogatja optikai jel beadását.

Optikai jel kiadásához használjon SFP+ modult. Az ellenőrzötten alkalmas SFP+ modulokról felvilágosítást a Sony szervizektől
kérhet.

5-041-958-53(1) Copyright 2022 Sony Corporation

* I teljesítményszint (1,0 W)
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Tally jel csatlakoztatása

Ez a témakör a tally jeles vezérlést ismerteti.

A tally lámpa működtetése távvezérlő jelével

A tally lámpa bekapcsolható külső eszköz, például RM-IP500, VISCA over IP parancsával.
Állítsa a webes menü vagy kameramenü [Technical] > [Tally] > [Tally Control] pontját [External] értékre.

A tally lámpa bekapcsolása külső eszközről

A tally lámpa bekapcsolható piros vagy zöld színűre külső eszköz, például RM-IP500 vagy kapcsoló jelével. A tally lámpa
vezérelhető a hálózaton közvetített parancsokkal vagy az egység OPTION csatlakozójára kötött tally bemenőjellel.
Állítsa a webes menü vagy kameramenü [Technical] > [Tally] > [Tally Control] pontját [External] értékre.
Tally jelnek az egység OPTION csatlakozójára kötése esetén a tally lámpa zöldre kapcsolásához kösse a 7. érintkezőt a
GND testpontra (4. vagy 5. érintkezőre), pirosra kapcsolásához kösse a 8. érintkezőt a GND testpontra (4. vagy 5.
érintkezőre).

Megjegyzés

Ha a [Tally Control] beállítása [External], a tally lámpa nem jelzi az egység felvételi állapotát.

Ha egyidejűleg érkezik piros és zöld tally lámpa bemenőjel, a lámpa pirosan világít.

Az OPTION csatlakozó érintkezőkiosztása

Érintkező Jelirány Megnevezés

1 – RS-232C TX jel (objektívvezérlőhöz)

2 – RS-232C RX jel (objektívvezérlőhöz)

3 OUT

Green tally lámpa kimenet
Alacsony kimeneti szint a zöld tally lámpa világításkor.
Hi-Z (nyitott drain kimenet) ha a zöld tally lámpa nem világít.

4 – GND (Ground)

5 – GND (Ground)
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Külső eszköz tally lámpájának kapcsolása az egység jelével

Külső eszköz tally lámpájának az egység jelével való kapcsolásához kösse össze az OPTION csatlakozó 3. és 6.
érintkezőjét, az alábbi ábra szerint.
Példa az OPTION csatlakozó 3. és 6. érintkezője összekapcsolására

Megjegyzés

Ne kössön feszültséget a 7. és 8. érintkezőre.

Ne csatlakoztasson olyan külső eszközt, amely feszültséget adhat az OPTION csatlakozóra.

Feszültséglökés vagy fordított polaritású feszültség 3. vagy 6. érintkezőre jutása működési hibát, füstölést vagy tüzet okozhat.

Állítsa be a kimenőjelet a webes menü vagy a kameramenü [Technical] > [Tally] > [Tally Control] pontjában.
[Internal]: az egység felvételi működési állapota
[External]: az egység IN jelek és távvezérlők útján kapott piros/zöld tally jeleinek logikai ÉS kapcsolata.

5-041-958-53(1) Copyright 2022 Sony Corporation

Érintkező Jelirány Megnevezés

6 OUT

Red tally lámpa kimenet
Alacsony kimeneti szint a piros tally lámpa világításakor.
Hi-Z (nyitott drain kimenet) ha a piros tally lámpa nem világít.

7 IN
Zöld tally külső vezérlő bemenet
Test (4. vagy 5.) érintkezőhöz zárásakor az egység tally lámpája zölden gyullad fel.

8 IN
Piros tally külső vezérlő bemenet
Test (4. vagy 5.) érintkezőhöz zárásakor az egység tally lámpája pirosan gyullad fel.
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Követési adatok (free-d) kiadása

Az egység szinkronjelhez szinkronizálva képes kiadni a pásztázás/döntés/zoom, fókusz és fényrekesz követési
információkat.
Az adatkiadás megfelel az ágazati szabványként használt free-d protokollnak. Kiválasztható a kiadási módszer;
választani lehet az állandó kiadás és az ügyfelek kérésére történő kiadás között. Válassza a VR/AR rendszerének
megfelelő kiadási módszert.

Adatkiadási formátum

Tipp

Műszaki részletek az „Integration manual for free-d” kézikönyvben találhatók. Vegye fel a kapcsolatot a Sony értékesítési
képviselőjével.

Az egység által kiadott követési adatok körébe a következők tartoznak, a free-d protokollban a Type D0/D1 alatt
megadott formátum szerint.
Type D0 – poll/command

Ellenőrizze, hogy be van-e kapcsolva az egység.1

Állítsa be a követési adatok kiadási módszerét.

Állandó kiadás

Kiadás ügyfelek kérésére

2

Állítsa a webes menü [Technical] > [Tracking Data Output] > [Transfer Mode] pontját [Always] értékre.1.
Az egység ID azonosítójának beállítására szolgál, itt: [Camera ID].2.
Adja meg a kimeneti célhely IP-címét itt: [Destination Address].3.
Adja meg a kimeneti célhely portszámát itt: [Destination Port].4.
Nyomja meg a [OK] gombot.5.

Állítsa a webes menü [Technical] > [Tracking Data Output] > [Transfer Mode] pontját [On Demand] értékre.1.
Az egység ID azonosítójának beállítására szolgál, itt: [Camera ID].2.
Adja meg az ügyfélkérések fogadására használandó portszámot itt: [Listen Port].3.
Nyomja meg a [OK] gombot.4.

Szimbólum Tartalom Magyarázat

<D0> Message type

<CA> Camera ID

<CD> command

A következő parancsokat támogatja:
00 Stop stream mode
01 Start stream mode

454



Type D1 – camera position/orientation data

Megjegyzés

Az alábbi helyzetekben előfordulhat, hogy a követési adatok késnek, vagy az értékek nem frissülnek:

RAW videó kiadásakor.
Az S&Q Motion bekapcsolt állapotában.
A kameramenü megjelenítésekor.
A miniatűrök képernyőjének megjelenítésekor.
Felvett klipek lejátszásakor.
A webes menü megjelenítésekor.
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Szimbólum Tartalom Magyarázat

<CK> Checksum

Szimbólum Tartalom Magyarázat

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Pásztázási szög (−170° ... +170°)

<TH><TM><TL> Camera Tilt Angle Döntési szög (−30° ... +195°)

<RH><RM><TL> Camera Roll Angle Nem támogatott (mindig 0)

<XH><XM><XL> Camera X-Position Nem támogatott (mindig 0)

<YH><YM><YL> Camera Y-Position Nem támogatott (mindig 0)

<HH><HM><HL> Camera Height Nem támogatott (mindig 0)

<ZH><ZM><ZL> Camera Zoom Gyújtótávolság

<FH><FM><FL> Camera Focus Fókuszálási távolság

<SH><SL> Spare/User Defined Fényrekesz helyzet

<CK> Checksum
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Objektívvezérlő csatlakoztatása

Az egységgel kompatibilis, kereskedelmi forgalomban kapható objektívvezérlő (különtartozék) csatlakoztatásával a
webes alkalmazásból, RM-IP500 készülékről (különtartozék) vagy az infra távvezérlőről zoomolhat kézi zoomolásos
objektívet.
Objektívvezérlő csatlakoztatásáról részletek az objektívvezérlő kezelői utasításaiban találhatók.
Részletek az objektívvezérlős zoomolásról a „Zoomolás objektívvezérlővel” cím alatt találhatók.

Megjegyzés

Az objektívvezérlő használata előtt olvassa el figyelmesen kezelői utasításait, és győződjön meg róla, hogy teljesen megértette
annak használatát. A Sony nem vállal felelősséget az objektívvezérlő használatából eredő semmilyen kárigényért.

Objektívvezérlő engedélyezett állapotában nem működik a Clear Image Zoom. Javasoljuk, hogy állítsa a Clear Image Zoom
nagyítását 1.0× értékre vagy tiltsa le a Clear Image Zoom-ot.

Kamera keretezési műveletek nem rögzíthetők és nem játszhatók le az objektívvezérlő engedélyezett állapotában.

Kapcsolódó témák
Zoomolás objektívvezérlővel
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Zoomolás objektívvezérlővel

A következő módon csatlakoztassa az objektívvezérlőt (különtartozék) és zoomoljon.

Az objektívvezérlő állapotának ellenőrzése
A kameraállapot képernyő megjelenítéséhez a webes alkalmazás képernyőjének közös területén nyomja meg a 
(Kameraállapot) gombot.

Az objektívvezérlőt az egység csatlakozótömbjén található OPTION csatlakozóra csatlakoztassa.

A csatlakoztatást végezze az objektívvezérlő kezelői utasításai szerint.

1

Állítsa be az objektívvezérlőt az adott zoomobjektívhez.

Részletek az objektívvezérlő kezelői utasításaiban találhatók.

2

Zárja le az egység pásztázó/döntő szerkezetét és helyezze fel a zoomobjektívet.

Részletek: „Objektív felszerelése”.

3

Állítsa be úgy az objektívvezérlőt, hogy az képes legyen működtetni a zoomobjektívet.4

Tartsa fenn a kamerafej előre/hátra egyensúlyát úgy, hogy a csúszótalp vízszintes legyen.

Részletek az objektívvezérlő kezelői utasításaiban és az „Objektív felszerelése” cím alatt találhatók.

5

Állítsa a webes menü [Technical] > [Lens Controller] > [Setting] pontját [On] értékre, és nyomja meg az [OK]
gombot.

Az egység újraindul. Várja meg, amíg a pásztázás/döntés visszaállítása befejeződik.

6

Nyomja meg a webes alkalmazás élő működtető képernyője kamera vezérlőpanelének  (Others) fülén az
 (Objektívvezérlő inicializálása) gombot.

Az objektívvezérlő elindítja a zoomolási tartomány érzékelését. Részletek az objektívvezérlő kezelői utasításaiban
találhatók.
Az előkészítés akkor fejeződött be, amikor a kamerakép-panel bal felső sarkában levő  (Objektívvezérlő hiba)
kijelzés  (Objektívvezérlő kész) kijelzésre vált.

Megjegyzés

Az objektívvezérlő inicializálásakor vegye figyelembe az objektív működési tartományát.

7

A zoomolást állítsa a webes alkalmazás [Zoom] csúszkájával vagy az infra távvezérlő zoom
kezelőgombjaival.

8
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Ezen a képernyőn ellenőrizheti az objektívvezérlő állapotát.

Megjegyzés

Objektívcsere esetén inicializálja az objektívvezérlőt.

Objektívvezérlő engedélyezett állapotában nem működik a Clear Image Zoom. Javasoljuk, hogy állítsa a Clear Image Zoom
nagyítását 1.0× értékre vagy tiltsa le a Clear Image Zoom-ot.

5-041-958-53(1) Copyright 2022 Sony Corporation

Állapot Magyarázat

Off E-bajonettes objektíven használja a motorzoomot.

Communication
Error

Kommunikációs hiba történt az egység és az objektívvezérlő között.
Ellenőrizze az egység és az objektívvezérlő kapcsolatát, majd vegye elő az objektívvezérlő
kezelői utasításait és inicializálja az objektívvezérlőt.

Uninitialized Hajtsa végre az inicializálást.

Initializing Várja meg az inicializálás befejeződését.

Initialization
Failed

Ellenőrizze az egység és az objektívvezérlő kapcsolatát, majd vegye elő az objektívvezérlő
kezelői utasításait és inicializálja az objektívvezérlőt.

Working Zoomoljon az objektívvezérlővel.

Rotation Error
Nem egyezik az objektív mozgástartománya a tárolt zoom mozgástartománnyal. Inicializálja az
objektívvezérlőt.

System Error Ellenőrizze az egység és az objektívvezérlő kapcsolatát, vegye elő az objektívvezérlő kezelői
utasításait és inicializálja az objektívvezérlőt, vagy kapcsolja ki és be az egységet és az
objektívvezérlőt.Unknown Error
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

A használattal kapcsolatos figyelmeztetések

Szállítással és becsomagolással kapcsolatos figyelmeztetések
Az egység szállításakor vagy becsomagolásakor tartsa be a következő feltételeket, és kerülje az erős rezgést vagy ütést.

Vegye le az objektívet és helyezze fel a vázsapkát.
A kamerafej (A) előre állítását követően fordítsa el a kamerafej zárókarját (B) a nyíllal jelölt irányba a kamerafej
lezárásához..

Igazítsa be a kamerafejet úgy, hogy az előre nézzen, és rögzítse a pásztázás/döntés rögzítő karjával.

Vegye le a bekötőkábeleket.

A légnedvesség kicsapódása
Ha a készüléket hirtelen hideg helyről meleg helyre helyezik, vagy a környezet hőmérséklete hirtelen megemelkedik, az
egység külső felületén és/vagy belsejében nedvesség képződhet. Ez a jelenség páralecsapódásként ismert. Ha
páralecsapódás képződik, kapcsolja ki a készüléket, és a készülék működtetése előtt várja meg, amíg a páralecsapódás
megszűnik. Ha a készüléket úgy működteti, hogy azon vagy abban páralecsapódás képződött, kárt tehet a készülékben.

A kamera CMOS képérzékelő jelenségei

Megjegyzés

A következő jelenségek, amelyek a képeken előfordulhatnak, a képérzékelőkre jellemzőek. Nem jelentik a készülék
meghibásodását.

Fehér foltok
Bár a képérzékelők precíziós technológiával készülnek, néha kozmikus sugarak stb. apró fehér foltokat kelthetnek a
képernyőn.
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Ez nem meghibásodás, hanem a képérzékelő működésének velejárója. Rendszeresen futtassa le az APR-t.
A fehér foltok különösen a következő esetekben jelentkezhetnek:

Nagy környezeti hőmérséklet esetén
Nagy erősítés (érzékenység) beállításakor

Képvibrálás
Ha a megvilágítást fénycső, nátriumlámpa, higanygőzlámpa vagy LED adja, a kép vibrálhat vagy a színek
elállítódhatnak.

Objektívmozgató és pásztázó/döntő hajtó egységek
Ha az objektívmozgató és a pásztázó/döntő szerkezetet hosszabb ideig nem használják, kenőzsíruk besűrűsödhet, és a
szerkezet emiatt beragadhat. Használja rendszeresen az objektívet és a pásztázó/döntő szerkezetet.

Fogyóanyagok és -eszközök
A ventilátor és a beépített akkumulátor fogyóeszköz; időnként cserélendő.
Szobahőmérsékleten üzemeltetve a normál csereciklus körülbelül 5 év. Ez a csereciklus azonban csak általános
iránymutatásként szolgál, és nem jelenti azt, hogy ezen alkatrészek várható élettartama garantált lenne.
Az alkatrészcserével kapcsolatban érdeklődjön a Sony szerviznél vagy a forgalmazójánál.

A hálózati tápegység és az elektrolitikus kondenzátor várható élettartama normál működtetési hőmérséklet és
használat (napi 8 óra; havi 25 nap) mellett körülbelül 5 év. Ha a használat meghaladja a normál használati
gyakoriságot, az élettartam ennek megfelelően csökkenhet.

Az egység működőképességének fenntartása és hasznos élettartama meghosszabbítása érdekében javasoljuk a
rendszeres ellenőrzést és felülvizsgálatot. Az ellenőrzésekről és felülvizsgálatokról a Sony szervizektől kérhet részletes
felvilágosítást.

A beépített akkumulátorról
Az egységnek beépített memóriaőrző akkumulátora van, amely kikapcsolt állapotban táplálja a dátumot, pontos időt és
egyéb beállításokat tároló memóriát. Az egység a hálózati tápegységről vagy PoE++ tápfeszültségről 24 óránként
utántölti a memóriaőrző akkumulátort, függetlenül attól, hogy az egység be vagy ki van-e kapcsolva. Ha az egység nem
kap tápfeszültséget, a memóriaőrző akkumulátor kb. 2 hónap elteltével lemerül. Az akkumulátor feltöltése után használja
az egységet. A memóriaőrző akkumulátor töltöttsége azonban nem befolyásolja az egység működését, amennyiben nem
kívánják rögzíteni a dátumot.

Használati és tárolási feltételek
A készüléket tárolja vízszintes, jól szellőző helyen.
A következő körülmények közötti használat vagy tárolás árthat a készüléknek:

esőnek vagy víznek kitett helyek (pl. eresz alatt),
Kültér és olyan helyek, ahol a hőmérséklet meghaladja a 40 °C értéket
Ne feledje, hogy nyáron zárt autóban a hőmérséklet könnyen 50 °C fölé emelkedhet.
olyan helyek, ahol a hőmérséklet 0 °C alá süllyedhet,
nedves vagy poros helyek, olyan helyek, ahol eső érheti a készüléket,
rezgésnek vagy rázkódásnak kitett helyek,
sugárzásnak, röntgensugárnak és erős mágneses térnek kitett helyek,
erős elektromágneses teret létrehozó rádió vagy TV adók környéke,
hosszabb idejű kitettség tűző napnak vagy fűtőtestnek,

Megjegyzés lézersugarakkal kapcsolatban
Lézersugarak kárt tehetnek a CMOS képérzékelőben. Ha olyan jelenetet vesz, ahol lézerfény is előfordul, vigyázzon,
hogy az ne jusson a kamera CMOS képérzékelőjére. Orvosi és egyéb eszközök nagyteljesítményű lézersugarai
tükröződve és szórva is kárt okozhatnak.

Hordozható távközlési eszközöktől származó elektromágneses zavarok megelőzése
Mobiltelefonok és más távközlési eszközök ezen egység körüli használata működési zavarokat okozhat és zavarhatja a
hang és kép jeleket. Ajánlatos kikapcsolni a hordozható távközlési eszközöket ezen egység környezetében.
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A készüléket ne helyezze orvosi eszközök közelébe
A készülék (beleértve a kiegészítőit) mágnest vagy mágneseket tartalmaz, amelyek zavart okozhatnak a szívritmus-
szabályozók, a programozható hydrocephalus söntszelepek és egyéb orvosi eszközök működésében. A készüléket ne
helyezze ilyen orvosi eszközöket használó személy közelébe. Ha ilyen orvosi eszközöket használ, a készülék használata
előtt kérje ki kezelőorvosa tanácsát.

Biztonsági óvintézkedések
A SONY SEMMINEMŰ FELELŐSSÉGET NEM VÁLLAL AZ ÁTVITELI ESZKÖZÖKRE VONATKOZÓ KELLŐ
BIZTONSÁGI INTÉZKEDÉSEK ELMULASZTÁSÁBÓL, AZ ÁTVITELI SPECIFIKÁCIÓK MIATT ELKERÜLHETETLEN
ADATSZIVÁRGÁSOKBÓL VAGY BÁRMINEMŰ BIZTONSÁGI GONDBÓL FAKADÓ SEMMILYEN KÁRÉRT.
Az üzemi környezettől függően előfordulhat, hogy illetéktelenek hozzáférnek a készülékhez a hálózaton. A készülék
hálózatra kapcsolásakor ellenőrizze, hogy kellően biztonságos-e a hálózat.
Biztonsági szempont: ha a készüléket hálózathoz csatlakoztatva használja, nyomatékosan javasoljuk, hogy a
vezérlőablakot webböngészőből használja, és módosítsa a hozzáférési korlátozási beállítások gyárilag beállított
értékeit. Javasoljuk továbbá, hogy használjon kellően hosszú és nehezen kitalálható jelszót, és tárolja biztonságos
helyen.
Ha hálózatra kapcsolja ezt a terméket, iktasson közbe védelmi funkciót, például útválasztót vagy tűzfalat. Ilyen
védelem nélkül veszélyeztetheti a termék biztonságát.

Tápellátás
Az egységen nincs tápfeszültség kikapcsoló. Az egység kikapcsolásához ellenőrizze, hogy minden működése
befejeződött-e és az egység készenléti állapotban van-e, majd kösse le róla a hálózati tápegységet. PoE++ táplálás
használatakor kösse le a LAN-kábelt.
Lehetőség szerint olyan konnektorból táplálja az egységet, ahová könnyen bedugható és ahonnan könnyen
kihúzható a hálózati dugó.
Ha poros helyen van a konnektor, tisztítsa le a környékét, hogy ne alakulhasson ki kúszóáram.
Ha nem használja az egységet, húzza ki a tápegységet.

Mozgó részekkel kapcsolatos óvintézkedések
Vigyázzon, hogy ne kerüljön idegen anyag a mozgó részekbe.
Ne fejtsen ki túlzott erőt, amikor kézzel mozgatja a mozgó részeket. Ez meghibásodást eredményezhet.
Ne akadályozza mozgó részek mozgását. Ez balesetet vagy meghibásodást eredményezhet.
A mozgó részek mozgása akadályozottá válhat, ha az egységet hosszabb időn át nem használják. Használja
rendszeresen az egység pásztázó/döntő mozgatószerkezetét.

Folyamatos használattal kapcsolatos figyelmeztetések
Az egység az év minden napján, napi 24 órában működtethető, illetve táplálható (készenléti állapot).
Mindig készítsen próbafelvételt és ellenőrizze az egység hibátlan működését.

24 órát meghaladó folyamatos felvételkészítés működése nem garantált.
Ha 24 óránál tovább kíván felvételt készíteni, állítsa az egységet készenléti állapotba, majd indítsa újra.

Felhívjuk figyelmét, hogy a Sony nem vállal semmilyen kártérítési felelősséget a képek tartalmáért, ha az egység
használata közben bármilyen meghibásodás miatt nem tud felvételt készíteni.
Használatbavétele előtt mindig győződjön meg az egység üzemképességéről. A SONY SEMMINEMŰ
FELELŐSSÉGET NEM VÁLLAL, TEHÁT PÉLDÁUL KÁRTÉRÍTÉST VAGY KÖLTSÉGTÉRÍTÉST SEM FIZET, HA
EZEN EGYSÉG JÓTÁLLÁSI IDŐN BELÜL VAGY AZON TÚL BEKÖVETKEZETT MEGHIBÁSODÁSA MIATT VAGY
BÁRMELY MÁS OKBÓL BÁRMELY TÉNYLEGES VAGY VÁRT NYERESÉG ELMARAD.
A SONY NEM FELEL AZ EGYSÉG FELHASZNÁLÓI VAGY HARMADIK SZEMÉLYEK ÁLTAL TÁMASZTOTT
IGÉNYEKÉRT.
A SONY NEM FELEL A JELEN EGYSÉGGEL KAPCSOLATOS BÁRMELY SZOLGÁLTATÁS BÁRMILYEN
KÖRÜLMÉNY MIATTI MEGSZŰNÉSÉÉRT VAGY FÉLBESZAKADÁSÁÉRT.

A felvételi funkcióval kapcsolatos óvintézkedések
Mindig készítsen próbafelvételt és ellenőrizze sikerességét. A SONY SEMMINEMŰ FELELŐSSÉGET NEM VÁLLAL,
TEHÁT PÉLDÁUL KÁRTÉRÍTÉST VAGY KÖLTSÉGTÉRÍTÉST SEM FIZET, HA EZEN EGYSÉG VAGY

461



ADATHORDOZÓJA VAGY BÁRMELY MÁS ADATHORDOZÓ VAGY TÁROLÓRENDSZER MEGHIBÁSODÁSA
MIATT BÁRMELY TÍPUSÚ TARTALOM NEM RÖGZÍTHETŐ.
Használatbavétele előtt mindig győződjön meg az egység üzemképességéről. A SONY SEMMINEMŰ
FELELŐSSÉGET NEM VÁLLAL, TEHÁT PÉLDÁUL KÁRTÉRÍTÉST VAGY KÖLTSÉGTÉRÍTÉST SEM FIZET, HA
EZEN EGYSÉG JÓTÁLLÁSI IDŐN BELÜL VAGY AZON TÚL BEKÖVETKEZETT MEGHIBÁSODÁSA MIATT VAGY
BÁRMELY MÁS OKBÓL BÁRMELY TÉNYLEGES VAGY VÁRT NYERESÉG ELMARAD.
A SONY NEM FELEL AZ EGYSÉG FELHASZNÁLÓI VAGY HARMADIK SZEMÉLYEK ÁLTAL TÁMASZTOTT
IGÉNYEKÉRT.
A SONY NEM FELEL A BELSŐ TÁROLÓRENDSZERÉN, ADATHORDOZÓIN VAGY BÁRMELY MÁS
ADATHORDOZÓN VAGY TÁROLÓN RÖGZÍTETT ADATOK ELVESZÉSÉÉRT, ÁLLAPOTÁÉRT VAGY
MEGJELENÍTÉSÉÉRT.
A SONY NEM FELEL A JELEN EGYSÉGGEL KAPCSOLATOS BÁRMELY SZOLGÁLTATÁS BÁRMILYEN
KÖRÜLMÉNY MIATTI MEGSZŰNÉSÉÉRT VAGY FÉLBESZAKADÁSÁÉRT.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kimeneti formátumok és korlátozások

Ez a témakör a kimeneti formátumokat és korlátozásokat ismerteti.

Megjegyzés

A kimeneti formátum felbontását a webes menü vagy kameramenü [Project] > [Rec Format] > [Frequency], [Codec], és [Video
Format] beállításai korlátozzák.

A kimeneti formátum felbontását korlátozza az S&Q képfrekvenciával való kombinálás is. Az SDI OUT/HDMI OUT csatlakozó
kimeneti formátumait tartalmazó alábbi táblázaton túlmenően a HDMI kimenet Full HD-re vagy alacsonyabbra vált, ha teljesül az
összes következő feltétel.

[Shooting] > [S&Q Motion] > [Setting] beállítása [On]
[Shooting] > [S&Q Motion] > [Frame Rate] értéke nagyobb, mint 60fps

A fenti feltételek teljesülése esetén a [Monitoring] > [Output Format] > [SDI/HDMI] menüpont 4096×2160P és 3840×2160P HDMI
kimenőjel választási lehetősége ki van szürkítve és nem választható.

A kép nem kerül a kimenetre, ha a lejátszási kép felbontásánál nagyobb felbontás van beállítva.

A SDI OUT/HDMI OUT csatlakozó kimeneti formátumai

Ha a rendszerfrekvencia 50/59.94 Hz

Beállítás Választható kimeneti formátum

Felvételi/lejátszási
üzemmód

RAW kimenet
felbontása/

belső felvételi
felbontás

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(alapértelmezés)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(alapértelmezés)
1920×1080i
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Ha a rendszerfrekvencia 25/29.97 Hz

Beállítás Választható kimeneti formátum

Felvételi/lejátszási
üzemmód

RAW kimenet
felbontása/

belső felvételi
felbontás

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(alapértelmezés)

1920×1080P
(alapértelmezés)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(alapértelmezés)

1920×1080P
(alapértelmezés)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(alapértelmezés)

1920×1080P
(alapértelmezés)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Kimenet leállítva)
720×480P2)

720×576P3)

A képernyőkép nem szuperponálható.1)

Ha a rendszerfrekvencia 59.942)

Ha a rendszerfrekvencia 503)
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Ha a rendszerfrekvencia 23.98 Hz

Beállítás Output Format (kimeneti felbontás)

Felvételi/lejátszási
üzemmód

RAW kimenet
felbontása/

belső felvételi
felbontás

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i
(alapértelmezés)

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i
(alapértelmezés)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(alapértelmezés)

1920×1080i
(alapértelmezés)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(alapértelmezés)

1920×1080i
(alapértelmezés)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Beállítás Output Format (kimeneti felbontás)

Felvételi/lejátszási
üzemmód

RAW kimenet
felbontása/

belső felvételi
felbontás

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(alapértelmezés)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
(alapértelmezés)
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Ha a rendszerfrekvencia 24 Hz

5-041-958-53(1) Copyright 2022 Sony Corporation

Beállítás Output Format (kimeneti felbontás)

Felvételi/lejátszási
üzemmód

RAW kimenet
felbontása/

belső felvételi
felbontás

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(alapértelmezés)

1920×1080P
(alapértelmezés)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(alapértelmezés)

1920×1080P
(alapértelmezés)

1920×1080
1920×1080P
(alapértelmezés)

1920×1080P
(alapértelmezés)

Beállítás Output Format (kimeneti felbontás)

Felvételi/lejátszási
üzemmód

RAW kimenet
felbontása/

belső felvételi
felbontás

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P
(alapértelmezés)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P
(alapértelmezés)

4096×2160P
1920×1080P
(alapértelmezés)
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Hibaelhárítás

Tápellátás

Kép kimenet

Hibajelenség Oka Megoldás

Nem kapcsol be
az egység.

Nem csatlakozik rendesen a hálózati
tápegység vezetéke a készülék DC IN
aljzatához.

Nyomja be ütközésig a vezeték dugaszát.

Nem csatlakozik rendesen a hálózati vezeték
a hálózati tápegységhez vagy a konnektorhoz.

Nyomja be ütközésig a vezeték dugaszát.

Nem csatlakozik rendesen a LAN-kábel a
PoE++ tápforráshoz vagy az egységhez.

Ellenőrizze, hogy a kábel kattanásig a helyére
van-e dugaszolva.

A LAN-kábel csatlakozik az OPTION
csatlakozóhoz, de nem csatlakozik a LAN
csatlakozóhoz.

Dugaszolja jól a helyére a LAN-kábel
csatlakozóját a LAN csatlakozóban.

Az egység olyan tápforráshoz csatlakozik,
amely nem PoE++ (IEEE802.3bt Type 4 Class
8) kompatibilis.

Csatlakoztassa PoE++ (IEEE802.3bt Type 4
Class 8) kompatibilis tápforráshoz.

Az összfogyasztás meghaladja a PoE++
tápforrás maximális teljesítményét.

Nézzen utána a PoE++ tápforrás kezelői
utasításaiban.

PoE++ tápellátást nem támogató kategóriájú
hálózati adatkábelt használnak.

PoE++ tápláláshoz csatlakoztasson 5e vagy
magasabb kategóriájú hálózati adatkábelt a
LAN csatlakozóhoz.

Nincs földelve a kamera, a PoE++ tápforrás
és a perifériák.

Földelje a kamerát, a PoE++ tápforrást és a
perifériákat.

Hibajelenség Oka Megoldás

Nem működik a kép
kiadása.

Nem csatlakoznak rendesen a kimenetre kötött
eszközök.

Csatlakoztassa őket rendesen.

Nem végezték el a kezdeti beállítást
(inicializálást).

Végezze el a kezdeti beállítást a
webes alkalmazással.

Nem jön létre kép a HDMI
csatlakozó kimenőjeléből.

A HDMI kimenet céleszközén nem támogatott jel
van konfigurálva.

Módosítsa a HDMI kimeneti
formátum beállítását vagy
használjon olyan eszközt, amely
képes fogadni a kiadott jelet.

A kimeneti HDMI szabványhoz alkalmatlan kábelt
használnak.

Használjon olyan kábelt, amely
támogatja a kimenet HDMI
szabványát.
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Távvezérlő

Infra távvezérlő

Hibajelenség Oka Megoldás

Nem jön létre kép az SDI
csatlakozó kimenőjeléből.

A kimeneti SDI szabványhoz alkalmatlan kábelt
használnak.

Használjon olyan kábelt, amely
támogatja a kimenet SDI
szabványát.

Az SDI csatlakozóra kötött monitor nem támogatja
a kimenőjelet.

Használjon SDI szabványos
monitort.

A felvételi formátum beállítása RAW kimenet.
Állítsa át a felvételi formátumot a
RAW kimeneti helyett más
beállításra.

A HDMI kimenet SD felbontásra van állítva.
Állítsa át más felbontásra a HDMI
kimenetet.

Nem jön létre kép a
fényvezetőszál
kimenőjeléből, vagy
torzított a kép.

A használt modul nem kompatibilis az SFF vagy
SMPTE szabvánnyal, vagy nem teljesíti a
Teljesítményszint I (1,0 W) teljesítményszint-
előírást.

Lásd: „Optikai jel kiadása
fényvezetőre”.

Külső szinkronizálás
használatakor nem
működik a kép kiadása
vagy torzított a kép.

Nem alkalmas a konfigurált videojel formátumhoz
a külső szinkronjel.

Adjon be a konfigurált videojel
formátumhoz alkalmas külső
szinkronjelet.

Zajos a hang.

Nincs földelve a kamera, a PoE++ tápforrás és a
perifériák.

Földelje az egységet, a PoE++
tápforrást és a perifériákat.

Az eszköz környezetében erős elektromos és
mágneses teret keltő zavarjel-források működnek
(például TV/rádió adóantennák, amatőr rádió
adók, légkondicionáló motorok, tápegység
transzformátorok).

Tartson kellő távolságot az erős
elektromos és mágneses teret keltő
zavarjel-forrásoktól.

Az objektív, az objektívtámasztó és a hajtóegység
érintkezik az egységgel vagy a környezet
valamilyen tárgyával, és ez rendellenes zajt kelt.

Szerelje fel az objektívet
szakszerűen.

Ellenőrizze, van-e valamilyen
akadály a kamera
környezetében.

Hibajelenség Oka Megoldás

Nem működik az infra
távvezérlő, hiába nyomják a
gombjait.

Le van tiltva az infra távvezérlő
működése.

Állítsa a webes menü [Technical] > [IR
Remote] > [Setting] pontját [On] értékre.

Lemerült az elem vagy fordított
polaritással helyezték be.

Az egység infra érzékelőjéhez minél közelebb
használja az infra távvezérlőt. Cserélje ki az
elemet, ha villog a Power LED.

Nem végezték el a kezdeti beállítást
(inicializálást).

Végezze el a kezdeti beállítást a webes
alkalmazással.
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RM-IP500

Webes alkalmazás

Hibajelenség Oka Megoldás

Lassú a pásztázó/döntő
mozgás.

A pásztázási/döntési gyorsaság az
infravörös távirányítóról normál
üzemmódra van állítva.

Állítsa az egység csatlakozótömbjén a 4.
SETUP kapcsolót ON helyzetbe.

Az infra távvezérlő más
kamerát működtet, nem a
szándékoltat.

Nem a szándékolt, hanem másik
kamera vette az infra vezérlőjelet.

Állítsa a nem vezérelendő kamera webes
menüje [Technical] > [IR Remote] > [Setting]
pontját [Off] értékre.

Hibajelenség Oka Megoldás

Nem működtethető a kamera az
RM-IP500 távvezérlővel.

Nincs tápegység kötve a
kamerára.

Ellenőrizze, hogy világít-e zöld vagy
narancssárga színnel az egység POWER
jelzőlámpája.

Nem kapcsolódik a
hálózatra a kamera vagy a
távvezérlő.

Ellenőrizze az egység és a távvezérlő
csatlakozásait.

Nem végezték el a kamera
kezdeti beállítását
(inicializálását).

Végezze el a kezdeti beállítást a webes
alkalmazással.

Nincs engedélyezve a
VISCA over IP
kommunikáció.

Állítsa az egység csatlakozópanelén a 3. SETUP
kapcsolót ON helyzetbe, és indítsa újra az
egységet.

Megváltozott a kamera IP-
címe.

Ellenőrizze a kamera IP-címét a webes menü
vagy a kameramenü [Network] > [Wired LAN]
pontjában.

Megváltoztatták a kamera IP-címét
az RM-IP500 távvezérlő AUTO IP
SETUP beállításával.

20 vagy több perc telt el a
kamera bekapcsolása óta.

Indítsa újra az egységet. Az AUTO IP SETUP
beállítással csak az egység bekapcsolását
követő 20 percben módosítható az IP-cím.
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Hibajelenség Oka Megoldás

Nem lehet felcsatlakozni a
webböngészővel.

Rosszul csatlakozik vagy nem
5e vagy jobb kategóriájú a LAN-
kábel.

Csatlakoztassa 5e vagy jobb kategóriájú a
LAN-kábellel.

Nem jó a LAN kapcsolat vagy
csatlakozás, vagy nem működik
rendesen a hálózat.

Ellenőrizze, hogy világít-e a LAN csatlakozó
kapcsolatjelző LED lámpája. Ha nem világít,
keresse meg a hálózati rendszergazdát.

Nincs tápegység kötve a
kamerára.

Lásd a fenti „Tápellátás” cím alatt.

Nem állítottak be érvényes IP-
címet az egységre.

Végezzen hálózat-visszaállítást.

Más eszköz már használja a
beállított IP-címet.

Ellenőrizze a perifériás egységek IP-címének
egyedi voltát.

A beállított alhálózati maszk nem
egyezik a ténylegesen
használttal.

Végezzen hálózat-visszaállítást.

Az egységhez ugyanazon a
hálózaton proxy szerver
kapcsolódik.

Módosítsa úgy a beállítást, hogy ne
kapcsolódjon proxy szerver.

Pontatlan az egység
alapértelmezett átjáró beállítása.

Végezzen hálózat-visszaállítást.

Pontatlan a megadott URL cím.
Írjon be pontos URL címet és próbálja meg
azzal.

Pontatlan a HTTP portszám.

Jelenítse meg a kamera menüjét külső
monitoron és ellenőrizze a [Network] > [Wired
LAN] > [HTTP Port] pont beállítását. Ha a
beállított érték nem 80, adja hozzá a HTTP
portszámot a hostnévhez vagy IP-címhez a
webböngészőben.
Példa: ha a HTTP port értéke 8080, ezt írja
be: http://<IP-cím>:8080

Ki van szűrve vagy blokkolva
van az egység HTTP portszáma.

Állítsa át az egység HTTP portszámát olyan
értékre, amely nincs kiszűrve vagy blokkolva.

A webböngésző gyorsítótárában
levő régi érték zavar be.

Törölje a webböngésző gyorsítótárát.

Nem lehet kapcsolódni a webes
alkalmazáshoz 2D (QR) kóddal.

A használt eszköz nem
támogatja az mDNS protokollt.

Használjon olyan eszközt, amelyik támogatja
az mDNS protokollt.
Az mDNS protokollt nem támogató eszköz
használatakor írja közvetlenül a
webböngészőbe az IP-címet.

A táblagép vagy számítógép
más hálózaton van, mint a
kamera.

Kösse a táblagépet vagy számítógépet
ugyanarra a hálózatra, amelyiken az egység
van.
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Hibajelenség Oka Megoldás

Nem lehet kapcsolódni a webes
alkalmazáshoz kézzel beírt URL
címmel.

A használt eszköz nem
támogatja az mDNS protokollt.

Használjon olyan eszközt, amelyik támogatja
az mDNS protokollt.

A táblagép vagy számítógép
más hálózaton van, mint a
kamera.

Kösse a táblagépet vagy számítógépet
ugyanarra a hálózatra, amelyiken az egység
van.

Folyamatosan a hitelesítést kérő
képernyő látszik.

Nem adták meg a helyes
felhasználónevet vagy jelszót.

Írja be a regisztrált felhasználónevet és
jelszót. Ha elfelejtette a regisztrált
felhasználói adatokat, inicializálja a hálózati
kapcsolat felhasználói adatait a
„Csatlakozótömb” cím „RESET kapcsoló”
pontjában leírtak szerint.

Lehet, hogy egy másik
webböngészővel bejelentkezett
felhasználó megváltoztatta a
felhasználónevet és jelszót.

Egyeztesse az egység rendszergazdájával a
felhasználónév és a jelszó helyességét.

Nem jelenik meg a kamera képe a
webes alkalmazásban.

A kamera HDMI kimenete
720×480 vagy 720×576
képpontos felbontásra van
állítva.

Állítsa át az egység HDMI kimenete
felbontását.

A kamera HDMI kimenőjelét
nem támogató HDMI monitort
használnak.

Kösse le a HDMI monitort vagy használjon a
kamera HDMI kimenet beállításait támogató
HDMI monitort.

Újraindították az egységet és
lekapcsolódott a munkamenet.

Várjon kb. egy percet és töltse be újra a
webböngészőt.

A webböngésző gyorsítótárában
levő régi érték zavar be.

Törölje a webböngésző gyorsítótárát.

A webes alkalmazásban
megjelenő kameraképnek kicsi a
felbontása.

Alacsonyra van állítva a webes
alkalmazás által használt 3.
video stream felbontása.

Növelje meg az értéket a webes menü
[Stream] > [Video Stream] > [Size 3]
pontjában.

A [Menu] gomb megnyomásakor
nem jelenik meg a kameramenü.

A kamera menü úgy van
beállítva, hogy nem ágyazódik a
HDMI kimenőjelbe.

Állítsa a webes menü [Monitoring] > [Output
Display] > [HDMI/Stream] pontját [On] értékre.

A beállító képernyőn valamelyik
beállítás értéke nem frissül/nem
látszik megfelelően.

A webes alkalmazás beállító
képernyője nem tükrözi
automatikusan azokat a
beállításokat, amelyeket másik
webes alkalmazásban
módosítottak.

Nyomja meg a webes alkalmazás beállító
képernyője alján található [Reload] gombot.
Ez újratölti és frissíti a beállítások értékét a
megjelenített beállító képernyőn.

Bezavarnak az ideiglenes
internet fájlok beállításai.

Törölje a webböngésző gyorsítótárát.

Nem tölthető le a konfigurációs fájl
vagy napló.

Le van tiltva a webböngésző fájl
letöltési funkciója.

Engedélyezze a webböngésző fájl letöltési
funkcióját.
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Felvételkészítés

Kamera

Pásztázás/döntés

Hibajelenség Oka Megoldás

A webes alkalmazás beállító
képernyője elérhető ugyan, de
nem képes műveleteket végezni
az élő működtető képernyőn és a
lejátszásvezérlő képernyőn.

Zárolva van a webes alkalmazás
működtető képernyője.

Állítsa a webes alkalmazás jobb felső
sarkában levő működtetés-zároló kapcsolót a

 (Működés feloldása) helyzetbe.

Lassú a webes alkalmazás
képernyője.

Sok felhasználó nézi egyszerre
az egység streamelt képét.

Csökkentse a webes alkalmazás egyidejű
elérésére jogosult felhasználók számát.

Torz vagy szaggatott a kép.

Rossz a videoátvitel a
kommunikációs útvonal
zsúfoltsága miatt.

Csökkentse a streamelési bitsebességet,
állítsa a [Video Stream 3] > [Size] menüpontot
a lehető legkisebb értékre, vagy csökkentse a
sebességet, hogy legyen egy kis tartalék a
kommunikációs sávban.

Több webböngésző fut a
táblagépen és foglalja a
memóriát.

Zárja be a háttérben futó webböngészőket.

A webböngészőn túl sok fül van
megnyitva, ami lassítja a
működést.

Zárja be a nem használt füleket.

Nagyon feltelt a webböngésző
gyorsítótára, és az előzmények
lassítják a működést.

Törölje a webböngésző gyorsítótárát.

Hibajelenség Oka Megoldás

Torzított a kép a pásztázó/döntő
mozgatás kezdetén és végén.

A torzulást az okozhatja, hogy be van
kapcsolva az objektív képstabilizáló
funkciója.

Kapcsolja ki az objektív
képstabilizáló funkcióját.

Felhasználói beavatkozás nélkül
megváltozott a látószög.

Objektív-lélegzés történt. Lásd: „Légzéskompenzálás”.

Nem működik a fókusz, zoom vagy
fényrekesz.

Lehet, hogy helytelen az objektív
kapcsolóinak beállítása.

Lásd: „Az objektív kapcsolóinak
ellenőrzése”.

Hibajelenség Oka Megoldás

Nem állítható vissza a
pásztázás/döntés.

LOCK helyzetben áll a
pásztázó/döntő zárókar.

Csúsztassa a pásztázó/döntő zárókart az UNLOCK
helyzetbe.
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Hibajelenség Oka Megoldás

Nem áll le a kamera a várt
helyzetben.

Kiegyensúlyozatlan a
kameratömb.

Mozgassa a kameratömböt előre/hátra, megfelelő
helyzetbe, az „Objektív felszerelése” cím alatt leírtak
szerint, és kapcsolja be ismét az egységet.

A pásztázó/döntő mozgatást
nem támogató objektív van
felhelyezve.

Lapozza fel az objektív kompatibilitási információit,
csatlakoztasson pásztázó/döntő mozgatást
támogató objektívet, és kapcsolja be ismét az
egységet.

Nem végezhető
pásztázás/döntés visszaállítás. Állítsa vissza a pásztázást/döntést a „A

pásztázás/döntés visszaállítása” cím alatt leírtak
szerint.

Váratlan erőhatás érte a
kamerafejet, ami hibát okozott
a pásztázó/döntő vezérlésben.

Nem tér vissza előrenéző
helyzetbe a kamera a

 (pásztázás/döntés
kezdőhelyzet) gomb
megnyomott állapotában.

Aktív a mennyezetre rögzítési
üzemmód.

Állítsa be a webes menü [Pan-Tilt] > [P/T Direction] >
[Ceiling] pontját a tényleges felerősítési helyzet
szerint, majd kapcsolja be ismét az egységet.
Mennyezetre szereléskor a csatlakozótömb a
kamera elején van.

Korlátozott a pásztázó/döntő
működés.

Pásztázási/döntési tartomány
korlátozás van beállítva.

Törölje a pásztázási/döntési tartomány korlátozását,
ha szükséges, a „P/T Range Limit” cím alatt leírtak
szerint.

Váratlan erőhatás érte a
kamerafejet, ami hibát okozott
a pásztázó/döntő működésben.

Állítsa vissza a pásztázást/döntést a „A
pásztázás/döntés visszaállítása” cím alatt leírtak
szerint.

Ellenkező irányba mozog a
pásztázás/döntés.

A beállított mennyezetre
rögzítési üzemmód eltér a
tényleges felerősítési
helyzettől.

Állítsa be a webes menü [Pan-Tilt] > [P/T Direction] >
[Ceiling] pontját a tényleges felerősítési helyzet
szerint.

Megváltoztak a
pásztázási/döntési iránnyal
kapcsolatos beállítások.

Ellenőrizze a webes menü [Pan-Tilt] > [P/T Direction]
beállításait.

Zökög a kép a
pásztázó/döntő mozgatás
kezdetén és végén.

Túl nagyra van állítva a
pásztázó/döntő mozgás
gyorsulása/lassulása.

A webes menü vagy kameramenü [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] pontjában állítsa
kisebbre a pásztázó/döntő mozgás
gyorsulását/lassulását, hogy ne ugráljon a kép a
pásztázó/döntő mozgatás kezdetén és végén. Ez
azonban azzal jár, hogy az objektív lassabban éri el
maximális mozgási sebességét.

Leállt a pásztázó/döntő
mozgás.

Kiegyensúlyozatlan a
kameratömb.

Mozgassa a kameratömböt előre/hátra, megfelelő
helyzetbe, az „Objektív felszerelése” cím alatt leírtak
szerint, és kapcsolja be ismét az egységet.

A felhelyezett objektívhez
képest túl nagyra van állítva a
pásztázó/döntő mozgás
gyorsulása/lassulása.

Ha nagy a felhelyezett objektív, csökkentse a webes
menü vagy kameramenü [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] pontjában beállított
értéket.

Nagy a felhelyezett objektív. Keresse meg a Sony vevőszolgálatot.
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Hibajelenség Oka Megoldás

Valami akadályozza a
pásztázó/döntő mozgást.

Az objektívtámasztó talapzat
rögzítőcsavar bilincsének
szorítókarjának ütközik a
kamera.

Úgy állítsa be az objektívtámasztó talapzat
rögzítőcsavar bilincsének szorítókarját, hogy felfelé
álljon.

Az objektívtámasztó bilincs
szorítókarjának ütközik a
kamera.

Úgy állítsa be az objektívtámasztó bilincs
szorítókarját, hogy felfelé álljon.

A kamerafej zárókarjának
ütközik a kamera.

Ellenőrizze, hogy teljesen LOCK helyzetben áll-e a
kamerafej zárókarja.

Rendellenes zaj hallatszik a
pásztázó/döntő mozgás
közben.

Kiegyensúlyozatlan a kamera.
Mozgassa előre/hátra a kamerafejet olyan helyzetbe,
hogy a csúszótalp vízszintes legyen.

A felhelyezett objektívhez
képest túl nagyra van állítva a
pásztázó/döntő mozgás
gyorsulása/lassulása.

Ha nagy a felhelyezett objektív, csökkentse a webes
menü vagy kameramenü [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] pontjában beállított
értéket.

Nincs a helyére rögzítve a
kamerafej és működése
közben mozgási zaj hallható.

Állítsa a kamerafej zárókarját LOCK helyzetbe.

Nem menthető el egy
előbeállított helyzet.

A Clear Image Zoom
működése közben nem
menthető el előbeállítás.

Állítsa vissza a Clear Image Zoom nagyítását 1×
értékre. (ilyenkor a tényező nem jelenik meg a 
(nagyítás) jobb oldalán)

Előbeállított helyzet
lejátszásakor eltolódott a
keretezés.

Jelentősen megváltozott a
környezet hőmérséklete az
előre beállított helyzet
elmentése és lejátszása között.

Mentse el ismét az előbeállított helyzetet.

Nem végeztek objektív-
kalibrálást.

Futtassa le a kalibrálást a kameramenü [Technical] >
[Lens] > [Lens Calibration] pontjában.

Más objektív van
csatlakoztatva, mint ami az
előbeállítás mentésekor volt.
Vagy eltérő a kézi zoomolás
Zoom helyzete.

Mentse el ismét az előbeállított helyzetet.

A webes alkalmazás
keretezésvezérlő panele ki
van szürkítve és nem
használható.

A pásztázás/döntés nem
működik a miniatűrök
képernyőjének megjelenítése
és lejátszás közben.

Jelenítse meg a lejátszásvezérlő képernyőt és lépjen
ki a miniatűrök képernyőjéből vagy állítsa le a
lejátszást.

Nem használható a
pásztázás/döntés, amikor a
webes alkalmazásban nem
jeleníthető meg a kamera
képe.

Lásd a „Hibaelhárítás” „Webes alkalmazás” pontját.

LOCK helyzetben áll a
pásztázó/döntő zárókar.

Csúsztassa a pásztázó/döntő zárókart az UNLOCK
helyzetbe.
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Felvétel / lejátszás

Fájlátvitel

IP streamelés

Hibajelenség Oka Megoldás

A webes alkalmazás
keretezésvezérlő panele
alatt „Execute Pan-Tilt
Reset” látható.

Váratlan erőhatás érte a
kamerafejet, ami hibát okozott
a pásztázó/döntő működésben.

Állítsa vissza a pásztázást/döntést a „A
pásztázás/döntés visszaállítása” cím alatt leírtak
szerint.

Hibajelenség Oka Megoldás

A felvétel START/STOP
gomb lenyomásakor nem
indul el a felvétel.

Megtelt a memóriakártya. Cserélje ki olyanra, amelyiken még van elég hely.

Visszaállítást igényel a
memóriakártya.

Állítsa vissza a memóriakártyát a
„Memóriakártyák visszaállítása” pontban leírtak
szerint.

A felvétel/állapot jelzőlámpa tally
lámpaként van beállítva, s ezért
nem tudja kijelezni a felvételi
állapotot.

Állítsa be felvételiállapot-jelző lámpaként a
felvétel/állapot jelzőlámpát, a „Tally jel
csatlakoztatása” cím alatt leírtak szerint.

Nem lehet hangfelvételt
készíteni.

Nincs csatlakoztatott mikrofon.
Csatlakoztasson mikrofont vagy hangeszközt a
csatlakozótömb AUDIO IN csatlakozójára.

A legkisebb értékre van állítva a
[Master Input Level].

Állítsa át [Master Input Level] értékét.

Torzított a felvett hang.
Túl nagyra van állítva a bemeneti
hangszint.

Állítsa a [CH1 Input Level] pontot [CH4 Input
Level] és [Master Input Level] értékre.

Ha hangos környezetben, például élő koncerten
használ mikrofont, előtte állítsa be [AUDIO IN
CH1 MIC Ref.] és [AUDIO IN CH2 MIC Ref.]
értékét.

Zajos a felvett hang.
Túl kicsire van állítva a bemeneti
hangszint.

Módosítsa az [Audio Input Level] és [Audio] >
[Audio] > [Audio Input] > [AUDIO IN CH1 MIC
Ref.] vagy [AUDIO IN CH2 MIC Ref.] beállításait.

Nem játszható le egy vagy
több klip.

A klip szerkesztés alatt áll.

Nem játszhatók le a klipek, ha megváltoztatta a
fájlneveket vagy mappaneveket, vagy ha az
érintett klipet számítógép használja. Ez nem a
készülék hibája.

A klipet nem ezzel az egységgel,
hanem más kamerával vették fel.

Más kamerával felvett klipek nem biztos, hogy
lejátszhatók ezzel az egységgel, vagy pontatlan
méretben jelennek meg. Ez nem a készülék
hibája.

Hibajelenség Oka Megoldás

Nem lehet feltölteni
fájlokat.

Helytelen a szerveren levő
felhasználónév és jelszó.

Lehet, hogy nem helyes a szerveren levő felhasználónév
és jelszó. Írja be a helyes értékeket.
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Hibajelenség Oka Megoldás

Nem érhető el a
streamelés.

A streamelésnek az egységről
nézéséhez az ügyfél
alkalmazásban megadott
felhasználónév vagy jelszó
hibás.

Ha az egység streamelési formátuma [RTSP], [SRT-
Listener] vagy [NDI|HX], az ügyfél alkalmazásban
meg kell adni az ehhez az egységhez tartozó
felhasználónevet és jelszót. Írja be a helyes
felhasználónevet és jelszót.

Nincs beállítva a streamelési
protokoll.

Válassza ki a célprotokollt a webes menü [Stream] >
[Stream Setting] pontjában.

Hat vagy több RTSP
munkamenet lett beállítva.

Állítsa a munkamenetek számát ötre vagy
kevesebbre.

Helytelen a beállított UDP
portszám.

Adja meg a portszámot és a célprotokoll más
beállításait a webes menü [Stream] > [Stream] >
[Stream Setting] pontjában.

Blokkolva van az UDP
kommunikáció.

Ellenőrizze a biztonsági szoftver beállításait.

A hang nem streamelődik.
A hang kimenet streamelésének
beállítása [Off].

Állítsa a webes menü [Stream] > [Audio Stream] >
[Setting] pontját [On] értékre.

Ki lett kapcsolva a
streamelés.

Streamelés közben
megváltoztatták a protokoll
beállítását vagy a streamelési
kodek beállításait.

A streamelés előtt állítsa be a protokoll beállítását és
a streamelési kodek beállításait.

A [Video Stream 1]
képmérete nem állítható
4096×2160 vagy
3840×2160 értékűre.

A képméret 1920×1080, ha az
[Output Format] beállítása
HDMI.

A streamelés képmérete nem állítható nagyobbra a
HDMI képméretnél. Módosítsa a HDMI képméretet a
webes menü [Monitoring] > [Output Format]
pontjában.

A [Video Stream 1]
képfrekvenciája nem
állítható 60 FPS vagy 50
FPS értékre.

A streamelés képfrekvencia
beállítása 29.97 vagy kisebb.

A streameléshez használt képfrekvenciát a
rendszerfrekvencia korlátozza. Módosítsa a
rendszerfrekvenciát a webes menü [Rec Format] >
[Frequency] pontjában.

Nem érhető el a [Video
Stream 3] stream.

A [Video Stream 3] nem
támogatja ezeket:
RTSP/SRT/NDI.

Használja a [Video Stream 1] vagy [Video Stream 2]
lehetőséget.

Nem frissül az RTSP/SRT
képernyő vagy nem jó a
megjelenése.

Ki van szűrve vagy blokkolva
van az RTSP-hez vagy SRT-hez
használt portszám.

Állítsa át az RTSP vagy SRT portszámát olyan
értékre, amelyet nem szűrnek ki vagy blokkolnak a
streamelést fogadó eszközök. Vagy módosítsa az
egységen az RTSP-hez vagy SRT-hez használt
portszámot.

Torz vagy szaggatott a
kép.

Rossz a videoátvitel a
kommunikációs útvonal
zsúfoltsága miatt.

Csökkentse a streamelési bitsebességet vagy
módosítsa a [Video Stream 2] kodek ([Codec 2])
beállítását [Off] értékre, hogy legyen egy kis tartalék a
kommunikációs sávban.

Megváltozott a videocsomagok
sorrendje a kommunikációs
csatornában.

Használja ugyanazt az internet-szolgáltatót az egység
oldalán és a vételi oldalon.
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Kapcsolat külső eszközökkel

Külső szinkronizálás

Tally

Objektívvezérlő

Hibajelenség Oka Megoldás

Az egység nincs NDI
eszközként érzékelve.

A streamelési protokoll nincs
NDI|HX-re állítva.

A streamelési protokollt NDI|HX-re kell állítani ahhoz,
hogy az egység NDI eszközként legyen érzékelve.
Állítsa a webes menü [Stream] > [Stream Setting]
pontját [NDI|HX] értékre.

Nem használható NDI
eszközként.

Nincs telepítve NDI|HX licenc.
Telepítsen NDI|HX licencet. NDI|HX licenc meglétét a
webes menü [Stream] > [Stream] > [Stream Setting] >
[NDI|HX] > [License] pontjában ellenőrizheti.

Hibajelenség Oka Megoldás

Nem szinkronizálható
külső jelforráshoz.

Nem alkalmas a konfigurált
videojel formátumhoz a külső
szinkronjel.

Adjon be a konfigurált videojel formátumhoz alkalmas
külső szinkronjelet.

Két lezáró csatlakozik az
eszközhöz.

Az eszköznek van már beépített 75 Ω-os lezárója. Kösse
közvetlenül jelforrásra (semmi mást nem csatlakoztatva
arra), vagy használjon elosztót (splittert).

Hibajelenség Oka Megoldás

Nem világít a tally
lámpa.

Off-ra van állítva a tally lámpa
fényereje.

Állítsa be a megfelelő fényerőt a webes menü [Technical]
> [Tally] > [Tally Lamp Brightness] pontjában.

A felvétel/állapot jelzőlámpa felvétel
lámpaként van konfigurálva.

Konfigurálja a felvétel/állapot jelzőlámpát tally lámpaként
való működésre a „Tally jel csatlakoztatása” cím alatt
leírtak szerint.

RM-IP500 van csatlakoztatva és le
van tiltva a VISCA over IP.

Állítsa az egység csatlakozótömbjén a 3. SETUP
kapcsolót ON helyzetbe.

OPTION csatlakozó hiba vagy nincs
GND földpontra kötve a
célérintkező.

Kösse GND földpontra az OPTION csatlakozó 7. vagy 8.
érintkezőjét, a „Tally jel csatlakoztatása” cím alatt leírtak
szerint.

Hibajelenség Oka Megoldás

[Communication Error]
látható az 
(Kameraállapot) alatt.

A kamera nem tud
kommunikálni az
objektívvezérlővel.

Ellenőrizze az egység és az objektívvezérlő kapcsolatát,
majd kapcsolja ki és be az egységet és az objektívvezérlőt.

[Rotation Error] látható
az  (Kameraállapot)
alatt.

Forgatási hiba történt az
objektívvezérlőben.

Nem egyezik az objektív mozgástartománya a tárolt zoom
mozgástartománnyal. Inicializálja az objektívvezérlőt.
Ha a probléma továbbra is fennáll, forduljon az
objektívvezérlő gyártójának képviselőjéhez.
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Kapcsolódó témák

Optikai jel kiadása fényvezetőre

Csatlakozótömb

Légzéskompenzálás

Az objektív kapcsolóinak ellenőrzése

Objektív felszerelése

A pásztázás/döntés visszaállítása

P/T Range Limit

Memóriakártyák visszaállítása

Tally jel csatlakoztatása

5-041-958-53(1) Copyright 2022 Sony Corporation

Hibajelenség Oka Megoldás

[System Error] látható az
 (Kameraállapot) alatt.

Rendszerhiba történt az
objektívvezérlőben.

Ellenőrizze az egység és az objektívvezérlő kapcsolatát,
vegye elő az objektívvezérlő kezelői utasításait és
inicializálja az objektívvezérlőt, vagy kapcsolja ki és be az
egységet és az objektívvezérlőt.
Ha a probléma továbbra is fennáll, forduljon az
objektívvezérlő gyártójának képviselőjéhez.

[Unknown Error] látható
az  (Kameraállapot)
alatt.

Ismeretlen hiba történt az
objektívvezérlőben.

Ellenőrizze az egység és az objektívvezérlő kapcsolatát,
vegye elő az objektívvezérlő kezelői utasításait és
inicializálja az objektívvezérlőt, vagy kapcsolja ki és be az
egységet és az objektívvezérlőt.
Ha a probléma továbbra is fennáll, forduljon az
objektívvezérlő gyártójának képviselőjéhez.
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Hibaüzenetek/figyelmeztetések

Ha figyelmeztetés, figyelemfelhívás jelenik meg vagy nyugtázást kérő üzemállapot jelentkezik, a kamerakép-panelen
üzenet jelenik meg, és villogni kezd az előlapi POWER és NETWORK jelzőlámpa, valamint a felvétel/állapot jelzőlámpa.

Megjegyzés

A felvétel/tally jelzőlámpa villogó jelzése csak akkor van engedélyezve, ha a webes menü vagy kameramenü [Technical] > [Tally]
> [Tally Control] beállítása [Internal] és egyidejűleg [Tally Lamp Brightness] beállítása nem [Off].

Hibaüzenetek

Ha az alább leírtak szerint villog a POWER és NETWORK jelzőlámpa, végezze el a következő beavatkozásokat.

Az egység leáll a következő képernyők megjelenésekor.

Figyelmeztető üzenetek

Kövesse a feltüntetett utasításokat a következő üzenetek megjelenésekor.

POWER
jelzőlámpa

NETWORK
jelzőlámpa Oka és megoldása

Lassú
narancssárga
villogás

Lassú zöld
villogás

Valami probléma van az egység működésével. Részletek: a webes menü
[Maintenance] > [System Log] pontjában. Ha a probléma az egység készenléti
üzemmódba helyezése vagy kikapcsolása, majd újra bekapcsolása után is
fennáll, keresse meg a Sony szervizt.

Gyors
narancssárga
villogás

Gyors zöld
villogás

Meghibásodott az egység. Keresse meg a Sony szervizt.

Üzenet
kijelzése

Felvétel/
állapot

jelzőlámpa
Oka és megoldása

E +
hibakód

Gyorsan villog

Rendellenességet jelez az egységben. A felvétel akkor is leáll, ha ●REC látható a
kamerakép-panelen.
Kapcsolja ki az egységet és ellenőrizze a használt eszközöket, kábeleket,
adathordozókat. Ha a hiba az egység ismételt bekapcsolásakor sem szűnik meg,
keresse meg a Sony szervizt. A hibajelzés vagy figyelmeztető hangjelzés el is
maradhat, az egység állapotától függően.

Üzenet kijelzése Felvétel/állapot
jelzőlámpa Oka és megoldása

Temperature High Villog
Nagy a belső hőmérséklet.
Kapcsolja ki a videokamerát és hagyja lehűlni, mielőtt ismét használni
kezdi.
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Figyelemfelhívó és a működésre vonatkozó üzenetek

A következő figyelemfelhívó és működésre vonatkozó üzenetek a képernyő közepén jelennek meg. A hiba elhárításához
kövesse a feltüntetett utasításokat.

Üzenet kijelzése Felvétel/állapot
jelzőlámpa Oka és megoldása

Media Temperature
High

Villog
Forró a CFexpress kártya.
Cserélje ki a kártyát, vagy hagyja lehűlni, mielőtt újra használja.

Voltage Low Villog Lecsökkent a DC IN feszültség (1. szint). Ellenőrizze a tápforrást.

Insufficient Voltage Gyorsan villog
Túlságosan lecsökkent a DC IN feszültség (2. szint). Felvételkészítés
letiltva.
Csatlakoztasson más tápforrást.

Media Near Full Villog Fogyóban a memóriakártya maradék kapacitása.
Cserélje ki, mihelyt lehet.

Media Full Gyorsan villog
Klipek nem rögzíthetők vagy másolhatók, mert megtelt a memóriakártya.
Cserélje ki haladéktalanul.

Clips Near Full Villog
Fogyóban a hely további klipek számára a memóriakártyán.
Cserélje ki, mihelyt lehet.

Clips Full Gyorsan villog

Elérte a memóriakártyára felvehető klipek legnagyobb megengedett
számát.
További klipek nem rögzíthetők vagy másolhatók rá. Cserélje ki
haladéktalanul.

Last Clip Recording Villog
A pillanatnyilag folyó felvétel az utolsó klip, ami elfér a kártyán; elérte a
memóriakártyán rögzíthető maximális klipszámot.
Készítsen elő új memóriakártyát.

Media(A) Life Near
End1) Villog A memóriakártya élettartama végéhez közeledik. Cserélje ki, mihelyt

lehet.

Media(A) Life End1) Gyorsan villog A memóriakártya élettartama végére ért. Cserélje ki haladéktalanul.

Media(A) Near
Full1) Villog A Simul Rec funkció használatakor

Media(A) Full1) Gyorsan villog A Simul Rec funkció használatakor

Media(A) Clips
Near Full1) Villog A Simul Rec funkció használatakor

Media(A) Clips
Full1) Gyorsan villog A Simul Rec funkció használatakor

Media(A) Last Clip
Rec1) Villog A Simul Rec funkció használatakor

(Nincs kijelzés) Villog
Ismeretlen hiba történt az objektívvezérlőben.
Ellenőrizze az állapotot a kameraállapot alatt a webes alkalmazásban.
Ellenőrizze a részleteket a webes alkalmazás rendszernaplójában.

„(B)” jelenik meg a B kártyahelyen levő kártyánál.1)
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Megjelenő üzenet Oka és megoldása

Backup Battery End
Please Change

Elégtelen a memóriaőrző akkumulátor maradék kapacitása.
Kösse az egységet tápegységre legalább 24 órán át, hogy feltöltődjön
a memóriaőrző akkumulátor.

Unknown Media(A)1)

Please Change

Particionált vagy az egység által kezelhetőnél több klipet tartalmazó
memóriakártyát helyeztek be.
A kártya nem használható az egységben, ki kell cserélni.

Cannot Use Media(A)1)

Unsupported File System

Más fájlrendszerű vagy formázatlan kártyát helyeztek be.
A kártya nem használható az egységben; cserélje ki vagy formázza
meg az egységgel.

Media Error
Media(A) Needs to be Restored1)

Hiba történt a memóriakártyán; a kártyán visszaállítást kell végezni.
Állítsa vissza a memóriakártyát.

Media Error
Cannot Record to Media(A)1)

Lehet, hogy megsérült a memóriakártya, és nem használható többé
felvétel rögzítésére.
Lejátszható, s ezért javasoljuk, hogy készítsen róla másolatot és
cserélje ki.

Media Error
Cannot Use Media(A)1)

Lehet, hogy megsérült a memóriakártya, és nem használható többé
felvétel rögzítésére vagy lejátszásra.
A kártya nem használható az egységben, ki kell cserélni.

Media(A) Error1)

Recording Halted
Playback Halted

Leállt a felvétel és lejátszás, mert hiba történt a memóriakártya
használata közben.
Ha nem szűnik meg a probléma, cserélje ki a memóriakártyát.

Media Reached Rewriting Limit
Change Media(A)1)

A memóriakártya élettartama végére ért.
Készítsen másolatot róla és haladéktalanul cserélje ki. Ha tovább
használja, lehet, hogy nem fog tudni felvételt készíteni rá, vagy
lejátszani róla.
Részletek: a memóriakártya kezelői utasításaiban.

The specified address is invalid.
Érvénytelen a megadott cím.
Ellenőrizze a beállítás helyességét.

Cannot Use Specified Port Number Érvénytelen a megadott portszám.
Ellenőrizze a beállítás helyességét.

Lens I/F Error(xx:xx)

E-bajonettes objektív felhelyezésekor hiba történt az objektív
csatlakozófelületének kommunikációjában.
Ellenőrizze az E-bajonettes objektív csatlakozási állapotát.
Ha nem szűnik meg a probléma, keresse meg a Sony szervizt és
közölje velük a hibakódot (öt karakter, zárójelben).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs
was reached.

Elérte az átviteli feladatok legnagyobb megengedett számát.
Törölje a szükségtelen feladatokat. Proxy fájlok automatikus feltöltési
célhely beállítása is pontatlan lehet. Ellenőrizze a beállítás
helyességét.

Fan Stopped

Leállt a ventilátor.
Ellenőrizze, hogy nem akadályozza-e por vagy idegen tárgy.
Ha a hiba a portalanítás vagy az idegen tárgy eltávolítása után sem
szűnik meg, keresse meg a Sony szervizt.

„(B)” jelenik meg a B kártyahelyen levő kártyánál.1)
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RTMP streamelési hiba információi

A következő hibainformációkat jelenítheti meg az egység. Szükség szerint végezze el a következő beavatkozásokat.

SRT streamelési hiba információk

A következő hibainformációkat jelenítheti meg az egység. Szükség szerint végezze el a következő beavatkozásokat.

Hibakód
Magyarázat Megoldás

RTMP RTMPS

1002
1004

2002
2004

Nem lehet kapcsolódni az
RTMP-szerverhez.

Ellenőrizze a szerver URL címbeállításának helyességét.
Ellenőrizze a hálózati kapcsolatot.

1003 2003 Nem oldható fel a tartománynév.
Ellenőrizze a szerver URL címbeállításának helyességét.
Ellenőrizze a kapcsolatot a DNS szerverrel.

–
2005
2008

CRL hiba
Ellenőrizze a szerver URL címbeállításának helyességét.
Ellenőrizze, hogy a kapcsolat célhelye megbízható webhely-e.

2006 CA tanúsítvány hiba
Ellenőrizze az órabeállítás helyességét.
Ellenőrizze a CA tanúsítvány helyességét.

– 2007

Nincs telepítve egy CA
tanúsítvány.
Szerver tanúsítvány hitelesítési
hiba.

Telepítsen egy CA tanúsítványt.
Ellenőrizze, hogy a kapcsolat célhelye megbízható webhely-e.

4002
Megszakadt az RTMP-
munkamenet.

Lekapcsolódhatott az egység az RTMP-szerver oldalán.
Ellenőrizze, hogy a beállítások megfelelnek-e a szolgáltatás
ajánlott codec paraméterének.

4003
Gyenge a hálózati kapcsolat
minősége.

Ellenőrizze a hálózati kapcsolatot.

Egyéb Egyéb hibák.

Hibakód

Magyarázat MegoldásSRT-
Caller

1001 Váratlan hiba
Lehet, hogy az egység hibásan működik. Kapcsolja ki,
majd be az egységet.

1002
Megszakadt a kommunikáció a beállítások
megváltozása miatt.

Megszakadt a kommunikáció, mert módosították a
beállításokat.
Állítsa helyre a kapcsolatot.

5001 Váratlan hiba
Lehet, hogy az egység hibásan működik. Kapcsolja ki,
majd be az egységet.

5005 Hiba a kapcsolatban Ellenőrizze a kapcsolati célcím beállítás helyességét.

5006 Titkosítási hiba Ellenőrizze a titkosítási beállítás helyességét.

5007 Váratlan hiba Lehet, hogy az egység hibásan működik. Kapcsolja ki,
majd be az egységet.5008 Váratlan hiba
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Hibakód

Magyarázat MegoldásSRT-
Caller

5009 Átviteli hiba
Kommunikáció közben lekötötték az egységet.
Ellenőrizze a hálózati kapcsolatot.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Menüpontok jegyzéke

A következő táblázatok az egység menüpontjait sorolják fel.

Jelmagyarázat
„Kameramenü” és „webes menü”
●: választható
▲: egyes elemek választhatók
–: nem választható

„All File” és „Scene File”
Igen: ALL fájlban vagy jelenetfájlban elmentett elem
Nem: elmentetlen elem

„All Reset (except for Network Settings)”
A [Reset]> [Reset] > [All Reset (except for Network Settings)] végrehajtásakor a webes menüben:
Igen: inicializált elem (hálózati beállítások kivételével)
Nem: nem értelmezett

„Network Reset”
A [Reset]> [Reset] > [Network Reset] végrehajtásakor a webes menüben:
Igen: inicializált elem (hálózati beállítás)
Nem: nem értelmezett

„Factory Default”
Igen: gyári alapértelmezésre visszaállított elem
Nem: nem értelmezett

Shooting

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Igen Igen Igen Igen Igen

ND Filter ● – Igen Igen*1 Igen Nem Igen

Shutter ● – Igen Igen Igen Nem Igen

Iris ● – Igen Igen Igen Nem Igen

Auto Exposure ● – Igen Igen*2 Igen Nem Igen

White ● – Igen Igen*3 Igen Nem Igen

White Setting ● – Igen Nem Igen Nem Igen

Offset White ● – Igen Nem Igen Nem Igen

Focus ● ▲ Igen Nem Igen Nem Igen

S&Q Motion ● – Igen Nem Igen Nem Igen
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Project

Paint/Look

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Igen Nem Igen Nem Igen

Noise
Suppression

● – Igen Igen Igen Nem Igen

Flicker Reduce ● – Igen Nem Igen Nem Igen

SteadyShot ● – Igen Nem Igen Nem Igen

[Mode] nem értelmezett*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] nem értelmezett*2

[Preset White] nem értelmezett*3

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Igen Nem Igen Nem Igen

Rec Format ● ● Igen Nem Igen*1 Nem Igen

Cine
EI/Flex.ISO Set

● – Igen Nem Igen Nem Igen

Simul Rec ● ● Igen Nem Igen Nem Igen

Proxy Rec ● ▲ Igen Nem Igen Nem Igen

Interval Rec ● ● Igen*2 Nem Igen Nem Igen

Picture Cache
Rec

● ● Igen*2 Nem Igen Nem Igen

SDI/HDMI Rec
Control

● – Igen Nem Igen Nem Igen

Assignable
Button

● – Igen Nem Igen Nem Igen

All File – ● Nem Nem Nem Nem Nem

[Frequency] nem értelmezett*1

[Setting] nem értelmezett*2

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – Nem Nem Nem Nem Nem

Base Look ● ▲ Igen*1 Nem Igen*1 Nem Igen*1

Reset Paint
Settings

● – Nem Nem Nem Nem Nem
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Pan-Tilt

TC/Media

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Igen Igen Igen Nem Igen

Knee ● – Igen Igen Igen Nem Igen

Detail ● – Igen Nem Igen Nem Igen

Matrix ● – Igen Igen Igen Nem Igen

Multi Matrix ● – Igen*2 Igen*2 Igen Nem Igen

Bázismegjelenésként importált LUT adat nem értelmezett*1

[Axis] nem értelmezett*2

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● Nem Nem Igen Nem Nem

P/T
Acceleration

● ● Nem Nem Igen Nem Nem

P/T Range
Limit

– ● Nem Nem Igen Nem Nem

P/T Direction – ● Nem Nem Igen Nem Nem

P/T Preset – ● Nem Nem Igen Nem Nem

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Igen*1 Nem Igen Nem Igen

TC Display ● – Igen Nem Igen Nem Igen

Users Bit ● – Igen*1 Nem Igen Nem Igen

HDMI TC Out ● – Igen Nem Igen Nem Igen

Clip Name
Format

● – *2 Nem Igen Nem Igen

Update
Media

● – Nem Nem Nem Nem Nem

Format
Media

● – Nem Nem Nem Nem Nem

Media Life ● – Nem Nem Nem Nem Nem

[Setting] nem értelmezett*1

[Auto Naming] értelmezett, [Camera ID] nem értelmezett*2
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Monitoring

Audio

Thumbnail

Technical

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output
Format

● ● Igen Nem Igen Nem Igen

Output
Display

– ● Igen Nem Igen Nem Igen

Display
On/Off ● – Igen Nem Igen Nem Igen

Video Signal
Monitor

● – Igen Nem Igen Nem Igen

Marker ● – Igen Nem Igen Nem Igen

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Igen Nem Igen Nem Igen

Audio
Output

● ▲ Igen Nem Igen Nem Igen

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Nem Nem Nem Nem Nem

Set Clip Flag ● – Nem Nem Nem Nem Nem

Lock/Unlock
Clip

● – Nem Nem Nem Nem Nem

Delete Clip ● – Nem Nem Nem Nem Nem

Transfer Clip ● – Nem Nem Nem Nem Nem

Transfer Clip
(Proxy)

● – Nem Nem Nem Nem Nem

Filter Clips ● – Nem Nem Nem Nem Nem

Customize View ● – Igen Nem Igen Nem Igen
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Network

Stream

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color
Bars

● – *1 Nem *1 Nem Igen

Genlock ● – Nem Nem Nem Nem Nem

Tally ● ● Igen Nem Igen Nem Igen

Rec
Review

● – Igen Nem Igen Nem Igen

Zoom ● – Igen Nem Igen Nem Igen

IR
Remote

– ● Nem Nem Igen Nem Igen

Lens ● – Igen Nem Igen Nem Igen

APR ● – Nem Nem Nem Nem Nem

[Type] értelmezett, [Setting] nem értelmezett*1

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● Nem Nem Nem Nem Igen

User – ● Nem Nem Nem Igen Igen

Wired LAN*1 ▲ ● Nem Nem Nem Igen Nem

File Transfer ● ▲ Igen Nem Igen Igen Igen

FTP Server 1 – ● Nem Nem Igen Nem Igen

FTP Server 2 – ● Nem Nem Igen Nem Igen

FTP Server 3 – ● Nem Nem Igen Nem Igen

SSL – ● Nem Nem Nem Igen Igen

Referer Check – ● Nem Nem Nem Igen Igen

Brute Force
Attack Protection

– ● Nem Nem Nem Igen Igen

Nem konfigurálható a kameramenüvel (csak kijelzés)*1

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Nem Nem Igen*1 Nem Igen*1
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Maintenance
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Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Video
Stream

– ● Igen Nem Igen Nem Igen

Audio
Stream

– ● Igen Nem Igen Nem Igen

[NDI|HX] > [License] nem értelmezett*1

Elem
(2. szint) Kameramenü Webes

menü
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Igen Nem Igen Nem Igen

Accessibility – ● Igen Nem Nem Nem Igen

Clock Set ● ● Igen*1 Nem Igen*2 Nem Igen

Reset – ● Nem Nem Nem Nem Nem

Hours Meter ● – Nem Nem Nem Nem Nem

Information – ● Nem Nem Nem Nem Nem

System Log – ● Nem Nem Nem Nem Igen

HTTP Access
Log

– ● Nem Nem Nem Nem Igen

Service – ● Nem Nem Nem Nem Nem

EULA – ● Nem Nem Nem Nem Nem

Software – ● Nem Nem Nem Nem Nem

Dátum és pontos idő információ nem értelmezett*1

[Time Zone], dátum és pontos idő információ nem értelmezett*2
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Előbeállított helyzet elmentett elemei

Az „Igen” az előbeállított helyzet elmentett, a „Nem” a nem elmentett beállítását jelöli.

Pásztázási/döntési elemek

Zoom elemek

Fókuszálási elemek

A megjelenítés helye Elem Cél elmentése

Az élő működtető képernyő keretezésvezérlő panele
Pásztázási/döntési helyzet Igen

[Pan-Tilt Speed] Nem

[Pan-Tilt] a webes menüben

[P/T Speed] Nem

[P/T Acceleration] Nem

[P/T Range Limit] Nem

[P/T Direction] Nem

[P/T Preset] > [Pan-Tilt] Nem

[P/T Preset] > [Default] > [Pan-Tilt Speed] Igen1)

Előbeállított helyzet mentésekor a beállítások értékei az adott előbeállított helyzet értékeiként kerülnek elmentésre. Elmentésük után az egyes
előbeállított helyzetek értékei módosíthatók. Részletek: „Előbeállított helyzetek átállási gyorsaságának (pásztázás-döntés/zoom/fókusz)
módosítása a webes alkalmazással”.

1)

A megjelenítés helye Elem Cél elmentése

Az élő működtető képernyő keretezésvezérlő panele
Zoom helyzet (fókuszálási távolság) Igen

[Zoom Speed] Nem

[Pan-Tilt] > [P/T Preset] > [Default] a webes menüben
[Zoom Sync] Igen1)

[Zoom Speed] Igen1)

[Technical] > [Zoom] a kameramenüben [Zoom Type] Nem

Előbeállított helyzet mentésekor a beállítások értékei az adott előbeállított helyzet értékeiként kerülnek elmentésre. Elmentésük után az egyes
előbeállított helyzetek értékei módosíthatók. Részletek: „Előbeállított helyzetek átállási gyorsaságának (pásztázás-döntés/zoom/fókusz)
módosítása a webes alkalmazással”.

1)
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Kapcsolódó témák

Az átállási gyorsaság (pásztázás-döntés/zoom/fókusz) módosítása előbeállított helyzet visszaállításakor

5-041-958-53(1) Copyright 2022 Sony Corporation

A megjelenítés helye Elem Cél
elmentése

Az élő működtető képernyő kamerakép-
panele

A valós idejű követő AF-hez megadott követési célpont Nem

A spot fókusz megadott koordinátái Nem

 Az élő működtető képernyő (Focus)
füle

[Touch Focus] kapcsoló Nem

[Auto Focus] kapcsoló Igen

[Focus Hold] gomb állapota Nem

[Push AF/MF] gomb állapota Nem

[Face/Eye Detection AF] Igen

[AF Subj. Shift Sens.] Igen

[AF Transition Speed] Igen

Fókuszhelyzet Igen1)

[Shooting] > [Focus] a webes menüben

[Push AF Mode] (programozható gombokat használó
beállításokkal együtt)

Nem

[Touch Function in MF] Nem

[AF Assist Control] Nem

[Pan-Tilt] > [P/T Preset] > [Default] a
webes menüben

[Focus Recall] Igen2)

[MF Speed] Igen2)

[Shooting] > [Focus] a kameramenüben

A [Focus Area] pontban beállított fókuszmező méret és
helyzet

Igen

A [Focus Area (AF-S)] pontban beállított fókuszmező
méret

Igen

Nem áll vissza az [Auto Focus] kapcsoló On helyzetbe kapcsolásakor.1)

Visszaáll az Off helyzetbe állításkor.
Előbeállított helyzet mentésekor a beállítások értékei az adott előbeállított helyzet értékeiként kerülnek elmentésre.2)

Elmentésük után az egyes előbeállított helyzetek értékei módosíthatók.
Részletek: „Az átállási gyorsaság (pásztázás-döntés/zoom/fókusz) módosítása előbeállított helyzet visszaállításakor”.
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Tömbvázlatok

Audio Input

Audio Output

5-041-958-53(1) Copyright 2022 Sony Corporation
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E-bajonettes objektív szoftverének frissítése

E-bajonettes objektív szoftvere az egység közreműködésével frissíthető.
A frissíthető objektívek és a megfelelő szoftverek jegyzéke az objektív webhelyén található.
A szoftver frissítésére használja a webes menüt.

Megjegyzés

Ne végezze el a következő műveleteket a frissítés befejezéséig.

Lekapcsolás a hálózatról
Objektív leszerelése
A táplálás kikapcsolása

Ha a frissítés sikertelenségére utaló üzenet jelenik meg, ellenőrizze a megjelenített leírást, és próbálja meg újra a frissítést.

5-041-958-53(1) Copyright 2022 Sony Corporation

Erősítsen E-bajonettes objektívet az egységre.1

Ellenőrizze a webes menü [Maintenance] > [Information] > [Lens] > [Model Name] és [Version Number]
pontját.

Az E-bajonettes objektív szoftververzió száma oldalt látható.
Ellenőrizze a szoftververzió számát és szükség esetén frissítse a szoftvert.

2

A webes alkalmazással töltse le az eszközre az objektív szoftverét frissítő fájl Windows változatát (.exe
kiterjesztésű).

3

A [Maintenance] > [Information] > [Lens] > [Version Up] menüpontban nyomja meg a [Choose File] gombot
és válassza ki a letöltött frissítő fájlt.

4

Kövesse a képernyőn megjelenő utasításokat.5
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Az objektívkioldó gomb védőfedelének felhelyezése

Az objektív véletlen eltávolítását megakadályozhatja, ha a CIB-PCM1 mennyezeti konzolhoz (különtartozék) mellékelt
objektívkioldó gomb védőfedelét az objektívkioldó gombhoz rögzíti.

Megjegyzés

Ez megakadályozza az objektív teljes eltávolítását.

Kapcsolódó témák

Objektív felszerelése

5-041-958-53(1) Copyright 2022 Sony Corporation

Szerelje fel az objektívet.

Részletek objektív felszereléséről: „Objektív felszerelése”.

1

Csúsztassa a pásztázó/döntő zárókart a LOCK helyzetbe a kamerafej lezárásához pásztázó/döntő mozgás
ellen.

2

Mozgassa a kameratömböt olyan helyzetbe, ahol felszerelhető az objektívkidobó védőfedele.3

Helyezze fel az objektívkidobó védőfedelét úgy, hogy takarja az objektívkioldó gombot.4

Rögzítse a helyére az objektívkidobó védőfedelet az objektívkidobó védőfedél rögzítőcsavarjával.5
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Licencek

MPEG-4 AVC Patent Portfolio licenc

AZ AVC PATENT PORTFOLIO LICENC ENGEDÉLYEZI E TERMÉK FOGYASZTÓ ÁLTALI SZEMÉLYES HASZNÁLATÁT
VAGY EGYÉB, ELLENSZOLGÁLTATÁS NÉLKÜLI HASZNÁLATÁT
(i) VIDEO ANYAGOK AVC VIZUÁLIS SZABVÁNY („AVC VIDEO”) SZERINTI KÓDOLÁSÁRA ÉS/VAGY
(ii) OLYAN AVC VIDEO DEKÓDOLÁSA, AMELYET EGY SZEMÉLYES TEVÉKENYSÉGET FOLYTATÓ FOGYASZTÓ
KÓDOLT ÉS/VAGY AVC VIDEO SZOLGÁLTATÁSÁRA ENGEDÉLLYEL RENDELKEZŐ VIDEÓSZOLGÁLTATÓTÓL
KAPOTT.
SEMMILYEN MÁS FELHASZNÁLÁSRA NEM ADUNK EXPLICIT VAGY BELEÉRTETT LICENCET. TOVÁBBI
INFORMÁCIÓK AZ MPEG LA, LLC. VÁLLALATTÓL KÉRHETŐK. HTTP://WWW.MPEGLA.COM

Szoftver beszerzése a GPL/LGPL licenc alapján

Ez a termék a GPL/LGPL licenc hatálya alá eső szoftvert használ. Ezennel tájékoztatjuk, hogy a GPL/LGPL feltételei
szerint Ön jogosult e szoftverprogramok forráskódjának elérésére, módosítására és terjesztésére.
A forráskód az interneten elérhető. Használja a következő URL címet és kövesse a letöltési utasításokat.
https://oss.sony.net/Products/Linux/
Kérjük, ne keressenek meg minket a forráskód tartalmával kapcsolatban.

μT-Kernel forráskód

Ez a termék a μT-Kernel forráskódját használja a TRON Forum (www.tron.org) által biztosított T-License 2.1 szerint.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Műszaki adatok

Általános

Tömeg
Kb. 4,6 kg (csak a váz)
Kb. 6,0 kg (SELP28135G objektívval)

Méretek
Lásd: „Befoglaló méretek”.

Tápfeszültség
19,5 V=
PoE++ (IEEE802.3bt, Type 4, Class 8 kompatibilis)

Teljesítményfelvétel
19,5 V=, 80,0 W (max)
PoE++: 71,3 W (max)　

Üzemi hőmérséklet
0 °C – 40 °C

Tárolási hőmérséklet
–20 °C – +60 °C

Felvételi formátum (video)
XAVC Intra
XAVC-I 4K/QFHD üzemmód: VBR, 600 Mbit/s (max) bitsebesség, MPEG-4 AVC/H.264
XAVC-I HD üzemmód: CBG, 223 Mbit/s (max), MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD üzemmód: VBR, 150 Mbit/s (max) bitsebesség, MPEG-4 H.264/AVC
XAVC-L HD 50 üzemmód: VBR, 50 Mbit/s (max), MPEG-4 H.264/AVC
XAVC-L HD 35 üzemmód: VBR, 35 Mbit/s (max), MPEG-4 H.264/AVC

Felvételi formátum (hang)
LPCM 24-bit, 48 kHz, 4 csatorna

Felvételi képfrekvencia

XAVC Intra
XAVC-I 4K üzemmód: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD üzemmód: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD üzemmód: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD üzemmód: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50 üzemmód: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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XAVC-L HD 35 üzemmód: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Felvételi/lejátszási idő
XAVC Intra
XAVC-I QFHD üzemmód: 59.94P, kb. 30 perc (CEA-G160T használatakor)
XAVC-I HD üzemmód: 59.94P, kb. 78 perc (CEA-G160T használatakor)

XAVC Long
XAVC-L QFHD üzemmód: 59.94P, kb. 115 perc (CEA-G160T használatakor)
XAVC-L HD 50 üzemmód: 59.94P, kb. 155 perc (CEA-G80T használatakor)
XAVC-L HD 35 üzemmód: 59.94P, kb. 210 perc (CEA-G80T használatakor)

Megjegyzés

A használati körülmények és memóriajellemzők miatt a felvételi/lejátszási idő eltérhet. A felvételi és lejátszási idők egyetlen klip
folyamatos vételére vonatkoznak. A tényleges idők rövidebbek is lehetnek, a felvett klipek számától függően.

Pásztázó/döntő hajtás rész

Legkisebb pásztázási gyorsaság: 0,02 fok/s
Legkisebb döntési gyorsaság: 0,02 fok/s
Legnagyobb pásztázási gyorsaság: 60 fok/s
Legnagyobb döntési gyorsaság: 60 fok/s
Pásztázási tartomány: −170 fok – +170 fok
Döntési tartomány: –30 fok – +195 fok
Zajkritérium minősítés: NC35 vagy kisebb
Előbeállított helyzetek száma: 100

Kamera rész

Képalkotó eszköz
35mm teljes képkocka (35,6 × 23,8 mm), Exmor R CMOS érzékelő

A képpontok száma
Kb. 12,9 megapixel (összes képpont)
Kb. 10,3 megapixel (hatásos képpontok)

Automatikus fókuszálás
Érzékelési módszer: fázisérzékelés/kontrasztérzékelés

Beépített ND szűrők
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Lineárisan változó ND: 1/4ND – 1/128ND

ISO érzékenység
ISO 800/12800 (Cine EI üzemmód, D55 fényforrás)

Objektívrögzítő foglalat
E-bajonett

Szélesség
15+ rekesz

497



Záridő
64F – 1/8000 s (23.98P)

Zárszög
5,6° – 360°, 2 – 64 képkocka

Lassított és gyorsított felvétel
XAVC QFHD: 1 fps – 120 fps
XAVC HD: 1 fps – 240 fps
XAVC 4K: 1 fps – 60 fps
XAVC HD (S35): 1 fps – 120 fps

Fehéregyensúly
2000 K – 15000 K

Erősítés
–3 dB – +30 dB (1 dB-es lépésekben)

Bázismegjelenés
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Hang rész

Mintavételi frekvencia
48 kHz

Kvantálás
24-bit

Frekvenciamenet
XLR bemenet MIC üzemmód: 20 Hz – 20 kHz (±3 dB vagy kisebb)
XLR bemenet LINE üzemmód: 20 Hz – 20 kHz (±3 dB vagy kisebb)

Dinamika
XLR bemenet MIC üzemmód: 80 dB (tipikus)
XLR bemenet LINE üzemmód: 90 dB (tipikus)

Torzítás
XLR input MIC mode: 0,08% vagy kisebb (–40 dBu bemeneti szint)
XLR input LINE mode: 0,08% vagy kisebb (+14 dBu bemeneti szint)

Bemenet/kimenet rész

Bemenetek
DC IN

EIAJ kompatibilis, 19,5 V=

AUDIO IN

XLR típusú, 5 érintkezős, aljzat
LINE / MIC / MIC+48V kapcsolható
MIC: referencia –30 dBu – –80 dBu
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GENLOCK IN

BNC csatlakozó, 1,0 Vcs-cs, 75 Ω

TC IN

BNC csatlakozó

Kimenetek
SDI OUT

BNC csatlakozó, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Type-A csatlakozó

OPTICAL kimeneti csatlakozó

SFP+ kompatibilis
* Az egység nem támogatja az optikai jelbemenetet.

Bemenet/kimenet
LAN csatlakozó

RJ-45, 1000BASE-T

OPTION csatlakozó

RJ-45 állapot bemenet/kimeneti csatlakozó

Adathordozó kártyahely rész

CFexpress Type A / SD kártyahely (2)

Gyári tartozékok

Hálózati tápegység (1)
Hálózati vezeték (1)
Infra távvezérlő (1)
Vázsapka (1) (a készülékhez erősítve)
HDMI-kábel tartó lemez (1)
Az egység használata előtt (1)
Jótállási füzet (1)

Külső méretek

A méret értékek közelítőek.
Mértékegység: mm

Kameraváz
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Mennyezeti konzol
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A kivitel és a műszaki adatok előzetes értesítés nélkül változhatnak.

5-041-958-53(1) Copyright 2022 Sony Corporation
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Súgó útmutató

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Védjegyek

 a Sony Group Corporation védjegye.
XAVC és  a Sony Group Corporation bejegyzett védjegye.
A HDMI és a HDMI High-Definition Multimedia Interface kifejezések, valamint a HDMI embléma a HDMI Licensing
Administrator, Inc. védjegyei vagy bejegyzett védjegyei az Amerikai Egyesült Államokban és más országokban.
A Microsoft és a Windows név a Microsoft Corporation védjegye vagy az Egyesült Államokban és/vagy más
országokban bejegyzett védjegye.
A Mac és macOS név az Apple Inc. Egyesült Államokban és/vagy más országokban bejegyzett védjegye.
A „Catalyst Browse” logó a Sony Group Corporation védjegye vagy bejegyzett védjegye.
Az IOS a Cisco védjegye vagy az Egyesült Államokban és más országokban bejegyzett védjegye és licenc alapján
használjuk.
Az iPadOS, Safari és iPad név az Apple Inc. Egyesült Államokban és más országokban és régókban bejegyzett
védjegye.
Az Android és a Google Chrome név a Google LLC védjegye vagy bejegyzett védjegye.
A Wi-Fi a Wi-Fi Alliance bejegyzett védjegye.
Az SDXC logó a SD-3C, LLC. védjegye.
A CFexpress és CFexpress Type A logó a CompactFlash Association védjegye.
A NewTek™ és NDI® név a NewTek, Inc. védjegye vagy bejegyzett védjegye.
A JavaScript az Oracle és/vagy kapcsolt vállalatai bejegyzett védjegye.
Az Intel, az Intel logó és az Intel Core az Intel Corporation vagy leányvállalatai védjegye.
A QR Code a Denso Wave Inc. védjegye.
Minden más cégnév és terméknév tulajdonosa bejegyzett védjegye vagy védjegye. E dokumentumban nem jelöljük
™ vagy ® szimbólummal a védjegyes elemeket.
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